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Overview of Cisco IoT Field Network Director
This section provides an overview of the Cisco IoT Field Network Director (Cisco IoT FND) and describes its role within the Cisco Internet of 
Things (IoT) Network solution. Topics include:

 Cisco IoT Connected Grid Network

 How to Use This Guide

 Interface Overview

Cisco IoT Connected Grid Network
This section provides an overview of:

 Cisco IoT FND Features and Capabilities

 IoT FND Architecture

 Mesh Endpoints

 Grid Security

 Related Software

The Cisco IoT Field Network Director (IoT FND) is a software platform that manages a multi-service network and security infrastructure for IoT 
applications, such as smart grid applications, including Advanced Metering Infrastructure (AMI), Distribution Automation (DA), distributed 
intelligence, and substation automation. IoT FND is a scalable, highly secure, modular, and open platform with an extensible architecture. IoT FND 
is a multi-vendor, multi-service, communications network management platform that enables network connectivity to an open ecosystem of power 
grid devices.

IoT FND is built on a layered system architecture to enable clear separation between network management functionality and applications, such as 
a distribution management system (DMS), outage management system (OMS), and meter data management (MDM). This clear separation between 
network management and applications helps utilities roll out Smart Grid projects incrementally, for example with AMI, and extend into distribution 
automation using a shared, multi-service network infrastructure and a common, network management system across various utility operations. 

Features

 Geographic Information System (GIS) map-based, visualization, monitoring, troubleshooting, and alarm notifications 

 Group-based configuration management for field-area routers (FARs) and smart meter endpoints 

 OS compatible (Guest OS) and provides application management

 Rule-engine infrastructure for customizable threshold-based alarm processing and event generation 

 North Bound API for transparent integration with utility head-end and operational systems 

 High availability and disaster recovery 

Cisco IoT FND provides powerful Geographic Information System (GIS) visualization and monitoring capability. Through the browser-based 
interface, utility operators manage and monitor devices in a Cisco IoT Connected Grid Field Area Network (FAN) solution, using IPv6 over 
Low-power Wireless Personal Area Networks (6LoWPANs). The FAN includes the following devices:
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 Cisco 1000 Series Connected Grid Routers (CGRs), also called pole-top or DIN-rail-mount routers. These devices are referred to as FARs in 
this document and identified by model (for example, CGR1000, CGR1120, or CGR1240) on the Field Devices page. Available CGRs modules 
provide 3G, 4G LTE, and mesh connectivity (WPAN) . CGR1000s also support the Itron OpenWay RIVA CAM module, which provides 
connectivity to the Itron OpenWay RIVA electric and gas-water devices.

 Cisco 800 Series Integrated Services Routers (ISR 800s) are used in most networks as edge routers or gateways to provide WAN connectivity 
(cellular, satellite over Ethernet, and WiFi) to an end device (energy-distribution automation devices, other verticals such as ATMs, and mobile 
deployments such as taxis or trucks). These devices are referred to as FARs in this document; and identified by product ID (for example, C800 
or C819) on the Field Devices page. You can use IoT FND to manage the following hardened Cisco 819H ISRs: 

— C819HG-4G-V-K9

— C819HG-4G-A-K9

— C819HG-U-K9

— C819HGW-S-A-K9

— C819H-K9

IoT FND also manages the following non-hardened Cisco 819 ISRs:

— C819G-B-K9

— C819G-U-K9

— C819G-4G-V-K9

— C819G-7-K9

 Cisco 800 Series Industrial Integrated Services Routers (IR800s) are compact, ruggedized, Cisco IOS Software routers. They offer support for 
integrated 4G LTE wireless WAN (both IR809 and IR829 models) and wireless LAN capabilities (IR829 only). These devices are referred to 
as FARs in this document; and identified by product ID (for example, IR800) on the Field Devices page. You can use IoT FND to manage the 
following IR800 models:

— IR809

— IR829

 Cisco Interface Module for Long Range Wide Area Network (LoRAWAN) is an extension module for the industrial routers, Cisco IR809 and 
IR829, and serves as carrier-grade gateways for outdoor deployments. The module provides unlicensed low-power wide area (LPWA) wireless 
connectivity for a range of Internet of Things (IoT) use cases such as asset tracking, water and gas metering, street lighting, smart 
parking/building/agriculture and environment monitoring. There are two models supported, which are differentiated by their band support 
(863-870 MHz ISM or 902-928 MHz ISM).

 Cisco 500 Series Wireless Personal Area Network (WPAN) Industrial Routers (IR500) supply RF mesh connectivity to IPv4 and serial Internet 
of Things (IoT) devices (for example, recloser control, cap bank control, voltage regulator controls, and other remote terminal units).

Note: CGRs, C800s, IR800s, IR500s and other types of mesh endpoint devices can coexist on a network, but cannot be in the same device 
group (see Creating Device Groups and Working with Mesh Endpoint Firmware Images) or firmware management group (see Configuring 
Firmware Group Settings).

 Cisco 800 Series Access Points are integrated with IR800s and C800s. These devices are referred to as FARs in this document; and identified 
by product ID (for example, AP800). You can use IoT FND to manage the following AP800 models:

— AP802 embedded in C800

— AP803 embedded in IR829

 Cisco ASR 1000 Series Aggregation Services Routers (ASRs) and Cisco ISR 3900 Series Integrated Service Routers (ISRs), referred to as 
head-end routers or HERs in this document.
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 Cisco IPv6 RF (radio frequency), PLC (power line communications), and Dual PHY (RF and PLC) mesh endpoints (smart meters and range 
extenders).

Note: In this document, mesh endpoints (MEs) refers to Cisco range extenders and Cisco-compatible smart meters.

IoT FND typically resides in the utility control center with other utility head-end operational systems, such as an AMI head end, distribution 
management system, or outage management system. IoT FND features enterprise-class fault, configuration, accounting, performance, and security 
(FCAPS) functionality, as defined in the Open Systems Interconnection (OSI) model.

The Cisco IoT FND North Bound Application Programmable Interface (NB API) allows various utility applications like DMS, OMS, or MDM to 
pull appropriate, service-specific data for distribution grid information, outage information, and metering data from a shared, multi-server 
communication network infrastructure. For more information about the Cisco IoT FND North Bound API, see the Cisco IoT FND NMS North 
Bound API Programming Guide for your IoT FND installation. 

The NB API can send events using HTTPS. NB API clients must subscribe to IoT FND by providing a valid HTTPS URL to send events. IoT FND 
accepts all SSL and handshake certificates published by the NB API client (the event consumer) while making the secure connection.

Cisco IoT FND Features and Capabilities 
 Configuration Management – Cisco IoT FND facilitates configuration of large numbers of Cisco CGRs, Cisco C800s, Cisco ISRs, Cisco 

IRs, Cisco ASRs, and MEs. Use Cisco IoT FND to bulk-configure devices by placing them into configuration groups, editing settings in a 
configuration template, and then pushing the configuration to all devices in the group.

 Device and Event Monitoring – Cisco IoT FND displays easy-to-read tabular views of extensive information generated by devices, allowing 
you to monitor your network for errors. Cisco IoT FND provides integrated Geographic Information System (GIS) map-based visualization of 
FAN devices such as routers and smart meters. Use IoT FND to create CGR-specific work orders that include the required certificates to access 
the router.

 Firmware Management – Cisco IoT FND serves as a repository for Cisco CGR, Cisco C800, Cisco ISR, Cisco IR, and ME firmware images. 
Use Cisco IoT FND to upgrade the firmware running on groups of devices by loading the firmware image file onto the Cisco IoT FND server, 
and then uploading the image to the devices in the group. Once uploaded, use IoT FND to install the firmware image directly on the devices. 
In release 3.0.1-36 and later, a Subnet List view on the Firmware Upgrade page for Mesh Endpoints lets you filter and view subnets by PAN 
identifier (PAN ID) and Group (details include number of nodes within a group, hops away from the router and operational status). A subnet 
progress histogram has also been added.

 OS Migration – For Cisco CGR 1000, IoT FND allows you to migrate CGRs running CG-OS to IOS. 

 Zero Touch Deployment – This ease-of-use feature automatically registers (enrolls) and distributes X.509 certificates and provisioning 
information over secure connections within a connected grid network.

 Tunnel Provisioning – Protects data exchanged between Cisco ASRs and Cisco CGRs, C800s, Cisco ISRs and Cisco IRs, and prevents 
unauthorized access to Cisco CGRs, to provide secure communication between devices. Cisco IoT FND can execute CLI commands to 
provision secure tunnels between Cisco CGRs, C800s, Cisco ISRs and Cisco IRs and Cisco ASRs. Use IoT FND to bulk-configure tunnel 
provisioning using groups.

 IPv6 RPL Tree Polling – The IPv6 Routing Protocol for Low-power and Lossy Networks (RPL) finds its neighbors and establishes routes 
using ICMPv6 message exchanges. RPL manages routes based on the relative position of the ME to the CGR that is the root of the routing tree. 
RPL tree polling is available through the mesh nodes and CGR periodic updates. The RPL tree represents the mesh topology, which is useful 
for troubleshooting. For example, the hop count information received from the RPL tree can determine the use of unicast or multicast for the 
firmware download process. IoT FND maintains a periodically updated snapshot of the RPL tree. 

 Dynamic Multipoint VPN and FlexVPN - For Cisco C800 devices and Cisco IR800 devices, DMVPN and FlexVPN do not require IoT FND 
to apply device-specific tunnel configuration to the HER during tunnel provisioning. HER tunnel provisioning is only required for site-to-site 
VPN tunnels.

 Embedded Access Point (AP) Management - IoT FND provides management of embedded APs on C819 and IR829 routers.
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 Dual PHY Support – IoT FND can communicate with devices that support Dual PHY (RF and PLC) traffic. IoT FND identifies CGRs running 
Dual PHY, enables configuration to masters and slaves, and collects metrics from masters. IoT FND also manages security keys for Dual PHY 
CGRs. On the mesh side, IoT FND identifies Dual PHY nodes using unique hardware IDs, enables configuration pushes and firmware updates, 
and collects metrics, including RF and PLC traffic ratios. 

 Guest OS (GOS) Support – For Cisco IOS CGR 1000 and IR800 devices that support Guest OS, IoT FND allows approved users to manage 
applications running on the supported operating systems. IoT FND supports all phases of application deployment, and displays application 
status and the Hypervisor version running on the device.

 Device Location Tracking – For CGR 1000, C800, and IR800 devices, IoT FND displays real-time location and device location history. This 
feature requires enabling the GPS feature.

 Software Security Module (SSM) – This is a low-cost alternative to the Hardware Security Module (HSM), and is used for signing CSMP 
messages sent to meters and IR500 devices. 

 Customer Certificates – Cisco IoT FND allows you to use your own CA and ECC-based certificates to sign smart meter messages.

 Diagnostics and Troubleshooting – The IoT FND rule engine infrastructure provides effective monitoring of triage-based troubleshooting. 
Device troubleshooting runs on-demand device path trace and ping on any CGR, Cisco C800, range extender, or meter (mesh endpoints). 

 High Availability – To ensure uninterrupted network management and monitoring, you can deploy the Cisco IoT FND solution in a High 
Availability (HA) configuration. By using clusters of load-balanced IoT FND servers and primary and standby IoT FND databases, 
Cisco IoT FND constantly monitors the health of the system, including connectivity within clusters and server resource usage. If a server 
cluster member or database becomes unavailable or a tunnel fails, another takes its place seamlessly. Additionally, you can add reliability to 
your IoT FND solution by configuring redundant tunnels between a Cisco CGR and multiple Cisco ASRs.

 Power Outage Notifications – Connected Grid Endpoints (CGEs) implement a power outage notification service to support timely and 
efficient reporting of power outages. In the event of a power outage, CGEs perform the necessary functions to conserve energy and notify 
neighboring nodes of the outage. FARs relay the power outage notification to IoT FND, which then issues push notifications to customers to 
relate information on the outage.

 Mesh Upgrade Support – Over-the-air software and firmware upgrades to field devices such as Cisco CGRs and CGEs (for example, AMI 
meter endpoints).

 Audit Logging – Logs access information for user activity for audit, regulatory compliance, and Security Event and Incident Management 
(SEIM) integration. This simplifies management and enhances compliance by integrated monitoring, reporting, and troubleshooting 
capabilities.

 North Bound APIs – Eases integration of existing utility applications such as outage management system (OMS), meter data management 
(MDM), trouble-ticketing systems, and manager-of-managers. 

 Work Orders for Device Manager – Credentialed field technicians can remotely access and update work orders.

 Role – Based Access Controls – Integrates with enterprise security policies and role-based access control for AMI network devices.

 Event and Issue Management – Fault event collection, filtering, and correlation for communication network monitoring. IoT FND supports 
a variety of fault-event mechanisms for threshold-based rule processing, custom alarm generation, and alarm event processing. Faults display 
on a color-coded GIS-map view for various endpoints in the utility network. This allows operator-level custom, fault-event generation, 
processing, and forwarding to various utility applications such as an outage management system. Automatic issue tracking is based on the 
events collected.

IoT FND Architecture
Figure 1 provides a high-level view of the systems and communication paths that exist in a typical utility company operating on a Cisco CGR 
connected grid network in which Zero Touch Deployment is in use.

For Cisco IOS CGRs, we recommend a tunnel configuration using FlexVPN. FlexVPN combines all of these features in one GRE tunnel (protected 
by IPsec). 

For Cisco C800s and IR800s, we recommend using Dynamic Multipoint VPN (DMVPN) or FlexVPN. 
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Figure 1 Zero Touch Deployment Architecture

In this example, the firewall provides separation between those items in the utility company public network (DMZ) and its private network.

The utility company private network shows systems that might reside behind the firewall such as the Cisco IoT FND, the Oracle database server, 
the Cisco IoT FND North Bound API, the DHCP server, and the Certificate Authority (CA). The Cisco IoT FND Tunnel Provisioning Server proxy 
(TPS proxy) and Registration Authority (RA) might be located in the DMZ. 

After installing and powering on the Cisco CGR, it becomes active in the network and registers its certificate with the RA by employing the Simple 
Certificate Enrollment Protocol (SCEP). The RA (Cisco 3945 ISR in Figure 1), functioning as a CA proxy, obtains certificates for the Cisco CGR 
from the CA. The Cisco CGR then sends a tunnel provisioning request over HTTPS to the TPS proxy that forwards it to IoT FND. 

Cisco IoT FND manages collection of all information necessary to configure a tunnel between Cisco CGRs and the head-end router (Cisco ASR 
1001 in Figure 1). For CG-OS CGR installations, we recommend a network configuration with an outer IPsec tunnel over IPv4 inside which is an 
IPv6-in-IPv4 GRE tunnel. All traffic from the MEs is over IPv6. The GRE tunnel provides a path for IPv6 traffic to reach the data center. The outer 
IPsec tunnel secures that traffic. When the tunnel is active, the Cisco CGR (after configuration) connects to the utility company network like a 
Virtual Private Network (VPN). 
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Main Components of a IoT FND Solution

High Availability and Tunnel Redundancy

The example in Figure 1 is of a single-server deployment with one database and no tunnel redundancy. However, you could take advantage of 
Cisco IoT FND HA support to deploy a cluster of Cisco IoT FND servers connected to a Cisco ACE 4710 load balancer, as shown in Figure 2. The 
load balancer sends requests to the servers in a round-robin fashion. If a server fails, the load balancer keeps servicing requests by sending them to 
the other servers in the cluster.

You could also deploy a standby Cisco IoT FND database to provide another layer of high availability in the system with minimal data loss.

Figure 2 IoT FND Server and Database HA

To provide tunnel redundancy, IoT FND allows you to create multiple tunnels to connect a CGR to multiple ASRs, as shown in Figure 3.

Component Description

IoT FND Application Server This the heart of IoT FND deployments. It runs on an RHEL server and allows administrators to control 
different aspects of the IoT FND deployment using its browser-based graphical user interface.

IoT FND HA deployments include two or more IoT FND servers connected to a load balancer.

NMS Database This Oracle database stores all information managed by your IoT FND solution, including all metrics 
received from the MEs and all device properties such as firmware images, configuration templates, logs, 
event information, and so on.

Software Security Module (SSM) This is a low-cost alternative to the Hardware Security Module (HSM), and is used for signing CSMP 
messages sent to meters and IR500 devices.

TPS Proxy Allows FARs to communicate with IoT FND when they first start up in the field. After IoT FND 
provisions tunnels between the FARs and ASRs, the FARs communicate with IoT FND directly.

Load Balancer (Optional) IoT FND uses the Cisco ACE 4710 in Figure 1 to provide HA. The load balancer distributes 
the traffic among the IoT FND servers in the server cluster in your solution.
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Figure 3 IoT FND Tunnel Redundancy

For more information about HA, see Database High Availability.

Mesh Endpoints
The Cisco Field Area Network (FAN) solution brings the first multi-service communications infrastructure to the utility field area network. It 
delivers applications such as AMI, DA, and Protection and Control over a common network platform. 

Advanced meter deployments follow a structured process designed to match the right solution to the needs of the utility company. This process 
moves in phases that require coordination between metering, IT, operations, and engineering. The first phase for most utilities is identification of 
goals, followed by analysis of data needs, and business processes. After an evaluation of the business case is complete and a technology chosen, 
system implementation and validation complete the process.

Once the utility company moves past the business case into system implementation, unforeseen complications can sometimes slow or delay a 
deployment. The true value of a plug-and-play system is that it saves cost and improves the return on investment by allowing the benefits of 
advanced metering to be realized sooner.

The features that enable a true plug-and-play RF or PLC mesh network system include:

 Self-initializing endpoints: CGRs automatically establish the best path for communication through advanced self-discovery – meters and 
infrastructure deploy without programming.

 Scalability: This type of network enables pocketed deployments where each Cisco IoT FND installation can accept up to 10 million 
meters/endpoints. Large capacity enables rapid, multi-team deployments to occur in various parts of the targeted AMI coverage area, while 
saving infrastructure and communication costs.

In a true mesh network, metering and range extender devices communicate to and through one another and decide their own best links, forming the 
RF Mesh Local Area Network (RFLAN) or PLC LAN. These ME devices become the network and possess dynamic auto-routing functions that 
eliminate the need for dedicated repeater infrastructure or intermediate (between endpoint and collector) tiered radio relay networks. The result is 
a substantial reduction in dedicated network infrastructure as well as powerful and more flexible fixed-network communication capability. 

Range extenders are installed by the utility company to strengthen mesh coverage and provide redundancy, supplementing network reliability in 
difficult environmental settings such as dense urban areas where buildings obstruct the normal mesh signal propagation, or in low-meter-density 
geographically sparse regions and RF-challenged areas. A range extender automatically detects and connects to the mesh after installation or outage 
recovery, and then provides an alternate mesh path. 

In a normal deployment scenario, these MEs form a stable RFLAN or PLC LAN network the same day they are deployed. Once the collector is 
installed, placing MEs throughout the deployment area is as simple as changing out a meter. MEs form a network and begin reporting automatically.

Mesh endpoints send and receive information. A two-way mesh system allows remote firmware upgrades, as well as system settings changes and 
commands for time-of-use periods, demand resets, and outage restoration notifications. Not having to physically “touch the meter” is a major value, 
especially when entering the advanced demand response metering domain that requires time-of-use (TOU) schedule changes and interval data 
acquisition changes to meet specific client needs. These commands can be sent to groups or to a specific ME. Meter commands can be scheduled, 
proactive, on-demand, or broadcast to the entire network. 
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Communication between the data center/network operations center (NOC) and the collector is accomplished by widely available and cost-efficient 
mass marketed TCP/IP-based public wide area network (WAN) or with the utility company-owned WAN. The flexibility and open standard public 
WAN architectures currently available and in the future create an environment that allows continued ongoing cost reduction and future options, 
without being tied into one type of connectivity over the life of the asset. It is best if the AMI system avoids using highly specialized WAN systems. 

After deployment is complete, the system can transmit scheduled hourly (and sub hourly) data to support utility applications such as billing reads, 
advanced demand response initiatives, load research, power quality, and transformer asset monitoring.

Easy access and reliable on-demand capability allow the utility to perform grid diagnostics and load research system-wide or for selected groups of 
meters. Other standard features support outage management, tamper detection, and system performance monitoring. 

Grid Security
Designed to meet the requirements of next-generation energy networks, Cisco Grid Security solutions take advantage of our extensive portfolio of 
cybersecurity and physical security products, technologies, services, and partners to help utility companies reduce operating costs while delivering 
improved cybersecurity and physical security for critical energy infrastructures.

Cisco Grid Security solutions provide:

 Identity management and access control: Secure utility facilities, assets, and data with user authentication and access control are 
custom-built for grid operations.

 Thread defense: Build a layered defense that integrates with firewall, VPN, intrusion prevention, and content security services to detect, 
prevent, and mitigate threats.

 Data center security: Turn network, computing, and storage solutions into a secure, shared pool of resources that protects application and data 
integrity, secures communications between business processes and applications within the utility, and secures connectivity to external resources 
such as providers of renewable energy.

 Utility compliance: Improve risk management and satisfy compliance and regulatory requirements such as NERC-CIP with assessment, 
design, and deployment services.

 Security monitoring and management: Identify, manage, and counter information security threats and maintain compliance through ongoing 
monitoring of cyber events. 

Related Software
The following software packages assist in deploying and managing your Cisco Internet of Things (IoT) Network solution.

Cisco IoT Device Manager

The Cisco IoT Device Manager (Device Manager or IoT-DM) is a Windows-based application used by field technicians to remotely manage Cisco 
CGRs. For some activities, the IoT-DM retrieves information from IoT FND.

Cisco Industrial Operations Kit 

The Cisco Industrial Operations Kit (IOK) incorporates multiple virtual appliances for management, network, and IOK security-related head-end 
network services for the Cisco IoT Network solution. Talk to your Cisco representative for more information.

How to Use This Guide
This section has the following topics to help you quickly find information:

 Common Tasks

 CGR Tasks

 Mesh Endpoint Tasks
8
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 Administration Tasks

 Document Conventions

Common Tasks
Table 1 lists tasks that users perform on both FARs and MEs. The ability to perform tasks is role-based. For information about user roles, see 
System-Defined User Roles.

CGR Tasks
Table 2 lists CGR tasks. For information about user roles, see System-Defined User Roles.

Table 1 Common Tasks

Task Use

Device Viewing Tasks

View devices Working with Router Views, Viewing Endpoints in Default View

View detailed device information Displaying Detailed Device Information

Device Labeling Tasks

Add labels Adding Labels in Bulk

Remove labels Removing Labels in Bulk

Search and Device Filtering Tasks

Use filters Using Filters to Control the Display of Devices

Diagnostics and Troubleshooting Tasks

Ping Pinging Devices

Traceroute Tracing Routes to Devices

Download logs Downloading Logs

Monitoring Tasks

View and search events Monitoring Events

View and search issues Monitoring Issues, Viewing Device Severity Status on the Issues Status Bar

View tunnel status Monitoring Tunnel Status

General Tasks

Change password Resetting Passwords

Set time zone Configuring the Time Zone

Set user preferences Setting User Preferences

Table 2 CGR Tasks

Task Use

Router Configuration Group Tasks

Add CGRs to configuration groups Creating Device Groups

Delete a configuration group Deleting Device Groups

List devices in a configuration group Listing Devices in a Configuration Group
9
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Mesh Endpoint Tasks 
Table 3 lists ME tasks. For information about user roles, see System-Defined User Roles.

Assign devices to groups Adding FARs to IoT FND

Adding HERs to IoT FND

Moving Devices to Another Configuration Group Manually

Moving Devices to Another Configuration Group in Bulk

Rename configuration groups Renaming a Device Configuration Group

Router Configuration Tasks

Change device configuration properties Changing Device Configuration Properties

Edit configuration templates Editing the ROUTER Configuration Template

Editing the AP Configuration Template

Push configurations Pushing Configurations to Endpoints

Migrate from CG-OS to IOS Performing OS Migrations

Manage applications Managing GOS Applications

Tunnel Provisioning Tasks

Configure tunnel provisioning Configuring Tunnel Provisioning

Edit tunnel provisioning templates Configuring Tunnel Provisioning Templates

Reprovision tunnels Tunnel Reprovisioning

Factory Reprovisioning

Firmware Management Tasks

Assign devices to firmware groups Assigning Devices to a Firmware Group

Upload images to firmware groups Uploading a Firmware Image to a FAR Group

Work Order Tasks

Create work orders Creating Work Orders

Table 3 Mesh Endpoint Tasks

Task Use

ME Configuration Group Tasks

Add mesh endpoint configuration groups Creating Device Groups

Delete mesh endpoint configuration groups Deleting Device Groups

Rename mesh endpoint configuration groups Renaming a Device Configuration Group

Assign mesh endpoint devices to a 
configuration group

Moving Devices to Another Group

List devices in a configuration group Listing Devices in a Configuration Group

ME Configuration Tasks

Change mesh endpoint configuration 
properties

Changing Device Configuration Properties

Edit mesh endpoint configuration templates Editing the ENDPOINT Configuration Template

Push configuration to mesh endpoints Pushing Configurations to Endpoints

Table 2 CGR Tasks (continued)

Task Use
1
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Administration Tasks
Table 4 lists administration tasks. 

Document Conventions
This document uses the following conventions. 

Add mesh endpoint firmware groups Creating Device Groups

Assign devices to firmware groups Moving Devices to Another Group

Upload images to firmware groups Uploading a Firmware Image to a Mesh Endpoint Group

Table 4 Administration Tasks

Task Use

System Management Tasks

Set password policies Managing the Password Policy

Define roles Managing Roles

Manage user accounts Managing Users

Access Management Tasks

Manage active sessions Managing Active Sessions

Display the audit trail Displaying the Audit Trail

Manage certificates Managing Certificates

Configure data retention Configuring Data Retention

Manage licenses Managing Licenses

Manage logging Managing Logs

Configure server settings Configuring Server Settings

Manage the syslog Managing System Settings

Configure tunnel settings Configuring Provisioning Settings

Conventions Indication

bold font Commands and keywords and user-entered text appear in bold font.

italic font Document titles, new or emphasized terms, and arguments for which you supply values are in italic font.

[   ] Elements in square brackets are optional.

{x | y | z } Required alternative keywords are grouped in braces and separated by vertical bars.

[ x | y | z ] Optional alternative keywords are grouped in brackets and separated by vertical bars.

string A nonquoted set of characters. Do not use quotation marks around the string or the string will include the 
quotation marks.

courier font Terminal sessions and information the system displays appear in courier font.

<   > Nonprinting characters such as passwords are in angle brackets.

[   ] Default responses to system prompts are in square brackets.

!, # An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.

Table 3 Mesh Endpoint Tasks (continued)

Task Use
1
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Note: Means reader take note. Notes contain helpful suggestions or references to material not covered in the manual.

Caution: Means reader be careful. In this situation, you might perform an action that could result in equipment damage or loss of data.

Warning: IMPORTANT SAFETY INSTRUCTIONS

Means danger. You are in a situation that could cause bodily injury. Before you work on any equipment, be aware of the hazards involved 
with electrical circuitry and be familiar with standard practices for preventing accidents. Use the statement number provided at the end of 
each warning to locate its translation in the translated safety warnings that accompanied this device.

SAVE THESE INSTRUCTIONS

Regulatory: Provided for additional information and to comply with regulatory and customer requirements. 

Interface Overview
This section provides a general overview of the IoT FND GUI, including:

 Common Page Controls

 Icons

 Main Menus

The IoT FND displays the dashboard after you log in (Figure 4). See Using the Dashboard. 
1
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Figure 4 IoT FND Dashboard

Common Page Controls

1 Submenu tabs 4 Dashboard title bar buttons: 

 Settings

 Interval

 Refresh

2 Main menus 5 Dashlet buttons:

 Show/Hide

 Export

 Refresh

 Interval/Filter Applied

 Close

3 <user name> menu 6 Issues Status bar
1
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This section describes buttons, tabs, user-entry fields, and available settings on IoT FND pages.

Navigating the Main Window

As shown in Figure 5, the top of the IoT FND window contains the main menus: Devices, Operations, Config, and Admin (3). Roll over these menus 
to display and select menu options. Submenus display as tabs below the main menus. Each page contains controls for functions specific to that page. 

Figure 5 Main Window Elements

Setting User Preferences

Access the <user name> drop-down menu in the upper-right of the menu bar (5) to set or do one of the following options:

 Preferences: Sets display settings of the user interface.

 Change Password

 Time Zone

 Log Out

1 Filter label drop-down menu 7 Issues Status bar

2 Default list view settings tab 8 Submenu tabs

3 Main menus 9 Map tab

4 Search query field 10 Device management drop-down menus

5 <user name> menu 11 Browse Devices pane

6 Refresh button 12 Device EID link to Device Info page 
1
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Working with Views

Use the Browse Devices pane (11) to view default and custom groups of devices. At the top of the Browse Devices pane the total number of 
registered devices displays in parenthesis. The total number of devices in groups displays in parenthesis next to the group name. 

You can refine the List display using filters (see Using Filters to Control the Display of Devices). Built-in filters are automatically deployed by 
clicking a device group in the Browse Devices pane. Use the Quick View tab to access saved custom filters.

Click the device Name or EID (element identifier) link (12) to display a device information page. You can generate work orders directly from the 
Device Info page, and perform some device-specific tests such as pinging the device to determine if it responds in your network. Click the <<Back 
link in the Device Info page to return to the page you were on when you clicked the device EID link. Click the refresh button (6) on any page to 
update the List view.

When you enable the Issues Status bar (7) in User Preferences, a tally of issues by alarm state displays at the bottom of the browser window (see 
Viewing Device Severity Status on the Issues Status Bar). 

Using the Tabs

When you are on a page, the main menu tab (3) is darkened (for example, in Figure 5 Devices is the main menu for the Routers page). On each page, 
use the tabs (8) below the main menu bar to access those submenu pages. The tab is lightened when you are on that page (for example, the Routers 
tab in Figure 5). 

Each device page has tabs in the main window (2 and 10) to view associated information. The active tab is lightened when you are on that tab (for 
example, the Default tab in Figure 5). These tabs are configurable (see Editing Device Views). Click the drop-down arrow on the Default tab to 
display the Edit/Delete View dialog where you can change the column display in List view. Column widths in List view are also configurable, and 
you can sort columns in ascending or descending order. 

Working with Devices

With device check boxes selected, you can perform device management from the drop-down menus above the list (7): 

 Label: Add and remove device label

 Bulk Import: Perform label management, change device properties, and remove devices

 More Actions: Create work orders for routers, refresh router mesh keys, block mesh devices, and remove devices

Navigating Page Views

By default, device management pages display in List view, which displays devices in a sortable table. On the Routers and Mesh pages, select the 
Map tab (9) to display devices on a GIS map (see Viewing Routers in Map View and Viewing Mesh Endpoints in Map View). 

Working with Filters

Create custom filters by clicking the Show Filters link (the Hide Filters link displays in the same place in Figure 5) and using the provided filter 
parameters (1) to build the appropriate syntax in the Search Devices field (4). Click the Quick Views tab to display saved custom filters (see Creating 
and Editing Quick View Filters).

Completing User-entry Fields

Figure 6 shows an error in the user-entry field. IoT FND displays a red alert icon, highlights the field in red, and disables the OK button. These 
errors occur, for example, on an invalid character entry (such as, @, #, !, or +) or when an entry is expected and not completed.
1
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Figure 6 Errored Group Name User-entry Field

Icons
Table 5 lists the icons that display in the UI.

Table 5 IoT FND Icons

Icon Description

This router icon is used for CGRs, ISRs, and IRs (FARs), and HERs.

This is the server icon.

This is the DA gateway (IR500) device icon. 

This is a meter icon.

This is an undefined endpoint icon.

The up icon indicates that the device is up and online.

The down icon indicates that the device is down.

The unheard icon indicates that the device has not yet registered with IoT FND.

The outages icon indicates that the device is under power outage.

The restored icon indicates that the device has recovered from an outage.

The default group icon indicates that this is the top-level device group. All devices appear in this 
group after successful registration.

This is the Add Group icon. 

These are the Edit and Delete Group icons.
1
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On the Events page, click this button to initiate an export of event data to a CSV file.

The Group icon indicates that this is a custom device group.

The Custom Label icon indicates a group of devices. Use labels to sort devices into logical groups. 
Labels are not dependent on device type; devices of any type can belong to any label. A device can 
also have multiple labels.

On the Dashboard page, click this button to set the refresh data interval and add dashlets.

On the Dashboard page, click this button to initiate an export of dashlet data to a CSV file.

On the Dashboard page, click this button to refresh dashlet data.

On the Dashboard page, click this button to change the data retrieval interval setting and add filters 
to the dashlets. On line-graph dashlets, this button not only provides access to the data retrieval 
interval setting and filters, but you can also access graph-specific data settings. This icon is green 
when a filter is applied.

On the Dashboard page in the dashlet title bar, click this button to show/hide the dashlet. When the 
dashlet is hidden, only its title bar displays in the Dashboard.

In Map view, this is the RPL tree root device icon. This can be a CGR or mesh device, as set when 
Configuring RPL Tree Polling. The colors reflect the device status: Up, Down, and Unheard.

The RPL tree connection displays as blue or orange lines. 

 Orange lines indicate that the link is up.

 Blue lines indicate that the link is down.

In Map view, this is a device group icon. The colors reflect the device status: Up, Down, and 
Unheard.

Table 5 IoT FND Icons (continued)

Icon Description
1
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Main Menus
This section describes the IoT FND menus available in the title bar at the top of the page.

Devices Menu

The Devices menu provides access to the Dashboard and the device management pages:

 Dashboard–This user-configurable page displays information about the connected grid.

 Field Devices–This page displays a top-level view of registered routers and mesh endpoints in your grid.

 Head-End Routers–This page displays a top-level view of registered HERs in your grid.

 Servers–This page displays a top-level view of IoT FND and database servers in your network.

Operations Menu

The Operations menu provides access to the following tabs:

 Events-This page displays events that have occurred in your grid.

 Issues-This page displays unresolved network events for quick review and resolution by the administrator.

 Tunnel Status-This page lists provisioned tunnels and displays information about the tunnels and their status.

 Work Orders–Use this page to create and monitor work orders.

Config Menu

The Config menu provides access to the following tabs:

 App Management (IOS CGRs only) –Use this page to manage applications.

 Device Configuration–Use this page to configure device properties.

On the Events and Issues pages, and on the Issues Status bar, these icons indicate the event severity 
level, top-to-bottom, as follows:

 Critical

 Major

 Minor

 Info

Each event type has a preset severity level. For example, a Router Down event is a Major severity 
level event.

On the Firmware Update page, click the Schedule Install and Reload button to configure firmware 
updates.

On the Firmware Update page, click the Set as Backup button to set the selected image as the 
firmware image backup.

Table 5 IoT FND Icons (continued)

Icon Description
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 Firmware Update–Use this page to install a new image on one or multiple devices, change the firmware group of a device, view the current 
firmware image on a device (routers, endpoints) and view subnet details on mesh endpoints.

 Router File Management–Use this page to view device file status, and upload and delete files from FARs. 

 Rules–Use this page to create rules to check for event conditions and metric thresholds.

 Tunnel Provisioning–Use this page to provision tunnels for devices.

Admin Menu

The Admin menu is divided into two areas for managing system settings and user accounts:

 Access Management pages:

— Password Policy–Use this page to set password conditions that user passwords must meet.

— Remote Authentication–Use this page to configure remote authentication for IoT-DM users.

— Roles–Use this page to define user roles.

— Users–Use this page to manage user accounts.

 System Management pages:

— Active Sessions–Use this page to monitor IoT FND sessions.

— Audit Trail–Use this page to track user activity.

— Certificates–Use this page to manage certificates for CSMP (CoAP Simple Management Protocol), IoT-DM, and the browser (Web) used 
by IoT FND.

— Data Retention–Use this page to determine the number of days to keep event, issue, and metric data in the NMS database.

— License Center–Use this page to view and manage license files.

— Logging–Use this page to change the log level for the various logging categories and download logs.

— Provisioning Settings–Use this page to configure the IoT FND URL, and the Dynamic Host Configuration Protocol v4 (DHCPv4) Proxy 
Client and DHCPv6 Proxy Client settings to create tunnels between CGRs and ASRs.

— Server Settings–Use this page to view and manage server settings.

— Syslog Settings–Use this page to view and manage syslog settings.
1
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Installing Cisco IoT FND
This section describes how to install IoT FND and related software, and includes the following topics:

 Before You Install IoT FND

 Installing and Setting Up the IoT FND Database

 Installing and Setting Up IoT FND

 Installing and Configuring the IoT FND TPS Proxy

 Configuring IoT FND for Dual-PHY

 Backing Up and Restoring the IoT FND Database

 Deploying IoT FND/Oracle/TPS Virtual Machines on ESX 5.x

Before You Install IoT FND
Use the procedures in the following sections to prepare for your IoT FND installation:

 IoT FND Map View Requirements

 System Requirements

 Obtaining IoT FND and CNR Licenses

 Installing the Linux Packages Required for Installing Oracle

 Obtaining IoT FND RPM Packages

 Configuring NTP Service

 IoT FND Installation Overview

IoT FND Map View Requirements
On any device tab, click the Map button in the main pane to display a GIS map of device locations. In its Map View pane, IoT FND uses a 
GIS map to display device locations. However, before you can use this feature, you must configure your firewall to enable access for all 
IoT FND operator systems to Cisco-provided GIS map tile servers. Only IoT FND operator browsers are allowed access to the GIS map tile 
servers. 

Note: The operator browsers will not have access to other Google sites. No Internet access is required for the IoT FND application server.

You must also assign a fully qualified domain name (FQDN) for each IoT FND server installation and provide Cisco at 
ask-fnd-pm-external@cisco.com with the following:

 The number of IoT FND installation environments (test and production)

 The FQDN of the IoT FND server 

 For cluster deployments, the FQDN of any load balancer in the deployment
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Note: The FQDN is only used to provision and authorize access to the licensed Cisco IoT FND installation and make API calls to Enterprise 
Google Map to download the map tiles. No utility operational data or asset information is ever used (that is, sent over Internet) to retrieve 
Google map tiles. Map tiles are retrieved only using geographic location information.

FQDN INFORMATION EXAMPLE

For example, your non-cluster installation has a domain named UtilityA.com, and cgnms1 as the hostname with an FQDN of 
cgms1.UtilityA.com. You would email ask-cgnms-pm@cisco.com and include the FQDN, cgms1.UtilityA.com. 

In a cluster deployment with one or more IoT FND servers and a load balancer with the FQDN of loadbalancer-vip, which directs traffic to 
the cgnms-main or cnms-dr cluster (DR installations). You would email ask-cgnms-pm@cisco.com and include the FQDN, 
loadbalancer-vip.UtilityA.com.

System Requirements
Table 1 lists the required hardware and software versions associated with this release.

Note: For a large scale system, refer to Table 2 and Table 3 for scale requirements.

Table 1 Minimum Hardware and Software Requirements for Cisco IoT FND and Supporting Systems 

Component Minimum Hardware Requirement Minimum Software Release

Cisco IoT FND application server (or 
comparable system that meets the 
minimum hardware and software 
requirements)

 Processor: 

— Intel Xeon x5680 2.27 GHz (64-bit)

— 4 CPUs

— RAM: 16 GB

 Disk space: 100 GB

 Hardware Security Module (HSM) or 
Software Security Module (SSM)

 Red Hat Enterprise Linux 6.4 and above, 
64-bit with all packages installed (software 
development and web server)

See Table 3 on page 26 for suggested 
application server resource allocation 
profiles.

 Internet connection

When you access IoT FND from a client 
browser, the browser connects to the 
Internet to download the necessary data 
files from the GIS maps provider.

 A license to use SafeNet for mesh endpoint 
security

Note: IoT FND software bundle includes the 
required Java version.

Cisco IoT FND TPS proxy  Processor: 

— Intel Xeon x5680 2.27 GHz (64-bit)

— 2 CPUs

 RAM: 4 GB

 Disk space: 25 GB

 Red Hat Enterprise Linux 6.4 and above 
with all packages installed (software 
development and web server)

 Internet connection

Note: IoT FND software bundle includes 
required Java version.
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Database server for IoT FND

Scalable to 25 routers/10,000 endpoints 
with minimum hardware requirement. See 
Resource Management Guidelines for 
additional scale sizes.

 Processor: 

— Intel Xeon x5680 3.33 GHz (64-bit)

 2 CPUs

 RAM: 16 GB

 Disk space: 100 GB (120 GB when 
installing Oracle 12c)

Note: IoT FND 3.2.x supports both of the Oracle 
releases listed below.

 Oracle Database 12c Enterprise Edition 
Release 12.1.0.2.0 - 64bit Production (with 
Patch 20830993)

 Oracle 11g Enterprise Edition (11.2.0.3 
64-bit version only)

Note: Before installing Oracle, install the 
Linux packages referenced in Installing the 
Linux Packages Required for Installing 
Oracle.

See Table 2 on page 26 for suggested 
Oracle Database server resource allocation 
profiles.

 Red Hat Linux 6.4 and above, 64-bit with 
all packages installed (software 
development and web server)

Cisco IoT FND Client The client must meet the following minimum 
requirements to connect to the IoT FND 
application server and view IoT FND displays:

 Windows 7 or Win2000 R2 Server

 RAM: 8 GB

 Processor: 2 GHz

 Resolution: 1024 x 768

 Adobe Flash Version 9.0.115 or later 
(required for viewing charts)

 Supported browsers:

— Internet Explorer (IE): 11.0

— Mozilla Firefox: 3.5 or higher

— Windows 7 works with IE 11.0

Cisco Network Registrar (CNR)
(used as a DHCP server)

Server must have the following minimum 
requirements:

 Free disk space: 146 GB

 RAM: 4 GB (small network), 8 GB 
(average network), 16 GB (large network)

 Hard drives:

— SATA drives with 7500 RPM drive > 
500 leases/second

or 

— SAS drives with 15K RPM drive > 
1000 leases/second

The following software environment must exist 
before installing Cisco Network Registrar, 
software release 8.2 on the server:

 Operating System: Windows Server 2000

 Development Kit (JDK) Java SE Runtime 
Environment (JRE) 
8.0 (1.8.0_65-b17) or equivalent Java 
Development Kit (JDK).

 User interfaces: Web browser and 
command-line interface (CLI) (Browser 
versions listed below):

— Internet Explorer (IE) 11.0, Mozilla 
Firefox 3.0 or later

 CNR license. Contact your Cisco partner 
for the necessary license.

Table 1 Minimum Hardware and Software Requirements for Cisco IoT FND and Supporting Systems  (continued)

Component Minimum Hardware Requirement Minimum Software Release
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IoT Device Manager (IoT-DM or Device 
Manager)

The laptop running Device Manager must have 
the following:

 Microsoft Windows 7 Enterprise

 2 GHz or faster processor recommended

 1 GB RAM minimum (for potential large 
log file processing)

 WiFi or Ethernet interface

 4 GB disk storage space

 Windows login enabled

 Utility-signed Certificate Authority (CA) 
and Client Certificate for router 
authentication (obtained from your IT 
department)

 Customer-specific IT security hardening 
to keep the Device Manager laptop secure

 Version 5.0.0.16

Cisco 1000 Series Connected Grid Router _  Cisco IOS Release 15.6.3M1b

 Cisco CG-OS Release CG4(5)

Cisco ISR 800 Series Integrated Services 
Routers (C800)

_  Cisco IOS Release 15.6.3M1

Cisco 800 Series Access Points (AP800) –  AP802: ap802-k9w7-tar.153-3.JBB.tar

 AP803: ap1g3-k9w7-tar.153-3.JBB2.tar

Cisco 800 Series Industrial Integrated 
Services Routers (IR800) 

–  Cisco IOS Release 15.6.3M1b

Cisco 3900 Series Integrated Service 
Router (ISR)

–  Cisco IOS Release 15.4(3)M

 Cisco IOS Release 15.4(2)T

Cisco ASR 1001 or 1002 Aggregation 
Services Router (ASR) serving as a 
head-end router

–  Cisco IOS XE Release 3.17.02.S for Flex 
tunnels (IOS)

 Cisco IOS XE Release 3.11S for Point to 
Point tunnels (CG-OS) 

Cisco 500 Series Wireless Personal Area 
Network (WPAN) Industrial Routers 
(IR500) 

–  Cisco IR509, DA Gateway device: 
Firmware version 5.6.10

 Cisco IR529, Range Extender: Firmware 
version 5.6.10

Note: ASRs and ISRs with different releases can co-exist on the network. 

Cisco Connected Grid CG-Mesh Module 
and supported endpoints

–  Firmware version 5.6.10
when communicating with 
CGR 1000s or Cisco ASRs and the 
minimum Cisco IOS software versions 
recommended for these routers in these 
release notes

Table 1 Minimum Hardware and Software Requirements for Cisco IoT FND and Supporting Systems  (continued)

Component Minimum Hardware Requirement Minimum Software Release
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Note: If deploying a IoT FND server cluster, all nodes in the cluster should run on similar hardware. Additionally, all nodes must run the 
same version of IoT FND.

Resource Management Guidelines

Virtual machine configuration workload characterization is important. When using multiple VMs on the same physical host, allocate 
resources so that individual VMs do not impact the performance of other VMs. For example, to allocate 4 VMs on a 8-CPU host, do not 
allocate all 8 CPUs to ensure that one (or more) VM does not use all resources.

Table 2 on page 26 lists example Oracle database server usage profiles for important resource parameters such as CPU, memory, and disk 
space.

Note: Please note the following with respect to Table 2, when you install the IOTFND SKU (R-IOTFND-V-K9) that has Oracle bundled 
into the Virtual Machine (VM), the maximum number of supported routers is 1000 and the maximum number of endpoints supported is 
250,000.

Cisco Connected Grid RF Mesh endpoints  Firmware version 5.6.10 when 
communicating with IR500

Long Range Wide Area Network 
(LoRAWAN) Interface Module for Cisco 
800 Series Industrial Integrated Services 
Routers (IR800)

-  Cisco IOS 15.6.3M1b

Hardware Security Module (HSM) Luna SA appliance, with client software 
installed on the IoT FND application servers

Luna SA appliance:

 Release 6.10.2 firmware

Note: Contact SafeNet to determine if you 
can run a higher version.

 Release 5.4.7-1 software, plus security 
patches

Luna SA client software:

 Release 5.4.7-1 software

Software Security Module (SSM)  RAM: 8 GB

 Processor: 2 GHz

 2 CPUs

 Red Hat Enterprise Linux 6.4 or 7.1, 64-bit 
with all packages installed (software 
development and web server)

Table 1 Minimum Hardware and Software Requirements for Cisco IoT FND and Supporting Systems  (continued)

Component Minimum Hardware Requirement Minimum Software Release
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Table 3 on page 26 lists example IoT FND Application server usage profiles for important resource parameters such as CPU, memory, and 
disk space.

1. Clustered installations.

Note: We strongly recommend RAID 10 for all deployments.

For Router Only Deployments

Information in Table 4 and Table 5 applies to Router Only deployments.

Table 5 Database Server Hardware Requirements Example Profile For Routers and LoRa Modules

Obtaining IoT FND and CNR Licenses
 Contact your Cisco partner to obtain the necessary licenses to use IoT FND and CNR.

Table 2 Oracle DB Server Hardware Requirements Example Profiles

Nodes
(Routers/Endpoints)

CPU 
(Virtual Cores)

Memory 
(RAM GB)

Disk Space (GB)

25/10,000 2 16 100

50/50,000 4 16 200

500/500,000 8 32 500

1,000/1,000,000 12 48 1000

2,000/2,000,000 16 64 1000

5,000/5,000,000 20 96 1000

Table 3 Application Server Hardware Requirements Example Profiles

Nodes
(Routers/Endpoints)

CPU 
(Virtual Cores)

Memory 
(RAM GB)

Disk Space (GB)

25/10,000 2 16 100

50/50,000 4 16 200

500/500,000 4 16 250

1,000/1,000,000 8 16 250

2,000/2,000,0001 8 16 500

5,000/5,000,0001 8 16 500

Table 4 Application Server Hardware Requirements Example Profile For Routers and LoRa Modules

Nodes
(IR800/LoRa modules)

CPU 
(Virtual Cores)

Memory 
(RAM GB)

Disk Space (GB)

10,000/30,000 4 24 100

Nodes
(IR800/LoRa modules)

CPU 
(Virtual Cores)

Memory 
(RAM GB)

Disk Space (GB)

10,000/30,000 6 32 500
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 Obtain a license to use SafeNet as your HSM for mesh endpoint security.

Installing the Linux Packages Required for Installing Oracle
Install these packages in this order before you install the Oracle database:

1. libaio-devel-0.3.106-5.i386.rpm

2. libaio-devel-0.3.106-5.x86_64.rpm

3. sysstat-7.0.2-11.el5.x86_64.rpm

4. unixODBC-libs-2.2.11-10.el5.i386.rpm

5. unixODBC-libs-2.2.11-10.el5.x86_64.rpm

6. unixODBC-2.2.11-10.el5.i386.rpm

7. unixODBC-2.2.11-10.el5.x86_64.rpm

8. unixODBC-devel-2.2.11-10.el5.i386.rpm

9. unixODBC-devel-2.2.11-10.el5.x86_64.rpm

Obtaining IoT FND RPM Packages
Before you install and set up your IoT FND system, ensure that you have the following packages:

Configuring NTP Service
Configure all RHEL servers (including all servers that run IoT FND) in your IoT FND deployment to have their NTP service enabled and 
configured to use the same time servers as the rest of the system.

Caution: Before certificates are generated, synchronize the clocks of all system components.

To configure NTP on your RHEL servers:

1. Configure the /etc/ntp.conf file.

For example:

cat /etc/ntp.conf

RPM Package Description

cgms-version_number.x86_64.rpm Contains the IoT FND installer. This is the main RPM that contains the IoT FND 
application server itself. Install this package on the IoT FND application servers.

cgms-oracle-version_number.x86_64.rpm Contains the scripts and tools to create the IoT FND Oracle database. This 
package contains the Oracle database template and management scripts. Install 
this package on the IoT FND database server system.

cgms-tools-version_number.x86_64.rpm Contains a few optional command-line tools. If needed, install this package on 
the system running the IoT FND application server.

cgms-ssm-version_number.x86_64.rpm Contains the Software Security Module (SSM). Install this package on the 
system running the IoT FND application server.

cgms-tpsproxy-version_number.x86_64.rpm Contains the TPS proxy application. Install this package on the IoT FND TPS 
proxy system.
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...
# Use the same NTP servers on all our Connected Grid systems. 
server 0.ntp.example.com
server 1.ntp.example.com
server 2.ntp.example.com
...

2. Restart the NTP daemon and ensure that it is set to run at boot time.

service ntpd restart
chkconfig ntpd on

3. Check the configuration changes by checking the status of the NTP daemon.

This example shows that the system at 192.0.2.1 is configured to be a local NTP server. This server synchronizes its time using the NTP 
server at 10.0.0.0.

# ntpq -p
     remote           refid      st t when poll reach   delay   offset  jitter
==============================================================================
*192.0.2.1 198.51.100.1  3 u  309 1024  377    0.694    0.899 0.435
 LOCAL(0)        .LOCL.          10 l   36   64  377    0.000    0.000   0.001

For information about configuring NTP on RHEL servers, refer to RHEL documentation.

IoT FND Installation Overview
Complete the following procedures to install IoT FND:

1. Installing and Setting Up the IoT FND Database.

2. Installing and Setting Up IoT FND.

3. Installing and Configuring the IoT FND TPS Proxy.

Installing and Setting Up the IoT FND Database
Complete the following procedures to finish your IoT FND installation:

 Installation and Setup Overview

 Downloading and Unpacking Oracle Database

 Running the Oracle Database Installer

 Setting Up the IoT FND Database

 Additional IoT FND Database Topics

Installation and Setup Overview
The following topics provide an overview of IoT FND deployment:

 Single-Server Deployment

 High Availability Deployment
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Single-Server Deployment

To install and set up IoT FND database for a single-server database deployment:

1. Log in to the database server.

2. Downloading and Unpacking Oracle Database.

3. Running the Oracle Database Installer.

4. Setting Up the IoT FND Database.

High Availability Deployment

To install and set up IoT FND database for HA:

1. Log in to the primary IoT FND database server.

2. Downloading and Unpacking Oracle Database.

3. Running the Oracle Database Installer.

4. Log in to the standby database server.

5. Downloading and Unpacking Oracle Database.

6. Running the Oracle Database Installer.

7. Setting Up IoT FND Database for HA.

Downloading and Unpacking Oracle Database
To download the Oracle database:

1. Log in to your server as root.

2. Download Oracle 11g Enterprise Edition (11.2.0.3 64-bit) or Oracle12c Enterprise Edition Release 12.1.0.2.0 - 64bit Production (with 
Patch 20830993).

3. To avoid display-related errors when installing the Oracle Database software, as root run this command:

# xhost + local:oracle

4. Create the oracle user and dba group:

# groupadd dba
# adduser -d /home/oracle -g dba -s /bin/bash oracle

5. Unpack the Oracle Database zip archives.

p10404530_112030_Linux-x86-64_1of7.zip
p10404530_112030_Linux-x86-64_2of7.zip
p10404530_112030_Linux-x86-64_3of7.zip
p10404530_112030_Linux-x86-64_4of7.zip
p10404530_112030_Linux-x86-64_5of7.zip
p10404530_112030_Linux-x86-64_6of7.zip
p10404530_112030_Linux-x86-64_7of7.zip
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Running the Oracle Database Installer
Note: Before running the Oracle installer, disable the firewall.

To install the Oracle database:

1. Switch to user oracle and run the Oracle database installer:

# su - oracle
# setenv DISPLAY <desktop>
# path_to_DB_installation_folder/database/runInstaller

2. Click Yes, and then click Next.

3. Click Install database software only, and then click Next.

4. Click Single instance database installation, and then click Next.

5. Select English as the language in which the database runs, and then click Next.

6. Click Enterprise Edition (4.29GB (Oracle 11g) or 6.4GB (Oracle12c), and then click Next.

7. Select the following two default installation values, Oracle Base and Software Location (11.2.0 or 12.1.0), and then click Next.

Later you will create the environment variables ORACLE_BASE and ORACLE_HOME based on the values of the Oracle Base and 
Software Location properties. 

8. On the Create Inventory page, keep the default values, and then click Next.

9. On the Privileged Operating System Groups page, keep the default values, and then click Next.

10. (optional) On the Perform Prerequisite Checks page, install any required software or run supplied scripts.

The installer might require the installation of additional software based on your system kernel settings, and may also instruct you to 
run scripts to configure your system and complete the database installation. 

Note: If no missing packages are noted or you see the message “This is a prerequisite condition to test whether the package “ksh” is 
available on the system, check the Ignore All box.

11. After installing any missing packages, click Fix & Check Again. 

Keep doing this until all requirements are met.

 Oracle Base—/home/oracle/app/oracle

 Software Location—/home/oracle/app/oracle/product/11.2.0/dbhome_1

 Software Location—/home/oracle/app/oracle/product/12.1.0/dbhome_1

 Inventory Directory—/home/oracle/app/oraInventory

 oraInventory_Group Name—dba

 Database Administrator (OSDBA) group—dba

 Database Operator (OSOPER) group—dba

Database Backup and Recovery (OSBACKUPDBA) group—dba (12c only)

 Data Guard administrative (OSDGDBA) group—dba (12c only)

 Encryption Key Management administrative (OSKMDBA) group—dba (12c only)
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Caution: Do not ignore errors on this page. If there are errors during database installation, IoT FND may not function properly.

12. Click Next.

13. On the Summary page, verify the database settings, and then click Finish (11g) or Install (12c) to start the installation process.

14. At the prompts, run the supplied configuration scripts.

Because the installer runs as the user oracle, it cannot perform certain installation operations that require root privileges. For these 
operations, you will be prompted to run scripts to complete the installation process. When prompted, open a terminal window and run 
the scripts as root.

15. If the installation succeeds, click Close on the Finish page.

Note: If performing a new installation of Oracle 12c or upgrading from Oracle 11g, you must install the Oracle 12c Patch 20830993. 
Go to (Mandatory) Installing 12c Patch.

(Mandatory) Installing 12c Patch
For all new Oracle 12c database installations and all Oracle 11g upgrades, you must install the 12c patch.

To install the patch:

1. Stop IoT FND application if running.

2. Stop Oracle service if running.

3. Run the following commands to verify inventory of installed Oracle software components and patches. No patches applied at this 
stage. The following displays at the end: There are no interim patches installed in this Oracle Home.

/home/oracle/app/oracle/product/12.1.0/dbhome_1/OPatch/opatch lsinventory -details

Oracle Interim Patch Installer version 12.1.0.1.3
Copyright (c) 2016, Oracle Corporation.  All rights reserved.

Oracle Home       : /home/oracle/app/oracle/product/12.1.0/dbhome_1
Central Inventory : /home/oracle/app/oraInventory   from           : 
/home/oracle/app/oracle/product/12.1.0/dbhome_1/oraInst.loc
OPatch version    : 12.1.0.1.3
OUI version       : 12.1.0.2.0
Log file location 
:/home/oracle/app/oracle/product/12.1.0/dbhome_1/cfgtoollogs/opatch/opatch2016-02-25_10-37-50AM_1.log

Lsinventory Output file location : 
/home/oracle/app/oracle/product/12.1.0/dbhome_1/cfgtoollogs/opatch/lsinv/lsinventory2016-02-25_10-37-50
AM.txt
--------------------------------------------------------------------------------

Installed Top-level Products (1):
Oracle Database 12c                                                  12.1.0.2.0
There are 1 products installed in this Oracle Home.
Installed Products (135):
Assistant Common Files                                               12.1.0.2.0
Buildtools Common Files                                              12.1.0.2.0
Cluster Verification Utility Common Files                            12.1.0.2.0
Database Configuration and Upgrade Assistants                        12.1.0.2.0
Database Migration Assistant for Unicode                             12.1.0.2.0
Database SQL Scripts                                                 12.1.0.2.0
Database Workspace Manager                                           12.1.0.2.0
DB TOOLS Listener                                                    12.1.0.2.0
Deinstallation Tool                                                  12.1.0.2.0
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Enterprise Edition Options                                           12.1.0.2.0
Expat libraries                                                       2.0.1.0.2
Generic Connectivity Common Files                                    12.1.0.2.0
Hadoopcore Component                                                 12.1.0.2.0
HAS Common Files                                                     12.1.0.2.0
HAS Files for DB                                                     12.1.0.2.0
Installation Common Files                                            12.1.0.2.0
Installation Plugin Files                                            12.1.0.2.0
Installer SDK Component                                              12.1.0.2.0J
Accelerator (COMPANION)                                             12.1.0.2.0
Java Development Kit                                                 1.6.0.75.0
LDAP Required Support Files                                          12.1.0.2.0
OLAP SQL Scripts                                                     12.1.0.2.0
Oracle Advanced Security                                             12.1.0.2.0
Oracle Application Express                                           12.1.0.2.0
Oracle Bali Share                                                    11.1.1.6.0
Oracle Call Interface (OCI)                                          12.1.0.2.0
Oracle Clusterware RDBMS Files                                       12.1.0.2.0
Oracle Configuration Manager                                         10.3.8.1.1
Oracle Configuration Manager Client                                  10.3.2.1.0
Oracle Configuration Manager Deconfiguration                         10.3.1.0.0
Oracle Containers for Java                                           12.1.0.2.0
Oracle Context Companion                                             12.1.0.2.0
Oracle Core Required Support Files                                   12.1.0.2.0
Oracle Core Required Support Files for Core DB                       12.1.0.2.0
Oracle Core XML Development Kit                                      12.1.0.2.0
Oracle Data Mining RDBMS Files                                       12.1.0.2.0
Oracle Database 12c                                                  12.1.0.2.0
Oracle Database 12c                                                  12.1.0.2.0
Oracle Database 12c Multimedia Files                                 12.1.0.2.0
Oracle Database Deconfiguration                                      12.1.0.2.0
Oracle Database Gateway for ODBC                                     12.1.0.2.0
Oracle Database Plugin for Oracle Virtual Assembly Builder           12.1.0.2.0
Oracle Database User Interface                                       11.0.0.0.0
Oracle Database Utilities                                            12.1.0.2.0
Oracle Database Vault option                                         12.1.0.2.0
Oracle DBCA Deconfiguration                                          12.1.0.2.0
Oracle Extended Windowing Toolkit                                    11.1.1.6.0
Oracle Globalization Support                                         12.1.0.2.0
Oracle Globalization Support                                         12.1.0.2.0
Oracle Globalization Support For Core                                12.1.0.2.0
Oracle Help for Java                                                 11.1.1.7.0
Oracle Help Share Library                                            11.1.1.7.0
Oracle Ice Browser                                                   11.1.1.7.0
Oracle Internet Directory Client                                     12.1.0.2.0
Oracle Java Client                                                   12.1.0.2.0
Oracle Java Layout Engine                                            11.0.0.0.0
Oracle JDBC Server Support Package                                   12.1.0.2.0
Oracle JDBC/OCI Instant Client                                       12.1.0.2.0
Oracle JDBC/THIN Interfaces                                          12.1.0.2.0
Oracle JFC Extended Windowing Toolkit                                11.1.1.6.0
Oracle JVM                                                           12.1.0.2.0
Oracle JVM For Core                                                  12.1.0.2.0
Oracle Label Security                                                12.1.0.2.0
Oracle LDAP administration                                           12.1.0.2.0
Oracle Locale Builder                                                12.1.0.2.0
Oracle Message Gateway Common Files                                  12.1.0.2.0
Oracle Multimedia                                                    12.1.0.2.0
Oracle Multimedia Client Option                                      12.1.0.2.0
Oracle Multimedia Java Advanced Imaging                              12.1.0.2.0
Oracle Multimedia Locator                                            12.1.0.2.0
Oracle Multimedia Locator Java Required Support Files                12.1.0.2.0
Oracle Multimedia Locator RDBMS Files                                12.1.0.2.0
Oracle Net                                                           12.1.0.2.0
Oracle Net Java Required Support Files                               12.1.0.2.0
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Oracle Net Listener                                                  12.1.0.2.0
Oracle Net Required Support Files                                    12.1.0.2.0
Oracle Net Services                                                  12.1.0.2.0
Oracle Netca Client                                                  12.1.0.2.0
Oracle Notification Service                                          12.1.0.2.0
Oracle Notification Service (eONS)                                   12.1.0.2.0
Oracle Notification Service for Instant Client                       12.1.0.2.0
Oracle ODBC Driver                                                   12.1.0.2.0
Oracle ODBC Driverfor Instant Client                                 12.1.0.2.0
Oracle OLAP                                                          12.1.0.2.0
Oracle OLAP API                                                      12.1.0.2.0
Oracle OLAP RDBMS Files                                              12.1.0.2.0
Oracle One-Off Patch Installer                                       12.1.0.1.2
Oracle Partitioning                                                  12.1.0.2.0
Oracle Programmer                                                    12.1.0.2.0
Oracle Quality of Service Management (Client)                        12.1.0.2.0
Oracle R Enterprise Server Files                                     12.1.0.2.0
Oracle RAC Deconfiguration                                           12.1.0.2.0
Oracle RAC Required Support Files-HAS                                12.1.0.2.0
Oracle Real Application Testing                                      12.1.0.2.0
Oracle Recovery Manager                                              12.1.0.2.0
Oracle Security Developer Tools                                      12.1.0.2.0
Oracle Spatial and Graph                                             12.1.0.2.0
Oracle SQL Developer                                                 12.1.0.2.0
Oracle Starter Database                                              12.1.0.2.0
Oracle Text                                                          12.1.0.2.0
Oracle Text ATG Language Support Files                               12.1.0.2.0
Oracle Text for Core                                                 12.1.0.2.0
Oracle Text Required Support Files                                   12.1.0.2.0
Oracle Universal Connection Pool                                     12.1.0.2.0
Oracle Universal Installer                                           12.1.0.2.0
Oracle USM Deconfiguration                                           12.1.0.2.0
Oracle Wallet Manager                                                12.1.0.2.0
Oracle XML Development Kit                                           12.1.0.2.0
Oracle XML Query                                                     12.1.0.2.0
oracle.swd.oui.core.min                                     12.1.0.2.0
Parser Generator Required Support Files                              12.1.0.2.0
Perl Interpreter                                                     5.14.1.0.0
Perl Modules 5.14.1.0.0
PL/SQL                                                               12.1.0.2.0
PL/SQL Embedded Gateway                                              12.1.0.2.0
Platform Required Support Files                                      12.1.0.2.0
Precompiler Common Files                                             12.1.0.2.0
Precompiler Common Files for Core                                    12.1.0.2.0
Precompiler Required Support Files 12.1.0.2.0
Precompilers                                                         12.1.0.2.0
RDBMS Required Support Files                                         12.1.0.2.0
RDBMS Required Support Files for Instant Client                      12.1.0.2.0
RDBMS Required Support Files Runtime                                 12.1.0.2.0
Required Support Files                                               12.1.0.2.0
Sample Schema Data                                                   12.1.0.2.0
Secure Socket Layer 12.1.0.2.0
SQL*Plus                                                             12.1.0.2.0
SQL*Plus Files for Instant Client                                    12.1.0.2.0
SQL*Plus Required Support Files                                      12.1.0.2.0
SQLJ Runtime                                                         12.1.0.2.0
SSL Required Support Files for InstantClient                         12.1.0.2.0
Tracle File Analyzer                                                 12.1.0.2.0
XDK Required Support Files                                           12.1.0.2.0
XML Parser for Java                                                  12.1.0.2.0
XML Parser for Oracle JVM                                            12.1.0.2.0
There are 135 products installed in this Oracle Home.
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There are no Interim patches installed in this Oracle Home.
_______________________________________________________________________________

4. Apply the patch.

a. On the database machine. Copy the patch file: “p20830993_121020_Linux-x86-64.zip”

b. Run a prerequisite check. It should pass.

$ cd /home/oracle/patches/20830993/
$ /home/oracle/app/oracle/product/12.1.0/dbhome_1/OPatch/opatch prereq 
CheckConflictAgainstOHWithDetail -ph ./
Oracle Interim Patch Installer version 12.1.0.1.3
Copyright (c) 2016, Oracle Corporation.  All rights reserved.

PREREQ session

Oracle Home       : /home/oracle/app/oracle/product/12.1.0/dbhome_1
Central Inventory : /home/oracle/app/oraInventory
   from           : /home/oracle/app/oracle/product/12.1.0/dbhome_1/oraInst.loc
OPatch version    : 12.1.0.1.3
OUI version       : 12.1.0.2.0
Log file location :/home/oracle/app/oracle/product/12.1.0/dbhome_1/cfgtool 
logs/opatch/opatch2016-02-25_10-48-48AM_1.log

Invoking prereq "checkconflictagainstohwithdetail"

Prereq "checkConflictAgainstOHWithDetail" passed.

OPatch succeeded.

c. Apply the patch.

$ /home/oracle/app/oracle/product/12.1.0/dbhome_1/OPatch/opatch apply
Oracle Interim Patch Installer version 12.1.0.1.3
Copyright (c) 2016, Oracle Corporation.  All rights reserved.

Oracle Home       : /home/oracle/app/oracle/product/12.1.0/dbhome_1
Central Inventory : /home/oracle/app/oraInventory   from           : 
/home/oracle/app/oracle/product/12.1.0/dbhome_1/oraInst.loc
OPatch version    : 12.1.0.1.3
OUI version       : 12.1.0.2.0
Log file location: 
/home/oracle/app/oracle/product/12.1.0/dbhome_1/cfgtoollogs/opatch/20830993_Feb_25_2016_10_53_25/ap
ply2016-02-25_10-53-25AM_1.log

Applying interim patch '20830993' to OH '/home/oracle/app/oracle/product/12.1.0/dbhome_1'
Verifying environment and performing prerequisite checks...
All checks passed.

Please shutdown Oracle instances running out of this ORACLE_HOME on the local system.
(Oracle Home = '/home/oracle/app/oracle/product/12.1.0/dbhome_1')

Is the local system ready for patching? [y|n]
y
User Responded with: Y
Backing up files...

Patching component oracle.rdbms, 12.1.0.2.0...

Verifying the update...
Patch 20830993 successfully applied
Log file location:/home/oracle/app/oracle/product/12.1.0/dbhome_1/cfgtoollogs/opatch/ 
20830993_Feb_25_2016_10_53_25/apply2016-02-25_10-53-25AM_1.log
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OPatch succeeded.

d. Run Opatch utility to verify that the patch is now recognized. Notice the mention of "Interim Patch" at the end of following output.

$ /home/oracle/app/oracle/product/12.1.0/dbhome_1/OPatch/opatch lsinventory -details
Oracle Interim Patch Installer version 12.1.0.1.3
Copyright (c) 2016, Oracle Corporation.  All rights reserved.

Oracle Home       : /home/oracle/app/oracle/product/12.1.0/dbhome_1
Central Inventory : /home/oracle/app/oraInventory
   from           : /home/oracle/app/oracle/product/12.1.0/dbhome_1/oraInst.loc
OPatch version    : 12.1.0.1.3
OUI version       : 12.1.0.2.0
Log file location : 
/home/oracle/app/oracle/product/12.1.0/dbhome_1/cfgtoollogs/opatch/opatch2016-02-25_11-05-19AM_1.lo
g
Lsinventory Output file location : 
/home/oracle/app/oracle/product/12.1.0/dbhome_1/cfgtoollogs/opatch/lsinv/lsinventory2016-02-25_11-0
5-19AM.txt

--------------------------------------------------------------------------------
Installed Top-level Products (1): 
Oracle Database 12c                                                  12.1.0.2.0
There are 1 products installed in this Oracle Home.

Installed Products (135):

Assistant Common Files                                               12.1.0.2.0
Buildtools Common Files                                              12.1.0.2.0
Cluster Verification Utility Common Files                            12.1.0.2.0
Database Configuration and Upgrade Assistants                        12.1.0.2.0
Database Migration Assistant for Unicode                             12.1.0.2.0
Database SQL Scripts                                                 12.1.0.2.0
Database Workspace Manager                                           12.1.0.2.0
DB TOOLS Listener                                                    12.1.0.2.0
Deinstallation Tool                                                  12.1.0.2.0
Enterprise Edition Options                                           12.1.0.2.0
Expat libraries                                                       2.0.1.0.2
Generic Connectivity Common Files                                    12.1.0.2.0
Hadoopcore Component                                                 12.1.0.2.0
HAS Common Files                                                     12.1.0.2.0
HAS Files for DB                                                     12.1.0.2.0
Installation Common Files                                            12.1.0.2.0
Installation Plugin Files                                            12.1.0.2.0
Installer SDK Component                                              12.1.0.2.0
JAccelerator (COMPANION)                                             12.1.0.2.0
Java Development Kit                                                 1.6.0.75.0
LDAP Required Support Files                                          12.1.0.2.0
LAP SQL Scripts                                                     12.1.0.2.0
Oracle Advanced Security                                             12.1.0.2.0
Oracle Application Express                                           12.1.0.2.0
Oracle Bali Share                                                    11.1.1.6.0
Oracle Call Interface (OCI)                                          12.1.0.2.0
Oracle Clusterware RDBMS Files                                       12.1.0.2.0
Oracle Configuration Manager                                         10.3.8.1.1
Oracle Configuration Manager Client                                  10.3.2.1.0
Oracle Configuration Manager Deconfiguration                         10.3.1.0.0
Oracle Containers for Java                                           12.1.0.2.0
Oracle Context Companion                                             12.1.0.2.0
Oracle Core Required Support Files                                   12.1.0.2.0
Oracle Core Required Support Files for Core DB                       12.1.0.2.0
Oracle Core XML Development Kit                                      12.1.0.2.0
Oracle Data Mining RDBMS Files                                       12.1.0.2.0
35



Installing Cisco IoT FND

  
Oracle Database 12c                                                  12.1.0.2.0
Oracle Database 12c                                                  12.1.0.2.0
Oracle Database 12c Multimedia Files                                 12.1.0.2.0
Oracle Database Deconfiguration                                      12.1.0.2.0
Oracle Database Gateway for ODBC                                     12.1.0.2.0
Oracle Database Plugin for Oracle Virtual Assembly Builder           12.1.0.2.0
Oracle Database User Interface                                       11.0.0.0.0
Oracle Database Utilities                                            12.1.0.2.0
Oracle Database Vault option                                         12.1.0.2.0
Oracle DBCA Deconfiguration                                          12.1.0.2.0
Oracle Extended Windowing Toolkit                                    11.1.1.6.0
Oracle Globalization Support                                         12.1.0.2.0
Oracle Globalization Support                                         12.1.0.2.0
Oracle Globalization Support For Core                                12.1.0.2.0
Oracle Help for Java                                                 11.1.1.7.0
Oracle Help Share Library                                            11.1.1.7.0
Oracle Ice Browser                                                   11.1.1.7.0
Oracle Internet Directory Client                                     12.1.0.2.0
Oracle Java Client                                                   12.1.0.2.0
Oracle Java Layout Engine                                            11.0.0.0.0
Oracle JDBC Server Support Package                                   12.1.0.2.0
Oracle JDBC/OCI Instant Client                                       12.1.0.2.0
Oracle JDBC/THIN Interfaces                                          12.1.0.2.0
Oracle JFC Extended Windowing Toolkit                                11.1.1.6.0
Oracle JVM                                                           12.1.0.2.0
Oracle JVM For Core                                                  12.1.0.2.0
Oracle Label Security                                                12.1.0.2.0
Oracle LDAP administration                                           12.1.0.2.0
Oracle Locale Builder                                                12.1.0.2.0
Oracle Message Gateway Common Files                                  12.1.0.2.0
Oracle Multimedia                                                    12.1.0.2.0
Oracle Multimedia Client Option                                      12.1.0.2.0
Oracle Multimedia Java Advanced Imaging                              12.1.0.2.0
Oracle Multimedia Locator                                            12.1.0.2.0
Oracle Multimedia Locator Java Required Support Files                12.1.0.2.0
Oracle Multimedia Locator RDBMS Files                                12.1.0.2.0
Oracle Net                                                           12.1.0.2.0
Oracle Net Java Required Support Files                               12.1.0.2.0
Oracle Net Listener                                                  12.1.0.2.0
Oracle Net Required Support Files                                    12.1.0.2.0
Oracle Net Services                                                  12.1.0.2.0
Oracle Netca Client                                                  12.1.0.2.0
Oracle Notification Service                                          12.1.0.2.0
Oracle Notification Service (eONS)                                   12.1.0.2.0
Oracle Notification Service for Instant Client                       12.1.0.2.0
Oracle ODBC Driver                                                   12.1.0.2.0
Oracle ODBC Driverfor Instant Client                                 12.1.0.2.0
Oracle OLAP                                                          12.1.0.2.0
Oracle OLAP API                                                      12.1.0.2.0
Oracle OLAP RDBMS Files                                              12.1.0.2.0
Oracle One-Off Patch Installer                                       12.1.0.1.2
Oracle Partitioning                                                  12.1.0.2.0
Oracle Programmer                                                    12.1.0.2.0
Oracle Quality of Service Management (Client)                        12.1.0.2.0
Oracle R Enterprise Server Files                                     12.1.0.2.0
Oracle RAC Deconfiguration                                           12.1.0.2.0
Oracle RAC Required Support Files-HAS                                12.1.0.2.0
Oracle Real Application Testing                                      12.1.0.2.0
Oracle Recovery Manager                                              12.1.0.2.0
Oracle Security Developer Tools                                      12.1.0.2.0
Oracle Spatial and Graph                                             12.1.0.2.0
Oracle SQL Developer                                                 12.1.0.2.0
Oracle Starter Database                                              12.1.0.2.0
Oracle Text                                                          12.1.0.2.0
Oracle Text ATG Language Support Files                               12.1.0.2.0
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Oracle Text for Core                                                 12.1.0.2.0
Oracle Text Required Support Files                                   12.1.0.2.0
Oracle Universal Connection Pool                                     12.1.0.2.0
Oracle Universal Installer                                           12.1.0.2.0
Oracle USM Deconfiguration                                           12.1.0.2.0
Oracle Wallet Manager                                                12.1.0.2.0
Oracle XML Development Kit                                           12.1.0.2.0
Oracle XML Query                                                     12.1.0.2.0 
oracle.swd.oui.core.min                                              12.1.0.2.0
Parser Generator Required Support Files                              12.1.0.2.0
Perl Interpreter                                                     5.14.1.0.0
Perl Modules                                                         5.14.1.0.0
PL/SQL                                                               12.1.0.2.0
PL/SQL Embedded Gateway                                              12.1.0.2.0
Platform Required Support Files                                      12.1.0.2.0
Precompiler Common Files                                             12.1.0.2.0
Precompiler Common Files for Core                                    12.1.0.2.0
Precompiler Required Support Files                                   12.1.0.2.0
Precompilers                                                         12.1.0.2.0
RDBMS Required Support Files                                         12.1.0.2.0
RDBMS Required Support Files for Instant Client                      12.1.0.2.0
RDBMS Required Support Files Runtime                                 12.1.0.2.0
Required Support Files                                               12.1.0.2.0
Sample Schema Data                                                   12.1.0.2.0
Secure Socket Layer                                                 12.1.0.2.0
SQL*Plus                                                             12.1.0.2.0
SQL*Plus Files for Instant Client                                    12.1.0.2.0
SQL*Plus Required Support Files                                      12.1.0.2.0
SQLJ Runtime                                                         12.1.0.2.0
SSL Required Support Files for InstantClient                         12.1.0.2.0
Tracle File Analyzer                                                 12.1.0.2.0
XDK Required Support Files                                           12.1.0.2.0
XML Parser for Java                                                  12.1.0.2.0
XML Parser for Oracle JVM                                            12.1.0.2.0
There are 135 products installed in this Oracle Home. 

Interim patches (1) :

Patch  20830993     : applied on Thu Feb 25 10:53:50 PST 2016
Unique Patch ID:  18912657
Created on 13 May 2015, 00:37:38 hrs PST8PDT
   Bugs fixed:     20830993   
Files Touched:     
/qksvc.o --> ORACLE_HOME/lib/libserver12.a

 ins_rdbms.mk --> ORACLE_HOME/rdbms/lib/ioracle
Patch Location in Inventory:     
/home/oracle/app/oracle/product/12.1.0/dbhome_1/inventory/oneoffs/20830993

Patch Location in Storage area:     
/home/oracle/app/oracle/product/12.1.0/dbhome_1/.patch_storage/20830993_May_13_2015_00_37_38

--------------------------------------------------------------------------------

Process complete. 

Continue to Setting Up the IoT FND Database

Setting Up the IoT FND Database
Complete the following procedures to set up the IoT FND database:

 IoT FND Database Setup Overview

 Defining Oracle Database Environment Variables
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 Installing IoT FND Oracle Database Scripts

 Creating the IoT FND Oracle Database

 Starting the IoT FND Oracle Database

IoT FND Database Setup Overview

To set up the IoT FND database:

1. Defining Oracle Database Environment Variables.

2. Installing IoT FND Oracle Database Scripts.

3. Creating the IoT FND Oracle Database.

4. Starting the IoT FND Oracle Database.

Defining Oracle Database Environment Variables

Before installing the IoT FND Oracle database, switch to the oracle user account and define the following Oracle database environment 
variables.

Table 6 Oracle Database Environment Variables

Variable Description

ORACLE_BASE Defines the path to the Oracle root directory on your system. For example: 

$ export ORACLE_BASE=/home/oracle/app/oracle

If this variable is not set, the IoT FND setup script displays an error.

ORACLE_HOME Defines the path to the Oracle home of the IoT FND database. For example: 

$ export ORACLE_HOME=/home/oracle/app/oracle/product/11.2.0/dbhome_1

Note: Do not have any trailing backslashes in the ORACLE_HOME environment variable.

PATH Defines the path to the Oracle binaries. For example: 

$ export PATH=$PATH:$ORACLE_HOME/bin

LD_LIBRARY_PATH Defines the path to the libraries. For example:

$ export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

ORACLE_SID Defines the Oracle System ID (SID). 

If you are only using one database server or installing an HA deployment, set this variable on the primary database 
server to cgms:

$ export ORACLE_SID=cgms

If deploying a standby database server, set this variable on the standby database server to cgms_s:

$ export ORACLE_SID=cgms_s

If this variable is not set, the IoT FND setup script displays an error.
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You can set these variables manually, as shown in the following example:

You can also use a .bashrc file to define these variables. 

Installing IoT FND Oracle Database Scripts

IoT FND is packaged with scripts and Oracle database templates. 

To install the Oracle scripts on your Oracle server:

1. Log in as the root user.

2. Securely copy the IoT FND Oracle script RPM to your Oracle server:

$ scp cgms-oracle-version_number.x86_64.rpm root@oracle-machine:~
$ rpm –ivh cgms-oracle-version_number.x86_64.rpm

3. Create the cgms directory and download the scripts and templates to it:

$ cd $ORACLE_BASE/app/oracle
$ mkdir cgms
$ cd cgms
$ cp -R /opt/cgms-oracle/scripts .
$ cp -R /opt/cgms-oracle/templates .
$ cp -R /opt/cgms-oracle/tools .
$ cd ..
$ chown -R oracle:dba cgms

Creating the IoT FND Oracle Database

To create the IoT FND Oracle database in a single-database-server deployment, run the setupCgmsDb.sh script as the user oracle. This script 
starts the Oracle Database and creates the IoT FND database. 

This script creates the user cgms_dev used by IoT FND to access the database. The default password for this user account is cgms123.

The default password for the sys DBA account is cgmsDba123.

Note: We strongly recommend that you change all default passwords. Do not use special characters such as, @, #, !, or + when using the 
encryption_util.sh script. The script cannot encrypt special characters.

Note: This script might run for several minutes. To check the setup progress, run the command:
$ tail -f /tmp/cgmsdb_setup.log

$ su - oracle
$ export DISPLAY=localhost:0
$ cd $ORACLE_BASE/cgms/scripts
$ ./setupCgmsDb.sh
09-13-2012 10:38:07 PDT: INFO: ======== CGMS Database Setup Started ==========

On a Single or Primary Database Server On a Standby Database Server

$ su - oracle
$ export ORACLE_BASE=/home/oracle/app/oracle
$ export 
ORACLE_HOME=/home/oracle/app/oracle/product/11.2.0/db
home_1
$ export PATH=$PATH:$ORACLE_HOME/bin
$ export 
LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
$ export ORACLE_SID=cgms 

$ su - oracle
$ export ORACLE_BASE=/home/oracle/app/oracle
$ export 
ORACLE_HOME=/home/oracle/app/oracle/product/11.2.0/db
home_1
$ export PATH=$PATH:$ORACLE_HOME/bin
$ export 
LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
$ export ORACLE_SID=cgms_s 
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09-13-2012 10:38:07 PDT: INFO: Log file: /tmp/cgmsdb_setup.log

Are you sure you want to setup CG-NMS database (y/n)? y

09-13-2012 10:38:08 PDT: INFO: User response: y
09-13-2012 10:38:08 PDT: INFO: CGMS database does not exist.
Enter new password for SYS DBA: 
Re-enter new password for SYS DBA: 
09-13-2012 10:38:14 PDT: INFO: User entered SYS DBA password.

Enter new password for CG-NMS database: 
Re-enter new password CG-NMS database: 
09-13-2012 10:38:18 PDT: INFO: User entered CG-NMS DB password.
09-13-2012 10:38:18 PDT: INFO: Stopping listener ...
09-13-2012 10:38:18 PDT: INFO: Listener already stopped.
09-13-2012 10:38:18 PDT: INFO: Deleting database files ...
09-13-2012 10:38:18 PDT: INFO: Creating listener ...
09-13-2012 10:38:19 PDT: INFO: Listener creation completed successfully.
09-13-2012 10:38:19 PDT: INFO: Configuring listener ...
09-13-2012 10:38:19 PDT: INFO: Listener successfully configured.
09-13-2012 10:38:19 PDT: INFO: Creating database. This may take a while. Please be patient ...
09-13-2012 10:42:55 PDT: INFO: Database creation completed successfully.
09-13-2012 10:42:55 PDT: INFO: Updating /etc/oratab ...
09-13-2012 10:42:55 PDT: INFO: /etc/oratab updated.
09-13-2012 10:42:55 PDT: INFO: Configuring database ...
09-13-2012 10:42:56 PDT: INFO: Starting listener ...
09-13-2012 10:42:56 PDT: INFO: Listener start completed successfully.
09-13-2012 10:42:56 PDT: INFO: Starting database configuration ...
09-13-2012 10:43:17 PDT: INFO: Database configuration completed successfully.
09-13-2012 10:43:17 PDT: INFO: Starting Oracle ...
09-13-2012 10:43:17 PDT: INFO: Starting Oracle in mount state ...
ORACLE instance started.

Total System Global Area 1.6836E+10 bytes
Fixed Size    2220032 bytes
Variable Size 8589934592 bytes
Database Buffers 8187281408 bytes
Redo Buffers   56487936 bytes
Database mounted.
09-13-2012 10:43:26 PDT: INFO: Opening database for read/write ...

Database altered.

09-13-2012 10:43:29 PDT: INFO: ========== CGMS Database Setup Completed Successfully ==========

Starting the IoT FND Oracle Database

To start the IoT FND Oracle database:

1. Run the script:

$ su - oracle
$ cd $ORACLE_BASE/cgms/scripts
$ ./startOracle.sh

2. Configure a cron job that starts IoT FND database at bootup by running this script:

./installOracleJob.sh

Additional IoT FND Database Topics
The following procedures discuss database management:
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 Stopping the IoT FND Oracle Database

 Removing the IoT FND Database

 Upgrading the IoT FND Database

 Changing the SYS DBA and IoT FND Database Passwords

 IoT FND Database Helper Scripts

Stopping the IoT FND Oracle Database

Typically, you do not have to stop the Oracle database during the installation procedure. However, if it becomes necessary to stop the Oracle 
database, use the stop script in the scripts directory:

su - oracle
cd $ORACLE_BASE/cgms/scripts
./stopOracle.sh
...
SQL> Database closed.
Database dismounted.
ORACLE instance shut down.
...

Removing the IoT FND Database

Caution: The following script is destructive. Do not use this script during normal operation.

To remove the IoT FND database, run this script:

cd $ORACLE_BASE/cgms/scripts
./deleteCgmsDb.sh

Upgrading the IoT FND Database

To upgrade the IoT FND database:

1. Add the database files (a total of 15 files).

ALTER TABLESPACE USERS ADD DATAFILE '&oracle_base/oradata/&sid_caps/users<02 to 15>.dbf' 
SIZE 5M AUTOEXTEND ON;

This is required for scaling the system.

2. Enable block-change tracking (required for incremental backup):

ALTER DATABASE ENABLE BLOCK CHANGE TRACKING USING FILE
'&oracle_base/oradata/&sid_caps/rman_change_track.f' REUSE;

3. Disable parallel execution:

set parallel_max_servers = 0 scope=both

Caution: The incremental IoT FND backup script enables the Oracle block-change tracking feature to improve backup performance. 
To take advantage of this feature, delete your IoT FND database and run the setupCgmsDb.sh script before performing the first 
incremental backup. To avoid losing data, run these commands:

sqlplus sys/password@cgms as sysdba
ALTER DATABASE ENABLE BLOCK CHANGE TRACKING USING FILE
'/home/oracle/app/oracle/oradata/CGMS/rman_change_track.f' REUSE;
exit;
41



Installing Cisco IoT FND

  
Changing the SYS DBA and IoT FND Database Passwords

To change default IoT FND database password for the cgms_dba user:

1. On the IoT FND server, run the setupCgms.sh script and change the password for the cgms_dba user.

Caution: The password for the IoT FND database and the cgnms_dba user password must match or IoT FND cannot access the 
database.

# cd /opt/cgms/bin
# ./setupCgms.sh 
...
Do you want to change the database password (y/n)? y
09-13-2012 17:15:07 PDT: INFO: User response: y
Enter database password: 
Re-enter database password: 
09-13-2012 17:15:31 PDT: INFO: Configuring database password. This may take a while. Please wait 
...
09-13-2012 17:15:34 PDT: INFO: Database password configured.
...

For information about running the setupCgms.sh script, see Setting Up IoT FND.

2. On the Oracle server, run the change_password.sh script and change the password for the cgms_dba user:

$ ./change_password.sh 
09-13-2012 10:48:32 PDT: INFO: ======== Database Password Util Started ==========
09-13-2012 10:48:32 PDT: INFO: Log file: /tmp/cgms_oracle.log

Are you sure you want to change CG-NMS database password (y/n)? y
09-13-2012 10:48:33 PDT: INFO: User response: y

Enter current password for SYS DBA: 
Re-enter current password for SYS DBA: 
09-13-2012 10:48:41 PDT: INFO: User entered current SYS DBA password.
Enter new password for SYS DBA: 
Re-enter new password for SYS DBA: 
09-13-2012 10:48:54 PDT: INFO: User entered SYS DBA password.

Enter new password for CG-NMS database: 
Re-enter new password CG-NMS database: 
09-13-2012 10:49:03 PDT: INFO: User entered CG-NMS DB password.
User altered.
...

Note: As root, you can also use this script to change the password for the sys user (SYS DBA).

3. On the IoT FND server, run the cgms_status.sh script to verify the connection between IoT FND and the IoT FND database:

# service cgms status 
09-06-2012 18:51:20 PDT: INFO: CG-NMS database server: localhost
09-06-2012 18:51:21 PDT: INFO: CG-NMS database connection verified.
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IoT FND Database Helper Scripts

Table 7 describes helper IoT FND database scripts available in the $ORACLE_BASE/cgms/scripts/ directory:

Installing and Setting Up the SSM
The Software Security Module (SSM) is a low-cost alternative to a Hardware Security Module (HSM). IoT FND uses the CSMP protocol 
to communicate with meters, DA Gateway (IR500 devices), and range extenders. SSM uses CiscoJ to provide cryptographic services such 
as signing and verifying CSMP messages, and CSMP Keystore management. SSM ensures Federal Information Processing Standards 
(FIPS) compliance, while providing services. You install SSM on the IoT FND application server or other remote server. SSM 
remote-machine installations use HTTPS to securely communicate with IoT FND.

This section describes SSM installation and set up, including:

 Installing or Upgrading the SSM Server

 Uninstalling the SSM Server

 Integrating SSM and IoT FND

With the SSM server installed, configured, and started and with IoT FND configured for SSM, you can view the CSMP certificate on Admin 
> Certificates > Certificate for CSMP. 

Note: See Setting Up an HSM Client for information on the Hardware Security Module (HSM).

BEFORE YOU BEGIN

Ensure that the installations meets the hardware and software requirements listed in Table 1.

Installing or Upgrading the SSM Server
To install the SSM server:

1. Run the cgms-ssm-<version>-<release>.<architecture>.rpm rpm script:

[root@VMNMS demossm]# rpm -Uvh cgms-ssm-<version>.x86_64.rpm
Preparing...                ########################################### [100%]
   1:cgms-ssm               ########################################### [100%]

Table 7 IoT FND Database Helper Scripts

Script Description

change_password.sh Use this script to change the passwords for the database administration and IoT FND database user accounts. The 
IoT FND database user account is used by IoT FND to access the database.

backup_archive_log.sh Use this script to back up the archive logs.

backupCgmsDb.sh Use this script to back up the IoT FND database. This script supports full and incremental backups.

restoreCgmsDb.sh Use this script to restore the IoT FND database from a backup.

setupCgmsDb.sh Use this script to set up IoT FND database.

startOracle.sh Use this script to start the IoT FND database.

stopOracle.sh Use this script to stop the IoT FND database.

setupStandbyDb.sh (IoT FND database HA installations only) Use this script to set up the standby database server.

setupHaForPrimary.sh (IoT FND database HA installations only) Use this script to set up the primary database server.

getHaStatus.sh Run this script to verify that the database is set up for HA.
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2. Get the IoT FND configuration details for the SSM. SSM ships with following default credentials:

[root@VMNMS demossm]# cd /opt/cgms-ssm/bin/
[root@VMNMS bin]# ./ssm_setup.sh

Software Security Module Server
1. Generate a new keyalias with self signed certificate for CSMP
2. Generate a new keypair & certificate signing request for CSMP
3. Import a trusted certificate
4. Change CSMP keystore password
5. Print CG-NMS configuration for SSM
6. Change SSM server port
7. Change SSM-Web keystore password
Select available options.Press any other key to exit
Enter your choice :

3. Enter 5 at the prompt, and complete the following when prompted:

Enter current ssm_csmp_keystore password :ciscossm
Enter alias name : ssm_csmp 
Enter key password :ciscossm 

security-module=ssm
ssm-host=<Replace with IPv4 address of SSM server>
ssm-port=8445
ssm-keystore-alias=ssm_csmp
ssm-keystore-password=NQ1/zokip4gtUeUyQnUuNw==
ssm-key-password=NQ1/zokip4gtUeUyQnUuNw==

4. To connect to this SSM server, copy paste the output from 3. into the cgms.properties file.

Note: You must include the IPv4 address of the interface for IoT FND to use to connect to the SSM server.

5. (Optional) Run the ssm_setup.sh script to:

Note: If you perform any of the above operations, you must run the SSM setup script, select “Print CG-NMS configuration for SSM,” 
and copy and paste all details into the cgms.properties file.

6. Start the SSM server:

[root@VMNMS ~]# service ssm start
Starting Software Security Module Server:                  [  OK  ]

Monitoring SSM Log Files

You can monitor SSM logs in /opt/cgms-ssm/log/ssm.log 

 ssm_csmp_keystore password: ciscossm

 csmp alias name: ssm_csmp

 key password: ciscossm

 ssm_web_keystore password: ssmweb

 Generate a new key alias with self-signed certificate for CSMP

 Change SSM keystore password

 Change SSM server port

 Change SSM-Web keystore password
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The default metrics report interval is 900 secs (15 min.), which is the minimum valid value. Only servicing metrics are logged. If there are 
no metrics to report, no messages are in the log. 

You can change the metrics report interval by setting the ssm-metrics-report-interval field (in secs) in the 
/opt/cgms-ssm/conf/ssm.properties file. 

Note: Your SSM must server is up and running before starting the IoT FND server.

Uninstalling the SSM Server
This section presents steps to completely uninstall the SSM server, including the steps for a fresh installation. 

Note: Do not use this procedure for upgrades. Use the procedure in Installing or Upgrading the SSM Server.

To uninstall the SSM server:

1. Stop the SSM server:

service ssm stop

2. Copy and move the /opt/cgms-ssm/conf directory and contents to a directory outside of /opt/cgms-ssm.

3. Uninstall the cgms-ssm rpm:

rpm -e cgms-ssm

Fresh installations only

4. Install a new SSM server. 

5. Copy and overwrite the /opt/cgms-ssm/conf directory with the contents moved in 2..

Integrating SSM and IoT FND
Note: You must install and start the SSM server before switching to SSM.

To switch from using the Hardware Security Module (HSM) for CSMP-based messaging and use the SSM:

1. Stop IoT FND.

service cgms stop

2. Run the ssm_setup.sh script on the SSM server. 

3. Select option 3 to print IoT FND SSM configuration. 

4. Copy and paste the details into the cgms.properties to connect to that SSM server.

EXAMPLE

security-module=ssm
ssm-host=127.107.155.85
ssm-port=8445
ssm-keystore-alias=ssm_csmp
ssm-keystore-password=NQ1/zokip4gtUeUyQnUuNw==
ssm-key-password=NQ1/zokip4gtUeUyQnUuNw==

5. To set up the HSM, specify the following properties in the cgms.properties file (see also, Setting Up an HSM Client):

security-module=ssm/hsm (required; hsm : Hardware Security Module default.)
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hsm-keystore-name=testGroup1 (optional; hsm partition name; testGroup1 default)
hsm-keystore-password=TestPart1 (optional; encrypted hsm partition password; TestPart1 default) 

6. Ensure that the SSM up and running and you can connect to it. 

7. Start IoT FND.

Installing and Setting Up IoT FND
Complete the following procedures to finish your IoT FND installation:

 Installation and Setup Overview

 Installing IoT FND

 Generating and Installing Certificates

 Setting Up IoT FND

 Starting IoT FND

 Checking IoT FND Status

 Running the IoT FND Database Migration Script

 Accessing the IoT FND Web GUI

BEFORE YOU BEGIN

To install IoT FND, first obtain the IoT FND installation RPM:

cgms-version_number.x86_64.rpm

Note: Ensure that /etc/hosts and /etc/resolv.conf files are correctly configured on the IoT FND server.

Installation and Setup Overview
These topics provide an overview of the two types of IoT FND installations:

 Single-Server Deployment

 Cluster Deployment (HA)

Single-Server Deployment

To install and set up IoT FND for a single-server deployment:

1. Log in to the RHEL server that will host IoT FND.

2. Installing IoT FND.

3. Setting Up IoT FND.

4. Running the IoT FND Database Migration Script.

5. Checking IoT FND Status.

6. Accessing the IoT FND Web GUI
46



 

Installing Cisco IoT FND

  
Cluster Deployment (HA)

To install and set up IoT FND for HA deployments, repeat the steps in Single-Server Deployment, but only run the IoT FND database 
migration script once.

Installing IoT FND
To install the IoT FND application:

1. Run the IoT FND installation RPM:

$ rpm –ivh cgms-version.x86_64.rpm

2. Verify installation and check the RPM version:

$ rpm -qa | grep -i cgms
cgms-1.0

Setting Up IoT FND 
To set up IoT FND, run the setupCgms.sh script.

Note: If deploying a IoT FND server cluster, the setupCgms.sh script must be run on every node in the cluster.

Caution: The IoT FND certificate encrypts data in the database. The setupCgms.sh script runs database migration, which requires access 
to the IoT FND certificate in the keystore. You must set up certificates must before running setupCgms.sh. The script results in an error if 
it migrates the database and cannot access the certificate (see Generating and Installing Certificates). 

Caution: Ensure that the database password entered while running the setupCgms.sh script is valid. If you enter an invalid password 
multiple times, Oracle might lock your user account. You can unlock your account on the database server. For more information about 
unlocking your password, see Unlocking the IoT FND Database Password.

This example uses the setupCgms.sh script to set up a single-server IoT FND system that uses one database.

# cd /opt/cgms/bin 
# ./setupCgms.sh 
09-13-2012 17:10:00 PDT: INFO: ========== CG-NMS Setup Started - 2012-09-13-17-10-00 ==========
09-13-2012 17:10:00 PDT: INFO: Log file: /opt/cgms/bin/../server/cgms/log/cgms_setup.log

Are you sure you want to setup CG-NMS (y/n)? y

09-13-2012 17:10:02 PDT: INFO: User response: y

Do you want to change the database settings (y/n)? y 

09-13-2012 17:10:05 PDT: INFO: User response: y

Enter database server IP address [example.com]: 128.107.154.246 
09-13-2012 17:11:02 PDT: INFO: Database server IP: 128.107.154.246

Enter database server port [1522]:
09-13-2012 17:11:07 PDT: INFO: Database server port: 1522

Enter database SID [cgms]:
09-13-2012 17:11:12 PDT: INFO: Database SID: cgms

Do you wish to configure another database server for this CG-NMS ? (y/n)? n 

09-13-2012 17:11:18 PDT: INFO: User response: n
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09-13-2012 17:11:18 PDT: INFO: Configuring database settings. This may take a while. Please wait ...
09-13-2012 17:11:19 PDT: INFO: Database settings configured.

Do you want to change the database password (y/n)? y 
09-13-2012 17:15:07 PDT: INFO: User response: y

Enter database password:
Re-enter database password:

09-13-2012 17:15:31 PDT: INFO: Configuring database password. This may take a while. Please wait ...
09-13-2012 17:15:34 PDT: INFO: Database password configured.

Do you want to change the keystore password (y/n)? n 

09-13-2012 17:16:18 PDT: INFO: User response: n

Do you want to change the web application 'root' user password (y/n)? n 
09-13-2012 17:16:34 PDT: INFO: User response: n

Do you want to change the FTP settings (y/n)? n 
09-13-2012 17:16:45 PDT: INFO: User response: n
09-13-2012 17:16:45 PDT: INFO: ========== CG-NMS Setup Completed Successfully ==========

The setupCgms.sh script lets you configure these settings:

 Configuring Database Settings

 Configuring Database HA

 Configuring the IoT FND Database Password

 Configuring the Keystore Password

 Configuring the Web root User Password

 Configuring FTPS Settings

Configuring Database Settings

To configure the database settings, the setupCgms.sh script prompts you for this information:

 IP address of the primary IoT FND database server

 Port number of the IoT FND database server

Press Enter to accept the default port number (1522).

 Database System ID (SID), which is cgms for the primary database server

Press Enter to accept the default SID (cgms). This SID identifies the server as the primary database server.

Do you want to change the database settings (y/n)? y 
09-13-2012 17:10:05 PDT: INFO: User response: y

Enter database server IP address [example.com]: 128.107.154.246 
09-13-2012 17:11:02 PDT: INFO: Database server IP: 128.107.154.246

Enter database server port [1522]:
09-13-2012 17:11:07 PDT: INFO: Database server port: 1522

Enter database SID [cgms]:
09-13-2012 17:11:12 PDT: INFO: Database SID: cgms
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Configuring Database HA

To configure the standby database settings, the setupCgms.sh script prompts you for the following information:

 IP address of the standby IoT FND database server

 Port number of the standby IoT FND database server

Enter 1522.

 Database System ID (SID), which is cgms for the primary database server

Enter cgms_s. This SID identifies the server as the standby database server.

Do you wish to configure another database server for this CG-NMS ? (y/n)? y 

09-13-2012 17:11:18 PDT: INFO: User response: y
Enter database server IP address []: 128.107.154.20 
09-13-2012 17:11:02 PDT: INFO: Database server IP: 128.107.154.20 
Enter database server port []: 1522 
09-13-2012 17:11:07 PDT: INFO: Database server port: 1522
Enter database SID []: cgms_s 
09-13-2012 17:11:12 PDT: INFO: Database SID: cgms_s
09-13-2012 17:11:18 PDT: INFO: Configuring database settings. This may take a while. Please wait ...
09-13-2012 17:11:19 PDT: INFO: Database settings configured.

For information about setting up database HA, see Setting Up IoT FND Database for HA.

Configuring the IoT FND Database Password

When prompted to change the IoT FND database password, enter the password of the cgms_dba user account on the database server. If 
using the default password, do not change the database password now. 

Do you want to change the database password (y/n)? y 

09-13-2012 17:15:07 PDT: INFO: User response: y

Enter database password:
Re-enter database password:

09-13-2012 17:15:31 PDT: INFO: Configuring database password. This may take a while. Please wait ...
09-13-2012 17:15:34 PDT: INFO: Database password configured.

Configuring the Keystore Password

To configure the keystore password:

Do you want to change the keystore password (y/n)? y 
09-13-2012 10:21:52 PDT: INFO: User response: y   

Enter keystore password: keystore_password 
Re-enter keystore password: keystore_password 

09-13-2012 10:21:59 PDT: INFO: Configuring keystore password. This may take a while. Please wait ... 
09-13-2012 10:22:00 PDT: INFO: Keystore password configured. 

Configuring the Web root User Password 

To change the password of the root user account that lets you access the IoT FND browser-based interface, enter y and provide the password:

Do you want to change the web application 'root' user password (y/n)? n 
49



Installing Cisco IoT FND

  
09-13-2012 17:16:34 PDT: INFO: User response: n

Configuring FTPS Settings

If deploying a cluster, provide the FTPS settings required for downloading logs. FTPS securely transfers files between cluster nodes. If the 
FTPS settings are not configured, you can only download logs from the IoT FND node where you are currently logged in. 

Do you want to change the FTP settings (y/n)? y 
09-13-2012 17:16:45 PDT: INFO: User response: y

Enter FTP user password:
Re-enter FTP user password:

09-13-2012 17:16:49 PDT: INFO: Configuring FTP settings. This may take a while. Please wait ...
09-13-2012 17:16:57 PDT: INFO: FTP settings configuration completed successfully

Checking IoT FND Status
Before you can start IoT FND, check its connection to the IoT FND database by running this command:

# service cgms status
09-06-2012 18:51:20 PDT: INFO: CG-NMS database server: localhost
09-06-2012 18:51:21 PDT: INFO: CG-NMS database connection verified.

This command provides the IP address or hostname and status of the IoT FND database, and also verifies the connection to the IoT FND 
database. If the connection is not verified, you cannot start IoT FND.

Running the IoT FND Database Migration Script
IoT FND uses a special database migration system that lets you quickly migrate your IoT FND database without having to perform a 
database dump and restore. Each database migration creates or modifies some of the tables in the IoT FND database so that IoT FND can 
keep a record of migrations already performed.

Before launching IoT FND the first time, run the database migration script to set up the IoT FND tables in the database:

# cd /opt/cgms/bin
# ./db-migrate

Note: This script runs for a few minutes before launching IoT FND for the first time. Running this script after upgrading to a new version 
of IoT FND takes longer depending on the amount of data in the IoT FND database.

Note: If deploying a IoT FND server cluster, run the db-migrate script on only one cluster node.

The db-migrate command prompts you for the database password. The default password is cgms123. 

Caution: Ensure that the password entered while running the db-migrate script is the correct password. If you enter an incorrect password 
multiple times, Oracle might lock your user account. If so, you have to unlock your account on the database server. For more information 
about unlocking your password, see Unlocking the IoT FND Database Password.

Accessing the IoT FND Web GUI
IoT FND has a self-signed certificate for its Web GUI. You must add a security exception in your browser to access the IoT FND GUI. Once 
you start IoT FND, you can access its web GUI at:

https://nms_machine_IP_address/

The initial default username is root; the password is root123.

IoT FND uses the default password of root123 unless the password was changed when the setup script ran. 
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For more information on the setup script, see Setting Up IoT FND.

Note: If the IoT FND includes the Hardware Security Module (HSM), the Firefox browser will not connect to IoT FND. To work around 
this issue, open Firefox Preferences, navigate to Advanced, and click the Encryption tab. Under Protocols, clear the Use TLS 1.0 check 
box. Reconnect to IoT FND and ensure that the page loaded properly.

HTTPS Connections

IoT FND only accepts TLSv1.2 based HTTPS connections. To access the IoT FND GUI, you must enable the TLSv1.2 protocol to establish 
an HTTPS connection with the IoT FND.

Note: IoT FND Release 2.1.1-54 and later do not support TLSv1.0 or TLSv1.1 based connections.

First-Time Log In

When you log in to IoT FND for the first time, a popup window (Figure 1) prompts you to change the password.

Figure 1 IoT FND Initial Password Change

Note: IoT FND supports a maximum 32-character password length. 

Configuring the Time Zone

To configure the time zone, follow these steps:

1. From the username drop-down menu (top right), choose Time Zone.

2. Select a time zone.

3. Click Update Time Zone.

4. Click OK.
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Changing the Sorting Order of Columns

In all pages where IoT FND displays a list with column headings, you can change the sort order of columns using the Sort drop-down menu, 
as shown in this example:

Filtering Lists 

IoT FND lets you define filters. In the following example, typing “ro” in the Filters field of the User Name column drop-down menu lists 
the active sessions for users with user names that start with “ro.” To reset the filter, you can click the Clear Filter button.

In the following example, typing the search string deviceType:cgmesh status:up in the Search Devices field lists the mesh endpoint devices 
with an Up status.
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Setting User Preferences

IoT FND lets you set these user preferences from the <user name> drop-down menu (top right):

 Enable the display of the Events chart on the Events page (Operations > Events).

 Enable the display of event counts on the Events page (Operations > Events) and issues counts on the Issues page (Operations > 
Issues). The counts display in the left pane next to the event or issue status.

 Enable the display of the Map View pane (Devices > Field Devices).

 Set the default display to Map View (Devices > Field Devices).

 Set the device type for issues that display on the Issues Status bar.

Logging Out

To log out of IoT FND, click Log Out in the <user name> drop-down menu (top right).

IoT FND CLIs
This section presents the following commands to manage IoT FND:

 Starting IoT FND

 Checking IoT FND Status

 Stopping IoT FND

 IoT FND Log File Location

 IoT FND Helper Scripts

 Upgrading IoT FND

 Uninstalling IoT FND

Starting IoT FND

To start IoT FND, run this command:

service cgms start

To configure IoT FND so that it runs automatically at boot time, run this command:
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chkconfig cgms on

Checking IoT FND Status

To check IoT FND status, run this command:

service cgms status

Stopping IoT FND

To stop IoT FND, run this command:

service cgms stop

Note: The application typically takes approximately 10 seconds to stop. Run ps | grep java to verify that no Java processes are running.

IoT FND Log File Location

The IoT FND log file (server.log) is located in the /opt/cgms/server/cgms/log directory.

IoT FND Helper Scripts

Table 8 describes the helper IoT FND scripts in the /opt/cgms/bin/ directory.

Upgrading IoT FND

Note: It is not necessary to stop the database during normal upgrades. All upgrades are in-place.

Note: For virtual IoT FND installations using custom security certificates, see Managing Custom Certificates before performing this 
upgrade.

Caution: Run the following steps sequentially.

To upgrade the IoT FND application:

1. Obtain the new IoT FND RPM.

2. Stop IoT FND:

service cgms stop

Note: The application typically takes approximately 10 seconds to stop. Run ps | grep java to verify that no Java processes are running.

3. Upgrade the IoT FND RPM:

rpm -Uvh new_cgms_rpm_filename

Note: These files overwrite the files in /opt/cgms.

Table 8 IoT FND Helper Scripts

Script Description

deinstall_cgms_watchdog.sh Uninstalls the watchdog script.

install_cgms_watchdog.sh Installs the watchdog script.

mcast_test.sh Tests the communication between cluster members.

password_admin.sh Changes or resets the user password used to access IoT FND.

print_cluster_view.sh Prints cluster members.
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4. Run the database migrations to upgrade the database from the /opt/cgms directory:

cd /opt/cgms
bin/db-migrate

Note: You must run the db-migrate script after each upgrade.

5. When prompted, enter the database password. The default password is cgms123.

6. Start IoT FND:

# service cgms start

You can also use the RHEL GUI to start the IoT FND service (Admin > Server Settings > Services). For information, see the RHEL 
documentation.

Uninstalling IoT FND

Note: This deletes all IoT FND local installation configuration settings and installation files (for example, the keystore with your 
certificates). 

Tip: If you plan to reinstall IoT FND, copy your current keystore and certificate files to use to overwrite the keystore and certificate files 
included with the install package.

To remove the IoT FND application, run these commands:

# rpm -e cgms
# rm -rf /opt/cgms

Cleaning up the IoT FND Database

To clean up the IoT FND database:

1. (HA database configurations) Stop the Observer server.

2. (HA database configurations) Run the $ORACLE_BASE/cgms/scripts/ha/deleteStandbyDb.sh script to delete the standby database.

3. (HA database configurations) Run the $ORACLE_BASE/cgms/scripts/ha/deletePrimaryDbHa.sh script to delete the HA configuration 
from primary database.

4. Run the $ORACLE_BASE/cgms/scripts/deleteCgmsDb.sh script to delete primary database. 

Installing and Configuring the IoT FND TPS Proxy
The first use of the optional TPS proxy is typically when a CGR sends an inbound request to initialize the portion of ZTD handled by 
IoT FND. IoT FND operates behind a firewall and does not have a publicly reachable IP address. When FARs (CGRs and ISRs) contact 
IoT FND for the first time, IoT FND requires that they use the TPS proxy. This server lets FARs contact the IoT FND application server to 
request tunnel provisioning (see Managing Tunnel Provisioning). 

The TPS proxy does not have its own GUI. You must edit the properties in the cgnms.properties and tpsproxy.properties-template files 
for HTTPS outbound tunnel provisioning requests so that IoT FND recognizes them as requests from the TPS proxy. 

After provisioning the tunnel(s), the FARs can contact IoT FND directly without using the TPS proxy. IoT FND is notified of the exact 
certificate subject from the proxy certificate, and then authenticates that the HTTPS inbound requests are coming from the TPS proxy.
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Setting Up the TPS Proxy
Install the cgms-tpsproxy RPM package Java application on a separate (TPS proxy) server to act as a stateless extension of IoT FND outside 
the firewall. The TPS proxy can be a Red Hat Enterprise Linux (RHEL) server (see TPS proxy system requirements in Table 1). The 
cgnms-tpsproxy application runs as a daemon on the server and requires the following configuration parameters:

 URL of the IoT FND server (to forward inbound requests).

 IP address of the IoT FND server, as part of a whitelist (approved list) for forwarding outbound requests.

Before you install the TPS proxy, obtain the TPS proxy installation package:

cgms-tpsproxy-version_number.x86_64.rpm

To configure the proxy-server settings:

1. Configure a RHEL server to use as the TPS proxy.

2. Connect this RHEL server so that it can be reached while outside the firewall.

3. Configure the TPS proxy using the template file:

ssh root@tps_proxy_server
cd /opt/cgms-tpsproxy/conf
cp tpsproxy.properties-template tpsproxy.properties

Note: Edit the cgnms.properties and tpsproxy.properties files after running the encryption_util.sh script during IoT FND TPS Proxy 
Enrollment. 

4. Edit the tpsproxy.properties file to add the following lines defining the inbound and outbound addresses for the IoT FND application 
server:

[root@cgr-centos57 conf]# cat tpsproxy.properties-template 
inbound-proxy-destination=https://nms_domain_name:9120
outbound-proxy-allowed-addresses=nms_ip_address
cgms-keystore-password-hidden=<obfuscated password>

Note: You must edit the properties in the cgnms.properties and tpsproxy.properties-template files for HTTPS outbound tunnel 
provisioning requests so that IoT FND recognizes them as requests from the TPS proxy.

Configuring the TPS Proxy Firewall
To configure the TPS proxy firewall:

 Set up a firewall rule to allow HTTPS connections from the TPS proxy to the IoT FND server on port 9120 (for HTTPS inbound 
requests).

 Set up a firewall rule to allow HTTPS connections from the IoT FND server to the TPS proxy on port 9122 (for HTTPS outbound 
requests).

IoT FND TPS Proxy Enrollment
The enrollment process for the TPS proxy is the same as the IoT FND enrollment process. The certification authority (CA) that signs the 
certificate of the IoT FND application server must also sign the certificate of the TPS proxy. The certificate of the TPS proxy is stored in a 
Java keystore and is similar to the IoT FND certificate.

For the enrollment process, consider these scenarios:

 Fresh installation

— If the keystore password is the same as the default password, change the default password.
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Note: We strongly recommend that you change all default passwords. Do not use special characters such as, @, #, !, or + as the 
encryption_util.sh script cannot encrypt special characters.

— If the keystore password is different from default password, run the encryption_util.sh script and copy the encrypted password to 
the properties file.

Note: Edit the cgnms.properties and tpsproxy.properties files after running the encryption_util.sh script. 

 Upgrade

Regardless of whether you are using the default password or a custom one, the upgrade process encrypts the password in the 
/opt/cgms-tpsproxy/conf/tpsproxy.properties file.

For information on IoT FND enrollment, see: Generating and Exporting Certificates.

To enroll the terminal TPS proxy:

1. Create a cgms_keystore file.

2. Add your certifications to this file.

3. Copy the file to the /opt/cgms-tpsproxy/conf directory.

Configuring IoT FND to Use the TPS Proxy
You must edit the properties in the cgnms.properties and tpsproxy.properties-template files for HTTPS outbound tunnel provisioning 
requests so that IoT FND recognizes them as requests from the TPS proxy. The TPS proxy logs all inbound and outbound requests. 

Note: If the properties in the cgnms.properties and tpsproxy.properties-template files are not set, IoT FND does not recognize the TPS 
proxy, drops the forwarded request, and considers it from an unknown device. 

Note: The following examples employ variable not mandatory values, and are provided as examples only.

To configure IoT FND to use the TPS proxy: 

1. Open an SSH connection to the IoT FND server:

ssh root@nms_machine
cd /opt/cgms/server/cgms/conf/

Note: Edit the cgnms.properties and tpsproxy.properties files after running the encryption_util.sh script during IoT FND TPS Proxy 
Enrollment. 

2. Edit the cgms.properties file to add lines identifying the TPS proxy IP address, domain name, and user subjects in the 
cgdm-tpsproxy-subject property:

Note: The cgdm-tpsproxy-subject property must match the installed TPS proxy certificate.

cgdm-tpsproxy-addr=proxy_server_IP_address
cgdm-tpsproxy-subject=CN="common_name", OU="organizational_unit", O="organization", L="location", 
ST="state", C="country"

Note: Use quotes around comma-separated strings.

Starting the IoT FND TPS Proxy
Start the TPS proxy after it is installed, configured, and enrolled. 

To start the TPS proxy, run the start script:
57



Installing Cisco IoT FND

  
service tpsproxy start

The TPS proxy log file is located at:

/opt/cgms-tpsproxy/log/tpsproxy.log

Note: For information, see TPS Proxy Validation.

TPS Proxy Validation
The TPS proxy logs all HTTPS inbound and outbound requests in the TPS proxy log file located at /opt/cgms-tpsproxy/log/tpsproxy.log

The following entry in the TPS proxy tpsproxy.log file defines inbound requests for a CGR:

73: cgr-centos57: May 21 2014 01:05:20.513 -0700: %CGMS-6-UNSPECIFIED: 
%[ch=TpsProxyServlet-49dc423f][eid=CGR1240/K9+JAF1732ARCJ][ip=192.168.201.5][sev=INFO][tid=qtp46675819-
29]: Inbound proxy request from [192.168.201.5] with client certificate subject 
[CN=CGRJAF1732ARCJ.example.com, SERIALNUMBER=PID:CGR1240/K9 SN:JAF1732ARCJ]

This message entry in the TPS proxy tpsproxy.log file indicates that the TPS successfully forwarded the message to IoT FND:

74: cgr-centos57: May 21 2014 01:05:20.564 -0700: %CGMS-6-UNSPECIFIED: 
%[ch=TpsProxyServlet-49dc423f][sev=INFO][tid=com.cisco.cgms.tpsproxy.TpsProxyServlet-49dc423f-22]: 
Completed inbound proxy request from [192.168.201.5] with client certificate subject 
[CN=CGRJAF1732ARCJ.example.com, SERIALNUMBER=PID:CGR1240/K9 SN:JAF1732ARCJ]

The following entry in the IoT FND server log file identifies the TPS proxy:

Request came from proxy
Using forwarded client subject (CN=cg-cgr-1, SERIALNUMBER=PID:CGR1240/K9 SN:JSJ15220047) for 
authentication

The following entry in the TPS proxy tpsproxy.log file defines outbound requests:

%CGMS-6-UNSPECIFIED: %[ch=TpsProxyOutboundHandler][ip=192.168.205.5][sev=INFO][tid=qtp257798932-15]: 
Outbound proxy request from [192.168.205.5] to [192.168.201.5:8443]

The following entry in the IoT FND server log file identifies the HTTPS connection:

Using proxy at 192.168.201.6:9122 to send to https://192.168.201.4:8443/cgdm/mgmt commands:

Configuring IoT FND for Dual-PHY
For Dual-PHY CGRs, you must configure all Dual-PHY WPAN modules–master and slaves–by setting the Dual-PHY parameters (see 
Table 13) in the device addition file. The parameters to set in the appropriate device addition file are masterWpanInterface and 
slaveWpanInterface. For slave Dual-PHY WPAN devices, you must also set the slave-mode parameter.

Note: See the Connected Grid WPAN Module for CGR 1000 Series Installation and CG-Mesh Configuration Guide (Cisco IOS) for 
Dual-PHY CGR configuration information.

EXAMPLE

The following instructs IoT FND which WPAN devices to allocate as the master interface and slave interface during the configuration push:

deviceType,eid,ip,meshPrefixConfig,meshPrefixLengthConfig,meshPanidConfig,meshAddressConfig,
dhcpV4LoopbackLink,dhcpV4TunnelLink,dhcpV6LoopbackLink,dhcpV6TunnelLink,tunnelSrcInterface1,
tunnelHerEid,adminUsername,adminPassword,certIssuerCommonName,ipsecTunnelDestAddr1,
masterWpanInterface,slaveWpanInterface,lat,lng
cgr1000,CGR1240/K9+JAF1741BFQS,2.2.56.253,2319:EXTRA:BEEF:CAFE::,64,1233,
2319:EXTRA:BEEF:CAFE::,20.211.0.1,20.211.0.1,2001:420:7bf:7e8::1,
2001:420:7bf:7e8::1,GigabitEthernet2/1,cg-isr900,cg-nms-administrator,
0ERIF+cKsLwyT0YTFd0k+NpVAAPxcIvFfoX1sogAXVkSOAczUFT8TG0U58ccJuhds52KXL4dtu5iljZsQNH+
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pEQ1aIQvIGuIas9wp9MKUARYpNErXRiHEnpeH044Rfa4uSgsWXEyrVNxHyuvSefB5j6H0uA7tIQwEHDXOiq
/d0yxvfd4IYos7NzPXlJNiR+Cp6bwx7dG+d9Jo+JuNxLXpi8Fo5n88usjMoXPNbyrqvgn7SS4f+VYgXx1iyDNP0k
+7OEE8uSTVeUJXe7UXkndz5CaU17yk94UxOxamv2i1KEQxTFgw/UvrkCwPQoDMijPstDBXpFv8dqtA0xDGKuaRg
==,cenbursaca-cenbu-sub-ca,2.2.55.198,Wpan3/1,Wpan5/1,41.413324,-120.920315

The following is a typical template for configuring the master/slave interface on CGR WPAN modules:

interface ${device.masterWpanInterface}
  no shut
  ipv6 address ${device.meshAddressConfig}/${device.meshPrefixLengthConfig}
  ieee154  panid ${device.meshPanidConfig}
  outage-server ${device.relayDest}
exit

interface ${device.slaveWpanInterface}
  no ip address
ip broadcast-address 0.0.0.0
no ip route-cache
ieee154 beacon-async min-interval 10 max-interval 10 suppression-coefficient 0
ieee154 ssid cisco_muruga_dual
ieee154 txpower 21
slave-mode 3
rpl dag-lifetime 240
rpl dio-min 21
rpl version-incr-time 240
authentication host-mode multi-auth
authentication port-control auto
ipv6 dhcp relay destination global  2001:420:7BF:5F::705
dot1x pae authenticator
  ieee154 panid ${device.meshPanidConfig}
exit
end

Mesh Security Keys for Dual-PHY Devices
Note: Do not configure mesh security keys on slave WPAN devices. 

With master/slave mode configured correctly in IoT FND, IoT FND automatically detects the master WPAN and sets its the mesh security 
keys. When configuring an existing CGR and adding another WPAN interface, remove all mesh security keys from both interfaces, and then 
configure master/slave mode through IoT FND. If CGRs are connected, all meters go through re-authentication.

You can remove mesh keys using the command:

mesh-security expire mesh-key interface wpan <slot>/<slot number>

Configuration Example
The following examples retrieve the current Dual-PHY WPAN device RPL slot tree, RPL slot table, RPL IP route info table, and 
configuration information for slots 4/1 and 3/1.

cisco-NXT-FAR5#show wpan 4/1 rpl stree

----------------------------- WPAN RPL SLOT TREE [4] -----------------------------

  [2001:RTE:RTE:64::4]
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1800    // SY RF nodes
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1801
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A00
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1802
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1803
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           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1804
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1805
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A03
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A07
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1806
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1807
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1808
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1809
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:180A
           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:180B
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A01
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C05
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C06
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C07
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A02
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A04
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A05
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C03
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C08
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C09
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C0A
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A06
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C02
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C04
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A08
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A09
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A0A
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C00
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C01
                           \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1C0B
                   \--(RF )-- 2001:RTE:RTE:64:207:8108:3C:1A0B
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E00    // CY PLC nodes
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E01
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E02
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E03
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E04
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E05
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E06
           \--(PLC)-- 2001:RTE:RTE:64:217:3BCD:26:4E07

RPL SLOT TREE: Num.DataEntries 44, Num.GraphNodes 45 (external 0) (RF 36) (PLC 8)

cisco-NXT-FAR5#ping 2001:RTE:RTE:64:217:3BCD:26:4E01
Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos to 2001:RTE:RTE:64:217:3BCD:26:4E01, timeout is 2 seconds:
!!!!!
Success rate is 100 percent (5/5), round-trip min/avg/max = 254/266/294 ms

cisco-NXT-FAR5#ping 2001:RTE:RTE:64:207:8108:3C:1C00
Type escape sequence to abort.
Sending 5, 100-byte ICMP Echos to 2001:RTE:RTE:64:207:8108:3C:1C00, timeout is 2 seconds:
!!!!!
Success rate is 100 percent (5/5), round-trip min/avg/max = 272/441/636 ms
cisco-NXT-FAR5#

cisco-NXT-FAR5#show wpan 4/1 rpl stable               

------------------------------ WPAN RPL ROUTE SLOT TABLE [4] ------------------------------
NODE_IPADDR                   NEXTHOP_IP                    SSLOT LAST_HEARD
2001:RTE:RTE:64:207:8108:3C:1800        2001:RTE:RTE:64::4                      3      17:49:12    
// SY RF nodes
2001:RTE:RTE:64:207:8108:3C:1801        2001:RTE:RTE:64::4                      3      18:14:05
2001:RTE:RTE:64:207:8108:3C:1802        2001:RTE:RTE:64::4                      3      18:14:37
2001:RTE:RTE:64:207:8108:3C:1803        2001:RTE:RTE:64::4                      3      17:56:56
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2001:RTE:RTE:64:207:8108:3C:1804        2001:RTE:RTE:64::4                      3      17:48:53
2001:RTE:RTE:64:207:8108:3C:1805        2001:RTE:RTE:64::4                      3      17:47:52
2001:RTE:RTE:64:207:8108:3C:1806        2001:RTE:RTE:64::4                      3      17:49:54
2001:RTE:RTE:64:207:8108:3C:1807        2001:RTE:RTE:64::4                      3      17:46:38
2001:RTE:RTE:64:207:8108:3C:1808        2001:RTE:RTE:64::4                      3      18:22:01
2001:RTE:RTE:64:207:8108:3C:1809        2001:RTE:RTE:64::4                      3      17:50:02
2001:RTE:RTE:64:207:8108:3C:180A        2001:RTE:RTE:64::4                      3      17:50:02
2001:RTE:RTE:64:207:8108:3C:180B        2001:RTE:RTE:64::4                      3      18:24:00
2001:RTE:RTE:64:207:8108:3C:1A00        2001:RTE:RTE:64:207:8108:3C:1801        3      17:56:34
2001:RTE:RTE:64:207:8108:3C:1A01        2001:RTE:RTE:64:207:8108:3C:180B        3      18:27:34
2001:RTE:RTE:64:207:8108:3C:1A02        2001:RTE:RTE:64:207:8108:3C:180B        3      18:03:06
2001:RTE:RTE:64:207:8108:3C:1A03        2001:RTE:RTE:64:207:8108:3C:1805        3      18:25:18
2001:RTE:RTE:64:207:8108:3C:1A04        2001:RTE:RTE:64:207:8108:3C:180B        3      17:57:15
2001:RTE:RTE:64:207:8108:3C:1A05        2001:RTE:RTE:64:207:8108:3C:180B        3      18:23:39
2001:RTE:RTE:64:207:8108:3C:1A06        2001:RTE:RTE:64:207:8108:3C:180B        3      18:04:16
2001:RTE:RTE:64:207:8108:3C:1A07        2001:RTE:RTE:64:207:8108:3C:1805        3      17:55:00
2001:RTE:RTE:64:207:8108:3C:1A08        2001:RTE:RTE:64:207:8108:3C:180B        3      18:19:35
2001:RTE:RTE:64:207:8108:3C:1A09        2001:RTE:RTE:64:207:8108:3C:180B        3      18:02:02
2001:RTE:RTE:64:207:8108:3C:1A0A        2001:RTE:RTE:64:207:8108:3C:180B        3      18:18:00
2001:RTE:RTE:64:207:8108:3C:1A0B        2001:RTE:RTE:64:207:8108:3C:180B        3      18:02:46
2001:RTE:RTE:64:207:8108:3C:1C00        2001:RTE:RTE:64:207:8108:3C:1A0A        3      18:22:03
2001:RTE:RTE:64:207:8108:3C:1C01        2001:RTE:RTE:64:207:8108:3C:1A0A        3      18:24:03
2001:RTE:RTE:64:207:8108:3C:1C02        2001:RTE:RTE:64:207:8108:3C:1A06        3      18:25:03
2001:RTE:RTE:64:207:8108:3C:1C03        2001:RTE:RTE:64:207:8108:3C:1A05        3      18:15:05
2001:RTE:RTE:64:207:8108:3C:1C04        2001:RTE:RTE:64:207:8108:3C:1A06        3      18:24:05
2001:RTE:RTE:64:207:8108:3C:1C05        2001:RTE:RTE:64:207:8108:3C:1A01        3      18:10:02
2001:RTE:RTE:64:207:8108:3C:1C06        2001:RTE:RTE:64:207:8108:3C:1A01        3      18:05:03
2001:RTE:RTE:64:207:8108:3C:1C07        2001:RTE:RTE:64:207:8108:3C:1A01        3      18:11:03
2001:RTE:RTE:64:207:8108:3C:1C08        2001:RTE:RTE:64:207:8108:3C:1A05        3      18:15:05
2001:RTE:RTE:64:207:8108:3C:1C09        2001:RTE:RTE:64:207:8108:3C:1A05        3      18:15:04
2001:RTE:RTE:64:207:8108:3C:1C0A        2001:RTE:RTE:64:207:8108:3C:1A05        3      18:15:04
2001:RTE:RTE:64:207:8108:3C:1C0B        2001:RTE:RTE:64:207:8108:3C:1A0A        3      18:24:03
2001:RTE:RTE:64:217:3BCD:26:4E00        2001:RTE:RTE:64::4                      4      18:21:40

// CY PLC nodes
2001:RTE:RTE:64:217:3BCD:26:4E01        2001:RTE:RTE:64::4                      4      17:47:23
2001:RTE:RTE:64:217:3BCD:26:4E02        2001:RTE:RTE:64::4                      4      18:20:16
2001:RTE:RTE:64:217:3BCD:26:4E03        2001:RTE:RTE:64::4                      4      17:49:07
2001:RTE:RTE:64:217:3BCD:26:4E04        2001:RTE:RTE:64::4                      4      18:21:49
2001:RTE:RTE:64:217:3BCD:26:4E05        2001:RTE:RTE:64::4                      4      18:22:06
2001:RTE:RTE:64:217:3BCD:26:4E06        2001:RTE:RTE:64::4                      4      18:22:51
2001:RTE:RTE:64:217:3BCD:26:4E07        2001:RTE:RTE:64::4                      4      18:24:04
 
Number of Entries in WPAN RPL ROUTE SLOT TABLE: 44 (external 0)

cisco-NXT-FAR5#show wpan 4/1 rpl itable

----------------------------- WPAN RPL IPROUTE INFO TABLE [4] -----------------------------
NODE_IPADDR                   RANK  VERSION     NEXTHOP_IP                    ETX_P      ETX_LRSSIR  RSSIF HOPS  PARENTS     SSLOT
2001:RTE:RTE:64:207:8108:3C:1800        835   1     2001:RTE:RTE:64::4                      0     762   -67   -71   1     1     3    
// SY RF nodes
2001:RTE:RTE:64:207:8108:3C:1801        692   2     2001:RTE:RTE:64::4                      0     547   -68   -67   1     1     3
2001:RTE:RTE:64:207:8108:3C:1802        776   2     2001:RTE:RTE:64::4                      0     711   -82   -83   1     1     3
2001:RTE:RTE:64:207:8108:3C:1803        968   2     2001:RTE:RTE:64::4                      0     968   -72   -63   1     1     3
2001:RTE:RTE:64:207:8108:3C:1804        699   1     2001:RTE:RTE:64::4                      0     643   -71   -66   1     1     3
2001:RTE:RTE:64:207:8108:3C:1805        681   1     2001:RTE:RTE:64::4                      0     627   -70   -64   1     1     3
2001:RTE:RTE:64:207:8108:3C:1806        744   1     2001:RTE:RTE:64::4                      0     683   -69   -68   1     1     3
2001:RTE:RTE:64:207:8108:3C:1807        705   1     2001:RTE:RTE:64::4                      0     648   -76   -63   1     1     3
2001:RTE:RTE:64:207:8108:3C:1808        811   2     2001:RTE:RTE:64::4                      0     811   -68   -69   1     2     3
2001:RTE:RTE:64:207:8108:3C:1809        730   1     2001:RTE:RTE:64::4                      0     692   -68   -70   1     1     3
2001:RTE:RTE:64:207:8108:3C:180A        926   1     2001:RTE:RTE:64::4                      0     926   -66   -68   1     1     3
2001:RTE:RTE:64:207:8108:3C:180B        602   2     2001:RTE:RTE:64::4                      0     314   -74   -69   1     1     3
2001:RTE:RTE:64:207:8108:3C:1A00        948   1     2001:RTE:RTE:64:207:8108:3C:1801        692   256   -73   -75   2     1     3
2001:RTE:RTE:64:207:8108:3C:1A01        646   2     2001:RTE:RTE:64:207:8108:3C:180B        323   256   -73   -75   2     3     3
2001:RTE:RTE:64:207:8108:3C:1A02        948   1     2001:RTE:RTE:64:207:8108:3C:180B        602   256   -73   -75   2     2     3
2001:RTE:RTE:64:207:8108:3C:1A03        803   2     2001:RTE:RTE:64:207:8108:3C:1805        503   256   -68   -78   2     3     3
2001:RTE:RTE:64:207:8108:3C:1A04        858   1     2001:RTE:RTE:64:207:8108:3C:180B        602   256   -65   -69   2     1     3
2001:RTE:RTE:64:207:8108:3C:1A05        646   2     2001:RTE:RTE:64:207:8108:3C:180B        323   256   -71   -69   2     2     3
2001:RTE:RTE:64:207:8108:3C:1A06        858   1     2001:RTE:RTE:64:207:8108:3C:180B        602   256   -73   -75   2     2     3
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2001:RTE:RTE:64:207:8108:3C:1A07        979   1     2001:RTE:RTE:64:207:8108:3C:1805        627   352   -71   -73   2     1     3
2001:RTE:RTE:64:207:8108:3C:1A08        646   2     2001:RTE:RTE:64:207:8108:3C:180B        390   256   -75   -70   2     3     3
2001:RTE:RTE:64:207:8108:3C:1A09        948   1     2001:RTE:RTE:64:207:8108:3C:180B        602   256   -70   -69   2     3     3
2001:RTE:RTE:64:207:8108:3C:1A0A        646   2     2001:RTE:RTE:64:207:8108:3C:180B        390   256   -75   -71   2     2     3
2001:RTE:RTE:64:207:8108:3C:1A0B        858   1     2001:RTE:RTE:64:207:8108:3C:180B        602   256   -68   -68   2     2     3
2001:RTE:RTE:64:207:8108:3C:1C00        902   2     2001:RTE:RTE:64:207:8108:3C:1A0A        646   256   -70   -74   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C01        902   2     2001:RTE:RTE:64:207:8108:3C:1A0A        646   256   -71   -72   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C02        1114  1     2001:RTE:RTE:64:207:8108:3C:1A06        858   256   -74   -73   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C03        1114  1     2001:RTE:RTE:64:207:8108:3C:1A05        858   256   -76   -77   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C04        902   2     2001:RTE:RTE:64:207:8108:3C:1A06        646   256   -75   -68   3     2     3
2001:RTE:RTE:64:207:8108:3C:1C05        1114  1     2001:RTE:RTE:64:207:8108:3C:1A01        858   256   -66   -74   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C06        1114  1     2001:RTE:RTE:64:207:8108:3C:1A01        858   256   -74   -72   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C07        1114  1     2001:RTE:RTE:64:207:8108:3C:1A01        858   256   -70   -75   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C08        1114  1     2001:RTE:RTE:64:207:8108:3C:1A05        858   256   -74   -70   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C09        1114  1     2001:RTE:RTE:64:207:8108:3C:1A05        858   256   -70   -74   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C0A        1114  1     2001:RTE:RTE:64:207:8108:3C:1A05        858   256   -70   -69   3     1     3
2001:RTE:RTE:64:207:8108:3C:1C0B        902   2     2001:RTE:RTE:64:207:8108:3C:1A0A        646   256   -76   -74   3     1     3
2001:RTE:RTE:64:217:3BCD:26:4E00        616   2     2001:RTE:RTE:64::4                      0     616   118   118   1     1     4    // CY PLC 
nodes
2001:RTE:RTE:64:217:3BCD:26:4E01        702   1     2001:RTE:RTE:64::4                      0     646   118   118   1     1     4
2001:RTE:RTE:64:217:3BCD:26:4E02        557   2     2001:RTE:RTE:64::4                      0     557   118   118   1     1     4
2001:RTE:RTE:64:217:3BCD:26:4E03        626   1     2001:RTE:RTE:64::4                      0     579   118   118   1     1     4
2001:RTE:RTE:64:217:3BCD:26:4E04        609   2     2001:RTE:RTE:64::4                      0     609   118   118   1     1     4
2001:RTE:RTE:64:217:3BCD:26:4E05        602   2     2001:RTE:RTE:64::4                      0     602   118   118   1     1     4
2001:RTE:RTE:64:217:3BCD:26:4E06        594   2     2001:RTE:RTE:64::4                      0     594   118   118   1     1     4
2001:RTE:RTE:64:217:3BCD:26:4E07        584   2     2001:RTE:RTE:64::4                      0     584   118   118   1     1     4

Number of Entries in WPAN RPL IPROUTE INFO TABLE: 44

cisco-NXT-FAR5#

cisco-NXT-FAR5#show run int wpan 4/1   
Building configuration... 
Current configuration : 320 bytes
!
interface Wpan4/1
 no ip address
 ip broadcast-address 0.0.0.0
 no ip route-cache
 ieee154 beacon-async min-interval 100 max-interval 600 suppression-coefficient 1
 ieee154 panid 5552
 ieee154 ssid ios_far5_plc
 ipv6 address 2001:RTE:RTE:64::4/64
 ipv6 enable
 ipv6 dhcp relay destination  2001:420:7BF:5F::500
end

cisco-NXT-FAR5#show run int wpan 3/1
Building configuration...
Current configuration : 333 bytes
!
interface Wpan3/1
 no ip address
 ip broadcast-address 0.0.0.0
 no ip route-cache
 ieee154 beacon-async min-interval 120 max-interval 600 suppression-coefficient 1
 ieee154 panid 5551
 ieee154 ssid ios_far5_rf
 slave-mode 4
 ipv6 address 2001:RTE:RTE:65::5/64
 ipv6 enable
 ipv6 dhcp relay destination  2001:420:7BF:5F::500
end

Backing Up and Restoring the IoT FND Database
The following topics demonstrate how IoT FND supports both full and incremental database backups:

 Before You Begin

 Creating a Full Backup of the IoT FND Database
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 Scheduling a Full IoT FND Backup

 Restoring a IoT FND Backup

Before You Begin
Before backing up your IoT FND database:

1. Download and install the latest cgms-oracle-version_number.x86_64.rpm package.

2. Copy the scripts, templates, and tools folders from the /opt/cgms-oracle folder to the $ORACLE_BASE/cgms folder. 

3. Set the ownership of the files and folders you copied to oracle:dba.

Creating a Full Backup of the IoT FND Database
Full backups back up all the blocks from the data file. Full backups are time consuming and consume more disk space and system resources 
than partial backups.

IoT FND lets you perform full hot backups of IoT FND database. In a hot backup, IoT FND and the IoT FND database are running during 
the backup. 

Note: The destination backup directory must be writable by the oracle user and have enough space for the IoT FND data.

To create a backup file of the IoT FND software:

1. On the IoT FND database server, open a CLI window.

2. Switch to the user oracle:

su - oracle

3. Change directory to the location of the IoT FND backup script (backupCgmsDb.sh):

cd /home/oracle/app/oracle/cgms/scripts 

4. Run the backup script and specify the destination folder. For example, to store the backup data in the /home/oracle/bkp folder, enter 
this command:

./backupCgmsDb.sh full /home/oracle/bkp
08-03-2012 15:54:10 PST: INFO: ========== CGMS Database Backup Started ==========
08-03-2012 15:54:10 PST: INFO: Log file: /tmp/cgms_backup_restore.log
Are you sure you want to backup CG-NMS database (y/n)? y

5. Enter y to begin the backup process.

Scheduling a Full IoT FND Backup
To schedule a full IoT FND backup to run daily at 1:00 AM (default setting):

Note: The destination backup directory must be writable by the oracle user and have enough space for the IoT FND data.

1. On the IoT FND database server, open a CLI window.

2. Switch to the user oracle:

su - oracle

3. Change directory to the location of the IoT FND backup script (backupCgmsDb.sh):
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cd /home/oracle/app/oracle/cgms/scripts 

4. Run the backup script and specify the destination folder.

To change the backup scheduling interval, edit the installCgmsBackupJob.sh script before running it. 
For example, to store the backup data in /home/oracle/bkp, enter this command:

./installCgmsBackupJob.sh /home/oracle/bkp

To delete the backup job, enter these commands:

cd /home/oracle/app/oracle/cgms/scripts 
./deinstallCgmsBackupJob.sh

Backing Up the IoT FND Database Incrementally
Incremental backups only back up data file blocks that changed since the previous specified backup. IoT FND supports two incremental 
backup levels, and an hourly log backup:

 incr0–Base backup for subsequent incremental backups. This is similar to a full backup. For large deployments (millions of mesh 
endpoints and several thousand FARs). Run incr0 backups twice a week.

 incr1–Differential backup of all blocks changed since the last incremental backup. For large deployments (millions of mesh endpoints 
and several thousand FARs), run incr1 backups once a day.

Note: An incr0 backup must run before an incr1 backup to establish a base for the incr1 differential backup.

 Hourly archivelog backup–The Oracle Database uses archived logs to record all changes made to the database. These files grow over 
time and can consume a large amount of disk space. Schedule the backup_archive_log.sh script to run every hour. This script backs up 
the database archive (.arc) log files, stores them on a different server, and deletes the source archivelog files to free space on the 
database server.

Tip: Before performing any significant operation that causes many changes in the IoT FND database (for example, importing a million 
mesh endpoints or uploading firmware images to mesh endpoints), perform am incr0 backup. After the operation completes, perform 
another incr0 backup, and then resume the scheduled incremental backups.

Performing an Incremental Backup

Note: The destination backup directory must be writable by the oracle user and have enough space for the IoT FND data.

To perform an incremental backup:

1. On the IoT FND database server, open a CLI window.

2. Switch to the user oracle and change directory to the location of the IoT FND backup script:

su - oracle
cd /home/oracle/app/oracle/cgms/scripts 

3. Run the backup script and specify the incremental backup level and the destination folder where the backup data is stored (for example, 
/home/oracle/bkp). For example, to perform an incr0 backup to/home/oracle/bkp, enter the command:

./backupCgmsDb.sh incr0 /home/oracle/bkp

To perform an incr1 backup, enter the command:

./backupCgmsDb.sh incr1 /home/oracle/bkp
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Restoring a IoT FND Backup
Perform database backups and restores using the scripts provided in the cgms-oracle.rpm package. If using the supplied scripts, backups 
and restores only work if performed on the same Oracle database version. 

Note: Backups from Oracle version 11.2.0.1 can only be restored on v11.2.0.1 if using the supplied scripts. Backups do not work across 
different versions of Oracle, for example, a backup taken on 11.2.0.1 cannot be restored on 11.2.0.3 using the supplied scripts. If a database 
upgrade from 11.2.0.1 to 11.2.0.3 is required, follow the Oracle upgrade procedure. Refer to the Oracle upgrade document and Web site.

IoT FND supports restoring IoT FND backups on the same host or different host. If you choose to restore IoT FND backups on a different 
host, ensure that the host runs the same or a higher version of the Oracle database software and that IoT FND database on the destination 
host was created using the setupCgmsDb.sh script. 

Note: IoT FND does not support cross-platform backups. 

To restore a IoT FND backup:

1. Stop IoT FND.

service cgms stop

2. Switch to the user oracle, change directories to the script location, and stop Oracle:

su -oracle
cd /home/oracle/app/oracle/cgms/scripts 
./stopOracle.sh

3. To restore the IoT FND database, run the command:

./restoreCgmsDb.sh full-backup-file 

Tip: Performing a restore from a full backup can be time consuming. For large deployments, we recommend restoring the database 
from incremental backups.

To restore IoT FND database from an incremental backup, run these commands and specify the path to last incremental backup file:

su -oracle
cd /home/oracle/app/oracle/cgms/scripts 
./restoreCgmsDb.sh last-incr1-backup-file 

The restore script might display these errors:

06-08-2012 13:12:56 PDT: INFO: Import completed successfully
06-08-2012 13:12:56 PDT: INFO: Shared memory file system. Required (1K-blocks): 6084456, 
Available (1K-blocks): 4083180
06-08-2012 13:12:56 PDT: ERROR: Insufficient shared memory file system. Increase your 
shared memory file system before restoring this database.
06-08-2012 13:12:56 PDT: ERROR: ========== CGMS Database Restore Failed ==========
06-08-2012 13:12:56 PDT: ERROR: Check log file for more information.

To avoid these errors, increase the size of the shared memory file system:

###### as "root" user
###### Following command allocates 6G to shm. Adjust size as needed.
# umount tmpfs
# mount -t tmpfs tmpfs -o size=6G /dev/shm

###### Edit /etc/fstab and replace defaults as shown below
tmpfs                   /dev/shm                tmpfs   size=6G        0 0

4. Start Oracle:

./startOracle.sh
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5. Change directories to /opt/cgms and run the db-migrate script:

$ cd /opt/cgms
$ bin/db-migrate

When you restore a IoT FND database, the restore script restores the database to the IoT FND version the database was using. An error 
returns if you restore an old database to a newer version of IoT FND. Run the migrate script to ensure that the database runs with the 
current version of IoT FND. 

6. Start IoT FND:

service cgms start

For disaster recovery, perform a clean restore. The script starts by deleting the current IoT FND database:

$ su -oracle
$ cd /home/oracle/app/oracle/cgms/scripts 
$ ./deleteCgmsDb.sh 
INFO: ======== CGMS Database Deletion Started - 2011-10-16-07-24-09 ========== 
INFO: Log file: /tmp/cgmsdb_setup.log 
INFO: Deleting database. This may take a while. Please be patient ... 
INFO: Delete database completed successfully 
INFO: ========== CGMS Database Deletion Completed Successfully - 2011-10-16-07-25-01 ==========

If a clean restore is not required, use the Oracle tool to restore the database.

Deploying IoT FND/Oracle/TPS Virtual Machines on ESX 5.x
You use the VMware vSphere client to import OVA files into ESXi 5.x.

BEFORE YOU BEGIN

 Install the VMware vSphere Client for the ESXi 5.x server.

 Locate the VMware ESXi 5. x credentials to create virtual machines in ESXi 5.x.

 Ensure that you meet the VMware server machine requirements.

These are the VM CPU and memory requirements for a small scale deployment:

NMS OVA

— 16 GB Memory

— 1 core and 4 virtual sockets

— 150 GB of virtual storage 

Oracle OVA 

— 24 GB of Memory

— 2 virtual sockets with 2 cores per socket

— 300 GB of virtual Storage

TPS OVA 

— 4 GB of Memory

— 1 virtual socket with 1 core

— 50 GB of virtual storage
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DETAILED STEPS

To import the IoT FND, Oracle, and TPS virtual appliances into ESXi 5.x using VMware vSphere Client 5.x:

1. Log in to the VMware vSphere Client.

2. Select File > Deploy OVF Template... 

3. Browse to the CISCO-IOK-NMS.ova file, and then click Open.

4. Ensure that the correct OVA file displays in the Source window, and then click Next.
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5. In the OVF Template Details window, verify the information and click Next.
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6. In the Name and Location window, enter a name for this virtual appliance, and then click Next.
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7. In the Disk Format window, select the Thin Provision option, and then click Next.

Thin Provision allows the VM disk to grow as needed.
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8. In the Network Mapping window, select your Source Network, and then click Next.

9. In the Ready to Complete window, confirm your deployment settings, and then click Finish.
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The VM is now in your Datastore.

10. While logged in to the vSphere Client, repeat the above steps to deploy the CISCO-IOK-ORACLE and CISCO-IOK-TPS OVA files.

11. Add all new OVA appliances to your VM Network.

The following vSphere Client home screen shows the nms appliance.
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12. Select the Configuration Tab to view Networking properties for this selected ESXi server.

Networking properties vary depending on server requirements. Shown below is the vSphere Standard Network Switch and VM 
Network label for management network connectivity.
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13. In the left panel, select the nms-303 appliance, and then select the Summary tab.

14. Scroll to the Command section, and then click Edit Settings.
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The Virtual Machine Properties page displays.

15. In the Network Connection section of the Hardware tab, select the network adapter, and then select the VM Network label (or the 
network label created for you) from the Network label drop-down menu.
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16. Click OK.

The Network Label is saved in your settings.

17. Right click on the nms instance, and then select Open Console from the context menu.

18. Click the green play button.

The Linux VM starts to boot up.

Linux boot messages display, and then your login screen. 

To exit the VM console, press Ctrl + Alt. 

19. Click the middle of the screen to login and adjust your IP address settings.

This is the same as any other RedHat 6.4 Enterprise System.

20. Repeat steps 12 through 19 for the Oracle and TPS appliances.

Editing Network Configuration Files within the VM

1. Right click on your desktop, and then click Open in Terminal. 

2. At the command prompt, type system-config-network.

The Device configuration window displays.
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3. In the Select Action window, ensure that Device configuration is selected, and then press Enter.

4. In the Select A Device window, use the arrow keys to select the interface, and then press Enter.

In the following example, DHCP is selected in the Network Configuration window.

5. Enter the network settings assigned by your network administrator.

6. Click OK.
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7. Repeat steps 1 through 5 to assign IP addresses for each appliance.
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Generating and Installing Certificates
This section describes how to generate and install certificates, and includes the following topics:

 Information About Certificates

 Generating and Exporting Certificates

 Installing the Certificates

 Configuring IoT FND to Access the Keystore

 Configuring the TPS Proxy to Access the Keystore

 Setting Up an HSM Client

 Configuring the HSM Group Name and Password

Information About Certificates
The following topics provide information on certificates:

 Role of Certificates

 Keystore

Role of Certificates
All communications between the Cisco 1000 Series Connected Grid Router (CGR 1000 or CGR) and the Cisco Connected IoT Field 
Network Director (IoT FND) must be authenticated in both directions through mutual authentication. Before mutual authentication can 
occur, the Cisco IoT FND and the CGR must each have a certificate signed by the same Certificate Authority (CA). You can employ either 
a root CA or subordinate CA (subCA).

For details on generating certificates for CGRs, refer to the Certificate Enrollment Guide for the Cisco 1000 Series Connected Grid Routers.

Generating certificates for IoT FND also involves generating and loading certificates on the IoT FND TPS Proxy (tpsproxy). After 
generating the certificates, import them into the storage location on the TPS proxy and IoT FND known as the Keystore.

Keystore
The Keystore provides details for a specific system (such as IoT FND or the TPS proxy) and includes the following items:

 The certificate for that system (such as the IoT FND certificate or TPS proxy certificate)

 The private key for the system

 The certificate chain (path to the CA or subCA)

The IoT FND key and certificates are stored in the cgms_keystore file on the IoT FND server in the 
/opt/cgms/server/cgms/conf directory.
81

Cisco Systems, Inc. www.cisco.com

http://www.cisco.com/en/US/docs/routers/connectedgrid/cgr1000/1_0/software/configuration/guide/certificates/CertsGuide_cgr1000.html


Generating and Installing Certificates

  
Generating and Exporting Certificates
Note: The IoT FND certificate encrypts data in the database. Do not lose this certificate! Loss of this certificate results in some database 
data that will not be able to be decrypted.

Complete the following procedures to generate and export certificates:

 Configuring a Certificate Template for IoT FND and the IoT FND TPS Proxy

 Enabling a Certificate Template

 Generating Certificates for IoT FND and the IoT FND TPS Proxy

 Command Authorization Support

 Configuring a Custom CA for HSM

 Configuring a Custom CA for SSM

 Exporting the CA Certificate

Configuring a Certificate Template for IoT FND and the IoT FND TPS Proxy
On the CA (or subCA) you must create certificate templates to generate certificates for the IoT FND and TPS proxy.

To create a certificate template:

1. Open the Certificate Authority application on a Windows Server 2008 R2 system operating with the Enterprise edition.

The Certificate Authority application is standard on the above noted Windows Server version.

2. Expand the menu to view the Certificate Templates folder.

3. Right-click Certificate Templates and choose Manage from the context menu.

4. In the right-pane, right-click Computer, choose Duplicate Template from the context menu, and enter NMS.

5. In the Duplicate Template pane, select Windows Server 2008 Enterprise. 

6. Click OK.

7. Click the NMS Properties > General tab, and do the following:

a. Enter NMS in the Template display name and Template name fields.

b. Enter an appropriate Validity period, which defines the lifetime of the certificate. 

c. Check the Publish certificate in Active Directory check box.

d. Click OK.

8. Click the NMS Properties > Extensions tab, and do the following:

a. Select Application Policies in the Extensions pane.

b. In the Application Policies pane, verify that Client Authentication and Server Authentication appear in the bottom pane.

c. Select Key Usage in the Extensions top pane and click Edit.

d. In the Edit Key Usage Extension pane, clear the Make this extension critical check box. 

e. Click OK.
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9. Click the NMS Properties > Request Handling tab, and do the following:

a. Choose Signature and encryption from the Purpose drop-down menu.

b. Check the Allow private key to be exported check box.

c. Click OK.

10. Click the NMS Properties > Security tab, and do the following:

a. Select Administrator within the Group or user names pane.

b. For each group or user names item listed (such as authenticated users, administrator, domain administrators, enterprise 
administrators) check the Allow check box for all permissions (full control, read, write, enroll, autoenroll).

c. Click OK.

11. Click the NMS Properties > Cryptography tab, and retain the following default settings: 

 Algorithm name: RSA

 Minimum key site: 2048

 Cryptographic provider: Requests can use any provider available on the subject computer

 Request hash: SHA256

12. Click OK.

13. Click the NMS Properties > Subject Name tab, and retain the following default settings: 

 Radio button for Supply in the request radio button selected

 Check box checked for Use subject information from existing certificates for autoenrollment renewal requests

14. Click OK.

Note: Retain the default settings for the remaining tabs: Superseded Templates, Server, and Issuance Requirements.

Enabling a Certificate Template
Before you can create a certificate, you must enable the certificate template. 

To enable the certificate template:

1. Configure a certificate template (see Generating and Exporting Certificates).

2. Open the Certificate Authority application on the Windows Server.

3. Expand the menu to view the Certificate Templates folder.

4. Right-click Certificate Templates and choose New > Certificate Template to Issue from the context menu.

5. In the Enable Certificate Templates window, highlight the new NMS template. 

6. Click OK.
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Generating Certificates for IoT FND and the IoT FND TPS Proxy 
Follow the same steps for generating a certificate for IoT FND and for the TPS proxy by using the configuration template that you previously 
created.

Go through the steps in this section twice: once to generate the IoT FND certificate, and once to generate the TPS proxy certificate. 

Tip: In 9.b the value you enter is dependent on whether you are creating a certificate for the IoT FND or the TPS proxy.

After creating these two certificates, securely transfer the IoT FND certificate to the IoT FND application server, and securely copy the TPS 
proxy certificate to the TPS proxy server.

To generate a certificate:

1. Configure a certificate template (see Generating and Exporting Certificates).

2. Enable the certificate template (see Enabling a Certificate Template).

3. From a server running Windows Server 2008, choose Start > Run and enter mmc to open the MMC console.

4. In the Console 1 window, expand the Certificates > Personal folders.

5. Right-click Certificates and choose All Tasks > Request New Certificate from the context menu.

6. In the Before You Begin window, click Next.

7. In the Select Certificate Enrollment Policy window, choose Active Directory Enrollment Policy. 
Click Next.

8. In the Request Certificates window, do the following:

a. Check the NMS check box.

b. Click the More information... link.

9. In the Certificate Properties window, click the Subject tab, and do the following:

a. From the Type drop-down menu, choose Common name (CN).

b. In the Value field, add the fully-qualified domain name (FQDN):

c. Click Add and the Common Name appears in the right-pane.

d. From the Type drop-down menu, choose Organization (O).

e. In the Value field, add the company name or organization for the IoT FND or TPS proxy.

f. Click Add and the organization appears in the right-pane.

 For IoT FND certificates, enter the FQDN of the IoT FND server for your deployment, for 
example: CN=nms.sgbu.cisco.com.

 For TPS proxy certificates, enter the FQDN for the TPS proxy for your deployment, for 
example: CN= tps.sgbu.cisco.com.
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Figure 1 Defining a Common Name and Organization for IoT FND

10. Click Apply. Click OK.

11. In the Certificate Enrollment window, check the NMS check box and click Enroll.

12. After enrollment completes, click Finish.

13. In the MMC console (Console 1), expand the Certificates folder.

14. Choose Personal > Certificates.

15. In the Issued To pane, right-click the new certificate and choose All Tasks > Export from the context menu.

The Export Wizard window appears.
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Figure 2 Issued To Pane Showing Supported Certificates

16. Initiate the Export Wizard.

17. At the Export Private Key window, select the Yes, export the private key radio button. Click Next.

18. At the Export File Format window, do the following:

a. Click the Personal Information Exchange radio button.

b. Check the Include all certificates in the certification path if possible check box. 

This option includes the full certificate chain within the certificate.

c. Click Next.

19. In the password window, enter keystore and re-enter to confirm. 

The password is the default password that the IoT FND and the TPS proxy use to read this file. 

20. Click Next.

21. In the File to Export window, enter the file name (such as nms_cert or tps_cert) and click Next. 

22. In the Completing the Certificate Export Wizard, click Finish. 

Files with a *.pfx extension are automatically saved to the Desktop. PFX refers to the Personal Information Exchange format, which 
is also known as PKCS_#12 format. PFX is an industry-standard format that allows certificates and their private keys to be transferred 
(exported) from one computer to another.

23. Securely transfer the two certificate files (such as nms_cert.pfx and tps_cert.pfx) from the Windows Desktop to the IoT FND 
(nms_cert.pfx) and TPS proxy (tps_cert.pfx), respectively.

Note: For heightened security, after a successful transfer delete the *.pfx files from the Windows Desktop and empty the Recycle bin.

Command Authorization Support
The Cisco Connected Grid Routers (CGRs) are managed by IoT FND over a WAN backhaul connection such as 3G, 4G, or WiMAX. For 
CG-OS CGRs, you define an OID value to enable administrative privileges for IoT FND. 

The OID for this policy is 1.3.6.1.4.1.9.21.3.3.1. This element appears in the certificate if IoT FND is authorized to issue management 
commands to the CGR with administrative privileges. IoT FND communicates with the CGR over a secured session, such as TLS, the CGR 
can execute these commands as if they were issued by the network administrator.
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This section discusses the following topics:

 Enabling Command Authorization Using NMS/TPS Certificates

 Adding an OID Value to the CA Certificate

 Renewing Certificates

Enabling Command Authorization Using NMS/TPS Certificates

Follow this procedure to authorize the command authorization (CA) feature of the router, and complete registration with IoT FND. 

1. Generate new NMS/TPS certificates (see Generating Certificates for IoT FND and the IoT FND TPS Proxy) or renew the existing 
NMS/TPS certificate (see Renewing Certificates). 

2. Add an OID value to the CA certificate (see Adding an OID Value to the CA Certificate).

3. Generate a new .pfx file for the NMS/TPS certificate (see Generating Certificates for IoT FND and the IoT FND TPS Proxy).

4. Stop IoT FND (see Stopping IoT FND).

5. Rename the existing cgms_keystore file (for example, cgms_keystore_no_oid).

6. Export the .pfx file to IoT FND and create a new cgms_keystore file (see Using Keytool to Create the cgms_keystore File).

7. Install the new certificates (see Installing the Certificates).

8. Add the new cgms_keystore file to IoT FND (see Copying the cgms_keystore File to IoT FND).

9. Start IoT FND (see Starting IoT FND).

10. Register the routers with IoT FND.

Adding an OID Value to the CA Certificate

You must add an OID value to the CA certificate to allow IoT FND to use the admin role for command authorization on the router. 

To add an OID value to the CA certificate:

1. On the CA server, open a cmd console and type:

certutil -setreg policy\EnableRequestExtensionList +1.3.6.1.4.1.9.21.3.3.1

2. Restart the CA.

3. In the Select Certificate Enrollment Policy window, choose Active Directory Enrollment Policy and click Next.

4. In the Request Certificates window, do the following:

a. Check the NMS check box.

b. Click the More information... link.

5. In the Certificate Properties window, click the Subject tab complete the fields.

6. In the Certificate Properties window, click the Extensions tab and click the Custom extension definition button to expand the section.
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7. Type the following in the Object ID field:

1.3.6.1.4.1.9.21.3.3.1

8. In the Value field, type:

01

9. Click Add.
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The OID and Value are added to the field at the right as custom extensions.

10. Ensure that these values are correct, and then click Apply.

Renewing Certificates

To renew certificates and add the OID value:

1. From the RSA CA server with the original NMS/TPS certificate, type the following open command at the command prompt:

certutil -setreg policy\EnableRequestExtensionList +1.3.6.1.4.1.9.21.3.3.1 

2. Restart the CA server.

3. Open the certificate console in the MMC.

4. Locate the issued NMS/TPS certificate in the Personal folder on the CA server.

5. Right-click on the server icon, and select All Tasks > Advanced Operations > Renew This Certificate with the Same Key option 
from the context menu.
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6. In the Certificate Enrollment window, click Next.

7. Click Details.
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8. Click Properties.

9. Enter the OID and its value, and click OK.
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10. Click Add >, and then click OK.

11. Click Enroll.
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12. Click Finish.

13. Verify that the certificate contains the OID value.

Configuring a Custom CA for HSM 
This section describes configuring a custom CA for the hardware security module (HSM) for signing CSMP messages sent from IoT FND 
to mesh devices.

BEFORE YOU BEGIN

 Ensure that you install the SafeNet client software version listed in Table 1 on page 22 on the IOT-FND server.

 You must have your own CA (for example, Microsoft or OpenSSL).

To configure a custom CA for generating HSM certificates:

1. Create a new partition on the HSM and assign it to your IoT FND client (see Setting Up an HSM Client).
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2. Generate a keypair on the HSM and export a CSR for that keypair (see Keystore). 

All commands run from the Luna client on the IoT FND server. You do not have to login to the HSM machine.

[root@<user>-scaledb bin]# cd /usr/safenet/lunaclient/bin/

# Generate a Key Pair (a set of private and public keys. You MUST provide explicit labels to the 
private and public keys)
[root@<user>-scaledb bin]# ./cmu generatekeypair -sign=T -verify=T -labelpublic="nms_public_key" 
-labelprivate="nms_private_key"
Please enter password for token in slot 1 : ********
Enter key type - [1] RSA  [2] DSA [3] ECDSA : 3    <--- Choose option 3
Enter curve type [1] NISTP 192
                 [2] NISTP 224
                 [3] NISTP 256
                 [4] NISTP 384
                 [5] NISTP 521
 
Enter curve type [1] NISTP 192
                 [2] NISTP 224
                 [3] NISTP 256   <--- Choose option 3
                 [4] NISTP 384
                 [5] NISTP 521
 (1 to 5) 3
[root@<user>-scaledb bin]#

# Test if the keypair exists on the HSM partition

[root@<user>-scaledb bin]# ./cmu list
Please enter password for token in slot 1 : ********
handle=2000001    label=nms_public_key
handle=2000002    label=nms_private_key

# Now, export a certificate signing request for this keypair. Note that the specific fields for DN 
and handle may be different for your HSM. Fill appropriately.

[root@<user>-scaledb bin]#./cmu requestcertificate
Please enter password for token in slot 1 : ********
Select the private key for the request :

Handler    Label
2000002    nms_private_key
Enter handler (or 0 for exit) : 2000002
Enter Subject 2-letter Country Code (C) : US
Enter Subject State or Province Name (S) : CA
Enter Subject Locality Name (L) : San Jose
Enter Subject Organization Name (O) : Cisco Systems Inc.
Enter Subject Organization Unit Name (OU) : IOTSSG
Enter Subject Common Name (CN) : IOT-FND-HSM
Enter EMAIL Address (E) :
Enter output filename : hsm.csr
[root@<user>-scaledb bin]#

# Verify the file exists and has properly formatted content

[root@<user>-scaledb bin]# ls hsm.csr
hsm.csr

[root@<user>-scaledb bin]# cat hsm.csr
-----BEGIN NEW CERTIFICATE REQUEST-----
MIIBKzCB0QIBADBvMQswCQYDVQQGEwJVUzELMAkGA1UECBMCQ0ExETAPBgNVBAcT
CFNhbiBKb3NlMRowGAYDVQQKExFDaXNjbyBTeXN0ZW1zIEluYzEPMA0GA1UECxMG
SW9UU1NHMRMwEQYDVQQDEwpDRy1OTVMtSFNNMFkwEwYHKoZIzj0CAQYIKoZIzj0D
AQcDQgAESfdlrrcVtzN3Yexj9trlI5qd0w5Sdu8Vj2s17JAF/vPFUOYIw/uXwD6+
bb8vq3WHlA6tmgRbj+FU6G3Bmt/vCqAAMAsGByqGSM49BAEFAANIADBFAiEAroJO
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qz3dHA2GLrGzBmUO1vYys642Nkb4B4qyEoUZIGsCIFs0iTUyGQreM1BaSDEPHArZ
RvFlrKo/Zi3c8O4gzFZW
-----END NEW CERTIFICATE REQUEST-----

3. Save the generated CSR to your CA and sign the certificate.

Note: Ensure that the certificate is signed for 30 years. Mesh nodes reject any certificate signed for less than 30 years. You can use the 
root CA that is used for 802.1x authentication for node admission.

4. Copy the signed certificate to the IoT FND server and import it to the HSM.

[root@<user>-scaledb bin]# ./cmu import
Please enter password for token in slot 1 : ********
Enter input filename : <your file name with signed certificate>

# Verify that the certificate was imported

[root@<user>-scaledb bin]# ./cmu list
Please enter password for token in slot 1 : ********
handle=2000001    label=nms_public_key
handle=2000002    label=nms_private_key
handle=2000003    label=IOT-FND-HSM    <--- This is my certificate with label = CN

5. Configure IoT FND to use this new certificate.

[root@kartven2-nms ~]# service cgms stop
[root@kartven2-nms ~]# cd /opt/cgms/server/cgms/conf/

# Add following properties to the cgms.properties file

hsm-private-key-label=nms_private_key     <--- private key label you gave to your public key
hsm-public-key-label=nms_public_key       <--- public key label you gave to your public key
hsm-cert-label=IOT-FND-HSM                <--- label for your signed certificate
hsm-keystore-name=customca-group          <--- your HA partition group
hsm-keystore-password=2bVvZsq+vsq94YxuAKdaag==   <--- encrypted password for the partition

[root@kartven2-nms conf]# service cgms start
[root@kartven2-nms conf]#

6. Verify that the certificate appears on the Certificates for CSMP tab (Admin > Certificates).
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7. Configure your mesh nodes to use this certificate for signatures.

Configuring a Custom CA for SSM 
This section describes configuring a custom CA for the software security module (SSM) for signing CSMP messages sent from IoT FND 
to mesh devices.

BEFORE YOU BEGIN

 Ensure that you install the SafeNet client software version listed in Table 1 on page 22 on the IOT-FND server.

 Only SSM versions 2.2.0-37 and above are supported.

 You must have your own CA (for example, Microsoft or OpenSSL).

To configure a custom CA for generating SSM certificates:

1. Stop the ssm service.

[root@nms-rhel-6-6 ~]# stop ssm

2. Use the ssm_setup.sh script to configure a new keypair with a specific alias and generate a CSR:

[root@nms-rhel-6-6 ~]# cd /opt/cgms-ssm/bin/
[root@nms-rhel-6-6 bin]# ./ssm_setup.sh

Software Security Module Server

1.Generate a new keyalias with self signed certificate for CSMP

2.Generate a new keypair & certificate signing request for CSMP   <--- Choose option 2

3.Import a trusted certificate

4.Change CSMP keystore password
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5.Print CG-NMS configuration for SSM

6.Change SSM server port

7.Change SSM-Web keystore password

Select available options.Press any other key to exit

Enter your choice : 2 
Warning: This action will modify ssm_csmp_keystore file. Backup the file before performing this 
action.
Do you want to proceed (y/n): y

Enter current ssm_csmp_keystore password :
Enter a new key alias name (8-16): ssmcustomca
Enter key password (8-12):

Enter certificate issuer details

Enter common name CN [Unknown]: IOT-FND-SSM     

Enter organizational unit name OU [Unknown]: IOTSSG

Enter organization name O [Unknown]: Cisco Systems Inc.

Enter city or locality name L [Unknown]: San Jose

Enter state or province name ST [Unknown]: CA

Enter country code for this unit C [Unknown]: US

Is [CN=IOT-FND-SSM, OU=IOTSSG, O=Cisco Systems Inc., L=San Jose, ST=CA, C=US] correct (y/n)? :y
Certificate Signing Request file name: /opt/ssmcustomca.csr   
Succefully generated keypair with alias ssmcustomca. You can use the CSR from /opt/ssmcustomca.csr 
for signature by certificate authority
[root@nms-rhel-6-6 bin]#

3. Save the generated CSR to your CA and sign the certificate.

Note: Ensure that the certificate is signed for 30 years. Mesh nodes reject any certificate signed for less than 30 years. You can use the 
root CA that is used for 802.1x authentication for node admission.

4. Copy the signed certificate to the IoT FND server and import it to the SSM.

5. Use the ssm_setup.sh script to import the two certificates to the SSM keystore:

[root@nms-rhel-6-6 bin]# ./ssm_setup.sh

Software Security Module Server

1.Generate a new keyalias with self signed certificate for CSMP

2.Generate a new keypair & certificate signing request for CSMP

3.Import a trusted certificate   <--- Choose option 3

4.Change CSMP keystore password
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5.Print CG-NMS configuration for SSM

6.Change SSM server port

7.Change SSM-Web keystore password

Select available options.Press any other key to exit

Enter your choice : 3 

Enter current ssm_csmp_keystore password :
Enter the alias for import: root
Certificate file name: /opt/ca.crt
Certificate reply was installed in keystore
Succefully imported certificate into alias root

6. Use the ssm_setup.sh script to import the signed certificate for the alias:

[root@nms-rhel-6-6 bin]# ./ssm_setup.sh

Software Security Module Server

1.Generate a new keyalias with self signed certificate for CSMP

2.Generate a new keypair & certificate signing request for CSMP

3.Import a trusted certificate   <--- Choose option 3

4.Change CSMP keystore password

5.Print CG-NMS configuration for SSM

6.Change SSM server port

7.Change SSM-Web keystore password

Select available options.Press any other key to exit

Enter your choice : 3 

Enter current ssm_csmp_keystore password :
Enter the alias for import: ssmcustomca
Certificate file name: /opt/ssmcustomca.crt
Certificate reply was installed in keystore
Succefully imported certificate into alias ssmcustomca

7. Update cgms.properties file with following parameters to configure IoT FND to use this certificate on the SSM for signatures:

security-module=ssm
ssm-host=172.27.163.153
ssm-port=8445
ssm-keystore-alias=ssmcustomca
ssm-keystore-password=GgeQJAOk3fSIH97qJARGRA==
ssm-key-password=GgeQJAOk3fSIH97qJARGRA==

8. Verify that the certificate appears on the Certificates for CSMP tab (Admin > Certificates).
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9. Configure your mesh nodes to use this certificate for signatures.

Exporting the CA Certificate
To export the certificate from the Certificate Authority or subordinate CA to the IoT FND:

1. Open the Certificate Authority application on a Windows Server 2008 R2 system operating with the Enterprise Edition.

2. Expand the menu to view the Certificates (Local Computer) > Personal > Certificates folder.

3. Locate the certificate whose fingerprint matches that in use by the Cisco CGR 1000 and 
Cisco ASR.

4. Right-click the certificate and choose All Tasks > Export from the context menu.

5. In the Certificate Export Wizard window, click Next.

6. In the Export Private Key window, select the No, do not export the private key radio button. Click Next.

7. In the Export File Format window, select the Base-64 encoded X.509 (.CER) radio button. Click Next.

8. In the File to Export window, assign a name for the file that you want to export. Click Next.

9. In the File to Export window, enter the file name (such as ca_cert or subca_cert) and click Next. 

10. In the Completing the Certificate Export Wizard, click Finish. 

Files with a *.cer extension are automatically saved to the Desktop.

11. Securely transfer the certificate file (such as ca_cert.cer) from the Windows Desktop to IoT FND.

Note: For heightened security, after a successful transfer delete the *.cer file from the Windows Desktop and empty the Recycle bin.
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Installing the Certificates
You must create a cgms_keystore file on both the servers running IoT FND and IoT FND TPS Proxy.

 IoT FND—When creating the cgms_keystore file, you import the IoT FND certificate, its private key, and the certificate chain. After 
creating the cgms_keystore file, you copy it into a specific directory on the server.

 IoT FND TPS Proxy—When you create the cgms_keystore file, you import the IoT FND TPS Proxy certificate, its private key, and 
the certificate chain. After you create the cgms_keystore file, you copy it into a specific directory on the TPS proxy.

To create the cgms_keystore file for the TPS proxy and IoT FND, use Keytool and complete the following procedures:

 BEFORE YOU BEGIN

 Using Keytool to Create the cgms_keystore File

 Copying the cgms_keystore File to IoT FND

 Importing the CA Certificate

 Installing Custom Browser Certificates

BEFORE YOU BEGIN

 Determine the password to use for the keystore. 

The examples in this chapter refer to this password as keystore_password.

Using Keytool to Create the cgms_keystore File
To create the cgms_keystore file for both IoT FND and the TPS proxy:

1. As root, view the contents of the .pfx file by entering the following command on the server (IoT FND and TPS proxy):

[root@tps_server ~]# keytool -list -v -keystore nms_cert.pfx -srcstoretype pkcs12

Note: Viewing the .pfx provides the Alias Name required during the import.

2. Enter the keystore password when prompted.

This is the same password entered when creating the .pfx file.

The information that displays (see the following Example) includes the alias_name needed for 3.

3. Enter the following command to import the certificates into the cgms_keystore file:

keytool -importkeystore -v -srckeystore filename.pfx -srcstoretype pkcs12 
-destkeystore cgms_keystore -deststoretype jks -srcalias alias_name -destalias cgms
-destkeypass
keystore_password

4. At the prompt, enter the destination keystore password.

5. Re-enter the keystore password when prompted.

6. Enter the password used when creating the .pfx file (either nms_cert.pfx or tps_cert.pfx) when prompted for the source keystore 
password.

Note: In this example, keystore was the password when we created the .pfx file.

Example

To view the nms_cert.pfx file and access the Alias name, enter the following commands as root:
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Note: This example shows the steps for the nms_cert.pfx. To view the details on the tps_cert.pfx and import the certificates to the TPS proxy, 
use the same commands but replace the references to nms_cert.pfx with tps_cert.pfx, and use the Alias name from the tps_cert.pfx file.

# keytool -list -v -keystore nms_cert.pfx -srcstoretype pkcs12 
Enter keystore password: keystore
Keystore type: PKCS12
Keystone provider: SunJSSE
Your keystore contains 1 entry
Alias name: le-cgnms-75edd1e3-7e65-41b4-97f1-a913ebf21c8b
Creation date: March 29.2012
Entry type: PrivateKey Entry
Certificate chain length: 3
Certificate[1]:
Owner: CN=nms.sgbu.cisco.com
Issuer: CN=cisco-RSA-SUBCA-CA, DC=cisco, DC=com
...

To import the certificates to the cgms_keystore file on IoT FND, enter the following commands as root:

# keytool -importkeystore -v -srckeystore nms_cert.pfx -srcstoretype pkcs12 
-destkeystore cgms_keystore -deststoretype jks -srcalias 
le-cgnms-75edd1e3-7e65-41b4-97f1-a913ebf21c8b -destalias cgms 
-destkeypass
keystore_password

Enter destination keystore password: keystore_password
Re-enter new password: keystore_password
Enter source keystore password: keystore
...Storing cgms_keystore

Note: The storing cgms_keystore text indicates successful completion.

Copying the cgms_keystore File to IoT FND
To copy the cgms_keystore file into the following IoT FND and TPS proxy directories:

1. For IoT FND, copy the cgms_keystore file to this directory: /opt/cgms/server/cgms/conf/

2. For the TPS proxy, copy the cgms_keystore file to this directory: /opt/cgms-tpsproxy/conf/

Note: For these certificates to be active and enforceable, they must be in the correct directory.

Importing the CA Certificate
In addition to importing the NMS certificate, you must import the CA or (subCA) certificate to the cgms_keystore.

To import the CA certificate into the cgms_keystore:

1. On the IoT FND application server, log in as root.

2. Change directory to /opt/cgms/server/cgms/conf, where you have placed the cgms_keystore file:

# cd /opt/cgms/server/cgms/conf

3. Import the CA certificate: 

# keytool -import -trustcacerts -alias root -keystore cgms_keystore -file ca_cert.cer

A script displays on the screen.

4. Enter the keystore password when prompted.
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5. Re-enter the password.

6. Enter yes when prompted to trust the certificate.

The certificate is added to the Keystore.

Example

To import the CA certificate, enter the following commands as root:

# keytool -import -trustcacerts -alias root -keystore cgms_keystore -file ca_cert.cer
Enter keystore password: keystore_password
Owner: CN=SGBUNMSCA-WIN-4BGS4M94L66-CA,DC=SGBUNMSCA,DC=lab,DC=co
Issuer: CN=SGBUNMSCA-WIN-4BGS4M94L66-CA,DC=SGBUNMSCA,DC=lab,DC=co
Serial number:50adbd57e6b136984f9c1512a0eb7174
Valid from: Wed Jan 11 10:58:09 PDT 2012 until: Wed Jan 11:08:59 PDT 2016
Certificate _fingerprints:

MD5: AE:5D:F4:0A:2B:E5:C8:D8:4A:F4:18:56:FD:A7:8D:7D
SHA1: 83:22:12:8C:6A:23:D3:08:2B:00:55:EF:BD:FF:BA:47:97:99:7E:41
Signature algorithm name: SHA1withRSA
Version:3

Extensions:
#1: ObjectId: 2.5.29.19 Criticality=true 
BasicConstraints:[
CA:true
PathLen:2147483647
]
#2:ObjectId: 2.5.29.15 Criticality=false
KeyUsage[
DigitalSignature
Key_CertSign
Crl_Sign
]
#3:ObjectId: 2.5.29.14 Criticality=false
SubjectKeyIdentifier [
KeyIdentifier [
0000:C6 AB 38 CC EE 79 B0 51 3B 4D 13 c8 9A 56 F6 73 ..8..y.Q;M...V.s
0010:B9 19 FF 7B ....
]
]
#4: ObjectId:1.3.6.1.4.1.311.21.1 Criticality=false
Trust this certificate [no] yes 
Certificate was added to the keystore.

Importing the CA Certificate into the IoT FND TPS Proxy Keystore

Follow the same steps as in Importing the CA Certificate to import the CA certificate into cgms_keystore on the IoT FND TPS proxy.

Installing Custom Browser Certificates
Default IoT FND installations use a self-signed certificate for HTTP(S) communication using either a client Web browser or the NB API 
client. If required, you can use certificates signed by your CA servers. This section presents installation procedures for these custom 
certificates.

This section covers the following topics:

 Installing Custom Certificates in the Browser Client

 Importing Custom Certificates with the North Bound API Client (Windows)

 Importing Custom Certificates with Window IE
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 Managing Custom Certificates

 Managing North Bound API Events

BEFORE YOU BEGIN

 Clear the client browser cache.

 Remove existing certificates for the NMS server (by IP and DNS) on the client browser. 

In Firefox for example, select Preferences > Advanced > Encryption > View Certifications. Remove the certificates in the list for 
the respective server.

 Choose a common name to use in the signed certificate. 

This name requires a DNS entry that resolves to the NMS server IP address. 

 Generate the new certificates and export them to a .PFX file.

This file must contain the private keys, public certificate, and CA server certificates. 

See Using Keytool to Create the cgms_keystore File for the procedure to generate the private and public keys for the cgms_keystore 
file and export them to a .PFX file.

Installing Custom Certificates in the Browser Client

1. On the NMS server, copy the existing jbossas.keystore and jbossas.keystore.password files from the /opt/cgms/server/cgms/conf/ 
directory to a safe location.

2. Delete the existing jbossas.keystore and jbossas.keystore.password files from the /opt/cgms/server/cgms/conf / directory.

3. Determine the alias in the .PFX file that you plan to import into the jbossas.keystore file:

#keytool -list -v -keystore newcert.pfx -storetype pkcs12

Enter the keystore password: keystore_password_when_pfx_file_was_created

Keystore type: PKCS12
Keystore provider: SunJSSE

Your keystore contains 1 entry

Alias name: le-nms-a88ef13a-a519-457f-a2e1-0540f5453ee0
Creation date: Feb 23, 2016
Entry type: PrivateKeyEntry
Certificate chain length: 2
Certificate[1]:
…

4. Import the new custom certificate, in .pfx file format into a new jbossas.keystore file; and, at the same time change the alias name to 
jboss. Follow the prompts:

# keytool -importkeystore -v -srckeystore newcert.pfx -srcstoretype pkcs12 
-destkeystore /opt/cgms/server/cgms/conf/jbossas.keystore -deststoretype jks-
srcalias le-nms-a88ef13a-a519-457f-a2e1-0540f5453ee0 -destalias
jboss -destkeypass your_keystore_password
Enter destination keystore password: your_keystore_password
Enter source keystore password: keystore_password_when_pfx_file_was_created
[Storing /opt/cgms/server/cgms/conf/jbossas.keystore]

5. (Optional) Define a salt. 
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Note: If salt is unchanged, then you can skip this step.

The salt defines the strength of the encrypted password and must be at least 8 characters long. 
For example: A1a1B2b2C3c3D4dE5e5F6f6G7g7H8h8I9i9J10j10K11k11L12l12M13m13N14n14O15

a. Copy the file /opt/cgms/server/cgms/deploy/security-service.xml to a safe location.

b. Update the salt in the /opt/cgms/server/cgms/deploy/security-service.xml file.

NOTE: Select either Step 6 or Step 7 below, based on the NMS release you are running. 

6. CG-NMS Releases earlier than 2.1.0 store the keystore password in the following file: 
/opt/cgms/server/cgms/conf/jbossas.keystore.password

This step encrypts the password that will be stored in the jbossas.keystore.password file.

The password is used to open the jbossas.keystore that has the new custom certificate imported in Step 4.

a. Run /opt/cgms/bin/encrypt-password.sh script with the following parameters:

— Specify the new salt defined in step 5. or use the existing one in the /opt/cgms/server/cgms/deploy/security-service.xml file.

— Set count to 1024.

— Set the password file to jbossas.keystore.password.

— Set your_keystore_password.

#./encrypt-password.sh
A1a1B2b2C3c3D4dE5e5F6f6G7g7H8h8I9i9J10j10K11k11L12l12M13m13N14n14O15 1024 jbossas.keystore.password 
your_keystore_password

b. Move or copy the jbossas.keystore.password to the /opt/cgms/server/cgms/conf directory.

c. Go to Step 8.

7. CG-NMS releases later than 2.1.0 or IoT FND 3.0 release or later, store the keystore password in the 
/opt/cgms/server/cgms/conf/VAULT.dat file

Perform the following steps to update the password to match the one entered in Step 4 (your_keystore_password):

a. Backup the VAULT.dat and vault.keystore files in /opt/cgms/server/cgms/conf to a safe location.

b. Update the VAULT.dat file with the new password:

#/opt/cgms/bin/vault.sh -k /opt/cgms/server/cgms/conf/vault.keystore -p cgms123
-e /opt/cgms/server/cgms/conf -i 50 -s 12345678 -v vault -b keystore_pass 
-a password -x your_keystore_password

where vault.keystore contains the reference to VAULT.dat and VAULT.dat stores and hides the jboss keystore password. This command 
creates a new VAULT.dat file that contains the new jboss.keytsore password. The default password to open vault.keystore is cgnms123.

8. Restart IoT FND:

# service cgms restart

9. Use your browser to connect to the NMS server.

10. Accept and add the new certificates.

11. Use your browser to log in to IoT FND.
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Importing Custom Certificates with the North Bound API Client (Windows)

For an NB API client running on a Windows Server, import the CA public certificate to the Certificate Store on your local computer. 
Matching CA public certificates ensures that the client machine communicates with IoT FND using the NB API client.

Importing Custom Certificates with Window IE

1. In IE, enter the https URL address of the NMS server.

The URL name must match the Common Name on the NMS Server certificate.

2. In the Security Alert window, click OK.

3. In the security certificate warning window, click the Continue to this Website (Not Recommended) link.

4. In the Security Alert window, click OK.

5. Click the Certificate error section of the address bar.

6. In the Certificate Invalid window, click View certificates.

The Certificate window lists the device certificate issued to the NMS server and signed by the issuing CA (or sub CA) server. 

7. Select the Certification Path tab, and look for the invalid certificate (that is, the one with a red cross).
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8. Select the invalid certificate, and select the General tab.

9. Click Install Certificate.

10. In the Certificate Install Wizard window, click Next.

11. Select the Place all certificates in the Following Store option, and then click Browse.
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12. In the Certificate Store window, check the Show physical stores check box, open the Trusted Root Certification Authorities folder, 
select Local Computer, and then click OK.

13. Click Next.

14. Click Finish.

15. Click OK.

16. In the Certificate window, click Install Certificate.

17. Select the Place all certificates in the Following Store option, and then click Browse.

18. In the Certificate Store window, check the Show physical stores check box, open the Trusted Root Certification Authorities folder, 
select Local Computer, and then click OK.
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19. Click Next.

20. Click Finish.

21. Click OK.

22. In the Certificate window, click OK.

23. Repeat the previous steps if the Certificate error section of the address bar is still displaying.

24. Close and restart the browser

25. Enter the IoT FND server secure URL in the address bar.

The IoT FND log in page displays without the security screen.

Managing Custom Certificates

1. Back up the following files that are overwritten when you upgrade or perform a fresh installation of IoT FND:

 Ensure that the device certificate issued to the NMS server and signed by the issuing CA (or sub CA) displays server in the 
Certificate window. 

 Select the Certification Path tab and verify that all certificates in the path are valid (that is, there are no red crosses on the 
certificates).

 In the /opt/cgms/server/cgms/conf/ directory:

— jbossas.keystore.password

— jbossas.keystore 

 In the /opt/cgms/server/cgms/deploy/ directory:

— security-service.xml file 

This is the file where you added the salt value in Installing Custom Certificates in the Browser 
Client).

 In the /opt/cgms/server/cgms/conf directory:

— VAULT.dat

— vault.keystore
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2. Perform the IoT FND upgrade or new installation (see Upgrading IoT FND).

3. Copy the above files to their respective folders, and restart IoT FND.

Managing North Bound API Events

The North Bound (NB) API client can send events using HTTPS. NB API clients must subscribe to IoT FND by providing a valid HTTPS 
URL over which IoT FND will send events. IoT FND accepts SSL certificates and handshakes published by the NB API client.

Configuring IoT FND to Access the Keystore
After you create cgms_keystore and import the NMS and CA certificates to it, configure IoT FND to access the cgms_keystore file.

To set the keystore password:

1. Stop IoT FND.

2. Run the setupCgms.sh script:

pwd
/opt/cgms/bin
./setupCgms.sh 
06-12-2012 10:21:39 PDT: INFO: ========== CG-NMS Setup Started - 2012-06-12-10-21-39 ===== 
06-12-2012 10:21:39 PDT: INFO: Log file: /opt/cgms/bin/../server/cgms/log/cgms_setup.log   
Are you sure you want to setup CG-NMS (y/n)? y   
06-12-2012 10:21:39 PDT: INFO: User response: y 
... 
Do you want to change the keystore password (y/n)? y   
06-12-2012 10:21:52 PDT: INFO: User response: y   
Enter keystore password: keystore_password
Re-enter keystore password: keystore_password
06-12-2012 10:21:59 PDT: INFO: Configuring keystore password. This may take a while. 
Please wait ... 
06-12-2012 10:22:00 PDT: INFO: Keystore password configured. 
...

This script saves the password set in the cgms.properties file.

3. Start IoT FND.

Tip: To protect the cgms_keystore and cgms.properties files, set their permissions to root read only.

Caution: Protect your system! Ensure that only root has access to the IoT FND server. Your firewall should only allow SSH access from 
internal hosts. 

Configuring the TPS Proxy to Access the Keystore
To configure the TPS proxy to access the keystore:

1. Change to the tpsproxy bin directory:

cd /opt/cgms-tpsproxy/bin

2. Convert your chosen password into encrypted form:

./encryptionUtil.sh {your chosen password for cgms_keystore} 
7jlXPniVpMvat+TrDWqh1w==

3. Copy the encrypted password into the tpsproxy.properties file:
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a. Open the file for editing.

cd /opt/cgms-tpsproxy/conf
emacs tpsproxy.properties

b. Add this line to the file:

cgms-keystore-password-hidden=keystore_password

In this example, the encrypted keystore_password is “7jlXPniVpMvat+TrDWqh1w==”.

4. Restart TPS proxy:

service tpsproxy restart

Setting Up an HSM Client
Complete the following procedures to set up the HSM client:

 Installing an HSM Client on the IoT FND Server

 Configuring an HSM HA Client

Note: If your installation uses SSM for CSMP-based messaging, see Installing and Setting Up the SSM.

Installing an HSM Client on the IoT FND Server
The Hardware Security Module (HSM) works as a security server listening at port 1792. For IoT FND to communicate with HSM:

1. Install an HSM client on the IoT FND server.

2. Configure the HSM client to have the certificate for HSM.

3. Upload the certificate to HSM. 

This section describes how to install and configure an HSM client, assuming that HSM is at 172.16.0.1 and the client at 172.31.255.254.

To install and set up an HSM client:

1. Get the HSM client package, unpack it, and run the installation script:

sh install.sh 

2. Change to the /usr/lunasa/bin directory:

cd /usr/safenet/lunaclient/bin/ 

3. Create the client certificate:

./vtl createCert -n ip_address_of_hsm_client 

4. Download the HSM certificate from the HSM server:

scp admin@ip_address_of_hsm_server:server.pem .

5. Upload the client certificate to the HSM server:

scp ../cert/client/ip_address_of_hsm_client.pem admin@ip_address_of_hsm_server: .

6. Load the HSM certificate:
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vtl addServer -n ip_address_of_hsm_server -c server.pem .

7. Ensure that the HSM server is added:

vtl listServer 

8. From the HSM client, use SSH to log in to the HSM server:

ssh admin@ip_address_of_hsm_server 
Last login: Mon Aug 15 15:36:43 2012 from 10.27.164.171  
Luna SA 5.0.1-2 Command Line Shell - Copyright (c) 2001-2010 SafeNet, Inc. All rights reserved.   
[TestLunaSA1] lunash:> 

9. Use SSH to perform these steps on the HSM server:

a. Add the client to the HSM server:

[TestLunaSA1] lunash:>client register -c hsm_client_name -i ip_address_of_hsm_client
'client register' successful.     Command Result : 0 (Success) 

b. List the clients defined on the server and ensure that the client was added:

[TestLunaSA1] lunash:>client list   
registered client 1: cg-nms 
registered client 2: hsm_client_name 
Command Result : 0 (Success) 

c. Assign the client to a partition:

[TestLunaSA1] lunash:>client assignPartition -c hsm_client_name -p partition_name 
'client assignPartition' successful.    
Command Result : 0 (Success) 

d. Log out of HSM.

10. On the server running the HSM client, verify the HSM client installation:

vtl verify 
The following Luna SA Slots/Partitions were found:   
Slot    Serial #    Label 
====    ========    =====  
1    151285008     TestPart1 

11. After the HSM client installation completes, run the test suite ckdemo.

ckdemo 
Ckdemo is the property of SafeNet Inc and is provided to our customers for
diagnostic and development purposes only.  It is not intended for use in
production installations.  Any re-distribution of this program in whole or
in part is a violation of the license agreement.
 
CrystokiConnect()            (modified on Oct 18 2012 at 20:57:53)
 
*** CHRYSTOKI DEMO - SIMULATION LAB ***
 
 
Status: Doing great, no errors (CKR_OK)
 
TOKEN FUNCTIONS
    ( 1) Open Session  ( 2) Close Session  ( 3) Login
    ( 4) Logout        ( 5) Change PIN     ( 6) Init Token
    ( 7) Init Pin      ( 8) Mechanism List ( 9) Mechanism Info
    (10) Get Info      (11) Slot Info      (12) Token Info
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    (13) Session Info  (14) Get Slot List  (15) Wait for Slot Event
                       (18) Factory Reset  (19) CloneMofN
OBJECT MANAGEMENT FUNCTIONS
    (20) Create object (21) Copy object    (22) Destroy object
    (23) Object size   (24) Get attribute  (25) Set attribute
                       (26) Find object    (27) Display Object
SECURITY FUNCTIONS
    (40)  Encrypt file (41) Decrypt file   (42)  Sign
    (43)  Verify       (44) Hash file      (45)  Simple Generate Key
                                           (46)  Digest Key
HIGH AVAILABILITY RECOVERY FUNCTIONS
    (50) HA Init       (51) HA Login
KEY FUNCTIONS
    (60) Wrap key      (61) Unwrap key     (62) Generate random number
    (63) Derive Key    (64) PBE Key Gen    (65) Create known keys
    (66) Seed RNG      (67) EC User Defined Curves
CA FUNCTIONS
    (70) Set Domain    (71) Clone Key      (72) Set MofN
    (73) Generate MofN (74) Activate MofN  (75) Generate Token Keys
    (76) Get Token Cert(77) Sign Token Cert(78) Generate CertCo Cert
    (79) Modify MofN   (86) Dup. MofN Keys (87) Deactivate MofN
    (88) Get Token Certificates     (112) Set Legacy Cloning Domain
OTHERS
    (90) Self Test
    (94) Open Access    (95) Close Access
    (97) Set App ID     (98) Options      (100) LKM Commands
OFFBOARD KEY STORAGE:
   (101) Extract Masked Object            (102) Insert Masked Object
   (103) Multisign With Value             (104) Clone Object
   (105) SIMExtract                       (106) SIMInsert
   (107) SimMultiSign                     (118) Extract Object
                                          (119) Insert Object
SCRIPT EXECUTION:
   (108) Execute Script                   (109) Execute Asynchronous Script
                                          (110) Execute Single Part Script
CLUSTER EXECUTION:
   (111) Get Cluster State
SRK FUNCTIONS:
   (200) SRK Get State  (201) SRK Restore  (202) SRK Resplit
   (203) SRK Zeroize    (204) SRK Enable/Disable
 
   (  0) Quit demo
 
Enter your choice : 1
 
Slots available:
    slot#1 - LunaNet Slot
    slot#2 - Luna UHD Slot
    slot#3 - Luna UHD Slot
    slot#4 - Luna UHD Slot
Select a slot: 1
 
SO[0] or normal user[1]?
 
You must enter a number between 0 and 1: 1
 
Status: Doing great, no errors (CKR_OK)
 
TOKEN FUNCTIONS
    ( 1) Open Session  ( 2) Close Session  ( 3) Login
    ( 4) Logout        ( 5) Change PIN     ( 6) Init Token
    ( 7) Init Pin      ( 8) Mechanism List ( 9) Mechanism Info
    (10) Get Info      (11) Slot Info      (12) Token Info
    (13) Session Info  (14) Get Slot List  (15) Wait for Slot Event
                       (18) Factory Reset  (19) CloneMofN
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OBJECT MANAGEMENT FUNCTIONS
    (20) Create object (21) Copy object    (22) Destroy object
    (23) Object size   (24) Get attribute  (25) Set attribute
                       (26) Find object    (27) Display Object
SECURITY FUNCTIONS
    (40)  Encrypt file (41) Decrypt file   (42)  Sign
    (43)  Verify       (44) Hash file      (45)  Simple Generate Key
                                           (46)  Digest Key
HIGH AVAILABILITY RECOVERY FUNCTIONS
    (50) HA Init       (51) HA Login
KEY FUNCTIONS
    (60) Wrap key      (61) Unwrap key     (62) Generate random number
    (63) Derive Key    (64) PBE Key Gen    (65) Create known keys
    (66) Seed RNG      (67) EC User Defined Curves
CA FUNCTIONS
    (70) Set Domain    (71) Clone Key      (72) Set MofN
    (73) Generate MofN (74) Activate MofN  (75) Generate Token Keys
    (76) Get Token Cert(77) Sign Token Cert(78) Generate CertCo Cert
    (79) Modify MofN   (86) Dup. MofN Keys (87) Deactivate MofN
    (88) Get Token Certificates     (112) Set Legacy Cloning Domain
OTHERS
    (90) Self Test
    (94) Open Access    (95) Close Access
    (97) Set App ID     (98) Options      (100) LKM Commands
OFFBOARD KEY STORAGE:
   (101) Extract Masked Object            (102) Insert Masked Object
   (103) Multisign With Value             (104) Clone Object
   (105) SIMExtract                       (106) SIMInsert
   (107) SimMultiSign                     (118) Extract Object
                                          (119) Insert Object
SCRIPT EXECUTION:
   (108) Execute Script                   (109) Execute Asynchronous Script
                                          (110) Execute Single Part Script
CLUSTER EXECUTION:
   (111) Get Cluster State
SRK FUNCTIONS:
   (200) SRK Get State  (201) SRK Restore  (202) SRK Resplit
   (203) SRK Zeroize    (204) SRK Enable/Disable
 
   (  0) Quit demo
 
Enter your choice : 3
Security Officer[0]
Crypto-Officer  [1]
Crypto-User     [2]: 1
Enter PIN          : 9JT5-WMYG-E5FE-TExs
 
Status: Doing great, no errors (CKR_OK)
 
TOKEN FUNCTIONS
    ( 1) Open Session  ( 2) Close Session  ( 3) Login
    ( 4) Logout        ( 5) Change PIN     ( 6) Init Token
    ( 7) Init Pin      ( 8) Mechanism List ( 9) Mechanism Info
    (10) Get Info      (11) Slot Info      (12) Token Info
    (13) Session Info  (14) Get Slot List  (15) Wait for Slot Event
                       (18) Factory Reset  (19) CloneMofN
OBJECT MANAGEMENT FUNCTIONS
    (20) Create object (21) Copy object    (22) Destroy object
    (23) Object size   (24) Get attribute  (25) Set attribute
                       (26) Find object    (27) Display Object
SECURITY FUNCTIONS
    (40)  Encrypt file (41) Decrypt file   (42)  Sign
    (43)  Verify       (44) Hash file      (45)  Simple Generate Key
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                                           (46)  Digest Key
HIGH AVAILABILITY RECOVERY FUNCTIONS
    (50) HA Init       (51) HA Login
KEY FUNCTIONS
    (60) Wrap key      (61) Unwrap key     (62) Generate random number
    (63) Derive Key    (64) PBE Key Gen    (65) Create known keys
    (66) Seed RNG      (67) EC User Defined Curves
CA FUNCTIONS
    (70) Set Domain    (71) Clone Key      (72) Set MofN
    (73) Generate MofN (74) Activate MofN  (75) Generate Token Keys
    (76) Get Token Cert(77) Sign Token Cert(78) Generate CertCo Cert
    (79) Modify MofN   (86) Dup. MofN Keys (87) Deactivate MofN
    (88) Get Token Certificates     (112) Set Legacy Cloning Domain
OTHERS
    (90) Self Test
    (94) Open Access    (95) Close Access
    (97) Set App ID     (98) Options      (100) LKM Commands
OFFBOARD KEY STORAGE:
   (101) Extract Masked Object            (102) Insert Masked Object
   (103) Multisign With Value             (104) Clone Object
   (105) SIMExtract                       (106) SIMInsert
   (107) SimMultiSign                     (118) Extract Object
                                          (119) Insert Object
SCRIPT EXECUTION:
   (108) Execute Script                   (109) Execute Asynchronous Script
                                          (110) Execute Single Part Script
CLUSTER EXECUTION:
   (111) Get Cluster State
SRK FUNCTIONS:
   (200) SRK Get State  (201) SRK Restore  (202) SRK Resplit
   (203) SRK Zeroize    (204) SRK Enable/Disable
 
   (  0) Quit demo
 
Enter your choice : 27
 
Enter handle of object to display (-1 to list available objects) :
 
You must enter a number between -1 and 10000000: -1
 
No objects found
 
Enter handle of object to display (-1 to list available objects) :
 
You must enter a number between -1 and 10000000:
 
You must enter a number between -1 and 10000000:
 
You must enter a number between -1 and 10000000: 0
ERROR: Can not find object with handle 0
 
Status: C_GetObjectSize returned error. (CKR_OBJECT_HANDLE_INVALID)
 
TOKEN FUNCTIONS
    ( 1) Open Session  ( 2) Close Session  ( 3) Login
    ( 4) Logout        ( 5) Change PIN     ( 6) Init Token
    ( 7) Init Pin      ( 8) Mechanism List ( 9) Mechanism Info
    (10) Get Info      (11) Slot Info      (12) Token Info
    (13) Session Info  (14) Get Slot List  (15) Wait for Slot Event
                       (18) Factory Reset  (19) CloneMofN
OBJECT MANAGEMENT FUNCTIONS
    (20) Create object (21) Copy object    (22) Destroy object
    (23) Object size   (24) Get attribute  (25) Set attribute
                       (26) Find object    (27) Display Object
SECURITY FUNCTIONS
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    (40)  Encrypt file (41) Decrypt file   (42)  Sign
    (43)  Verify       (44) Hash file      (45)  Simple Generate Key
                                           (46)  Digest Key
HIGH AVAILABILITY RECOVERY FUNCTIONS
    (50) HA Init       (51) HA Login
KEY FUNCTIONS
    (60) Wrap key      (61) Unwrap key     (62) Generate random number
    (63) Derive Key    (64) PBE Key Gen    (65) Create known keys
    (66) Seed RNG      (67) EC User Defined Curves
CA FUNCTIONS
    (70) Set Domain    (71) Clone Key      (72) Set MofN
    (73) Generate MofN (74) Activate MofN  (75) Generate Token Keys
    (76) Get Token Cert(77) Sign Token Cert(78) Generate CertCo Cert
    (79) Modify MofN   (86) Dup. MofN Keys (87) Deactivate MofN
    (88) Get Token Certificates     (112) Set Legacy Cloning Domain
OTHERS
    (90) Self Test
    (94) Open Access    (95) Close Access
    (97) Set App ID     (98) Options      (100) LKM Commands
OFFBOARD KEY STORAGE:
   (101) Extract Masked Object            (102) Insert Masked Object
   (103) Multisign With Value             (104) Clone Object
   (105) SIMExtract                       (106) SIMInsert
   (107) SimMultiSign                     (118) Extract Object
                                          (119) Insert Object
SCRIPT EXECUTION:
   (108) Execute Script                   (109) Execute Asynchronous Script
                                          (110) Execute Single Part Script
CLUSTER EXECUTION:
   (111) Get Cluster State
SRK FUNCTIONS:
   (200) SRK Get State  (201) SRK Restore  (202) SRK Resplit
   (203) SRK Zeroize    (204) SRK Enable/Disable
 
   (  0) Quit demo
 
Enter your choice : 0
 
Exiting GESC SIMULATION LAB

Configuring an HSM HA Client
Note: You must perform the steps in this section even if you only have one HSM server. You must also create a group that contains the HSM 
server.

To configure an HSM HA client:

1. Configure the HSM client so that it connects with both HSM servers, as described in Installing an HSM Client on the IoT FND Server.

2. Change to the /usr/safenet/lunaclient/bin/ directory:

/usr/safenet/lunaclient/bin/

3. Create a group that contains only the partition of the first HSM server by running this command and providing the serial number 
(serial_num) of the HSM server obtained by running the ./vtl verify command (10.), the name of the group (group_name), and the 
password (prtn_password) for accessing the partition:

./vtl haAdmin newGroup -serialNum serial_num -label group_name -password prtn_password

For example:

./vtl haAdmin newGroup -serialNum 151285008 -label testGroup1 -password TestPart1
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Warning:  There are 2 objects currently on the new member.
          Do you wish to propagate these objects within the HA
          group, or remove them?
           
          Type 'copy' to keep and propagate the existing
          objects, 'remove' to remove them before continuing,
          or 'quit' to stop adding this new group member.
          > copy
 
New group with label "testGroup1" created at group number 1151285008.
Group configuration is:
 
                HA Group Label:  testGroup1
               HA Group Number:  1151285008
               Synchronization:  enabled
                 Group Members:  151285008
                    Needs sync:  no

4. Add the partition of the second HSM to the group. 

For example:

./vtl haAdmin addMember -group testGroup1 -serialNum 151268008 -password TestPart1
Member 151268008 successfully added to group testGroup1. New group
configuration is: 
 
                HA Group Label:  testGroup1
               HA Group Number:  1151285008
               Synchronization:  enabled
                 Group Members:  151285008, 151268008
                    Needs sync:  yes

Please use the command 'vtl haAdmin -synchronize' when
you are ready to replicate data between all members of the
HA group. (If you have additional members to add, you may
wish to wait until you have added them before synchronizing
to save time by avoiding multiple synchronizations.)

5. Verify that both partitions can be listed:

./vtl haAdmin -listGroups

If you would like to see synchronization data for group testGroup1,
please enter the password for the group members. (Press enter to
skip the synchronization check):
> *********
 
                HA Group Label:  testGroup1
               HA Group Number:  1151285008
               Synchronization:  enabled
                 Group Members:  151285008, 151268008
                    Needs sync:  yes
 

              HA auto recovery:  disabled
                    HA logging:  disabled

6. Enable HA auto recovery:

[root@localhost bin]# ./vtl haAdmin -autoRecovery

vtl haAdmin -autoRecovery [ -retry <count> | -interval <seconds> ] -retry <retry count> 
-interval <seconds> 

— Set the retry value between -1 and 500 where, -1 is an infinite number of retries and 0 disables auto recovery. 
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— Specify the auto recovery poll interval in seconds.

7. Enable HA.

./vtl haAdmin -HAOnly -enable

Configuring the HSM Group Name and Password
The HSM Group name and password is provided by Cisco at manufacture.

To allow the HSM Group name and password to be configured by the user:

1. Edit the cgms.properties file to add the following properties:

 hsm-keystore-name <name>

 hsm-keystore-password <encrypted password> 

Tip: You can use the same HSM server for multiple IoT FND installations by creating multiple partitions on the HSM server, configuring 
the HSM client, and specifying the partition name and partition password in the cgms.properties file.

2. Save the cgms.properties file.

3. To apply these changes, restart IoT FND:

service cgms start 
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Managing User Access
This section has the following topics for managing users and roles in IoT FND:

 Managing the Password Policy

 Configuring Remote Authentication

 Managing Roles

 Managing Users

All user management actions are accessed through the Admin > Access Management menu (Figure 1).

Figure 1 Admin Menu

Managing the Password Policy
IoT FND provides default password policy values that you can enforce among IoT FND users. 

Note: To modify these values, you must be logged in either as root or as a user with Administrative Operations permissions. 

Caution: In some cases, changing password policies immediately terminates all user sessions and resets all passwords.

Note: The “Password history size” and “Max unsuccessful login attempts” policies do not apply to IoT FND North Bound API users.

These changes invalidate all user sessions and expire their passwords (including the root user):

 When you increase the minimum length of passwords

 When you decrease the password expiry interval
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 When you enable “Password cannot contain username or reverse of username”

 When you enable “Password cannot be cisco or ocsic (cisco reversed)”

 When you enable “No character can be repeated more than three times consecutively in the password”

 When you enable “Must contain at least one character from all the character sets (upper-case, lower-case, digits and special 
characters)”

To edit password policies:

1. Choose Admin > Access Management > Password Policy.

2. To enable or disable a policy, choose the appropriate option (Enabled or Disabled) from the Status drop-down menu.

3. To modify the value of a policy, if applicable, enter the new value in the Value field.

Note: IoT FND supports a maximum password length of 32 characters.

4. Click Save to start enforcing the new policies.

Note: The password policy you configure in IoT FND applies only to local users and not to remote Active Directory (AD) users. The 
password policy for AD users is determined and enforced by the AD admin.

Configuring Remote Authentication
To configure remote authentication for IoT FND, you need to perform configurations steps in Active Directory (AD) and IoT FND.

 Support for Remote Authentication

 Configuring Remote Authentication in AD

 Configuring Security Policies on the RADIUS Server
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 Configuring Remote Authentication in IoT FND

 Enabling and Disabling Remote User Accounts

 Deleting Remote User Accounts

 Logging In to IoT FND Using a Remote User Account

Support for Remote Authentication
With Remote Authentication, it is easier to integrate IoT FND into an existing AD and Network Policy Server (NPS) infrastructure. This 
allows administrators to configure IoT FND access for users in AD.

When you configure remote authentication in IoT FND, it hands over the authentication and authorization responsibility to AD and NPS. 
AD performs user authentication to check the validity of user credentials. The RADIUS server performs user authorization to check whether 
a user belongs to a group that defines the user role. If so, the server returns the role name to IoT FND.

The following is the flow of user authentication and authorization by AD and NPS:

1. The user enters their credentials.

2. For remote users, if authentication and authorization are successful, the assigned user role returns to the NMS server from the RADIUS 
server.

3. If the role that returns is valid, the user is granted access.

Note: When remote authentication is enabled, user management is done in AD. If an AD user logs in who was deleted from IoT FND, 
their profile is added back to IoT FND. To prevent access to IoT FND, their AD user profiles must first be deleted from AD. 

Configuring Remote Authentication in AD
To configure AD to allow IoT FND to remotely authenticate users:

1. Log in to NPS.

2. Add IoT FND as a radius client on the RADIUS server. 

Provide a friendly name, and IP address or DNS name of the IoT FND server and configure the shared secret that IoT FND uses to 
connect to the RADIUS server.

 If user was created locally on the NMS server, authentication and authorization occurs locally.

 If IoT FND determines that the user is a remote user, authentication and authorization occurs on the configured RADIUS server. 

 If remote authentication is not configured, authentication fails and user is denied access.

RADIUS 
Server

CG-NMS
Server

Active
Directory

34
73

34
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An entry for the RADIUS client appears under RADIUS Clients and Servers.

3. Log in to AD and create an organizational unit.

Cisco recommends that you create all security groups (IoT FND roles) within this organizational unit.
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4. Add security groups corresponding to IoT FND roles to the organizational unit.

The following example shows the security groups defined in the NMS_ROLES organizational unit.

Tip: When creating the security groups, ensure that they map one-to-one to IoT FND roles (that is, every role defined in IoT FND maps 
to only one AD security group). The name of the security group does not have to match a role name in IoT FND, but for organizational 
purposes, Cisco recommends using names that correlate the security group name to a IoT FND role.
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Note: You cannot create or assign the IoT FND root role in AD.

5. Assign AD users a role by adding them to the security group mapping to that role. 

Since, users can only belong to one security group, the IoT FND role that the user is assigned after log in is dependent on their assigned 
AD security group.

Tip: In AD, users cannot be assigned multiple IoT FND roles, and cannot belong to multiple security groups. To assign permissions 
from more than one role to a group of users, create a new IoT FND role with the required permissions, and a create the corresponding 
AD security group. Users in this new group can then carry out the tasks allowed by this role.

6. Configure the Dial-in Network Access Permission to use the NPS Network Policy.

IoT FND Roles AD Security Groups

34
73

35
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Configuring Security Policies on the RADIUS Server
To authorize users for IoT FND access, configure security policies for the RADIUS server.

To configure security policies on the RADIUS server, follow these steps:

1. Create a network policy for each security group you created in AD. 

2. Configure the policy as follows:

a. In the Overview pane, define the policy name, enable it, and grant access permissions.
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b. Click the Conditions tab, select the User Groups condition, and click Add.

The User Groups condition specifies that the connecting user must belong to the selected group. For this policy to pass, the user being 
authorized must belong to the user group configured in this policy.

c. In the User Groups window, click Add Groups.
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d. In the Select Group window, enter the name of the group

e. Click OK to close the Select Group dialog box, and then click OK to close the User dialog box. 

f. Click Cancel to close the Select condition window. 

The condition appears in the Conditions pane.
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g. Click the Settings tab, and then click Add to display the Attribute Information window.
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h. Click Add to define a Vendor Specific Attribute (VSA) that is sent to IoT FND (RADIUS client) after the user credentials and 
security group membership are verified.

The VSA to configure is:

Note: The string entered in the Attribute value field must be the exact string listed in the Radius Server VSA column on the Roles page 
in IoT FND (Admin > Access Management > Roles).

 Attribute Name: Cisco-AV-Pair

 Attribute number: 5000

 Attribute format: String. 

 Attribute value: Enter the attribute value to send to IoT FND. 
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i. Click OK.

The VSA attribute appears in the Settings pane.
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j. Click OK.

Configuring Remote Authentication in IoT FND
You enable remote user authentication and configure RADIUS server settings on the Remote Authentication page (Admin > Access 
Management > Remote Authentication).
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To configure remote authentication:

1. Choose Admin > Access Management > Remote Authentication.

2. Check the Enable Remote Authentication check box.

3. Enter this information about the RADIUS server:

4. To ensure that IoT FND can reach the RADIUS server, click Test Configuration.

a. Enter your AD username and password.

b. Click Submit.

The results of the configuration test displays. 

c. Click OK.

5. Click Save when done.

Enabling and Disabling Remote User Accounts
In IoT FND you cannot enable or disable remote AD user accounts. To enable or disable remote AD user accounts, use your AD server. 

Field Description

IP The IP address of the RADIUS server.

Name A descriptive name of the RADIUS server.

Shared Secret The shared secret you configured on the RADIUS server.

Confirm Shared Secret

Authentication Port The RADIUS server port that IoT FND uses to send request to. The default port is 1812.

Accounting Port The RADIUS server accounting port. The default port is 1813.

Retries The number of times to send a request to the RADIUS server before IoT FND times out and remote 
authentication fails because no response was received from the RADIUS server.

Timeout The number of seconds before IoT FND times out and remote authentication fails because no response was 
received from the RADIUS server.
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Deleting Remote User Accounts
In IoT FND, you can delete remote user accounts. However, this only removes the user from the IoT FND Users page (Admin > Access 
Management > Users); it does not delete the user account from AD. If a deleted user logs in to IoT FND and AD authentication is 
successful, an entry for the user is added to the IoT FND Users page.

Logging In to IoT FND Using a Remote User Account
Logging in to IoT FND using a remote AD user account is transparent to the user. In the background, IoT FND checks whether the account 
is local, and for remote users sends an authentication request to the RADIUS server configured on the Remote Authentication page (Admin 
> Access Management > Remote Authentication). If both authentication and authorization are successful, IoT FND adds an entry for the 
user in the Users page (Admin > Access Management > Users).

Unlike entries for local users on the Users page, the user name filed in remote user entries is not a link. You cannot click the name of a 
remote user to obtain more information about the user.

Note: Remote users cannot be managed through IoT FND. If a remote user wants to update their password, they must use their 
organization’s AD password update tool. Remote users cannot update their password using IoT FND. 

Managing Roles
Use roles to assign permissions based on the role or roles a user plays. Roles define the type of tasks IoT FND users can perform. This 
section has the following topics:

 Adding Roles

 Deleting Roles

 Editing Roles

 Viewing Roles

IoT FND lets you assign a role to any user. The operations the user can perform are based on the permissions enabled for the role. The 
following topics are discussed in this section:

 Basic User Permissions

 System-Defined User Roles

 Custom User Roles

Basic User Permissions

Table 1 describes basic IoT FND permissions.

Table 1 IoT FND User Permissions

Permission Description

Add/Modify/Delete Devices Allows users to import, remove and change FAR and endpoint devices.

Administrative Operations Allows users to perform system administration operations such as user management, 
role management, and server configuration settings.

Endpoint Configuration Allows users to edit configuration templates and push configuration to MEs.

Endpoint Firmware Update Allows users to add and delete firmware images and perform ME firmware update 
operations.

Endpoint Group Management Allows users to assign, remove and change devices from ME configuration and 
firmware groups.
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System-Defined User Roles

Note: The system-defined Root role cannot be assigned to users.

Endpoint Reboot Allows users to reboot the ME device.

GOS Application Management Allows uses to add and delete Guest OS applications.

Issue Management Allows users to close issues.

Label Management Allows users to add, change, and remove labels.

Manage Device Credentials Allows users to view FAR credentials such as WiFi pre-shared key, admin user 
password, and master key.

Manage Head-End Devices Credentials Allows users to view the ASR admin NETCONF password.

NBAPI Audit Trail Allows users to query and delete audit trails using IoT FND NB API.

NBAPI Device Management Allows users to add, remove, export, and change FAR and endpoint devices using 
IoT FND NB API.

NBAPI Endpoint Operations Allows users to manage endpoint operations using IoT FND NB API.

NBAPI Event Subscribe Allows users to search events, subscribe and unsubscribe from events (including Outage 
events) using IoT FND NB API.

NBAPI Reprovision Allows users to reprovision devices using IoT FND NB API.

NBAPI Rules Allows users to search, create, delete, activate, and deactivate rules using IoT FND NB 
API.

NBAPI Search Allows users to search devices, get device details, group information, and metric history 
using IoT FND NB API.

Router Configuration Allows users to edit FAR configuration templates and push configuration to FARs.

Router Firmware Update Allows users to add and delete firmware images and perform firmware update 
operations for FARs.

Router Group Management Allows users to assign, remove, and change device assignments to FAR configuration 
and firmware groups.

Router Reboot Allows users to reboot the FAR.

Rules Management Allows users to add, edit, activate, and deactivate rules.

Security Policy Allows users to block mesh devices, refresh mesh keys, and so on.

Tunnel Provisioning Management Allows users to manage tunnel groups, edit/apply tunnel-related templates, and perform 
factory reprovisioning.

Work Order Management Allows users to manage work orders for IoT-DM.

Table 1 IoT FND User Permissions (continued)

Permission Description
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Table 2 lists system-defined roles. These roles cannot be modified.

Table 2 System-defined User Roles

Role Description

Add Devices This role can add, modify, and delete devices from IoT FND.

Administrator This role combines these basic permissions: 

 Administrative Operations

 Label Management

 Rules Management

Endpoint Operator This role combines these basic permissions: 

 Label Management

 Endpoint Configuration

 Endpoint Firmware Update

 Endpoint Group Management

 Endpoint Reboot

Monitor Only This role provides users with read-only access to IoT FND. By default, this role is defined 
for every user.

North Bound API This role combines these basic permissions: 

 NB API Audit Trail

 NB API Device Management

 NB API Endpoint Operations

 NB API Event Subscribe

 NB API Orchestration Service

 NB API Rules

 NB API Search

Router Operator This role combines these basic permissions: 

 Label Management

 Router Configuration

 Router Firmware Update

 Router Group Management

 Router Reboot

Router Operator with Manage Device Creds This role combines the permissions of a Router Operator with: 

 Device credential management

Security Policy This role can manage security policies through IoT FND.

Tunnel Provisioning Management This role can provision tunnels.
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Custom User Roles

In IoT FND you can define custom roles. For each role you create, you can assign it one or more basic user permissions (see Table 1). These 
permissions specify the type of actions users with this role can perform. 

Adding Roles
To add IoT FND user roles:

1. Choose Admin > Access Management > Roles.

2. Click Add.

3. Enter the name of the role.

4. Check the appropriate check boxes to assign permissions.

5. Click Save.

6. To continue to add roles, click Yes; otherwise, click No to return to the Roles page.

Deleting Roles
Note: You cannot delete a custom role if it is in use.
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To delete IoT FND user roles:

1. Choose Admin > Access Management > Roles.

2. Check the check boxes of the roles to delete.

3. Click Delete.

4. Click Yes.

5. Click OK.

Editing Roles
Note: You cannot edit system-defined roles, but you can edit custom roles.

To edit IoT FND custom roles:

1. Choose Admin > Access Management > Roles.

2. Click the role to edit.

3. Make changes to the permission assignments by checking or unchecking the relevant check boxes.

4. Click Save.

Viewing Roles
To view IoT FND user roles:

1. Choose Admin > Access Management > Roles.

For every role, IoT FND lists the users assigned to this role.

2. To view permission assignments for the role, click the role link.
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Managing Users
This section has the following topics on managing users:

 Resetting Passwords

 Viewing Users

 Adding Users

 Deleting Users

 Enabling Users

 Disabling Users

 Editing Users

Resetting Passwords
As the root user of the Linux server on which IoT FND runs, you can reset your password and use the password utility to reset the password 
for any other IoT FND user.

To reset a password, enter this command:

[root@yourname-lnx1 bin}#./password_admin.sh root 

IoT FND manages its own user account database; therefore, you must add all new local users from the IoT FND user interface at the Admin 
> Access Management > Users page. Remote users are automatically added to the database. You can also enable, disable, edit, or delete 
users on this page.

A user with a disabled account cannot log in until an administrator enables their account. After a user account is active, the user must reset 
their password. There is no limit to the number of users that you can define on the system other than the available database storage.

Viewing Users
To view IoT FND users, open the Users page (Admin > Access Management > Users).

IoT FND displays this information about users:

Field Description

User Name Specifies the user name. 

Enabled Indicates whether the user account is enabled.

Time Zone Specifies the user’s time zone.
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Adding Users
To add users to IoT FND:

1. Choose Admin > Access Management > Users.

2. Click Add.

3. Enter the following user information:

4. Select the user roles to assigned to this user by checking the appropriate check box under Role Assignment.

5. Click Save.

IoT FND creates a record for this user in the IoT FND database.

6. To add the new user, click Yes; otherwise, click No to return to the Users page.

Note: A new user account is enabled by default. This means that the user can access IoT FND.

Roles Specifies the roles assigned to the user.

Audit Trail A link to the user’s audit trail.

Remote User Indicates whether the user account is stored locally. If the value is false, the user account is 
stored in Active Directory and is accessed via the RADIUS server configured in the Remote 
Authentication page (Admin > Access Management > Remote Authentication).

Field Description

Field Description

User Name Enter the user name.

New Password Enter the password. The password must conform to the IoT FND password policy.

Confirm Password Re-enter the password.

Time Zone Choose a time zone from the drop-down menu.
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Deleting Users
Deleting user accounts removes user preferences such as the default map location from the system. Disable a user account to temporarily 
deactivate it.

To delete users from IoT FND:

1. Choose Admin > Access Management > Users.

2. Check the check boxes of the user accounts to delete.

3. Click Delete.

4. Click Yes to confirm.

5. Click OK.

Enabling Users
You must enable the user account for users to access IoT FND. When users log in for the first time, IoT FND prompts them to change their 
password.

To enable user accounts in IoT FND:

1. Choose Admin > Access Management > Users.

2. Check the check boxes for the user accounts to enable.

3. Click Enable.

4. Click Yes.

5. Click OK.

Disabling Users
To prevent users from accessing IoT FND, disable their accounts. Disabling user accounts does not delete their records from the IoT FND 
database.

To disable user accounts in IoT FND:

1. Choose Admin > Access Management > Users.

2. Check the check boxes for the user accounts to disable.

3. Click Disable.

Note: If you disable a user account, IoT FND resets the user password.

4. Click Yes.

5. Click OK.

Editing Users
To edit user settings in IoT FND:

1. Choose Admin > Access Management > Users.

2. To edit user credentials: 
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a. Click the user name link.

b. Edit the role assignments.

c. Click Save.
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Managing System Settings
This section describes how to manage system settings, and includes the following sections:

 Managing Active Sessions

 Displaying the Audit Trail

 Managing Certificates

 Configuring Data Retention

 Managing Licenses

 Managing Logs

 Configuring Provisioning Settings

 Configuring Server Settings

 Managing the Syslog

Note: To manage system settings, you must be logged in either as root or as a user with Administrative Operations permissions.

System settings are managed from the Admin > System Management menu (Figure 1)
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Figure 1 Admin Menu

Managing Active Sessions
IoT FND tracks active user sessions and lets you log out users. 

 Viewing Active Sessions

 Logging Users Out

 Filtering the Active Sessions List

Viewing Active Sessions
To view active user sessions, choose Admin > System Management > Active Sessions. IoT FND displays the Active Sessions page 
(Figure 2).

Figure 2 Active Sessions Page
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Table 1 describes the Active Session fields.

Tip: Click Refresh to update the users list.

Logging Users Out
To log IoT FND users out:

1. Choose Admin > System Management > Active Sessions.

2. Check the check boxes of the users to log out.

3. Click Logout Users.

4. Click Yes.

Filtering the Active Sessions List
To filter the Active Sessions list using column filtering:

1. Choose Admin > System Management > Active Sessions.

2. From the User Name drop-down menu, choose Filters and enter the user name or the first characters in the user name to filter the list.

For example, to list the active sessions for the root user, enter root.

Tip: To remove the filter, from the User Name drop-down menu, clear the Filters check box or click Clear Filter.

Table 1 Active Session Fields

Field Description

User Name The user name in the session record. To view user settings, click the user name.

IP The IP address of the system the user employs to access IoT FND.

Login Time The log in date and time for the user.

Last Access Time The last time the user accessed the system.
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Displaying the Audit Trail
Use the audit trail to track IoT Field Network Director user activity.

To display the Audit Trail, choose Admin > System Management > Audit Trail.

Table 2 describes the Audit Trail fields.

Tip: Click Refresh to update the list.

Filtering the Audit Trail List
To filter the Audit Trail list using column filtering:

1. Choose Admin > System Management > Audit Trail.

2. From the User Name drop-down menu, choose Filters and enter the user name or the first characters of the user name to filter the list.

For example, to list the Audit Trail entries for the user jane, enter jane.

Table 2 Audit Trail Fields

Field Description

Date/Time Date and time of the operation.

User Name The user who performed the operation. To view user settings, click the user name.

IP IP address of the system that the user employs to access IoT FND.

Operation Type of operation performed.

Status Status of the operation.

Details Operation details.
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Tip: To remove the filter, from the User Name drop-down menu, clear the Filters check box or click Clear Filter.

Managing Certificates
The Certificates page displays the certificates for CSMP (CoAP Simple Management Protocol), IoT-DM (IoT Device Manager), and Web 
used by IoT FND and lets you download these certificates.

To display the CSMP, IoT-DM and Web certificates:

1. Choose Admin > System Management > Certificates.

2. To view a certificate, click its corresponding tab.

3. To download a certificate, click the encoding (Binary or Base64) radio button, and then click Download.

For more information about certificates, see Generating and Installing Certificates.

Configuring Data Retention
The Data Retention page lets you determine the number of days to keep event, issue, and metric data in the IoT FND database.

Note: Data retention prunes events even if they have associated open issues. 

To set IoT FND data retention:

1. Choose Admin > System Management > Data Retention.
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2. For each of the retention categories, specify the number of days to retain data.

Table 3 lists the allowable maximum values for each field.

3. Click Save.

4. To revert to default settings, click Reset.

Managing Licenses
The License Center page (Admin > System Management > License Center) lets you view and manage license files. 

 Viewing License Summary

Table 3 Data Retention Fields Allowable Maximum Values

Field Value in Days

Minimum Maximum Default

Event data 1 90 31

Firmware data 7 180 7

Historical NMS data 1 90 62

NMS data 1 7 7

Closed issues data 1 90 30

Job engine data 1 30 30

Historical router data 1 90 30

Device data 1 7 7

Service provider down routers data 1 31 31
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 Viewing License Files

 Viewing License File Details

 Adding License Files

 Deleting License Files

Note: IoT FND performs license enforcement when importing devices. Without licenses, IoT FND allows only 3 FARs and 100 mesh 
endpoints. If you add licenses, IoT FND only allows the permitted number of devices to be imported, as defined in the licenses.

Viewing License Summary
To view IoT FND license summary:

1. Choose Admin > System Management > License Center.

2. Click License Summary.

For every license, IoT FND displays the information described in Table 4.

Note: IR500s use mesh endpoint licenses, and require no special license.

Viewing License Files
To view IoT FND license files:

1. Choose Admin > System Management > License Center.

Table 4 License File Information 

Field Description

Package Name Name of license package.

Max CGR1000 Count Maximum number of CGR 1000s supported.

Max C800 Count Maximum number of C800 devices supported.

Max IR800 Count Maximum number of IR809 and IR829 devices supported.

Max IR509 Count Maximum number of IR500 devices supported.

Max Endpoint Count Maximum number of mesh endpoints supported.

Max LoRaWAN Modem Count Maximum number of LoRaWAN modems (modules) supported.

Max User Maximum number of users supported.

Max NBAPI User Maximum number of IoT FND North Bound API users supported.

Days Until Expiry Number of days remaining until the license expires.
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2. Click License Files.

For every file, IoT FND displays the fields described in Table 5.

Viewing License File Details
To view license file details:

1. Choose Admin > System Management > License Center.

2. Click License Files.

3. Choose the licenses to view.

4. Click Show Details.

For every selected file, the License File Details section displays the following information:

Table 5 License File Fields 

Field Description

ID License ID.

PAK Number for issuing license fulfillment.

Added At Date and time the license was added to IoT FND.

License Filename Filename of the license.

Table 6 License File Details

Field Description

Package Name License package name.
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Adding License Files
To add a license file:

1. Choose Admin > System Management > License Center.

2. Click License Files.

3. Click Add.

4. Click Browse to locate the license file, and then click Open. 

5. Click Upload.

Deleting License Files
Note: You can only delete ALL license files. Ensure that you have access to license files before deleting existing license files. Without 
licenses, IoT FND allows registration of only 3 FARs and 100 mesh endpoints.

To delete license files:

1. Choose Admin > System Management > License Center.

2. Click License Files.

3. Click Delete All, and then click Yes.

Type License target (ROUTER, ENDPOINT, USER, NB_USER). The type is an empty string if a value is not 
applicable.

Max Count Maximum number of target devices entitled by this license.

Days Until Expiry The number of days remaining until the license expires.

Table 6 License File Details (continued)

Field Description
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Managing Logs
 Configuring Log Settings

 Downloading Logs

Configuring Log Settings
IoT FND lets you change the logging level for the various log categories and download the logs. Logs incur a certain amount of disk space. 
For example, for 5 million meters at an 8-hour reporting interval and 5000 routers at a 60-minute periodic inventory notification, disk 
consumption is approximately 7MB/sec. Ensure that your server has enough disk space to contain your logs.

To configure the logging level:

1. Choose Admin > System Management > Logging.
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2. Click Log Level Settings.

3. Check the check boxes of all logging categories to configure.

4. From the Change Log Level to drop-down menu, choose the logging level setting (Debug or Informational).

 To generate all possible logging messages, use the Debug level. 

Note: Running the Debug logging category can impact performance.

 To generate a subset of these messages, use the Informational logging level.

Note: The Informational logging level is the default for all categories when IoT FND opens. Custom logging level settings are 
retained between log-in sessions, but not after IoT FND restarts. 
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5. To apply the configuration, click Go.

Note: The server.log file is rotated based on size.

Downloading Logs
To download logs:

1. Choose Admin > System Management > Logging.

2. Click the Download Logs tab.

3. Click the Download Logs button.

4. To download a zip file locally, click its file name.

Tip: In a cluster environment, if you need to send log files to Cisco Support, ensure that you send the log files of all cluster servers.

Configuring Provisioning Settings
The Provisioning Settings page (Admin > System Management > Provisioning Settings) lets you configure the IoT FND URL, DHCPv4 
Proxy Client, and DHCPv6 Proxy Client settings required for IoT FND to create tunnels between FARs and ASRs (Figure 3). See Figure 1 
for an example of tunnels as used in the IoT FND architecture. See Tunnel Provisioning Configuration Process for information on 
provisioning tunnels. Also, during ZTD you can add DHCP calls to the device configuration template for leased IP addresses. 

Note: For Red Hat Linux 7.x server installations, you must configure specific IPv4 and IPv6 addresses from the IoT FND Linux host server 
to which to bind DHCP IPv4 and IPv6 clients by setting the following values in IoT FND:

 When you click this button in a single-server deployment, IoT FND compresses the log files into a single zip file and adds an 
entry to the Download Logs pane with a link to the zip file.

 In IoT FND cluster deployments, when you click this button, the IoT FND server to which you are connected:

— Compresses the log files on the server into a single zip file and adds an entry to the Download Logs pane with a link to the 
zip file.

— Initiates the transfer of the log files in .zip format from the other servers to this server. As files become available, the server 
adds entries for these files to the Download Logs pane.

 Admin > Provisioning Settings > DHCPv6 Proxy Client > Client Listen Address: Set the value to the IPv6 address of the 
interface to use to obtain IPv6 DHCP leases from the DHCP server. The default value is “::”. Change the default setting to an 
actual IPv6 address on the Linux host machine.

 Admin > Provisioning Settings > DHCPv4 Proxy Client > Client Listen Address: Set the value to the IPv4 address of the 
interface to use to obtain IPv4 DHCP leases from the DHCP server. The default value is “0.0.0.0”. Change the default setting to 
an actual IPv4 address on the Linux host machine.
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Note: To configure tunnel and proxy settings, you must be logged in either as root or as a user with Administrative Operations permissions.

Figure 3 Provisioning Settings Page

This section provides the following topics for configuring tunnel settings:

 Configuring the IoT FND Server URL

 Configuring DHCPv6 Proxy Client

 Configuring DHCPv4 Proxy Client

Configuring the IoT FND Server URL
The IoT FND URL is the URL that FARs use to access with IoT FND after the tunnel is established. This URL is also accessed during 
periodic inventories. During ZTD, FARs transition from accessing IoT FND through the TPS proxy to using this URL, which must be 
appropriate for use through the tunnel.

To configure the IoT FND URL:

1. Choose Admin > System Management > Provisioning Settings.

2. In the IoT FND URL field, enter the URL of the IoT FND server.

The URL must use the HTTPS protocol and include the port number designated to receive registration requests. By default, the port 
number is 9121. For example:

https://nms.sgbu.example.com:9121
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3. Click Save.

Configuring DHCPv6 Proxy Client
To configure DHCPv6 Proxy Client settings:

1. Choose Admin > System Management > Provisioning Settings.

2. Configure the DHCPv6 Proxy Client settings:

a. In the Server Address field, enter the address of the DHCPv6 server that provides tunnel IP addresses.

You can enter multiple addresses separated by commas. However, in most cases, you only need one server. IoT FND tries to get the 
tunnel IP addresses using DHCP protocols. If it cannot, it goes to the next server in the list and so on.

b. In the Server Port field, enter the port address on the DHCP server to send DHCPv6 requests.

Note: Do not change the default port number (547) unless you have configured your DHCP server to operate on a non-standard port.

c. In the Client Listen Address field, enter the address to bind to for DHCPv6 send and receive messages.

This is the address of the interface that the DHCP server uses to communicate with IoT FND. You can enter multiple backup addresses 
separated by commas. 

Tip: For IoT FND installations where the host has multiple interfaces, the client sends requests using each listed source address. The 
default values, “0.0.0.0” (IPv4) and “::” (IPv6), cause the client to send requests out each interface. Usually, one interface faces the 
DHCP server(s). In these installations, setting the Client Listen Address field to the IP address of the facing interface sends all client 
requests out that interface.

3. Click Save.

Configuring DHCPv4 Proxy Client
To configure DHCPv4 Proxy Client settings:

1. Choose Admin > System Management > Provisioning Settings.

2. Configure the DHCPv4 Proxy Client settings:

a. In the Server Address field, enter the address of the DHCPv4 server that provides tunnel IP addresses.

You can enter multiple addresses separated by commas. However, in most cases, you only need one server. IoT FND tries to get the 
tunnel IP addresses from the first server in the list. If it cannot, it moves to the next server in the list, and so on.

b. In the Server Port field, enter the port address on the DHCP server to send DHCPv4 requests to.

Note: Do not change the default port number (67) unless you have configured your DHCP server to operate on a non-standard port.

c. In the Client Listen Address field, enter the address to bind to for send and receive DHCPv4 messages.

This is the address of the interface that the DHCP server uses to communicate with IoT FND. You can enter multiple backup addresses 
separated by commas. 

3. Click Save.

Configuring Server Settings
The Server Settings page (Admin > System Management > Server Settings) lets you view and manage server settings. 

 Configuring Download Logs Settings
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 Configuring Web Sessions

 Configuring Device Down Timeouts

 Configuring Billing Period Settings

 Configuring RPL Tree Polling

 Configuring the Issue Status Bar

Configuring Download Logs Settings
Note: Configuring download log settings is only required for IoT FND cluster setup.

The Download Logs page lets you configure the Keystore settings. 

To configure Download Logs settings:

1. Choose Admin > System Management > Server Settings.

2. Click the Download Logs tab.

3. Configure these settings:

4. Click Save.

Configuring Web Sessions
The Web Sessions page lets you specify the number of timeout seconds after which IoT FND terminates web sessions and logs users out. 

Table 7 Keystore Settings

Field Description

Keystore Filename Click Upload Keystore File to upload a Keystore file with the public key of the X.509 certificate 
that IoT FND uses. You can reuse the same Keystore file.

Keystore Password Enter the password that IoT FND uses to access the Keystore file on start up.

Confirm Keystore Password

FTP Password Enter the FTP password. 

Confirm FTP Password
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To configure web session timeout:

1. Choose Admin > System Management > Server Settings.

2. Click the Web Session tab.

3. Enter the number of timeout seconds. Valid values are 0–86400 (24 hours).

If a web session is idle for the specified amount of time, IoT FND terminates the session and logs the user out.

4. Click Save.

Configuring Device Down Timeouts
The Device Down Timeouts page lets you specify the number of timeout seconds after which the status of Routers (ASRs, FARs) and 
Endpoints changes to Down in IoT FND. The device down poll interval is five minutes. The system uses the device down timeouts values 
and the last heard time to decide whether to change the device status to Down. For example, if the FAR device down timeout value is set to 
two hours (7200 seconds), all FARs with a last heard time older than 2 hours are marked as status Down. 

You can also configure the device timeout setting for FAR Config groups and Endpoint Config Groups. 

Device status changes to Up when IoT FND detects any of the following:

 Periodic inventory notifications 

 Events

 Manual metric refreshes 

 Device registrations

To configure device down timeout settings:

1. Choose Admin > System Management > Server Settings.

2. Click the Device Down Timeouts tab.
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3. For each device type listed, enter the number of seconds after which the device status changes to Down in IoT FND. 

This value must be greater than the corresponding polling intervals. For example, the default polling interval for endpoints is 8 hours 
(28800 seconds), so the value in the Mark Mesh Endpoints Down After (secs) field must be greater than 28800.

4. Click Save.

Device Down Timeout Settings for FAR Config Groups and Endpoint Config Groups

To configure device down timeout settings for FAR Config groups or Endpoint Config Groups:

1. Choose Config > Device Configuration.

2. Select the Device you want to configure <ROUTERS or ENDPOINTS> in the left pane.

3. Click the Group Properties tab.

4. In the Mark Routers Down After (secs) or Mark Endpoints Down After (secs) field, enter the number of seconds after which the 
status of the devices (router or endpoints) in the group changes to Down in IoT FND.

This value must be greater than the corresponding polling interval. 

For example, the default polling interval for FARs is 30 minutes (1800 seconds), so the value in the Mark Routers Down After (secs) 
field must be greater than 1800.

The default polling interval for ENDPOINTS is 960 minutes (57600 seconds), so the value in the Mark Routers Down After (secs) 
field must be greater than 57600 seconds.

5. Click Save Changes.
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Configuring Billing Period Settings
IoT FND lets you configure the start day of the monthly billing periods for cellular and Ethernet (satellite) services.

To configure the billing period settings:

1. Choose Admin > System Management > Server Settings.

2. Click the Billing Period Settings tab.

3. Enter the starting days for the cellular and Ethernet billing periods.

4. From the drop-down menu, choose the time zone for the billing period.

5. Click Save.

Configuring RPL Tree Polling
RPL tree polls are derived from FAR periodic notification events. Since the RPL tree is not pushed from the FAR with the periodic 
notification event, IoT FND must explicitly poll for the RPL tree at the configured intervals. IoT FND lets you configure the RPL tree 
polling cycle (that is, how many periodic notification events occur between RPL tree polls), and set the maximum amount of time between 
tree polls.

Caution: CG-NMS 1.1(5) release does not support router RPL tree updates. Do not enable RPL tree updates from Routers.

To configure RPL tree polling settings:

1. Choose Admin > System Management > Server Settings.

2. Choose the RPL Tree Settings tab.
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3. Choose the Enable RPL tree update from radio button for Mesh Nodes or CGR devices to receive the RPL tree update from those 
devices at the specified intervals.

4. For Router polling, enter the number of events that pass between RPL tree polling intervals in the Number of Periodic Notification 
RPL Tree Polls field. 

5. In the Maximum Time between RPL Tree Polling (minutes) field, enter the maximum amount of time between tree polls in minutes.

6. Click Save.

Configuring the Issue Status Bar
The Issue Status bar displays issues by device type (as set in user preferences; see Setting User Preferences) and severity level in the 
lower-left browser frame. 

To enable the Issue Status bar and configure the refresh interval:

1. Choose Admin > System Management > Sever Settings > Issue Settings.

2. To display the Issue status bar in the browser frame, check the Enable/Disable Issue Status Bar check box.

3. In the Issue Status Bar Refresh Interval field, enter a refresh value in seconds.

4. In the Certificate Expiry Threshold (days) field for all supported routers or an IoT FND application server, enter a value in days.

Note: When the configured Certificate Expiry Threshold default date is met, a Major event, certificateExpiration, is created. When the 
Certificate has expired (>180 days), a Critical event, certificateExpired, is created.

 The default value is 8.

Note: If thresholds are exceeded during periodic notification events, IoT FND performs a RPL tree poll.

 The default value is 480 minutes (8 hours).

 Valid values are 30 secs (default) to 300 secs (5 minutes).

 Valid value is 180 days (default) to 365 days.
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Managing the Syslog
When IoT FND receives device events it stores them in its database and sends syslog messages to a syslog server that allows third-party 
application integration.

To configure Syslog forwarding:

1. Choose Admin > System Management > Syslog Settings.

2. In the Syslog Server IP Address field, enter the IP address of the Syslog server.

3. In the Syslog Server Port Number field, enter the port number (default is 514) over which to receive device events. 

For IoT FND cluster solutions, each server in the cluster sends events to the same Syslog server.

 To enable message forwarding to the Syslog server, click Enable Syslog Sending Events.

 To disable message forwarding to the Syslog server, click Disable Syslog Sending Events.
162



 

Managing Devices

  
Managing Devices
This section describes how to manage devices in IoT FND, and includes the following topics:

 Managing Routers

 Managing Endpoints

 Managing Head-End Routers

 Managing Servers

 Common Device Operations

 Configuring Rules

 Configuring Devices

 Managing a Guest OS

 Managing Work Orders

 Device Properties

Use the following IoT FND pages to monitor, add and remove devices, and perform other device management tasks that do not include device 
configuration:

 To work with FARs and Endpoints (MEs), use the Field Devices page (Devices > Field Devices).

 To work with HERs, use the Head-End Routers page (Devices > Head-End Routers).

 To work with database and NMS servers, use the Servers page (Devices > Servers).

 To configure the device properties of routers and MEs, use the Device Configuration page (Config > Device Configuration).

Managing Routers
You manage routers on the Field Devices page (Devices > Field Devices). By default, the page displays devices in Default view. This section 
includes the following topics:

 Working with Router Views

 Creating Work Orders

 Using Router Filters

 Refreshing the Router Mesh Key

 Managing Embedded Access Points on Cisco C819 and Cisco IR829 ISRs

 Displaying Router Configuration Groups

 Displaying Router Firmware Groups

 Displaying Router Tunnel Groups
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Working with Router Views
Unless you select the Default to map view option in user preferences (see Setting User Preferences), the Field Devices page defaults to the List 
view, which contains basic device properties. Select a router or group of routers in the Browse Devices pane (left pane) to display tabs in the main 
pane. The router or routers you select determine which tabs display.

Note: Listed below are all the possible tabs:

 Cellular-CDMA 

 Cellular-GSM

 Config

 DHCP Config

 Default

 Ethernet Traffic

 Firmware

 LoRaWAN

 Mesh

 Mesh Config

 Physical

 Tunnel

 WiMAX

Each of the tab views above displays different sets of device properties. For example, the Default view displays basic device properties, and the 
Cellular-GSM view displays device properties particular to the cellular network. 

For information on how to customize router views, see Customizing Device Views. 

For information about the device properties that display in each view, see Device Properties. 

For information about common actions performed in these views (for example, adding labels and changing device properties), see Common Device 
Operations.

Viewing Routers in Map View

To view routers in Map view, check the Enable map check box in <user> > Preferences, and then click the Map tab in the main pane (see Setting 
User Preferences). You can view any RPL tree by clicking the device in Map view, and closing the information popup window. The RPL tree 
connection displays data traffic flow as blue or orange lines, as follows:

 Orange lines indicate that the link is an uplink: data traffic flows in the up direction on the map.

 Blue lines indicate that the link is a downlink: data traffic flows in the down direction on the map.
1



 

Managing Devices

  
Figure 1 Map View: Downlink Data Flow RPL Trees

Migrating Router Operating Systems
You migrate CGR operating systems from CG-OS to IOS on the Config > Firmware Update page, using the procedure in Performing OS 
Migrations. 

Creating Work Orders
Create work orders in IoT FND to deploy field technicians for device inspections. Field technicians use the IoT-DM client to connect to IoT FND 
and download the work order. 

Note: The Work Orders feature works with Release 3.0 or later of Device Manager (IoT-DM) only. See “Accessing Work Authorizations” in the 
Cisco Connected Grid Device Manager Installation and User Guide, Release 3.1 for integration instructions for CG-OS installations. For Cisco 
IOS installations, please refer to the Cisco Connected Grid Device Manager Installation and User Guide, Release 4.0 or later. 

Note: Before you can create a work order, your user account must have Work Order Management permissions enabled. See Managing Roles.

To create work orders for CGRs, select a router or group of routers in the Browse Devices pane, and then in Default view:

1. Check the check box of the faulty CGR.

2. Choose More Actions > Create Work Order.
1
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The Work Orders page appears (Config > Device Configuration > Work Orders). On that page, IoT FND adds the names of the selected 
FARs to the List of FAR Names field as a comma-separated list.

3. Follow the steps in Creating Work Orders to create the work order.

For more information about work orders, see Managing Work Orders.

Refreshing the Router Mesh Key
If you suspect unauthorized access attempts to a FAR, refresh its mesh key. 

Caution: Refreshing the router mesh key can result in MEs being unable to communicate with the FAR for a period of time until the MEs re-register 
with the FAR, which happens automatically.

To refresh the router mesh key, select a router or group of routers in the Browse Devices pane, and then in Default view:

1. Check the check boxes of the of the FARs to refresh. 

2. Choose More Actions > Refresh Router Mesh Key from the drop-down menu.

3. Click Yes to continue.

Managing Embedded Access Points on Cisco C819 and Cisco IR829 ISRs
IoT Field Network Director allows you to manage the following embedded access point (AP) attributes on C819 and IR829 ISRs:

Note: IoT Field Network Director can only manage APs when operating in Autonomous mode.

 Discovery

 AP configuration 

 Periodic inventory collection

 Firmware update of APs when operating in Autonomous Mode

 Event Management over SNMP
1
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Note: Not all C800 Series and IR800 routers have embedded APs. A C800 ISR features matrix is here. The IR800 ISR features matrix is here.

Using Router Filters
To refine the list of displayed routers, use the built-in router filters under ROUTERS in the Browse Devices pane or saved custom searches in the 
Quick View pane (left pane). For example, to display all operational FARs, click the Up group under ROUTERS in the Browse Devices pane. Click 
a filter to insert the corresponding search string in the Search Devices field. For example, clicking the Up group under ROUTERS inserts the search 
string status:up in the Search Devices field.

Displaying Router Configuration Groups 
Use the Browse Devices pane to display the router devices that belong to one of the groups listed under ROUTERS. 

Displaying Router Firmware Groups 
Use the Browse Devices pane to display the router devices that belong to one of the groups listed under ROUTER FIRMWARE GROUPS.

Displaying Router Tunnel Groups 
Use the Browse Devices pane to display the router devices that belong to one of the groups listed under ROUTER TUNNEL GROUPS. 

Managing Endpoints
To manage endpoints, view the Devices > Field Devices page. By default, the page displays the MEs in List view. This section includes the 
following topics:

 Viewing Endpoints in Default View

 Viewing Mesh Endpoints in Map View

 Blocking Mesh Devices

 Displaying Mesh Endpoint Configuration Groups

 Displaying Mesh Endpoint Firmware Groups

Viewing Endpoints in Default View
When you open the Field Devices page in Default view, IoT FND lists all FAN devices and basic device properties. When you select an ENDPOINT 
device or group in the Browse Devices pane, IoT FND provides tabs to display additional endpoint property views:

 Map

 Config

 Default

 Firmware

 PLC Mesh

 RF Mesh

 Security

 Cellular Endpoints
1
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Each one of these views displays different sets of device properties. For example, the Firmware view displays the device properties that fall under 
the firmware category, such as Hardware ID, Firmware Group, and FW Uploaded Version.

For information on how to customize ME views, see Customizing Device Views. 

For information about the device properties displayed in each view, see Device Properties. 

For information about the common actions in these views (for example, adding labels and changing device properties) that also apply to other 
devices, see Common Device Operations.

Viewing Mesh Endpoints in Map View
To view MEs in Map view, select Enable map in <user> > Preferences, and click the Map tab.

Blocking Mesh Devices
If you suspect unauthorized access attempts to a mesh device, block it from accessing IoT FND. 

Caution: If you block an ME, you cannot unblock it using IoT FND. To re-register the ME with IoT FND, you must escalate and get your ME 
administrator involved.

To block an ME device, in Default view:

1. Check the check boxes of the mesh devices to refresh. 

2. Choose More Actions > Block Mesh Device from the drop-down menu.

3. Click Yes in the Confirm dialog box.

4. Delete the mesh endpoint from the NPS server to prevent the device from rejoining the mesh network.

Displaying Mesh Endpoint Configuration Groups
You can use the Browse Devices pane to display the ME devices that belong to one of the groups listed under MESH DEVICE CONFIGURATION 
GROUPS.

Displaying Mesh Endpoint Firmware Groups
You can use the Browse Devices pane to display the ME devices that belong to one of the groups listed under ENDPOINTS.
1
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Managing Industrial Routers
You can use the configuration template to apply DSCP and Raw Socket settings to the IR509 Industrial Router.

DSCP Configuration
To configure DSCP on the IR509:

1. Choose Config > Device Configuration.

2. Select default-ir500 under ENDPOINT in the left-pane.

3. Choose Edit Configuration Template (Figure 2 and Figure 3)

Note: Refer to Table 1 for a summary of configuration options.

Figure 2 Setting DSCP Markings on Ethernet Interface

Figure 3 Setting DSCP Markings on DCE and DTEs

Configuration Notes:

 Set DSCP (QoS) markings for all interfaces - Ethernet, DTE and DCE. Options: Low Priority (0), Normal Priority (10), Medium Priority (18).

 DSCP is applied on interfaces. Default values for DCE and DTE are Low Priority (0). There are no default value for Ethernet. Traffic will flow 
unmarked if you do not configure any value on the Configuration Template.

 Only one Raw Socket session can flow through DCE and DTE interfaces at a time. The DSCP value will be the same throughout. 
1
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Raw Socket Configuration
To configure Raw Socket on the IR509:

1. Choose Config > Device Configuration.

2. Select default-ir500 under ENDPOINT in the left-pane.

3. Choose Edit Configuration Template ( ).

Note: Refer to Table 1 for a summary of configuration options.

Configuration Notes:

 Update Raw Socket settings to support UDP sockets.

 Set stop bit values for serial devices. Values 1 to 4.

 Set minimum periodic notification interval for device. Values 1 to 5 minutes.
1
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Managing Head-End Routers
To manage head-end routers (HERs), open the Head-End Routers page by choosing Devices > Head-End Routers (Figure 4). Unless Enable Map 
is selected in user preferences, by default, the page displays the HERs in List view. When you open the Head-End Routers page in List view, 
IoT FND displays the Default list view. This view displays basic HER device properties. In addition, IoT FND provides these tabs to display 
additional HER property views:

 Tunnel 1

 Tunnel 2

Table 1 Configuration Options for IR509

Interface Settings

Ethernet 1. Ethernet Settings panel options (and required values):

 Enable Ethernet: Leave option disabled (unchecked)

 Disable Ethernet on Disconnect: Leave option disabled (unchecked)

 DSCP Markings: Select NONE from the pull down menu.

2. MAP-T Settings panel options:

— Default Mapping IPv6 Prefix: 0:0:0:0:0:0:0:1

— IPv6 Prefix Length: 64

DCE Serial Interface 0 Settings (DCE) panel options (and required values):

 Media Type: Disable

 Baud rate: 115200

 Data Bits: 8

 Parity: Normal

 Stop Bit: 1

 Flow Control: None

 DSCP Marking: Normal

DTE Serial Interface 1 Settings (DTE) panel options (and required values):

 Media Type: Disable

 Baud rate: 115200

 Data Bits: 8

 Parity: None

 Stop Bit: 1

 Flow Control: None

 DSCP Marking: Low
1
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Each one of these views displays different sets of device properties. These views display information about the HER tunnels.

Figure 4 Head-End Routers Page

For information on how to customize HER views, see Customizing Device Views.

For information about the device properties displayed in each view, see Device Properties.

For information about the common actions in these views (for example, adding labels and changing device properties) that also apply to other 
devices, see Common Device Operations.

Managing External Modules
To manage devices that connect to Field Devices such as routers, choose Devices > Field Devices. By default, the page displays all known FAN 
Devices in List view.

 LoRaWAN

There are two ways to upload the LRR image for a LoRaWAN module to the IR800 router: during zero touch deployment (ZTD) and by on-demand 
configuration push.
1
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Note: We do not support discovery for the LoRaWAN module. Rather, IoT FND recognizes it as an IR800 module and will communicate with it 
via Cisco IOS.

 To view LoRaWAN modules in a Device List, choose an IR800 router in the Browse Devices list and select the LoRaWAN tab.

 To reboot the modem on the LoRaWAN module:

a. Click on the relevant IXM-LORA link under the Name column to display the information seen below:

b. Click Reboot Modem. When the reboot completes, the date and time display in the Last Reboot Time field in the Device Info pane for 
the LoRaWAN module. You can only process one modem reboot at a time. 

The Reboot Modem action generates two events: LoRa Modem Reboot Initiated and LoRa Modem Reboot Success.

 To remove a LoRaWAN module from the IR800 router inventory:

a. In the Browse Devices pane, select the IR800, which has the LoRA module which needs to be disabled and removed from inventory.

b. Select the LoRaWAN tab and check the box next to the LoRaWAN module to be removed.

c. At the More Actions drop-down menu, select Remove Devices.

Managing Servers
To manage servers, open the Servers page by choosing Devices > Servers. By default, the page displays the servers in List view. When you open 
the Servers page in List view, IoT FND displays the Default list view. This view displays basic server device properties. To obtain information about 
a server, click its name.

To add additional views, see Customizing Device Views.

For more information about the device properties displayed in each view, see Device Properties.

For information about the common actions in this view, see Common Device Operations.
1
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Managing NMS Servers
In the Browse Devices pane, NMS servers appear under NMS Servers. In single-NMS server deployments, only one server appears under NMS 
Servers. In cluster deployments, multiple NMS servers appear under NMS Servers. To filter the list pane:

 To display all NMS servers, click NMS Servers in the Browse Devices pane.

 To display only operational servers, click Up.

 To display only non-operational servers, click Down.

Managing Database Servers
In the Browse Devices pane, IoT FND database servers appear under Database Servers. In single-server deployments, only one database server 
appears under Database Servers. If a secondary database is configured, it also appears under the same entry.

 To display all database servers in List view, click Database Servers in the Browse Devices pane.

 To only display servers that are operational, click Up.

 To only display servers that are non-operational, click Down.

Common Device Operations
This section describes how to use IoT FND to manage and view information about devices, and includes the following topics:

 Selecting Devices

 Customizing Device Views

 Viewing Devices in Map View

 Configuring Map Settings

 Changing the Sorting Order of Devices

 Exporting Device Information

 Pinging Devices

 Tracing Routes to Devices

 Managing Device Labels

 Removing Devices

 Displaying Detailed Device Information

 Using Filters to Control the Display of Devices

 Performing Bulk Import Actions

Selecting Devices
In List view, IoT FND lets you select devices on a single page and across pages. When you select devices, a yellow bar displays that maintains a 
count of selected devices and has the Clear Selection and Select All commands. The maximum number of devices you can select is 1000. Perform 
the following to select devices:

 To select devices across all pages, click Select All.
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 To select all devices listed on a page, check the check box next to Name.

 To select a group of devices, check the check boxes of individual devices listed on a page and across pages. The count increments with every 
device selected, and selections on all pages are retained.

Customizing Device Views
IoT FND lets you customize device views. For List views you can:

 Add and delete tabs

 Specify the properties to display in the columns for each view (see Device Properties by Category for available properties)

 Change the order of columns

Adding Device Views

To add a custom device view tab to a device page in list view:

1. Click the + tab.

2. In the Add New View dialog box, enter the name of the new tab.
1
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3. Add properties to the Active Columns list by selecting them from the Available Columns list, and then clicking the left arrow button, or 
dragging them into the Active Columns list.

4. Click Save View.

Editing Device Views

To edit a device view:

1. Click the drop-down arrow on the desired tab.

2. In the Edit/Delete View dialog box:

a. To remove properties from the Active Columns list, select those properties and click the right-arrow button or drag them out of the Active 
Columns list.

b. To add properties to the Active Columns list, select those properties from the Available Columns list and click the left-arrow button, or 
drag them into position in the Active Columns list.

c. To change the sort order of the active columns, use the up- and down-arrow buttons, or drag them to the desired position.

3. Click Save View.

 To change column order, use the up and down arrow buttons or drag them to the desired position.

 To remove properties from the Active Columns list, select those properties and click the right arrow button, or drag them out of 
the list.

Tip: Hold the Shift key to select multiple column labels and move them to either list.
1
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Deleting Device Views

To delete a device view:

1. Click the arrow on the tab of the device view to delete.

2. In the Edit/Delete View dialog box, select the desired label in the Active Columns pane.

3. Click Delete.

Viewing Devices in Map View
IoT FND provides a map view for visualizing device information based on geographic location. In Map view, IoT FND displays a Geographic 
Information System (GIS) map and uses GIS Map services to show device icons on the map based on the latitude and longitude information of the 
device. When this information is not defined for a device, IoT FND does not display the device on the map.
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To view devices in Map view:

1. Choose <user> > Preferences, check the Enable map check box, and click Apply.

2. Choose Devices > Field Devices.

3. Click the Map tab.

By default, IoT FND displays all devices registered in its database on the map. Depending on the zoom level of the map and the device count, 
individual device icons might not display. Instead, IoT FND displays device group icons.
1
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To view individual devices, zoom in until the device icons appear. You can also click on a device to display a popup window that includes the 
Zoom In link to move the map display to the device level.
1
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IoT FND displays the device count next to each device group or category in the Browse Devices pane (left pane). 

 To display a subset of all devices, click one of the filters listed in the Browse Devices pane. 

IoT FND changes the map region based on your selection and displays the devices found by the filter. For example, you can use 
the Routers > Up filter to display all FARs that are up and running. You can also use saved custom filters in the Quick View 
pane (left pane) to filter the device view. For information about creating custom filters, see Creating a Quick View Filter.

 To display information about a device or group, click its icon on the map.
1
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A popup window displays listing basic device or group information. 

You can also ping the device, perform a trace route, and create a work order from this window. 

4. Close the Device popup window to view the RPL tree associated with the device. See Configuring RPL Tree Polling

The RPL tree connection displays as blue or orange lines; where blue indicates that the link is down, and orange indicates that the link is up.

5. Click the refresh button (  ) to update the Map view. 

 To view device specifics, click Details or the device EID link in the Device popup window. 
1
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Configuring Map Settings
In Map view, IoT FND lets you configure these settings for maps:

 Automatically zoom to devices

 Display the map in grayscale

 Default map location (set to North America by default) 

To configure map settings:

1. Choose Devices > Field Devices.

2. Click the Map tab.

3. Click OK.

Changing the Sorting Order of Devices
To change the sorting order of devices, click the right side of the column heading and choose a sort command from the drop-down menu. 

Exporting Device Information
IoT FND lets you export the device properties of the selected devices in List view. IoT FND exports only properties in the current view. 

To export device information displayed in the current view, in List view:

1. Select the devices to export by checking their corresponding check boxes.

2. Click Export CSV.

3. Click Yes in the confirmation dialog box.

 To automatically zoom to devices, check the Zoom to Devices check box.

 To display the map in grayscale, check the Grayscale check box.

 To overlay all associated wireless personal area network (WPAN) endpoints on the map, select Associated WPAN Endpoints 
from the Overlay drop-down menu.

 To set the map location to always open to a certain area, display the area of the map to display by default, and then click Set 
Default Map Location (top right).
1
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IoT FND creates a CSV file, export.csv, containing the information that displays in the List view pane. By default, IoT FND saves this file to your 
default download directory. When a file with the same name exists, IoT FND adds a number to the default filename (for example, export-1.csv and 
export-2.csv). 

The export.csv file consists of one header line defining the exported fields followed by one or more lines, each representing a device. Here is an 
example of an export of selected devices from the Field Devices page:

name,lastHeard,meshEndpointCount,uptime,runningFirmwareVersion,openIssues,labels,lat,lng
CGR1240/K9+JSJLABTES32,2012-09-19 00:58:22.0,,,,Door Open|Port Down,,50.4,-130.5
sgbuA1_cgr0,,,,,,,42.19716359,-87.93733641
sgbuA1_cgr1,,,,,,,44.3558597,-114.8060403

Pinging Devices
When troubleshooting device issues, ping registered devices to rule out network connectivity issues. If you can ping a device, it is accessible over 
the network. 

To ping selected devices, in List view:

1. Check the check boxes of the devices to ping. 

Note: If the status of a device is Unheard, a ping gets no response.

2. Click Ping.

A window displays the ping results. If you check the check box for Auto Refresh, IoT FND pings the device at predefined intervals until you 
close the window. Click the Refresh button to ping the device at any time.

3. Click Close when done.

Tracing Routes to Devices
The Traceroute command lets you determine the route used to reach a device IP address. 

Note: You cannot use the Traceroute command with the Itron OpenWay RIVA CAM module or the Itron OpenWay RIVA Electric devices 
and Itron OpenWay RIVA G-W (Gas-Water) devices.

To trace routes to selected devices, in List view:

1. Check the check boxes of the devices to trace. 

Note: You can only trace routes to devices registered with IoT FND. If the status of a device is Unheard, you cannot trace the route to it.

2. Click Traceroute.

A window displays with the route-tracing results. 
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Expand the Result column to view complete route information. 

Click the Refresh button to resend the Traceroute command. Check the Auto Refresh check box to resend the Traceroute command at 
predefined intervals until you close the window. 

3. Click Close when done.

Managing Device Labels
You use labels to create logical groups of devices to facilitate locating devices and device management.

Managing Labels

You use the Label Management window to display all custom labels, label properties, and search for custom labels. 

To manage labels, in the Browse Device pane on any devices page:

1. Hover your mouse over LABELS and click the edit icon ( ). 
1
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2. Click Update to accept label property changes or Cancel to retain label properties.

3. Click Close.

Adding Labels

To add labels to selected devices, in List view:

1. Check the check boxes of the devices to label. 

2. Choose Label > Add Label.

3. Enter the name of the label or choose an existing label from the drop-down menu.

4. Click Add Label.

Tip: You can add multiple labels to one device.

5. Click OK.

To add labels in bulk, see Adding Labels in Bulk.

 To find a specific label, enter the label name in the Search field.

Tip: Click the Label column title to reverse label name sort order. 

 To change label properties, double-click a label row, edit the label name and device status display preference.
1
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Removing Labels

To remove labels from selected devices, in List view:

1. Check the check boxes of the devices from which to remove the label. 

2. Choose Label > Remove Label.

3. Click OK.

To remove labels in bulk, see Removing Labels in Bulk.

Removing Devices
Caution: When you remove FARs, IoT FND returns all the leased IP addresses associated with these devices to the Cisco Network Registrar (CNR) 
server and removes the corresponding tunnels from the HERs.

To remove devices, in List view:

1. Check the check boxes of the devices to remove. 

2. Choose More Actions > Remove Devices.

3. Click Yes.

Displaying Detailed Device Information
IoT FND keeps detailed information about every device in the system. To access detailed information about a device, click its name or EID.

 Detailed Information Displayed

 Actions You Can Perform from the Detailed Device Information Page

Detailed Information Displayed 

 Server Information

 HER, FAR, and Endpoint Information

Note: IoT FND automatically refreshes the detailed information without the need to reload the page.
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Server Information

IoT FND displays the following information about the system running the NMS and database servers. 

HER, FAR, and Endpoint Information

IoT FND groups the detailed device information it displays about HERs, FARs, and Endpoints into the following categories:

Table 2 NMS Server Pane Areas

Area and Field Name Description

Host System Information

Hostname Hostname of the IoT FND server.

Host Operating System Operating system.

CPU CPU specifications.

Total Memory Total amount of RAM memory (GB) available on the system.

Current System Time Current system time.

Host Disk Information

File System File system.

Size Size of file system disk space (GB).

Used Amount of file system disk space used (GB).

Available Available file system disk space (GB).

Use % Percentage of file system disk space used.

Mounted On The directory in which the file system is mounted.

IoT FND Application Information

EID EID of the server.

Start Time Time when the IoT FND server started.

Number of Restarts The number of times the IoT FND application has restarted.

Memory Allocation Memory space allocation in GB for the IoT FND application.

Information Category Description

Device Info Displays detailed device information (see Device Properties).

For FARs and MEs, IoT FND also displays charts (see Viewing Device Charts).

Events Displays information about events associated with the device. 

Config Properties Displays the configurable properties of a device (see Device Properties).

You can configure these properties by importing a CSV file specifying the properties to configure and 
their new values, as described in Changing Device Configuration Properties.

Running Config (FARs) Displays the running configuration on the device.

Mesh Routing Tree (FARs and MEs) Displays the mesh routing tree. 

For FARs, the Mesh Routing Tree pane displays all the possible routers from the MEs to the FAR. 

For MEs, the Mesh Routing Tree pane displays the mesh route to the FAR.

Mesh Link Traffic (FARs) Displays the type of mesh link traffic over time in bits per second.

Router Files (FARs) Lists files uploaded to the .../managed/files/ directory.

Raw Sockets (FARs) Lists metrics and session data for the TCP raw sockets (see Table 29 on page 250)
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Actions You Can Perform from the Detailed Device Information Page

Depending on device type, the Detailed Device Information page lets you perform these actions:

Using Filters to Control the Display of Devices
Depending on your deployment, the number of devices managed by IoT FND can be very large (IoT FND supports up to 10 million devices). To 
facilitate locating and displaying devices in Map View and List view, IoT FND provides filters and lets you add customized filters. Filters are listed 
in the Browse Devices and Quick View tabs.

Browse Devices Filters

Built-in device filters display in the Browse Devices pane. These filters control the display of devices in List and Map views. For every filter entry, 
IoT FND provides a device count in parenthesis. IoT FND automatically updates the device count without having to reload the page. In the example 
in Figure 5, the top-level Endpoints label is selected, which inserts the following built-in filter in the Search Devices field: deviceType:cgmesh 
firmwareGroup:default-cgmesh. 

Embedded AP (IR829) Lists inventory (configuration) details and metrics for the attached access point.

AP Running Config (C800 and IR800) Lists the running configuration file for the attached access point.

Action Description

Show on Map 

(MEs only) 

Displays a popup window with a map location of the device. This is the equivalent of entering 
eid:Device_EID in the search field in Map View.

Ping Sends a ping to the device to determine its network connectivity. See Pinging Devices

Traceroute Traces the route to the device. See Tracing Routes to Devices

Refresh Metrics

(HERs and FARs only) 

Instructs the device to send metrics to IoT FND.

Note: IoT FND assigns historical values for metrics for each device. To access historical metric values, use 
the GetMetricHistory North Bound API call.

Refresh Router Mesh Key

(FARs only) 

Refreshes the router ME key. See Refreshing the Router Mesh Key

Create Work Order

(FARs and DA Gateway only) 

Creates a work order. See Creating Work Orders

Sync Config Membership

(MEs only)

Synchronizes the configuration membership for this device. See Synchronizing Endpoint Membership

Sync Firmware Membership

(MEs only) 

Click Sync Firmware Membership to synchronize the firmware membership for this device, and then click 
Yes to complete the process.

Block Mesh Device

(MEs only)

Blocks the ME device.

Caution: This is a disruptive operation. 

Note: You cannot use Block Mesh Device with the Itron OpenWay RIVA CAM module or the Itron 
OpenWay RIVA Electric devices and Itron OpenWay RIVA G-W (Gas-Water) devices.

Information Category Description
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Figure 5 Built-in Filter to Search for MEs 

Creating and Editing Quick View Filters

The Quick View pane displays custom filters. Click a filter in this pane to view the devices that fulfill the search criteria defined in the filter.

Creating a Quick View Filter

To create a Quick View filter:

1. On any device page, click Show Filters and add filters to the Search field.

For more information about adding filters, see Adding a Filter.

2. From the Quick View/Rule drop-down menu, choose Create Quick View.

3. In the Name field of the Save Quick View dialog box, enter the name for the Quick View filter.

4. Click Save.

Editing a Quick View Filter

To edit or delete a Quick View filter:

1. Click the Quick View tab and select the filter to edit.

2. From the Quick View/Rule drop-down menu, choose Edit Quick View.

3. In the Update Quick View dialog box, make the necessary modifications, and then click Save.

4. To delete the Quick View, click the Delete button.
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Adding a Filter

To add a filter to the Search field:

1. If the Add Filter fields are not present under the Search field, click Show Filters.

2. From the Label drop-down menu, choose a filter.

The drop-down menu defines filters for all device information categories. For more information about these categories, see Working with 
Router Views.

3. From the Operator (:) drop-down menu, choose an operator.

For more information about operators, see Table 3. If you choose a numeric metric from the Label menu (for example, Transmit Speed), you 
can specify a range of values in the filter you are adding. For date/time filters, “between” is the operator. Use the calendar buttons to specify 
the date range for the filter.

4. In the Value field, enter a value to match or a range of values in the case of numeric metrics or select an available value from the drop-down 
menu.

5. Click the Add (+) button to add the filter to the existing filter syntax in the Search field.

6. (Optional) Repeat the process to continue adding filters.

Filter Operators

Table 3 describes the operators you can use to create filters.

Search Syntax

IoT FND supports this simple query language syntax:

Search := filter [filter ...]

Filter := fieldname operator value

operator := < | <= | > | >= | <> | = | :

Note the following when creating filters to search fields:

 Each field has a data type (String, Number, Boolean, and Date).

 String fields can contain a string, and you can search them using string equality (“:”).

 Numeric fields can contain a decimal number (stored as a double-precision float), and you can search them using the numeric comparison 
operators (“>”, “>=”, “<“, “<=”, “<>”).

 Boolean fields can contain the strings “true” or “false”.

 Date fields can contain a date in this format: yyyy-MM-dd HH:mm:ss:SSS. You can search dates using numeric comparison operators.

Table 3 Filter Operators

Operator Description

: Equal to

> Greater than

>= Greater than or equal to

< Less than

<= Less than or equal to

<> Not equal to 
1
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Table 4 describes filter examples.

Performing Bulk Import Actions
In IoT FND, you can perform these bulk import device actions:

 Adding Devices in Bulk

 Removing Devices in Bulk

 Changing Device Properties in Bulk

 Adding Labels in Bulk

 Removing Labels in Bulk

Adding Devices in Bulk

The Add Devices option in the Bulk Import drop-down menu lets you add FARs and HERs to IoT Field Network Director in bulk using a CSV file. 

To add devices in bulk:

1. On any device page, from the Bulk Import drop-down menu, choose Add Devices.

2. Click Browse to locate the CSV file containing the device information to import, and then click Open.

For more information about adding HERs, see Adding HERs to IoT FND.

For more information about adding FARs, see Adding FARs to IoT FND.

Note: For FARs, you can also use the Notice-of-Shipment XML file provided by your Cisco partner to import FARs. 

3. Click Add.

4. Click Close.

Table 4 Filter Examples

Filter Description

configGroup:"default-cgr1000" Finds all devices that belong to the default-cgr1000 group.

name:00173* Finds all FARs with a name starting with 00173.

deviceType:cgr1000 status:up 
label:"Nevada"

Finds all CGR 1000s in the Nevada group that are up and running.
1
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Adding HERs to IoT FND

Configuring HERs Before Adding them to IoT FND

Before you can add an HER to IoT FND, configure the HER to allow management by IoT FND using Netconf over SSH as follows:

hostname <her_hostname>
ip domain-name <domain.com>
aaa new-model 
no ip domain-lookup
ip ssh time-out 120
ip ssh version 2
crypto key gen rsa 
netconf ssh
netconf max-sessions 16

Where <her_hostname> is the hostname or IP address of the IoT FND server, and <domain.com> is the name of the domain name where the HER 
and IoT FND reside. The time-out value of 120 is required for large networks. 

After configuring the HER to allow management by IoT FND, ensure that you can:

 Ping the management interface of the HER.

 Access the management interface of the HER over SSH and vice versa.

Adding HERs

To add HERs, create a CSV file like the following example that consists of a header line followed by one or more lines, each representing an HER:

eid,deviceType,lat,lng,ip,netconfUsername,netconfPassword
ASR1001+JAE1546007O,asr1000,40.0,-132.0,172.27.166.57,admin,cisco
ASR1001+JAE15460071,asr1000,40.0,-132.0,172.27.166.58,admin,cisco

Table 5 describes the fields to include in the CSV file.

Note: For device configuration field descriptions, see Device Properties.

When you add an HER, IoT FND displays its status as Unheard. IoT FND changes the status to Up after it polls the HER. IoT FND polls HERs in 
the background every 15 minutes to collect device metrics, so it should take no more than 15 minutes for the status of HERs to change to Up after 
you add them to IoT FND. However, you can trigger the polling of HERs by clicking Refresh Metrics (Refresh Metrics).

Adding FARs to IoT FND

Typically, when adding FARs to IoT FND, you use the Notice-of-Shipment XML file sent to you by your Cisco partner. This file contains an R 
record for every FAR shipped to you. This is an example of an R record for a CGR:

Table 5 HER Import Fields

Field Description

eid The element identifier (EID) of the device, which consists of the product ID (PID), a plus sign, and the serial 
number (SN) of the HER (for example, HER_PID+HER_SN). 

deviceType The device type must be asr1000 or isr3900.

lat (Optional) The location (latitude and longitude) of the HER.

lng

ip The IP address of the HER. The address must be reachable from the IoT FND server.

netconfAddress

netconfUsername The SSH username and password that IoT FND uses to connect to the HER.

netconfPassword
1
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<AMI>
<Re1ays>

<DCG deviceC1ass=?10.84.82.56?>
<PID>CGR1240/K9</PID>
<R>

<ESN>2.16.840.1.114416.3.2286.333498</ESN>
<SN>FIXT:SG-SALTA-10</SN>
<wifiSsid>wifi ssid 1</wifiSsid>
<wifiPsk>wifi psk 1</wifiPsk>
<adminPassword>ppswd 1</adminPassword>
<type6PasswordMasterKey>secret 1</type6PasswordMasterKey>
<tunne1SrcInterface1>Ethernet2/3</tunnelSrcInterface1>

</R>
</DCG>

</Re1ays>
</AMI>

Note: For a list of all Device Properties that you can configure using the XML configuration template go to Device Properties, page 237.

Table 6 describes the FAR properties defined in the R record used in this example:

Mapping FARs to HERs

After you determine the FAR-to-HER mapping, which is essential for tunnel provisioning, you can configure the mapping in IoT FND in one of 
two ways:

 Adding the mapping information to every FAR record in the Notice-of-Shipment XML file.

 Creating a CSV file specifying the mapping of FARs to HERs.

Adding FAR-to-HER Mappings to the Notice-of-Shipment XML File

To map a FAR to an HER, add the tunnelHerEid and ipsecTunnelDestAddr1 HER properties to the FAR record in the Notice-of-Shipment XML file.

 The tunnelHerEid property specifies the EID of the HER 

 The ipsecTunnelDestAddr1 property specifies the tunnel IP address of the HER.

For example:

...
<tunnelHerEid>ASR1001+JAE15460070</tunnelHerEid>

Table 6 FAR Import Fields

Field Description

PID The product ID, as supplied by Cisco. This is not printed on the product. 

SN The FAR serial number. 

Note: IoT FND forms the FAR EID by combining the PID and SN.

ESN A serial number assigned by your Cisco partner to the WPAN mesh card inside the FAR. This field is 
not used by IoT FND.

wifiSsid This information is configured on the FAR by your Cisco partner during the manufacturing 
configuration process. IoT FND stores this information in its database for future use.

Note: For CG-OS CGRs, a maximum of two SSIDs is allowed.

wifiPsk

adminPassword

adminUsername

type6PasswordMasterKey

tunnelSrcInterface1
1
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<ipsecTunnelDestAddr1>172.27.166.187</ipsecTunnelDestAddr1>
</R>

</DCG>

Adding FAR-to-HER Mappings to a CSV File

To map FARs to HERs using a CSV file, add a line for every FAR-to-HER mapping. The line must specify the EID of the FAR, the EID of the 
corresponding HER, and the tunnel IP address of the HER, as in this example for a CGR:

eid,tunnelHerEid,ipsecTunnelDestAddr1
CGR1240/K9+FIXT:SG-SALTA-10,ASR1001+JAE1546007O,172.27.166.187

Removing Devices in Bulk

You can remove devices in bulk using a CSV file listing the EIDs of the devices to remove.

Caution: When you remove FARs, IoT FND returns all the leased IP addresses associated with these devices to CNR and removes the 
corresponding tunnels from the HERs.

To remove devices in bulk:

1. Choose Devices > Device Type.

2. Choose Bulk Import > Remove Devices.

3. Click Browse to locate the CSV file containing the devices to delete, and then click Choose. 

This is an example of the CSV format expected. In this case, the CSV file specifies three CGRs and one HER:

eid
cgr1000-CA-107
cgr1000-CA-108
cgr1000-CA-109
asr1000-CA-118

4. Click Remove.

The Status section of the Remove Devices window displays the status of the operation. The History section describes additional information 
about the operation. If there was any failure, click the corresponding link in the Failure# column to get more information about the error. 

5. Click Close when done.

Changing Device Properties in Bulk

IoT FND lets you configure device properties in bulk using a CSV file. For example, this CSV file changes the latitude and longitude for the 
specified HER:

eid,lat,lng,ip,
ASR1001+JAE1546007O,42.0,-120.0
1
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To configure device properties in bulk:

1. On any device page, choose Bulk Import > Change Device Properties.

2. Click Browse to locate the CSV containing the list of devices and corresponding properties to configure, and then click Open.

3. Click Change.

4. Click Close when done.

Adding Labels in Bulk

You can group devices logically by assigning them labels. Labels are independent of device type, and devices of any type can belong to any label. 
A device can also have multiple labels. Unlike configuration groups and firmware groups, there are no policies or metadata associated with labels. 

IoT FND lets you add labels in bulk using a CSV file. In the CSV file, specify the list of devices to be labeled. 

To add device labels:

1. On any device page, choose Bulk Import > Add Label.

2. Click Browse to locate the CSV file that contains the list of devices to label, and then click Open.

This is an example of the expected CSV format:

eid
cgr1000-CA-107
cgr1000-CA-108
cgr1000-CA-109
asr1000-CA-118

3. In the Label field, enter the label or choose one from the drop-down menu.

4. Click Add Label.

The label appears in the Browse Devices tab (left pane) under LABELS.
1



Managing Devices

  
5. Click Close when done.

Removing Labels in Bulk

IoT FND lets you delete labels in bulk using a CSV file. 

To delete device labels:

1. On any device page, choose Bulk Import > Remove Label.

2. Click Browse to locate the CSV containing the list of devices to remove the label from, and then click Open.

3. From the drop-down menu, choose the label to remove.

4. Click Remove Label.

5. Click Close.

Configuring Rules
A IoT FND rule defines a filter and actions that IoT FND performs after an event or after it receives metrics that match the search criteria defined 
in the filter. Rules can check for event conditions and metric thresholds.

For example, whenever the status of a FAR in a configuration group changes to Up, you can add a custom message to the server log (server.log) and 
add the appropriate labels to the device. This helps you automate the process of adding labels to devices. 

When working with rules, you can do the following:

 Add rules with conditions and actions.

 Define a rule with a condition using a device search query, which matches devices according to properties and metrics.

 Define a rule with an action that adds labels to matching devices or to the devices that sent a matching event.

 Define a rule with an action that removes a label from a matching device or the device that sent a matching event.

 Define a rule with an action that places a user alert event into the log, which includes a user-defined message.

Viewing and Editing Rules
To view rules:

1. Choose Config > Rules.
1
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IoT FND displays the list of rules stored in its database. Table 7 describes the fields displayed in the list.

2. To edit a rule, click its name.

For information on how to edit rules, see Adding a Rule.

Adding a Rule
To add a rule:

1. Choose Config > Rules.

2. Click Add.

3. Enter a name for the rule.

Note: If you enter invalid characters (for example, “=”, “+”, and “~”), IoT FND displays a red alert icon, highlights the field in red, and disables 
the OK button.

4. To activate the rule, check the Active? check box.

Table 7 Rule Fields

Field Description

Name The name of the rule. 

Active? Whether the rule is active. Rules are not applied until you activate them.

Rule definition The syntax of the rule.

For example, IoT FND executes this rule when a device battery 0 level drops below 50%:

battery0Level<50

Rule Actions The actions performed by the rule. For example:

Log Event With: CA-Registered , Add Label: CA-Registered

In this example, the actions:

 Set the eventMessage property of the Rule Event generated by this rule to CA-Registered.

 Add the label CA-Registered to the matching device.

Updated By The username of user who last updated the rule.

Updated At The date and time when the rule was last updated.
1



Managing Devices

  
5. Enter the syntax of the rule.

Use the same syntax used for creating filters. See Search Syntax.

6. Check the check box of at least one action:

 Log event with—Specify the message to add to the log entry of the event in the server log, the severity, and event name. 

— Severity—Select the severity level to assign to the event.

— Event Name—Enter the event name to assign to the event (see Searching By Event Name, page 327).

For example, if you enter Red Alert in this field, set the Severity to CRITICAL and enter CHECK ROUTER in the Event Name 
field, the eventMessage field in the logged entry for the event that matches the rule is set to Red Alert, as shown in this sample 
entry from the server log (server.log):

16494287: NMS-200-5: May 02 2012 22:32:41.964 +0000: %CGMS-7-UNSPECIFIED: 
%[ch=EventProducer][sev=DEBUG][tid=com.espertech.esper.Outbound-CgmsEventProvider-1]: Event 
Object which is send = EventObject [netElementId=50071, eventTime=1335997961962, 
eventSeverity=0, eventSource=cgr1000, eventType=UserEventType, eventMessage=Red Alert, 
eventName=CHECK ROUTER, lat=36.319324, lng=-129.920815, geoHash=9n7weedx3sdydv1b6ycjw, 
eventTypeId=1045, eid=CGR1240/K9+JAF1603BBFF]
1
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7. Click Save.

Activating Rules
IoT FND does not apply rules if they are not activated.

To activate a rule:

1. Choose Config > Rules.

2. Check the check boxes of the rules to activate.

3. Click Activate.

4. Click Yes to activate the rule.

5. Click OK.

Deactivating Rules
If you deactivate a rule, IoT FND does not apply it.

To deactivate rules:

1. Choose Config > Rules.

2. Check the check boxes of the rules to deactivate.

3. Click Yes to deactivate the rule.

4. Click OK.

Deleting Rules
To delete rules:

1. Choose Config > Rules.

2. Check the check boxes of the rules to delete.

3. Click Delete.

4. Click Yes to delete the rule.

5. Click OK.

In IoT FND, the message you define in the Log event with field appears in the Message field of the matching event entries 
listed on the Events page (Operations > Events), and the new Event Name is a new search filter.

 Add Label—Enter the name of a new label or choose one from the Add Label drop-down menu.

 Show label status on Field Devices page–Shows the status of the device that triggered this rule in the LABELS section of the 
Browse Devices pane.

 Remove Label—Choose the label to remove from the Remove Label drop-down menu.
1
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Configuring Devices
This section describes how to configure devices in IoT FND, including:

 Configuring Device Group Settings

 Editing the ROUTER Configuration Template

 Editing the ENDPOINT Configuration Template

 Pushing Configurations to FARs

 Pushing Configurations to Endpoints

Configuring Device Group Settings
IoT FND uses groups to manage devices in bulk. When you add FARs to IoT Field Network Director, IoT FND automatically adds them to the 
appropriate default ROUTER configuration groups, for example, default-cgr1000. When you add MEs (meters and range extenders), IoT FND adds 
them to the default ENDPOINT configuration group, default-cgmesh. 

 Creating Device Groups

 Changing Device Configuration Properties

 Moving Devices to Another Group

 Listing Devices in a Configuration Group

 Configuring Periodic Inventory Notification and Mark-Down Time

 Renaming a Device Configuration Group

 Deleting Device Groups
2
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Creating Device Groups

By default, IoT FND defines the following device groups listed on the Devices > Field Devices page left tree as follows:

Each default group defines a default configuration template that you can push to all devices in that group. However, if you need to apply a different 
template to a group of devices, create a new group and modify its default configuration template as needed.

Note: You cannot delete the default groups, but you can change their names, although we do not recommend it. Also, the default ROUTER and 
ENDPOINT groups use the same icon, while custom groups use a different icon. See Table 5 for icon definitions.

 Creating ROUTER Groups

 Creating ENDPOINT Groups

Creating ROUTER Groups

Note: CGRs, IR800s, and ISR800s can coexist on a network; however, you must create custom templates that includes all router types.

To create a ROUTER configuration group:

1. Choose Config > Device Configuration.

2. Select the default group: default-cgr1000 default-ir800. or default-c800

3. Click the Add Group button.

Group Name Description

default-act By default, all Itron OpenWay RIVA Electric devices (METER) are members of this group. 

 Individual RIVA electric devices listed under the Group heading display as
OW Riva CENTRON.

default-bact By default, all Itron OpenWay RIVA G-W (Gas-Water) devices (METER) are members of 
this group.

 Individual RIVA water meters listed under the Group heading display as
OW Riva G-W.

 Individual RIVA gas meters listed under the Group heading display as
OW Riva G-W.

default-cam By default, all Itron OpenWay RIVA CAM modules (ROOT) are members of this group.

 Individual RIVA CAM modules listed under the CAM heading display as OW Riva 
CAM.

default-c800 By default, all C800s and ISRs (ROUTER) are members of this group.

default-cgmesh By default, all cgmesh endpoints (METER) are members of this group.

default-cgr1000 By default, all CGRs (ROUTER) are members of this group.

default-ir800 By default, all IR800s (ROUTER) are members of this group.
2
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4. Enter the name of the group.

The device category is selected by default. 

Note: If you enter invalid characters (for example, “=”, “+”, and “~”), IoT FND displays a red alert icon, highlights the field in red, and disables 
the OK button.

5. Click Add.

The new group entry appears in the ROUTERS list (left pane).

 To change the name of a group, see Renaming a Device Configuration Group.

 To remove a group, see Deleting Device Groups.

Creating ENDPOINT Groups

To create an ENDPOINT configuration group:

1. Choose Config > Device Configuration.

2. Select the default group (default-cgmesh, default-act, default-cam)

3. Click the Add Group ( ) button.

4. Enter a name for the group.

Note: If you enter invalid characters (for example, “=”, “+”, and “~”), IoT FND displays a red alert icon, highlights the field in red, and disables 
the OK button.

5. Click Add.
2
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The new group entry appears in the ENDPOINT list (left pane).

 To change the name of a group, see Renaming a Device Configuration Group.

 To remove a group, see Deleting Device Groups.

Changing Device Configuration Properties

You can change the configurable properties of devices by uploading a Device Properties CSV file with modified values for the devices. 

To change device configuration properties:

1. Choose Config > Device Configuration.

2. Click Change Device Properties.

3. Click Browse and select the Device Properties CSV file to upload.

4. Click Change.

5. Click Close when done.

 For a list of configurable device properties in IoT FND, see Device Properties.

Moving Devices to Another Group

There are two ways to move devices from one configuration group to another:

 Moving Devices to Another Configuration Group Manually

 Moving Devices to Another Configuration Group in Bulk

Moving Devices to Another Configuration Group Manually

To move devices to another configuration group:

1. Choose Config > Device Configuration.

2. Select a group from the list of configuration groups (left pane).

3. Check the check boxes of the devices to move. 

4. Click Change Configuration Group.
2
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5. From the drop-down menu in the dialog box, choose the target group for the devices.

6. Click Change Config Group.

7. Close OK.

Moving Devices to Another Configuration Group in Bulk

To move a large number of devices from one group to another, you can import a CSV file containing the list of the devices to move. 

For example, this CSV file specifies the EIDs of three CGRs to move:

eid
CGR1120/k9+JS1
CGR1120/k9+JS2
CGR1120/k9+JS3

To move devices to another configuration group in bulk:

1. Choose Config > Device Configuration.

2. Click Assign Devices to Group.

3. Click Browse to locate the CSV file containing the list of devices to move, and then click Open.

4. From the Group drop-down menu, choose the target group for the devices.

5. Click Change Group.

6. Click OK.

Listing Devices in a Configuration Group

To list the devices in a configuration group:

1. Choose Config > Device Configuration.

2. Select a group from the list of configuration groups (left pane).
2
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3. To get more information about a device in the list, click its EID.

Configuring Periodic Inventory Notification and Mark-Down Time

You can change the periodic inventory notification interval for a configuration group of FARs without affecting the logic that IoT FND uses to mark 
those FARs as Down. However, for this to happen, you must enable the periodic configuration notification frequency for the FAR group so that it 
is less than the mark-down timer. 

You can configure the mark-down timer by clicking the Group Properties tab for the group and modifying the value of the Mark Routers Down 
After field. 

 Configuring Periodic Inventory Notification

 Configuring the Mark-Down Timer

Configuring Periodic Inventory Notification 

To configure the periodic inventory notification interval for a ROUTER configuration group:

1. Click Config > Device Configuration.

2. Select a ROUTER configuration group.

3. Click Edit Configuration Template.
2
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4. This step is OS-specific:

5. Click Save Changes.

Configuring the Mark-Down Timer

To configure the mark-down timer for a ROUTER configuration group:

1. Click Config > Device Configuration.

2. Select a ROUTER configuration group.

3. Click Group Properties.

 For Cisco IOS CGRs, change the value of the cgna heart-beat interval parameter. The time is in minutes

For example, to enable periodic inventory notification to report metrics every 20 minutes for an IOS CGR, add these lines to the 
template:

<#-- Enable periodic configuration (heartbeat) notification every 20 min. -->
cgna heart-beat interval 20
exit

 For CG-OS CGRs, change the value of the periodic-inventory notification frequency parameter to the new value. The time unit 
is minutes. 

CG-IOS CGRs

CG-OS CGRs

34
72

19
2
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4. In the Mark Routers Down After field, enter the number of seconds after which IoT FND marks the FARs as down if they do not send periodic 
configuration notifications (heartbeats) to IoT FND during that time.

Note: We recommend a 1:3 ratio of heartbeat interval to mark-down timer.

5. Click Save Changes.

6. Ensure that the periodic-configuration notification frequency in the configuration template is less than the value you entered the Mark Routers 
Down After field:

a. Click Edit Configuration Template.

b. Ensure that the value of the periodic-configuration notification frequency parameter is less than the Mark Routers Down After value. 

Use a notification value that is at most one-third of the mark-down value. For example, if you choose a mark-down value of 3600 seconds (60 
minutes), set the periodic-configuration notification frequency parameter to 20 minutes:

<#-- Enable periodic configuration (heartbeat) notification every 20 minutes. -->
<#if far.supportsHeartbeat()>
callhome
periodic-configuration notification frequency 20

exit
</#if>

Note: The ability to control the periodic inventory notification interval and the periodic-configuration notification frequency applies to CGR 
image version 3.2.

Renaming a Device Configuration Group

To rename a device configuration group:

1. Choose Config > Device Configuration.

2. Select a group from the list of configuration groups (left pane).

3. Click the Edit Group icon.

The Edit Group button displays as a pencil icon when you hover over the name of the group in the list. 
2
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4. Enter the new name in the Rename Group dialog box, and then click OK.

Note: If you enter invalid characters (for example, “=”, “+”, and “~”), IoT FND displays a red alert icon, highlights the field in red, and disables 
the OK button.

Deleting Device Groups

Note: Before deleting a group, move all devices in that group to another group. You cannot delete a non-empty group.

To delete a configuration group:

1. Choose Config > Device Configuration.

2. Select a group from the list of configuration groups (left pane).

3. Ensure that the group is empty.

4. Click Delete Group ( ).

The Delete icon displays as a red minus sign when you hover over the name of the group in the list.

5. Click Yes to confirm, and then click OK.

Synchronizing Endpoint Membership
MEs maintain information about the IoT FND group to which they belong. If the group information changes, the ME becomes out of sync. For 
example, if you rename an ME group, the members of the group might not be modified immediately (for example, due to a packet loss). If a device 
is out of sync, any operation you perform on the group through IoT FND does not reach the device. To ensure that the MEs remain in sync, use the 
Sync Membership button to push the group information to group members.

To send group information to MEs:

1. Choose Config > Device Configuration.

2. Select an ENDPOINT group (left pane).

3. Check the check boxes of the members in the group to sync.
2
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4. Click Sync Membership.

5. When prompted to synchronize membership for the group, click Yes.

6. Click OK.

Devices sync for the first time after they register with IoT FND.

Editing the ROUTER Configuration Template
IoT FND lets you configure FARs in bulk using a configuration template. When a FAR registers with IoT FND, IoT Field Network Director pushes 
the configuration defined in the default template to the device and commits the changes to the router startup configuration. IoT FND then retrieves 
the running configuration from the router before changing the device status to Up.

To edit a ROUTER group configuration template:

1. Choose Config > Device Configuration.

2. Under CONFIGURATION GROUPS (left pane), select the group with the template to edit.

3. Click Edit Configuration Template.
2
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4. Edit the template.

The template is expressed in FreeMarker syntax. For more information about FreeMarker, see Tunnel Provisioning Template Syntax.

Note: The router configuration template does not validate the configuration data entered. Verify the configuration before saving.

5. Click Save Changes.

IoT FND commits the changes to the database and increases the template version number.

Editing the AP Configuration Template

IoT FND lets you configure APs in bulk using a configuration template. When the AP registers with IoT FND, it pushes the configuration defined 
in the default template to devices and commits the changes to the startup configuration. IoT FND then retrieves the running configuration from the 
AP before changing the device status to Up.

To edit a AP group configuration template:

1. Choose Config > Device Configuration.

2. Under CONFIGURATION GROUPS (left pane), select the C800 device group with embedded AP devices with the template to edit.

3. Click Edit AP Configuration Template.
2
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4. Edit the template.

The template is expressed in FreeMarker syntax. For more information about FreeMarker, see Tunnel Provisioning Template Syntax.

AP TEMPLATE EXAMPLE

ip dhcp pool TEST_POOL
 network 10.10.10.0 255.255.255.0
 default-router 10.10.10.1 
 lease infinite
!
dot11 ssid GUEST_SSID
authentication open
authentication key-management wpa
wpa-psk ascii 0 12345678
guest-mode
!
interface Dot11Radio0
no ip address
encryption mode ciphers aes-ccm
ssid GUEST_SSID
!
interface Dot11Radio0
no ip address
encryption mode ciphers aes-ccm
ssid GUEST_SSID

Note: The AP configuration template does not validate the configuration data entered. Verify the configuration before saving.

5. Click Save Changes.

IoT FND commits the changes to the database and increases the template revision number.

Enabling Dual PHY Support

You can configure CGR master and slave interfaces. For more information about configuring a dual-PHY WPAN interface, refer to Cisco Connected 
Grid WPAN Module for CGR 1000 Series Installation and CG-Mesh Configuration Guide (Cisco IOS).

Enabling Router GPS Tracking

You can enable GPS traps to trigger an event if the router moves a distance threshold, after a time threshold, or both. For example, you can configure 
stationary, pole-top CGR monitoring for a distance threshold, to detect movement from theft or pole incident; for mobile routers, set both thresholds 
to determine distance over time. The recommended distance threshold is 100 feet (30 m). 

To enable GPS traps, uncomment these lines in the default configuration template.

<#-- 
Enable the following configurations to generate events that track if the router 
moves by a certain distance (unit configurable) or within a certain time (in minutes) 
-->
<#-- cgna geo-fence interval 10 -->
<#-- cgna geo-fence distance-threshold 100 -->
2
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<#-- cgna geo-fence threshold-unit foot -->
<#-- cgna geo-fence active -->

Tip: Because GPS traps only generate Informational logs, we recommend that you create a rule-based event with high severity (such as CRITICAL) 
to inform the administrator of router movement. An example of this type of rule definition is: configGroup:name eventName:deviceLocChanged 
(see Adding a Rule).

Configuring SNMP v3 Informational Events

For Cisco IOS routers you configure SNMP v3 Informational Events to replace the default SNMP v3 traps. In CG-OS by default, SNMP v3 traps 
are configured for any IoT FND event-related changes that generate a trap on the router. IoT FND maps these traps to the corresponding event. For 
Cisco IOS routers, converting these SNMP v3 traps to SNMP v3 Informational Events sends an acknowledgment to the router for every event 
received from the router. The router then verifies that the trap was received by IoT FND. To enable SNMP v3 Informational Events, uncomment 
the following lines in the default configuration file and push the new configuration file to all router(s) in the group:

<#-- Enable the following configurations for the nms host to receive informs instead of traps -->
<#-- no snmp-server host ${nms.host} traps version 3 priv ${far.adminUsername} -->
<#-- snmp-server engineID remote ${nms.host} ${nms.localEngineID} -->
<#-- snmp-server user ${far.adminUsername} cgnms remote ${nms.host} v3 auth sha ${far.adminPassword} priv aes 
256 ${far.adminPassword} -->
<#-- snmp-server host ${nms.host} informs version 3 priv ${far.adminUsername} -->

Editing the ENDPOINT Configuration Template
To edit an ENDPOINT configuration template:

1. Choose Config > Device Configuration.

2. Under CONFIGURATION GROUPS (left pane), select the ENDPOINT group with the template to edit.

3. Click Edit Configuration Template.
2
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4. Edit the template.
2
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For example, in the Report Interval field, you can enter the number of seconds between data updates. By default, MEs send a new set of 
metrics every 28,800 seconds (8 hours).

You can change the following values on the Edit Configuration Template tab:

5. Click Save Changes.

IoT FND commits the changes to the database and increases the version number.

Pushing Configurations to FARs 
Note: CGRs, C800s, IR800s, and ISR 800s can coexist on a network; however, you must create custom configuration templates that includes both 
router types.

To push the configuration to FARs:

1. Choose Config > Device Configuration.

2. Select the group or subset of a group to push the configuration to in the CONFIGURATION GROUPS pane.

3. Click the Push Configuration tab.

 Report Interval: The number of seconds between data updates.

 BBU Settings: Enable this option to configure BBU Settings for range extenders with a battery backup unit.

 Enable Ethernet: Check this check box to enable Ethernet for selected devices or configure NAT 44 settings on selected DA 
Gateway devices. 

Note: For NAT 44 configuration, you must specify values for all three fields in a CSV file. The default values are 127.0.0.1, 0, 
0, respectively. You do not need to configure any other settings for a particular map index. If these settings are invalid for that 
map index, they are ignored during a configuration push.

 MAP-T Settings: The iPv6 and iPv4 settings for the device.

Note: For Cisco IOS CGRs, MAP-T rules are set by indicating the MAP-T IPv6 basic mapping rule (BMR), IPv4 BMR, and 
IPv6 default mapping rule (DMR). On Cisco IR509 devices, the MAP-T IPv6 is an IPv6 prefix that integrates the MAP-T BMR 
IPv6 rules, IPv4 suffix value, and length being based on the BMR EA length value.

 Serial Interface 0 (DCE) Settings: The data communications equipment (DCE) communication settings for the selected 
device.

Note: There can be only one session per serial interface. You must configure the following parameters for all TCP raw socket 
sessions (for each virtual line and serial port) for the selected DA Gateway device(s):

 Initiator – Designate the device as the client/server.

 TCP idle timeout (min) – Set the time to maintain an idle connection 

 Local port – Set the port number of the device.

 Peer port – Set the port number of the client/server connected to the device. 

 Peer IP address – Set the IP address to the host connected to the device. 

 Connect timeout – Set the TCP client connect timeout for Initiator DA Gateway devices.

 Packet length – Sets the maximum length of serial data to convert into the TCP packet. 

 Packet timer (ms) – Sets the time interval between each TCP packet creation. 

 Special Character – Sets the delimiter for TCP packet creation.

 Serial Interface 1 (DTE) Settings: The data terminal equipment (DTE) communication settings for the selected device.

Note: The IPv6 prefix must valid. Maximum prefix lengths are:

— IPv6: 0–128

— IPv4: 0–32
2
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4. In the Select Operation drop-down menu, choose Push Router Configuration.

For C800 and IR800 groups with embedded AP devices, choose Push AP Configuration to push the AP configuration template.

5. Click Start.

The Push Configuration page displays the status of the push operation for every device in the group. If an error occurs while pushing 
configuration to a device, the error and its details display in the relevant columns.

In the Status column, one of these values appear:

Tip: To refresh the status information, click the Refresh button.

Enabling CGR SD Card Password Protection

Password protection for the SD card in the CGR helps prevent unauthorized access and prevents transference of the CGR SD card to another system 
with a different password. 

Note: This does not apply to C800s or IR800s.

The Device Info pane displays CGR SD card password protection status in the Inventory section. The Config Properties tab displays the SD card 
password in the Router Credentials section.

To enable CGR SD card password protection:

1. Choose Config > Device Configuration.

2. Select the CGR group or CGRs to push the configuration to in the CONFIGURATION GROUPS pane.

3. Select the Push Configuration tab.

 NOT_STARTED—The configuration push has not started.

 RUNNING—The configuration push is in progress.

 PAUSED—The configuration push is paused. Active configuration operations complete, but those in the queue are not initiated.

 STOPPED—The configuration push was stopped. Active configuration operations complete, but those in the queue are not 
initiated.

 FINISHED—The configuration push to all devices is complete.

 STOPPING—The configuration push is in the process of being stopped. Active configuration operations complete, but those in 
the queue are not initiated.

 PAUSING—The configuration push is in the process of being paused. Active configuration operations complete, but those in 
the queue are not initiated.
2
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4. In the Select Operation drop-down menu, choose Push SD Card Password.

5. Click Start.

6. Select SD Card protection > Enable.

7. Select the desired protection method:

8. Click Push SD Card Password.

Pushing Configurations to Endpoints
To push configuration to mesh endpoints:

1. Choose Config > Device Configuration.

2. Select the group or subset of a group to push the configuration to in the ENDPOINT list.

 Property: This password is set using a CSV or XML file, or using the Notification Of Shipment file.

 Randomly Generated Password: Enter the password length.

 Static Password: Enter a password.
2
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3. Click the Push Configuration tab.

Note: The Push Configuration tab supports a subnet view for cgmesh Endpoints that summarizes:

4. In the Select Operation drop-down menu, choose Push Endpoint Configuration.

5. Click Start.

The Push Configuration page displays the status of the push operation for every device in the group. If an error occurs while pushing 
configuration to a device, the error and its details display in the relevant columns.

In the Status column, one of these values appear:

Pan ID Identifies the Personal Area Network Identifier for a group of endpoints 
(nodes).

Subnet Prefix Identifies the IPv6 subnet prefix for the endpoint.

Nodes in Group Number of nodes within the group. In the example above, there are a total of 
51 nodes within the group, which are split across three different subnets.

Total in Subnet Number of nodes with the subnet. In the example above, there are 19 nodes 
in the subnet.

Config Synced Shows how many nodes within a Pan ID are in the process or have finished a 
configuration push out of the total nodes in that Pan.

 NOT_STARTED—The configuration push has not started.

 RUNNING—The configuration push is in progress.

 PAUSED—The configuration push is paused. Active configuration operations complete, but those in the queue are not started.

 STOPPED—The configuration push was stopped. Active configuration operations complete, but those in the queue are not 
started.
2
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To refresh the status information, click the Refresh button.

Managing a Guest OS
Cisco IOS CGRs support a virtual machine to run applications on a Guest OS (GOS) instance running beside the Cisco IOS virtual machine. The 
GOS is Linux. Applications running on the GOS typically collect statistics from the field for monitoring and accounting purposes. The Cisco IOS 
firmware bundle installs a reference GOS on the VM instance on the CGR. IoT FND supports the following role-based features on the GOS:

 Monitoring GOS status

 Managing GOS applications

 Upgrading the reference GOS in the Cisco IOS firmware bundle

Note: IoT FND only supports the reference GOS provided by Cisco.

You manage and monitor a GOS on the Config > Device Configuration page, on the Guest OS tab.

 FINISHED—The configuration push to all devices is complete.

 STOPPING—The configuration push is in the process of being stopped. Active configuration operations complete, but those in 
the queue are not started.

 PAUSING—The configuration push is in the process of being paused. Active configuration operations complete, but those in 
the queue are not started.
2
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Figure 6 Config > Device Configuration Page – Guest OS Tab Restart GOS Button

This section includes the following topics:

 Installing a GOS

 Managing GOS Applications

 Restarting a Guest OS

Installing a GOS
Depending on CGR factory configuration, a GOS may be present in the VM instance. The GOS installs with the Cisco IOS firmware bundle (see 
“FAR Firmware Updates” section on page -259). The GOS, Hypervisor, and Cisco IOS all upgrade when you perform a Cisco IOS image bundle 
installation or update. 

After any Cisco IOS install or upgrade, when IoT FND discovers a GOS, it checks if the initial communications setup is complete before it performs 
the required setup. The CGR must have a DHCP pool and Gigabit Ethernet 0/1 interface configured to provide an IP address and act as the gateway 
for the Guest OS. See the Cisco 1000 Series Connected Grid Routers Configuration Guides web portal for information on configuring the CGR.

Note: If IoT FND detects a non-Cisco OS is installed on the VM, the firmware bundle will not upload and the Cisco reference GOS will not install.
2
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Managing GOS Applications
Applications (apps) run on the VM instance, but are not included in the Cisco IOS firmware bundle. You distribute GOS apps as standard 
app-<appname>-ver-<version>.zip files, and use the Config > App Management page to upload, install, start and stop, and uninstall GOS apps. 
The IoT FND internal backup and restore mechanism preserves existing apps during upgrades.

Note: For IoT FND GOS communications such as application uploads to the GOS using ssh, the gosPassword must be the CGR properties file. You 
upload the properties file in a CSV/XML upload. Without the gosPassword property, IoT FND cannot upload apps to a GOS.

Users with the GOS Application Management role enabled can upload, install, and deploy apps on Cisco IOS CGRs within your network.

Figure 7 Config > Apps Management Page–Last Job Status

Managing GOS App Activities

You can manage app activities (jobs) on the Config > App Management Activity Status tab. The top pane (above the device list) displays job-related 
info for the last activity performed, which includes:

 The start and stop time of the last activity.

 The app name.

 The status of the activity.

 The number of devices with successful results and the number of devices with errored results.
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Table 8 lists fields that display in the device list on the Activity Status tab.

On the Activity Status tab, you can also:

 Click the Cancel Current Activity button to cancel any activity. Any activity in progress can be canceled.

 Click the Refresh Status button to update activity status. 

Uploading GOS Apps

After GOS apps are imported to IoT FND, you can upload them for deployment on the GOS on Cisco IOS CGRs and IR800s, using the Config > 
Apps Management page Upload tab (Figure 8). Apps are OS specific. If the GOS is Linux, any apps you upload must run on Linux. 

Figure 8 Upload Tab

To upload apps to IoT FND to deploy on Cisco IOS CGRs and IR800s, on the Config > Apps Management page:

1. Select a firmware or configuration group in the left pane.

2. Click the Upload tab.

3. Click Select an App or click the Import Apps button in the left pane.

The Import Apps dialog box displays apps already uploaded to the NMS server. 

Table 8 Activity Status Tab

Field Description

Device Name Name of the selected device.

GOS Host Name Name of the GOS host.

App Name Name of the app.

App Version Version assigned to the app.

Start Time The start for the selected activity.

Last Status Time The last status update time.

Activity The selected activity: Upload, Set to Run, Install, Start, Stop, Uninstall, and Delete Remote Package.

Activity Status The status of the selected activity.

Progress How much of the activity completed.

Message Notes generated by the activity.

Error Details Details on errors encountered during the activity.
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4. In the Import Apps dialog box, click Add App.

5. In the Add App dialog box, click Browse to navigate to the directory containing your app. 

Note: Apps must be in the standard <appname>-<version>.zip file format.

6. In the Open dialog box, select the app file, and click Open.

7. Click Add File.

Note: Only one app may be uploaded at a time.

The app file uploads to the NMS server and displays in the App Name list.

8. In the Add App dialog box, click the desired app to upload to CGRs, click Add to Upload, and click OK.

The app filename displays in the App Name list.

9. In the App Name list, select the desired app to upload.

The app filename displays on the Upload tab as a link in the Selected App field, which is sensorbot 7.5 in the following example.

10. Click the Upload button to upload the file to IoT FND.

The activity status (UPLOAD_OP_COMPLETE or UPLOAD_OP_WAITING) displays on the Upload tab.
2
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Deploying GOS Apps

The Config > App Management Deployment tab allows you to perform the following activities on selected CGRs and IR800s:

 Set to Run – A combination of install and start operations. 

 Install – Installs the remote package and extracts the app.

 Start and Stop – Starts or stops the app.

 Uninstall – Uninstalls the app.

 Delete Remote Package – Deletes the previous upload package from the repository.

To deploy GOS apps on selected CGRs:

1. On the Config > Apps Management page, select a firmware or configuration group in the left pane.

2. Click the Deployment tab.

3. In the Select an Action drop-down menu, choose the desired action to perform on the selected group.

The action button at the right reflects your selected action (that is, if you select Install as the action, the action button label is “Install.”

4. In the Select an App drop-down menu, choose an app or select all apps.

5. Click the action button.

The activity begins. You can monitor activity progress on the Activity Status tab.

Deleting GOS Apps

To delete an app from the NMS server, on the Config > Apps Management page:

1. Select a firmware or configuration group in the left pane.

2. Click the Upload tab.

3. Click Select an App or click the Import Apps button in the left pane.

The Import Apps dialog box displays apps already uploaded to the NMS server. 

4. In the App Name list, scroll to the right and click the Delete link in the row with the app to delete from the NMS server.
2
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5. Click OK in the confirmation dialog box.

Restarting a Guest OS
To restart a GOS, on the Config > Device Configuration page:

1. In the CONFIGURATION GROUPS pane, select the device with the GOS to restart.

2. Click the Guest OS tab.

3. Click the Restart button (Figure 9).

Figure 9 Config > Device Configuration Page – Guest OS Tab Restart Button

Pushing GOS Configurations
You can push the GOS configuration to the CGR using the IoT FND config template. This is the only way to configure the DHCP pool. 
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Managing Files
Use the Config > Router File Management page to transfer and execute dual backhaul and Embedded Event Manager (EEM) scripts on the FAR. 
The Template module performs file validation. This section includes the following topics:

 File Types and Attributes

 Adding a File to IoT FND

 Transferring Files

 Viewing Files

 Monitoring Files

 Monitoring Actions

 Deleting Files

Note: File management is role-dependent and may not be available to all users. See Managing Roles.

File Types and Attributes
Two types of EEM scripts are used on the FAR: an embedded applet, and Tool Command Language (TCL) scripts that execute on the FAR 
individually. You can upload and run new EEM TCL scripts on the FAR without doing a firmware upgrade. EEM files upload to the eem directory 
in FAR flash memory. These scripts display in the Import File page File Type column as eem script. You must edit the configuration template file 
to activate the EEM TCL scripts (see Editing the ROUTER Configuration Template). This feature works with all FAR OS versions currently 
supported by IoT FND. 

You can also transfer other file types to the FAR for better file management capability. You must first import the files to IoT FND to upload files to 
the FAR. IoT FND processes the file and stores it in the IoT FND database with the following attributes:

 Filename

 Description

 Import Date/Time

 Size

 Sha1 Checksum

 MD5 Checksum

 File Content

Adding a File to IoT FND
To add a file to IoT FND:

1. On the Config > Router File Management page, click Import Files or Upload to open the Select File from List dialog box.
2
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2. Click Add File and browse to the file location.

Note: The maximum import file size is 200 MB.

Note: In the Select File from List dialog box, you can also delete imported files from the IoT FND database if the file is not in an active file 
transfer. This only removes the file from the IoT FND database, not from any FARs that contain the file. Click the Name hyperlink to view 
uploaded text files (file size must be less than 100KB).
2
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3. (Optional) Type a description for the file.

4. Click Add File.

When the upload completes, the file name displays in the Select File From List dialog box.

5. Repeat steps 2 through 4 to add another file, or see Transferring Files to upload the file to the selected device or group, or close the Select File 
From List dialog box. 

Transferring Files 
You can transfer files from the NMS database to any firmware, configuration or tunnel provisioning group, or to individual FARs. The maximum 
import file size is 200 MB.

To perform a file transfer:

1. On the Config > Router File Management page, select the group to transfer the file to in the Browse Devices pane. 

2. Click Import Files or Upload on the Actions tab.
2
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The Select File from List dialog box displays.

3. Select the file to transfer to the FARs in the selected group. 

4. Click File to Upload.

The Upload File to Routers dialog box displays.
2
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5. Check the check boxes of the FARs to which you want to transfer the file.

6. Click Upload.

If there is no file transfer or deletion, configuration push, firmware upload, or install or reprovision operations in progress for the group, the upload 
starts. 

You can choose to transfer files to all FARs in the selected group or select only a subset of the FARs in the group. You can also select another group 
and file to perform a separate file transfer or deletion simultaneously. 

All files transferred from IoT FND reside on the FAR in flash:/managed/files/ for Cisco IOS CGRs, and bootflash:/managed/files/ for CG-OS CGRs.

The status of the last file transfer is saved with the group, as well as the operation (firmware update, configuration push, and so on) and status of the 
group. 

Viewing Files
To view imported text file content:

1. Click the EID link to display the Device Info pane. 

2. Click the Router Files tab.
2
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3. Click the file name link to view the content in a new window. 

Note: IoT FND only displays files saved as plain text that are under 100 KB are viewable. You cannot view larger text files or binary files of 
any size. Those file types do not have a hyperlink.

Monitoring Files
On the Config > Router File Management page, click the Managed Files tab to view a list of FARs and the files uploaded to their .../managed/files/ 
directories. Devices listed in the main pane are members of the selected group.
2
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Figure 10 Managed Files Tab

The following information is included in this list:

 EID link to the Device Info page

 Number of files stored on the device

 Uploaded file names

You can use the Filter By File Name drop-down menu to only view devices that contain a particular file. Select All to include all devices in the 
group. Click the refresh button to update the list during file transfer or deletion processes.

Monitoring Actions
On the Config > Router File Management page, click the Actions tab to view the status of the last file transfer or last file deleted for FARs in the 
selected group. You can click the Cancel button to terminate any active file operation.

Figure 11 Actions Tab

The Actions tab lists the following attributes:

 Start date and time of the last transfer

 End date and time of the last transfer

 File name

 Status of the process: UNKNOWN, AWAITING_DELETE, DELETE_IN_PROGRESS, DELETE_COMPLETE, CANCELLED, 
NOTSTARTED, UPLOAD_IN_PROGRESS, UPLOAD_COMPLETE, STOPPING, STOPPED

 Number of devices with upload complete and total number of target devices

 Number of errors and errored device count

 File path 
2
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 EID link to Device Info page

 Activity performed: UPLOAD, DELETE, NONE

 Progress percentage

 Messages regarding any issues discovered during the process

 Error details

Deleting Files
To delete files from FARs:

1. On the Config > Router File Management page, select the group to transfer the file to in the Browse Devices pane. 

2. On the Actions tab, click Delete.

3. In the Delete file from List dialog, select a file to delete.

You can delete the file from all FARs in the selected group or any subset of FARs in the group. 

4. Click File to Delete.

The Delete File from Routers dialog box displays.
2
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5. Check the check boxes of the FARs from which you want to delete the file.

6. Click Delete.

If there are no file transfer or deletion, configuration push, firmware upload, or install or reprovision operations in progress for the group, the 
delete operation begins. IoT FND searches the .../managed/files/ directory on the devices for the specified file name. 

Note: On deletion, all file content is purged from the selected devices, but not from the IoT FND database. File clean-up status displays for the 
selected group.

You can select another group and file to perform a separate file deletion while file transfer or deletion processes are in progress for this group. 
When you cancel file deletion processes before they complete, the currently running file deletion process completes and all waiting file deletion 
processes are canceled.

Managing Work Orders
 Viewing Work Orders

 Creating User Accounts for Device Manager (IoT-DM) Users

 Creating Work Orders

 Editing Work Orders

 Deleting Work Orders

Note: The Work Orders feature works with Release 3.0 or later of IoT-DM. For integration instructions, see “Accessing Work Authorizations” in 
the Cisco Connected Grid Device Manager Installation and User Guide, Release 3.1, or “Managing Work Orders” in the Cisco Connected Grid 
Device Manager Installation and User Guide (Cisco IOS), Release 4.0 and 4.1 or Cisco IoT Device Manager Installation and User Guide (Cisco 
IOS), Release 5.0.

 You can click Change File to select a different file to delete from the selected FARs.

 You can select multiple FARs.

 Only one file can be deleted at a time.
2
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Note: If you are using CGDM Release 3.1 and later, you must enable SSLv3 for IoT-DM–IoT FND connection authentication:

1. Stop IoT FND:

service cgms stop

2. For IoT-DM Release 3.x and later, in the following files, replace protocol="TLSv1" attribute:

For CGDM 3.x 

For CGDM 4.x and IoT-DM 5.x

3. Start IoT FND:

service cgms start

Viewing Work Orders
To view work orders in IoT FND, choose Operations > Work Orders. 

Table 9 lists fields that display on the Work Orders page.

 /opt/cgms/standalone/configuration/standalone.xml

 /opt/cgms/standalone/configuration/standalone-cluster.xml

 Replace the attribute with: protocol="TLSv1,SSLv3" 

 Replace the attribute with: protocol="TLSv1.x,SSLv3" 

Table 9 Work Orders Page Fields

Field Description

Work Order Number Unique identifier of the work order.

Work Order Name Name of the work order.

Role (CG-OS only) Role of the user assigned to the work order: tech, admin, or viewer.

FAR Name EID of the FAR associated with the work order.

Technician User Name User name of the assigned technician.

Time Zone The time zone where the FAR is located–not the user’s time zone. This value is deployment dependent, and 
can match the user’s time zone.

Start Date Project start and end date allotted to the field technician.

End Date

Last Update Time of last work order status update.

Status Work order status. Valid status values are: New, Assigned, InService, Completed, Incomplete, or Expired.
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Searching Work Orders
To refine your search, use the following syntax in the Search Work Order field (Operations > Work Orders):

For example, to search for completed work orders that have a user with an admin role assigned to them, use this syntax:

role:admin workOrderStatus:Completed

To search work orders in IoT FND:

1. Choose Operations > Work Orders. 

2. In the Search Work Order field, enter the search syntax and click Search Work Orders.

Creating User Accounts for Device Manager (IoT-DM) Users
Before creating work orders, you must create user accounts for the field technicians who use IoT-DM to download work orders from IoT FND.

To create a Device Manager user account:

1. If not defined, create a Device Manager User role:

a. Choose Admin > Access Management > Roles.

b. Click Add.

c. (CG-OS only)) In the Role Name field, enter a name for the role.

d. Check the check box for Device Manager User, and then click Save.

2. Create the user account:

a. Choose Admin > Access Management > Users, and then click Add.

b. Configure the user name, password, and time zone information.

c. Check the check boxes for Monitor Only and the Device Manager User role you created in Step 1.

d. Click Save.

Creating Work Orders
If you need a technician to inspect a deployed FAR (CGR 1120 or CGR 1240) or DA Gateway (IR509) in the field, create a work order. A work 
order includes the WiFi credentials required for the technician to connect to the router. 

BEFORE YOU BEGIN

 Your user account must have the Work Order Management permissions enabled.

Parameter Description

workOrderNumber Unique identifier of the work order.

role (CG-OS only) Role of the user assigned to the work order. Valid roles are: tech, admin, or viewer.

technicianUserName User name of the technician assigned to the work order.

workOrderStatus Status of the work order. Valid status labels are: New, Assigned, InService, Completed, Incomplete, or 
Expired.

eid EID of the FAR associated with the work order.
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 To provide a signed work order to IoT-DM on request, you must import IoT-DM certificates to cgms_keystore using the alias cgms.

 Create the user account for the field technician. (See Creating User Accounts for Device Manager (IoT-DM) Users)

Note: You can only create work orders for CGRs and IR509 devices.

DETAILED STEPS

To create a work order for Router (CGR1000) or Endpoint (IR509):

1. Choose Operations > Work Orders. 

2. Click Add Work Order.

3. In the Work Order Name field, enter the name of the work order.

4. In the Field Device Names/EIDs field, enter a comma-separated list of FAR names or EIDs.

For every FAR in the list, IoT FND creates a separate work order.

5. Device Type (Router or Endpoint) and CGR OS version (CG-OS or IOS) auto-populate.

6. Enter the IoT-DM system name in the Device Username field.

Select the Technician User Name for the IoT-DM from the drop-down menu.This menu only lists users with IoT-DM User permissions 
enabled.

7. From the Status drop-down menu, choose the status of the work order (New, Assigned, In Service, Completed, or InComplete). The New 
option auto-populates.

Note: For a IoT-DM user to retrieve a work order, the work order must be in the Assigned state in IoT FND for that user. If the work order is 
in any other state, IoT-DM cannot retrieve the signed work order.
2
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Note: After the work order has been successfully requested by the IoT-DM user, the state of work order changes to In Service.

8. In the Start Date and End Date fields, specify the starting and ending dates for which the work order is valid.

If the work order is not valid, the technician cannot access the router.

9. In the Device Time Zone field, choose the time zone of the device from the drop-down menu.

10. Click Save.

11. Click OK.

You can also create work orders on the Field Devices page (Devices > Field Devices), as described in Creating Work Orders, and on the Device 
Info page.

Downloading Work Orders

To download the work orders created by IoT FND, field technicians use Cisco IoT-DM, a Windows-based application that field technicians use to 
manage a single Cisco CGR 1000 router. The technician can download all work orders in the Assigned state.

Field technicians use IoT-DM to update work order status, which is sent to IoT FND.

Note: Certificates are not included in the work order and are preinstalled on the IoT-DM field laptop prior to downloading work orders from 
IoT FND.

For more information about IoT-DM, see the Cisco IoT Device Manager User Guide.

Editing Work Orders
To edit work order details:

1. Choose Operations > Work Orders. 

2. Select the work order to edit, and then click Edit Work Order.

Alternatively, click the work order number to open the page displaying the work order details.

3. Click Save.

Deleting Work Orders
To delete work orders:

1. Choose Operations > Work Orders. 

2. Check the check box of the work orders to delete.

3. Click Delete Work Order.

4. Click Yes.

Device Properties
This section describes the device properties that you can view in IoT FND. Some of these properties are configurable; others are not.

 Types of Device Properties

 Device Properties by Category
2
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Types of Device Properties
IoT FND stores two types of device properties in its database:

 Actual device properties—These are the properties defined by the device, such as IP Address, Transmit Speed, and SSID. 

 IoT FND device properties—These are properties defined by IoT FND for devices, such Latitude and Longitude properties, which IoT FND 
uses to display device locations on its GIS map.

Note: The Key column provides the version of the property name in the IoT FND database that you can use in filters. For example, to search 
for the device with an IP address of 10.33.0.30, enter ip:10.33.0.30 in the Search Devices field. 

Device Properties by Category
This section presents IoT FND device properties by category:

 Cellular Link Settings

 Cellular Link Metrics for CGRs

 DA Gateway Properties

 Dual PHY WPAN Properties

 Embedded Access Point Credentials

 Embedded AP Properties

 Ethernet Link Metrics

 Guest OS Properties

 Head-End Routers > Netconf Config

 Head-End Routers > Tunnel 1 Config

 Head-End Routers > Tunnel 2 Config

 Inventory

 Mesh Link Config

 Mesh Device Health

 Mesh Link Keys

 Mesh Link Settings

 Mesh Link Metrics

 NAT44 Metrics

 PLC Mesh Info

 Raw Sockets Metrics and Sessions

 Router Battery

 Router Config

 Router Credentials

 Router DHCP Proxy Config
2
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 Router Health

 Router Tunnel Config

 Router Tunnel 1 Config

 Router Tunnel 2 Config

 SCADA Metrics

 User-defined Properties

 WiFi Interface Config

 WiMAX Config

 WiMAX Link Metrics

 WiMAX Link Settings

Every device in IoT FND presents a list of fields, which are used for device searches. The available fields for a device are defined in the Device 
Type field. Fields are either configurable or discovered. Configurable fields are set using XML and CSV files; the device EID is the lookup key. 
Discovered fields are presented from the device. Fields are also accessible in the device configuration templates for FARs. 

Cellular Link Settings

Table 10 lists the fields in the Cellular Link area of the Device Detail page for all Cellular interfaces.

Note: Beginning with IoT FND 3.2, Cisco routers IR829, CGR1240, CGR1120 and Cisco 819 4G LTE ISRs (C819) support a new dual-active radio 
module that support dual modems and 2 physical interfaces (interfaces 0 and 1, interfaces 2 and 3) per modem. See SKUs below:

 IR829GW-2LTE-K9

 CGM-LTE-LA for CGR 1000 routers

 C819HG-LTE-MNA-K9

Cellular properties supported on the dual modems and their two physical interfaces (and four logical interfaces 0, 1, 2 and 3), display as follows:

Additionally, the 4G LTE dual-active radio module does not support or display all fields summarized in Table 10

Cellular Link Metrics 

Cellular Link Settings Interface 0 and Interface 1 Interface 2 and Interface 3
2
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Table 10 Cellular Link Settings Fields

Field Key Configurable? Description

Cellular Network Type N/A Yes Defines the type of cellular network for 
example, GSM or CDMA.

Module Status cellularStatus No Displays whether the cellular interface 
module is active in the network. There is 
also an unknown state for the module.

Network Name _ Yes Defines the service provider name for 
example, AT&T or Verizon.

APN cellularAPN No Displays the Access Point Name (APN) of 
the AP to which the cellular interface 
connects.

Cell ID cellularID No Displays the cell ID for the cellular 
interface. This value must exist to activate 
the interface.

Cellular SID cellularSID No Displays the System Identification Number 
for the CDMA cellular area.

Cellular NID cellularNID No Displays the Network Identification 
Number, for the CDMA cellular area.

Cellular Roaming Status cellularRoamingStatus No Indicates whether the modem is in the 
Home network or Roaming.

Cellular Modem Serial Number N/A No Displays the serial number of the 
connected modem.

Cellular Modem Firmware Version cellularModemFirmwareVersion No Displays the version of the modem 
firmware on the module installed within 
the CGR.

Connection Type connectionType No Displays the connection type as:

 Packet switched 

 Circuit switched 

 LTE

Location Area Code locationAreaCode No Displays the Location Area Code (LAC) 
given by the base station.

Routing Area Code routingAreaCode No Displays the routing area code given by the 
base station.

IMEI cellularIMEI No Displays the International Mobile 
Equipment Identity (IMEI) for the cellular 
interface within a GSM network only. The 
IMEI value is a unique number for the 
cellular interface.

APN cellularAPN No Displays the Access Point Name (APN) of 
the AP to which the cellular interface 
connects.

Cellular Modem Firmware Version cellularModemFirmwareVersion No Displays the version of the modem 
firmware on the Cellular module installed 
within the CGR.
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Cellular Link Metrics for CGRs

Table 11 describes the fields in the Cellular Link Metrics area of the Device Info view.

Connection Type connectionType No Displays the connection type as:

 Packet switched 

 Circuit switched 

IMSI cellularIMSI No The International Mobile Subscriber 
Identity (IMSI) identifies an individual 
network user as a 10-digit decimal value 
within a GSM and CDMA network.

Possible values are:

 10-digit decimal value

 Unknown

IMEI cellularIMEI No Displays the International Mobile 
Equipment Identity (IMEI) for the cellular 
interface within a GSM network only. The 
IMEI value is a unique number for the 
cellular interface.

Table 11 Cellular Link Metrics Area Fields

Field Key Description

Transmit Speed cellularTxSpeed Displays the current speed (bits/sec) of data transmitted by the cellular interface over 
the cellular uplink for a defined period (such as an hour).

Receive Speed cellularRxSpeed Displays the average speed (bits/sec) of data received by the cellular uplink network 
interface for a defined period (such as an hour).

RSSI cellularRssi Indicates the radio frequency (RF) signal strength of the cellular uplink. Valid values 
are 0 to -100. 

The LED states on the cellular interface and corresponding RSSI values are:

 Off: RSSI < = -110 

 Solid amber: -100 < RSSI <= -90 

 Fast green blink: -90 < RSSI <= -75 

 Slow green blink: -75 < RSSI <= -60 

 Solid green: RSSI > -60

Bandwidth Usage 
(Current Billing Cycle)

CellBwPerCycle (bytes) Displays current bandwidth usage (in bytes) of a particular route for the current billing 
cycle.

Cell Module 
Temperature

cellModuleTemp Internal temperature of 3G module.

Cell ECIO cellularEcio Signal strength of CDMA at the individual sector level.

Cell Connect Time cellConnectTime Length of time that the current call lasted. This field only applies only to CDMA.

Table 10 Cellular Link Settings Fields (continued)

Field Key Configurable? Description
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DA Gateway Properties

DA Gateway Metrics Area Fields describe the fields in the DA Gateway area of the Device Info view.

Table 12 DA Gateway Metrics Area Fields

Field Key Description

SSID – The mesh SSID.

PANID – The subnet PAN ID.

Transmit Power – The mesh transmit power.

Security Mode – Mesh Security mode: 

 0 indicates no security mode set

 1 indicates 802.1x with 802.11i key management

Meter Certificate meterCert The subject name of the meter certificate.

Mesh Tone Map Forward 
Modulation

toneMapForwardModulation Mesh tone map forward modulation: 

 0 = Robo 

 1 = DBPSK 

 2 = DQPSK

 3 = D8PSK

Mesh Tone Map Reverse 
Modulation

– Mesh tone map reverse modulation:

 0 = Robo 

 1 = DBPSK 

 2 = DQPSK

 3 = D8PSK

Mesh Device Type – The primary function of the mesh device (for example, meter, range 
extender, or DA gateway).

Manufacturer of the Mesh 
Devices

– Manufacturer of the mesh device as reported by the device.

Basic Mapping Rule End User 
IPv6 Prefix

– End-user IPv6 address for basic rule mapping for the device.

Basic Mapping Rule End User 
IPv6 Prefix Length

– Specified prefix length for the end-user IPv6 address.

Map-T IPv6 Address – IPv6 address for MAP-T settings.

Map-T IPv4 Address – IPv4 address for MAP-T settings.

Map-T PSID – MAP-T PSID.

Active Link Type – Link type of the physical link over which device communicates with 
other devices including IoT FND.
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Dual PHY WPAN Properties

Table 13 describes the fields in the Dual PHY area of the Device Info view.

Table 13 Dual PHY Metrics Area Fields

Field Key Description

SSID ssid The mesh SSID.

PANID panid The subnet PAN ID.

Transmit Power txpower The mesh transmit power.

Security Mode – Mesh Security mode: 

 0 = No security mode set

 1 = 802.1x with 802.11i key management

Meter Certificate meterCert The subject name of the meter certificate.

Mesh Tone Map Forward 
Modulation

toneMapForwardModulation Mesh tone map forward modulation: 

 0 = Robo 

 1 = DBPSK 

 2 = DQPSK

 3 = D8PSK

Mesh Tone Map Reverse 
Modulation

– Mesh tone map reverse modulation:

 0 = Robo 

 1 = DBPSK 

 2 = DQPSK

 3 = D8PSK

Mesh Device Type – The primary function of the mesh device (for example, meter, range 
extender, or DA gateway).

Manufacturer of the Mesh 
Devices

– Manufacturer of the mesh device as reported by the device.

Basic Mapping Rule End User 
IPv6 Prefix

– End-user IPv6 address for basic rule mapping for the device.

Basic Mapping Rule End User 
IPv6 Prefix Length

– Specified prefix length for the end-user IPv6 address.

Map-T IPv6 Address – IPv6 address for Map-T settings.

Map-T IPv4 Address – IPv4 address for Map-T settings.

Map-T PSID – MAP-T PSID.

Active Link Type – Link type of the physical link over which device communicates with 
other devices including IoT FND.
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Embedded Access Point Credentials

Table 14 describes the fields in the Embedded Access Point Credentials area of the Device Info view.

Embedded AP Properties

Table 15 describes the fields on the Embedded AP tab of the C800 or IR800 Device Info view.

Ethernet Link Metrics

Table 16 describes the fields in the Ethernet link traffic area of the Device Info view.

Table 14 Embedded Access Point Credentials Fields

Field Key Configurable? Description

AP Admin Username – Yes The user name used for access point authentication.

AP Admin Password – Yes The password used for access point authentication. 

Table 15 Embedded AP Properties

Field Key Description

Inventory – Summary of name, EID, domain, status, IP address, hostname, domain name, first heard, last 
heard, last property heard, last metric heard, model number, serial number, firmware version 
and uptime details.

Wi-Fi Clients - Provides client MAC address, SSID, IPv4 address, IPv6 address, device type, state, name, 
parent

Dot11Radio 0 Traffic – Provides admin status (up/down), operational status (up/down), physical address, Tx speed 
(bps), Tx drops (bps) and Rx speed (bps).

Dot11Radio 1 Traffic – Provides admin status (up/down), operational status (up/down), physical address, Tx speed 
(bps), Tx drops (bps) and Rx speed (bps).

Tunnel3 - Provides admin status (up/down), operational status (up/down), Tx speed (bps), Tx drops 
(bps) and Rx speed (bps).

BVI1 – Provides admin status (up/down), operational status (up/down), IP address., physical 
address, Tx speed (bps), Tx drops (bps) and Rx speed (bps).

GigabitEthernet0 – Provides admin status (up/down), operational status (up/down), physical address, Tx speed 
(bps), Tx drops (bps) and Rx speed (bps).

Table 16 Ethernet Link Metrics Area Fields

Field Key Description

Transmit Speed ethernetTxSpeed Indicates the average speed (bits/sec) of traffic transmitted on the Ethernet interface for a 
defined period of time.

Receive Speed ethernetRxSpeed Indicates the average speed (bits/sec) of traffic received on the Ethernet interface for a 
defined period of time.

Transmit Packet Drops ethernetTxDrops Indicates the number of packets dropped (drops/sec) when the transmit queue is full.
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Guest OS Properties 

Table 17 describes the fields in the Guest OS Properties area of the Config Properties page.

Head-End Routers > Netconf Config

Table 18 describes the fields in the Netconf Client area of the Head-End Routers > Config Properties page.

Head-End Routers > Tunnel 1 Config

Table 19 describes the fields in the Tunnel 1 Config area of the Head-End Routers > Config Properties page.

Head-End Routers > Tunnel 2 Config

Table 20 describes the fields in the Tunnel 2 Config area of the Head-End Routers > Config Properties page.

Table 17 Guest OS Properties Fields

Field Key Description

GOS Password – Password to access the GOS.

DHCPv4 Link for Guest OS Gateway – The DHCPc4 gateway address.

Guest OS IPv4 Subnet mask – The IPv4 subnet mask address.

Guest OS Gateway IPv6 Address – The IPv6 gateway address.

Guest OS IPv6 Subnet Prefix Length – The IPv6 subnet prefix length.

Table 18 Head-End Routers > Netconf Config Client Fields

Field Key Configurable? Description

Netconf Username netconfUsername Yes Identifies the username to enter when establishing a Netconf SSH session on 
the HER.

Netconf Password netconfPassword Yes Identifies the password to enter when establishing a Netconf SSH session on 
the HER.

Table 19 Head-End Routers > Tunnel 1 Config Fields

Field Key Configurable? Description

IPsec Tunnel Source 1 ipsecTunnelSrc1 Yes Identifies the source interface or IP address of IPsec tunnel 1.

IPsec Tunnel Dest Addr 1 ipsecTunnelDestAddr1 Yes Identifies the destination interface or IP address of IPsec tunnel 
1.

GRE Tunnel Source 1 greTunnelSrc1 Yes Identifies the source interface or IP address of GRE tunnel 1.

GRE Tunnel Dest Addr 1 greTunnelDestAddr1 Yes Identifies the destination interface or IP address of GRE tunnel 
1.
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Inventory

Table 21 describes the fields in the Inventory area of the Device Info page.

EXAMPLE PATH to Device Info page: Devices > Field Devices > ENDPOINT > ROOT-OW Riva CAM > Name (Select product link in Config 
Panel).

Table 20 Head-End Routers > Tunnel 2 Config Device Fields

Field Key Configurable? Description

IPsec Tunnel Source 2 ipsecTunnelSrc2 Yes Identifies the source interface or IP address of IPsec tunnel 2.

IPsec Tunnel Dest Addr 2 ipsecTunnelDestAddr2 Yes Identifies the destination interface or IP address of IPsec tunnel 
2.

GRE Tunnel Source 2 greTunnelSrc2 Yes Identifies the source interface or IP address of GRE tunnel 2.

GRE Tunnel Dest Addr 2 greTunnelDestAddr2 Yes Identifies the destination interface or IP address of GRE tunnel 
2.
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Mesh Link Config

Table 21 Inventory Fields

Field Key Configurable? Description

Config Group configGroup Yes The name of the configuration group to which the device 
belongs.

Device Category deviceCategory No This field lists the type of device.

Device Type deviceType No This field determines all other fields, as well as how the device 
is communicated with how it displays in IoT FND.

Domain Name domainName Yes The domain name configured for this device.

EID eid No The primary element ID of the device, which is used as the 
primary unique key for device queries. 

Firmware Group firmwareGroup Yes The name of the firmware group to which the device belongs.

Firmware Version runningFirmwareVersion No The firmware version running on the device.

Hardware Version vid No The hardware version of the device.

Hypervisor Version hypervisor No (Cisco IOS CGRs running Guest OS only) The version of the 
Hypervisor.

Hostname hostname No The hostname of the device

IP Address ip Yes The IP address of the device. Use this address for the IoT FND 
connection through a tunnel.

Labels label Yes Custom label assigned to the device. A device can have 
multiple labels. Labels are assigned through the UI or API, but 
not through a XML or CSV file.

Last Heard lastHeard No The last date and time the device contacted IoT FND.

Last Metric Heard N/A No The time of last polling (periodic notification). 

Last Property Heard N/A No The time of last property update for the FAR.

Last RPL Tree Update N/A No The time of last RPL tree poll update (periodic notification). 

Location N/A No The latitude and longitude of the device.

Manufacturer – No The manufacturer of the endpoint device.

Mesh Function cgmesh No Function of the mesh device. Valid values are Range Extender 
and Meter.

Meter Certificate meterCert No The global or unique certificate reported by the meter.

Meter ID meterId No ME meter ID.

Model Number pid No The product ID of the device.

Name name Yes The unique name assigned to the device.

SD Card Password Lock – Yes (CGRs only) The state of the SD card password lock (on/off).

Serial Number sn No The serial number of the device.

Status status No The device status.

Tunnel Group tunnelGroup Yes The name of the tunnel group to which the device belongs.
2



Managing Devices

  
Table 22 describes the fields in the Mesh Link Config area of the Routers > Config Properties page.

Mesh Device Health

Table 23 describes the fields in the Mesh Device Health area of the Device Info view.

Mesh Link Keys

Table 24 describes the fields in the Mesh Link Keys area of the Device Info view.

Mesh Link Settings

Table 25 describes the fields in the Mesh Link Settings area of the Device Info view.

Table 22 Mesh Link Config Fields

Field Key Configurable? Description

Mesh Prefix Config meshPrefixConfig Yes The subnet prefix address.

Mesh Prefix Length Config meshPrefixLengthConfig Yes The subnet prefix address length.

Mesh PAN ID Config meshPanidConfig Yes The subnet PAN ID.

Mesh Address Config meshAddressConfig Yes The IP address of the mesh link.

Master WPAN Interface masterWpanInterface Yes (Dual-PHY CGRs only) The interface on which the device 
is master.

Slave WPAN Interface slaveWpanInterface Yes (Dual-PHY CGRs only) The interface on which the device 
is slave.

Table 23 Mesh Device Health Fields 

Field Key Description

Uptime uptime The amount of time, in seconds, that the element has been running since last boot.

Table 24 Mesh Link Keys Fields

Field Key Configurable? Description

Key Refresh Time meshKeyRefresh No The last date the mesh link keys were uploaded.

Key Expiration Time meshKeyExpire Yes The date the mesh link keys expire.

Table 25 Mesh Link Settings Fields

Field Key Description

Firmware Version meshFirmwareVersion The ME firmware version.

Mesh Interface Active meshActive The status of the ME.

Mesh SSID meshSsid The ME network ID.

PANID meshPanid The subnet PAN ID.

Transmit RF Power meshTxPower The ME transmission power (dBm).

Security Mode meshSecMode The ME security mode.

Transmit PLC TX Level tx_level dBuV The PLC level for Itron OpenWay RIVA CAM module and Itron OpenWay 
RIVA Electric devices (dBuV) where u = micro

RPL DIO Min meshRplDioMin An unsigned integer used to configure the Imin of the DODAG Information 
Object (DIO) Trickle timer. 
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Mesh Link Metrics

Table 26 describes the fields in the Mesh Link Metrics area of the Device Info page.

NAT44 Metrics

Table 27 describes the fields in the NAT44 area of the Device Info page.

RPL DIO Double meshRplDioDbl An unsigned integer used to configure the Imax of the DIO Trickle timer. 

RPL DODAG Lifetime meshRplDodagLifetime An an unsigned integer used to configure the default lifetime (in minutes) for 
all downward routes display as Directed Acyclic Graphs (DAGs). 

RPL Version Incr. Time meshRplVersionIncrementTime An unsigned integer used to specify the duration (in minutes) between 
incrementing the RPL version.

Table 26 Mesh Link Metrics Fields

Field Key Description

Meter ID meterId The ME meter ID.

PANID meshPanid The ME PANID.

Mesh Endpoints meshEndpointCount Number of MEs.

Mesh Link Transmit Speed meshTxSpeed The current speed of data transmission over the uplink network interface 
(bits/sec) averaged over a short element-specific time period (for example, 
an hour).

Mesh Link Receive Speed meshRxSpeed The rate of data received by the uplink network interface (bits/sec) averaged 
over a short element-specific time period (for example, an hour).

Mesh Link Transmit Packet Drops – The number of data packets dropped in the uplink.

Mesh Route RPL Hops meshHops The number of hops that the element is from the root of its RPL routing tree.

Mesh Route RPL Link Cost linkCost The RPL cost value for the link between the element and its uplink 
neighbor.

Mesh Route RPL Path Cost pathCost The RPL path cost value between the element and the root of the routing 
tree.

Transmit PLC Level tx_level dBuV Supported on the PLC and the Itron OpenWay RIVA Electric devices and 
the Itron OpenWay RIVA G-W (Gas-Water) devices only (u within dBuV = 
micro)

Table 27 NAT44 Metrics Fields

Field Key Description

NAT44 Internal Address nat44InternalAddress0 The internal address of the NAT 44 configured device.

NAT 44 Internal Port nat44InternalPort0 The internal port number of the NAT 44 configured device.

NAT 44 External Port nat44ExternalPort0 The external port number of the NAT 44 configured device.

Table 25 Mesh Link Settings Fields (continued)

Field Key Description
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PLC Mesh Info

Table 28 describes the fields in the PLC Mesh Info area of the Device Info view.

Raw Sockets Metrics and Sessions

Table 29 describes the fields in the TCP Raw Sockets area of the Field Devices > Config Properties page.

Table 28 PLC Mesh Info Fields 

Field Key Description

Mesh Tone Map Forward Modulation toneMapForwardModulation Mesh tone map forward modulation: 

 0 = Robo

 1 = DBPSK

 2 = DQPSK

 3 = D8PSK

Mesh Tone Map Forward Map toneMapForward Indicates the number of usable subcarriers in the channel, 
shown as a binary octet (for example, 0011 1111). Ones 
indicate viable channels. The more ones in the map, the higher 
the channel capacity.

Mesh Tone Map Reverse Modulation toneMapRevModulation Mesh tone map reverse modulation:

 0 = Robo

 1 = DBPSK 

 2 = DQPSK

 3 = D8PSK

Mesh Tone Map Reverse Map toneMapReverse Indicates the number of usable subcarriers in the channel, 
shown as a binary octet (for example, 0011 1111). Ones 
indicate viable channels. The more ones in the map, the higher 
the channel capacity. The reverse map information, used in 
conjunction with RSSI, combine to determine viable channels.

Mesh Absolute Phase of Power – Mesh absolute phase of power is basically relative position of 
current and voltage waveforms for a PLC node.

LMAC Version – Version of LMAC firmware in use by the PLC module DSP 
processor, which provides lower media access functionality 
for PLC communications compliant with the IEEE P1901.2 
PHY standard.

Table 29 Raw Sockets Metrics and Sessions View

Field Key Description

Metrics

Tx Speed (bps) rawSocketTxSpeedS[portNo] The transmit speed of packetized streams of serial data in bits per second.

Rx Speed (bps) rawSocketRxSpeedS[portNo] The receive speed of packetized streams of serial data in bits per second.

Tx Speed (fps) rawSocketTxFramesS[portNo] The transmit speed of packetized streams of serial data in frames per second.

Rx Speed (fps) rawSocketRxFramesS[portNo] The receive speed of packetized streams of serial data in frames per second.

Sessions

Interface Name – The name of the serial interface configured for raw socket encapsulation.
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Router Battery

Table 30 describes the fields in the Router Battery area of the Device Info page.

TTY – The asynchronous serial line on the router associated with the serial interface.

VRF Name – Virtual Routing and Forwarding instance name.

Socket – The number identifying one of 32 connections.

Socket Mode – Client or server. The mode in which the asynchronous line interface is set up.

Local IP Address – The IP address that either the server listens for connections on (in Server Socket 
Mode), or to which the client binds to initiate connections to the server (in Client 
Socket Mode).

Local Port – The port that either the server listens to for connections (in Server Socket Mode), or 
to which the client binds to initiate connections to the server (in Client Socket 
Mode).

Dest. IP Address – The destination IP address of the remote TCP Raw Socket server.

Dest. Port – Destination port number to use for the connection to the remote server.

Up Time – The length of time that the connection has been up.

Idle Time – The length of time that no packets were sent.

Time Out – The currently configured session idle timeout, in minutes.

Table 30 Router Battery Device View

Field Key Configurable? Description

Battery 0 Charge battery0Charge No The percentage of charge remaining in battery 0.

Battery 0 Level (%) battery0Level No The percentage of charge remaining in battery 0.

Battery 0 Remaining Time battery0Runtime No How long battery 0 has been up and running since its installation 
or its last reset.

Battery 0 State battery0State No The current battery 0 state of the device.

Battery 1 Level (%) battery1Level No The percentage of charge remaining in battery 1.

Battery 1 Remaining Time battery1Runtime No How long battery 1 has been up and running since its installation 
or its last reset.

Battery 1 State battery1State No The current battery 0 state of the device.

Battery 2 Level (%) battery2Level No The percentage of charge remaining in battery 2.

Battery 2 Remaining Time battery2Runtime No How long battery 2 has been up and running since its installation 
or its last reset.

Battery 2 State battery2State No The current battery 0 state of the device.

Battery Total Remaining Time batteryRuntime No The total aggregate charge time remaining for all batteries. 

Number of BBU numBBU No The number of battery backup units (BBUs) installed in the router. 
The router can accept up to three BBUs (battery 0, battery 1, 
battery 2).

Power Source powerSource No The router power source: AC or BBU.

Table 29 Raw Sockets Metrics and Sessions View (continued)

Field Key Description
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Router Config

Table 31 describes the fields in the Router Config area of the Field Devices > Config Properties page.

Router Credentials

Table 32 describes the fields in the Router Credentials area of the Field Devices > Config Properties page.

Router DHCP Info

Table 33 describes the fields in the DHCP Info area of the Device Info page.

Router DHCP Proxy Config

Table 34 describes the fields in the DHCP Proxy Config area of the Field Devices > Config Properties page.

Table 31 Router Config Device View

Field Key Configurable? Description

Use GPS Location useGPSLocationConfig Yes The internal GPS module provides the router location (longitude and 
latitude).

Table 32 Router Credentials Fields

Field Key Configurable? Description

Administrator Username – Yes The user name used for root authentication.

Administrator Password – Yes The password used for root authentication. 

Master key – Yes The master key used for device authentication.

SD Card Password – No SD card password protection status.

Token Encryption Key – Yes The token encryption key.

CGR Username – Yes The username set for the CGR.

CGR Password – Yes The password set on the CGR for the associated username.

Table 33 Router DHCP Fields

Field Key Description

DHCP Unique ID (DUID) – A DHCP DUID in hex string format (for example, 0xHHHH).

Table 34 DHCP Proxy Config Fields

Field Key Configurable? Description

DHCPv4 Link for Loopback Interfaces dhcpV4LoopbackLink Yes Refers to the IPv4 link address to use within 
DHCP DISCOVER messages when requesting a 
lease for loopback interfaces.

DHCPv4 Link for Tunnel Interfaces dhcpV4TunnelLink Yes Refers to the IPv4 link address to use within 
DHCP DISCOVER messages when requesting a 
lease for tunnel interfaces.

DHCPv6 Link for Loopback Interfaces dhcpV6LoopbackLink Yes The IPv6 link address to use in DHCPv6 
Relay-forward messages when requesting a lease 
for loopback interfaces.

DHCPv6 Link for Tunnel Interfaces dhcpV6TunnelLink Yes The IPv6 link address to use in DHCPv6 
Relay-forward messages when requesting a lease 
for tunnel interfaces.
2
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Router Health

Table 35 describes the Router Health fields in the Device Info view.

Router Tunnel Config

Table 36 describes the fields in the Router Tunnel Config area of the Field Devices > Config Properties page.

Router Tunnel 1 Config

Table 37 describes the fields in the Router Tunnel 1 Config area of the Field Devices > Config Properties page.

Table 35 Router Health Device View

Field Key Configurable? Description

Uptime uptime No Indicates the length of time (in seconds) that the router has been up and 
operating since its last reset.

Door Status doorStatus No Options for this field are:

 “Open” when the door of the router is open

 “Closed” after the door is closed

Chassis Temperature chassisTemp No Displays the operating temperature of the router. You can configure alerts to 
indicate when the operating temperature falls outside of the customer-defined 
temperature range.

Table 36 Router Tunnel Config Device View

Field Key Configurable? Description

Tunnel Config tunnelHerEid Yes Displays the EID number of the HER that the FAR connects 
with through secure tunnels.

Common Name of Certificate Issuer No Displays the name of the certificate issuer.

NMBA NHS IPv4 Address Yes Displays the Non-Broadcast Multiple Access (NBMA) 
IPv4 address.

NMBA NHS IPv6 Address Yes Displays the NBMA IPv6 address.

Use FlexVPN Tunnels Yes Displays the FlexVPN tunnel setting.

Table 37 Router Tunnel 1 Config Device View

Field Key Configurable? Description

Tunnel Source Interface 1 tunnelSrcInterface1 Yes Defines the interface over which the first tunnel is built to 
provide WAN redundancy.

OSPF Area 1 ospfArea1 Yes Defines the OSPFv2 Area 1 in which the router (running IPv4) 
is a member.

OSPFv3 Area 1 ospfV3Area1 Yes Defines OSPFv3 Area 1 in which the router (running IPv6) is 
a member.

OSPF Area 2 ospfArea1 Yes Defines the OSPFv2 Area 2 in which the router (running IPv4) 
is a member.

OSPFv3 Area 2 ospfV3Area1 Yes Defines OSPFv3 Area 2 in which the router (running IPv6) is 
a member.

IPsec Dest Addr 1 ipsecTunnelDestAddr1 Yes Defines the destination IP address for IPsec tunnel 1.

GRE Dest Addr 1 greTunnelDestAddr1 Yes Defines the destination IP address for GRE tunnel 1.
2
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Router Tunnel 2 Config

Table 38 describes the fields in the Router Tunnel 2 Config area of the Field Devices > Config Properties page.

SCADA Metrics

Table 39 describes the fields on the SCADA tab of the Device Info page.

User-defined Properties

The User-defined Properties area of the Routers > Config Properties page displays any customer defined properties.

Table 38 Router Tunnel 2 Config Device View

Field Key Configurable? Description

Tunnel Source Interface 2 tunne2SrcInterface1 Yes Defines the interface over which the second tunnel is built to 
provide WAN redundancy.

OSPF Area 2 ospfArea2 Yes Defines the OSPFv2 Area 2 in which the router (running IPv4) 
is a member.

OSPFv3 Area 2 ospfV3Area2 Yes Defines OSPFv3 Area 2 in which the router (running IPv6) is 
a member.

IPsec Dest Addr 2 ipsecTunnelDestAddr2 Yes Defines the destination IP address for IPsec tunnel 2.

GRE Dest Addr 2 greTunnelDestAddr2 Yes Defines the destination IP address for GRE tunnel 2.

Table 39 SCADA Metrics View

Field Key Configurable? Description

Channel Name channel_name No Identifies the channel on which the serial port of the FAR communicates to the 
RTU.

Protocol Type protocol No Identifies the Protocol Translation type.

Messages Sent – No The number of messages sent by the FAR.

Messages Received – No The number of messages received by the FAR.

Timeouts – No Displays the timeout value for connection establishment.

Aborts – No Displays the number of aborted connection attempts.

Rejections – No Displays the number of connection attempts rejected by IoT FND.

Protocol Errors – No Displays the number of protocol errors generated by the FAR.

Link Errors – No Displays the number of link errors generated by the FAR.

Address Errors – No Displays the number of address errors generated by the FAR.

Local IP – No Displays the local IP address of the FAR.

Local Port – No Displays the local port of the FAR.

Remote IP – No Displays the remote IP address of the FAR.

Data Socket – No Displays the Raw Socket server configured for the FAR.
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WiFi Interface Config

Table 40 describes the fields in the WiFi Interface Config area of the Field Devices > Config Properties page.

WiMAX Config

Table 41 describes the fields in the WiMAX Config area of the Device Info page.

WiMAX Link Metrics

Table 42 describes the fields in the WiMAX Link Health area of the Device Info page.

WiMAX Link Settings

Table 43 describes the fields in the WiMAX Link Settings area of the Device Info page.

Table 40 WiFi Interface Config Fields

Field Key Configurable? Description

SSID wifiSsid No The service set identifier (SSID) assigned to the WiFi interface on the 
FAR.

Pre-Shared Key type6PasswordMasterKey No The key used to encrypt other pre-shared keys stored on the FAR.

Table 41 WiMAX Config Fields

Field Key Description

PkmUsername PkmUsername

PkmPassword PkmPassword

Table 42 WiMAX Link Health Fields

Field Key Description

Transmit Speed wimaxTxSpeed The current speed of data transmission over the WiMAX uplink network interface, measured in bits 
per second, averaged over a short element-specific time period (for example, an hour).

Receive Speed wimaxRxSpeed The rate of data that has been received by the WiMAX uplink network interface, measured in bits per 
second, averaged over a short element-specific time period (for example, an hour).

RSSI wimaxRssi The measured RSSI value of the WiMAX RF uplink (dBm).

CINR wimaxCinr The measured CINR value of the WiMAX RF uplink (dB).

Table 43 WiMAX Link Settings Fields

Field Key Description

BSID wimaxBsid The ID of the base station connected to the WiMAX device.

Hardware Address wimaxHardwareAddress The hardware address of the WiMAX device.

Hardware Version wimaxHardwareVersion The hardware version of the WiMAX device.

Microcode Version wimaxMicrocodeVersion The microcode version of the WiMAX device.

Firmware Version wimaxFirmwareVersion The firmware version of the WiMAX device.

Device Name wimaxDeviceName The name of the WiMAX device.

Link State wimaxLinkState The link state of the WiMAX device.

Frequency wimaxFrequency The frequency of the WiMAX device.

Bandwidth wimaxBandwidth The bandwidth the WiMAX device is using.
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Managing Firmware Upgrades
This section describes managing firmware upgrade settings in IoT FND, and includes the following sections:

 FAR Firmware Updates

 Configuring Firmware Group Settings

 Working with FAR Firmware Images

 Performing OS Migrations

 Working with Mesh Endpoint Firmware Images

Use IoT FND to upgrade the firmware running on FARs (CGR1000s, C800s, IR800s), AP800s and Mesh Endpoints (CGEs and range 
extenders). IoT FND stores the firmware binaries in its database for later transfer to FARs in a firmware group through an IoT FND and 
IoT-DM file transfer, and to MEs using IoT FND.

Cisco provides the firmware bundles as a zip file. For Cisco IOS, software bundles include hypervisor, system image and IOx images (for 
example, Guest-OS, Host-OS). For Cisco CG-OS, IoT FND automatically unzips the kickstart and system images included in the bundle. 
Firmware system images are large (approximately 130 MB); kickstart images are approximately 30 MB. Every firmware bundle includes a 
manifest file with metadata about the images in the bundle. You can pause, stop, or resume the upload process.

FAR Firmware Updates
IoT FND updates FAR firmware in two steps:

1. Uploads the firmware image from IoT FND to the devices.

Because of their large size, firmware-image uploads to FARs takes approximately 30 minutes, depending on interface speeds.

2. Installs the firmware on the device and reloads it.

Note: You must initiate the installation process. IoT FND does not start it automatically after the image upload.

When a FAR contacts IoT FND for the first time to register and request tunnel provisioning, IoT FND rolls the FAR back to the default 
factory configuration (ps-start-config) before uploading and installing the new firmware image. 

Note: This rollback requires a second reload to update the boot parameters in ps-start-config and apply the latest configuration. This second 
reload adds an additional 10–15 minutes to the installation and reloading operation.

Upgrading Guest OS Images

Depending on CGR factory configuration, a Guest OS (GOS) may be present in the VM instance. You can install or upgrade Cisco IOS on 
the Config > Firmware Update page (see FAR Firmware Updates). The GOS, hypervisor, and Cisco IOS all upgrade when you perform a 
Cisco IOS image bundle installation or update. 

After after any Cisco IOS install or upgrade, when IoT FND discovers a GOS, it checks if the initial communications setup is complete 
before it performs the required setup. The CGR must have a DHCP pool and GigabitEthernet 0/1 interface configured to provide an IP 
address and act as the gateway for the GOS. The new GOS image overwrites existing configurations. IoT FND has an internal backup and 
restore mechanism that ports existing apps to the upgraded Guest OS (see Managing a Guest OS). 

See the Cisco 1000 Series Connected Grid Routers Configuration Guides documentation page for information on configuring the CGR.
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Note: If IoT FND detects a non-Cisco OS installed on the VM, the firmware bundle will not upload and the Cisco reference GOS will not 
install.

Upgrading WPAN Images

At the Config > Firmware Update page, you can upload the independent WPAN images (IOS-WPAN-RF or IOS-WPAN-PLC) to IoT FND 
using the Images sub-tab (left-hand side) and Upload Image button like other image upgrades. This process is known as a non-integrated 
WPAN firmware upgrade.

The WPAN firmware image integrated with the IOS CGR image option is still supported.

Also, if only the WPAN firmware upgrade from the image bundled with IOS image is desired (for example, when the WPAN firmware 
upgrade option was not checked during IOS upgrade), the “Install from Router” option is also provided under respective WPAN image types 
(IOS-WPAN-RF or IOS-WPAN-PLC).

For detailed steps, go to Working with FAR Firmware Images, page 268.

Changing Action Expiration Timer

You can use the cgnms_preferences.sh script to set or retrieve the action expiration timer value in the IoT FND database:

/opt/cgms
/bin/cgnms_preferences setCgrActionExpirationTimeout 50

Valid options are:

 set<pkg>actionExpirationTimeoutMins<value> 

where,

— <pkg> is the preference package (required for set and get operations).

— actionExpirationTimeoutMins is the preference key (required for set and get operations).

— <value> is the preferred value, in minutes (required for set and setCgrActionExpirationTimeout operations).

 setCgrActionExpirationTimeout <value> 

 get<pkg>actionExpirationTimeoutMins 

 getCgrActionExpirationTimeout 

Example

In the following example, the action timer value is retrieved, set, the current value retrieved again, the value removed, and a null value 
retrieved:

[root@userID-lnx2 cgms]# ./dist/cgms-1.x/bin/cgnms_preferences.sh getCgrActionExpirationTimeout
2013-08-12 22:38:42,004:INFO:main:CgmsConnectionProvider: registered the database url for CG-NMS: 
[jdbc:oracle:thin:@localhost:1522:cgms]
5
[root@userID-lnx2 cgms]# ./dist/cgms-1.x/bin/cgnms_preferences.sh setCgrActionExpirationTimeout 50
2013-08-12 22:38:51,907:INFO:main:CgmsConnectionProvider: registered the database url for CG-NMS: 
[jdbc:oracle:thin:@localhost:1522:cgms]
Successfully set the preferences.
[root@userID-lnx2 cgms]# ./dist/cgms-1.x/bin/cgnms_preferences.sh getCgrActionExpirationTimeout
2013-08-12 22:38:58,591:INFO:main:CgmsConnectionProvider: registered the database url for CG-NMS: 
[jdbc:oracle:thin:@localhost:1522:cgms]
50
[root@userID-lnx2 cgms]# ./dist/cgms-1.x/bin/cgnms_preferences.sh get com.cisco.cgms.elements.ciscocgr 
actionExpirationTimeoutMins
2013-08-12 22:39:12,921:INFO:main:CgmsConnectionProvider: registered the database url for CG-NMS: 
[jdbc:oracle:thin:@localhost:1522:cgms]
50
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[root@userID-lnx2 cgms]# ./dist/cgms-1.x/bin/cgnms_preferences.sh set com.cisco.cgms.elements.ciscocgr 
actionExpirationTimeoutMins 15
2013-08-12 22:39:23,594:INFO:main:CgmsConnectionProvider: registered the database url for CG-NMS: 
[jdbc:oracle:thin:@localhost:1522:cgms]
Successfully set the preferences.
[root@userID-lnx2 cgms]# ./dist/cgms-1.x/bin/cgnms_preferences.sh get com.cisco.cgms.elements.ciscocgr 
actionExpirationTimeoutMins
2013-08-12 22:39:29,231:INFO:main:CgmsConnectionProvider: registered the database url for CG-NMS: 
[jdbc:oracle:thin:@localhost:1522:cgms]
15

Mesh Endpoint Firmware Updates
When you instruct IoT FND to upload a firmware image to the members of an ME firmware group or subnet, IoT FND pushes the image 
to the group members in the background and tracks the upload progress to ensure that the devices receive the image. 

A mesh endpoint stores three firmware images:

 Uploaded image: Image most recently uploaded.

 Running image: Image that is currently operational.

 Backup image: It serves as a golden (fallback) image for the endpoint if there is an issue with the running image.

Note: You can initiate up to 3 firmware downloads simultaneously.

Mesh Firmware Migration (CG-OS CG4 platforms only)

Note: Mesh Firmware Migration to Cisco Mesh is not supported for CGRs running CG-OS version CG4(4).

IoT FND allows you to update earlier versions of CGR firmware to allow Cisco mesh networking using the following IoT FND North 
Bound APIs:

 findEidByIpAddress

 startReprovisionByEidList

 startReprovisionByEidListAbridged

 startReprovisionByGroup

 startReprovisionByGroupAbridged

See the Cisco Connected Grid NMS North Bound API Programming Guide for usage information. 

Configuring Firmware Group Settings
This section describes how to add, delete, and configure firmware groups, and includes the following topics:

 Adding Firmware Groups

 Assigning Devices to a Firmware Group

 Renaming a Firmware Group

 Deleting Firmware Groups

Note: Upload operations only begin when you click the Resume button.
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When you add FARs or MEs to IoT FND, the application sorts the devices into the corresponding default firmware group: default-<router> 
or default-cgmesh. Use these groups to upload and install firmware images on member devices. Add firmware groups to manage custom 
sets of devices. You can assign devices to firmware groups manually or in bulk. Before deleting a firmware group, you must move all devices 
in the group to another group. You cannot delete non-empty groups.

Note: When creating firmware groups note the following caveats:

 CGRs, IR800s, and C800s can coexist on a network; however, for firmware management, they cannot belong to the same firmware 
group. 

 IR500s and other mesh endpoint devices can coexist on a network; however, for firmware management, they cannot belong to the same 
group.

The Groups tab on the Config > Firmware Update page displays various device metrics.

IoT FND displays this information about the image on the FARs in the selected firmware group:

For every FAR in the group, IoT FND displays this information:

Field Description

Selected Firmware Image The name of the current image zip archive or the image being uploaded to group members.

Current Action The name of the firmware action being performed.

Current Status The status of the image uploading. Possible statuses are: 

 Image Loading, Upload Paused, Upload Stopped, Upload Finished, Upload Stopping, Upload 
Pausing

 Scheduling Reload, Reload Paused, Reload Stopped, Reload Scheduling Finished, Reload 
Stopping, Reload Pausing

 Setting Backup, Backup Paused, Backup Stopped, Backup Finished, Backup Stopping, Backup 
Pausing

Written/Devices Specifies how many devices received or installed the image out of the total number of devices in the 
group.

For example, 1/3 means that one device received the firmware image out of 3 devices in the group.

Error/Devices Specifies how many devices failed to receive or install the image out of the total number of devices 
in the group. For example, 2/3 means that two out of the three devices in the group failed to install 
the image. 

Tip: Click the Error/Devices link (1 in Figure 1) to view the devices that are in the errored state. 

Field Description

Status Device status of the (for example, Up, Down, or Unheard).

Name EID of the device. 

IP Address IP address of the device.

Firmware Version Version of the firmware image installed on the device.

Activity Device activity.

Update Progress Firmware image updating progress. A progress of 100% indicates that the image uploading is 
complete.

Last Firmware Status Heard The last time the firmware status was heard.

Error Message Error message if image upload failed.

Error Details Displays error details for the selected device.
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Tip: Click the Error/Devices link (1 in Figure 1) to apply a filter (3). Click the Clear (2) button to revert to an unfiltered view of the selected 
device group.

Figure 1 Firmware Update Page – Errored Devices

Adding Firmware Groups
To add a firmware group:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select default-cgr1000, default-c800, default-ir500, default-ir800, or default-cgmesh.
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4. Click Add Group ( ) at the top-right of the FIRMWARE GROUPS pane.

5. In the Add Group dialog box, enter the name of the firmware group. Device Category is dependent on the device type you select in 3..

6. Click Add.

The new group label appears under the corresponding device type in the FIRMWARE GROUPS pane.

To assign devices to the new group, see Assigning Devices to a Firmware Group.

Assigning Devices to a Firmware Group
This section describes moving devices, and includes the following topics:

 Moving Devices to Another Group Manually

 Moving Devices to Another Group In Bulk

Moving Devices to Another Group Manually

To manually move devices to a group:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the desired firmware group based on device type.

Note: If this is an ENDPOINT firmware group, click the Devices tab above the main pane.
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4. Check the check boxes of the devices that you want to move.

5. Click Change Firmware Group.

6. From the Firmware Group drop-down menu, choose the firmware group to which you want to move the devices or enter a new group 
name.

7. Click Change Firmware Group. 

8. Click Close.
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Moving Devices to Another Group In Bulk

To move devices from one group to another in bulk:

1. Create a CSV or XML file listing devices that you want to move using the format shown in the following examples: 

Note: Each file can only list one device type.

2. Choose Config > Firmware Update.

3. Click the Groups tab.

4. Click Assign Devices to Group.

5. Click Browse and locate the device list CSV or XML file. 

6. From the Group drop-down menu, choose the destination group.

7. Click Change Group.

IoT FND moves the devices listed in the file from their current group to the destination group.

DeviceType/EID for CGRs:

eid
CGR1120/k9+JS1
CGR1120/k9+JS2
CGR1120/k9+JS3

EID only for MEs:

eid
00078108003c1e07
00078108003C210b

EID only for IR800s

eid
ir800

EID only for ISR 800s:

eid
C819HGW-S-A-K9+FTX174685V0
C819HGW-S-A-K9+FTX174686V0
C819HGW-S-A-K9+FTX174687V0

EID only for IR500s:

eid
da1
da2
da3
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8. Click Close.

Renaming a Firmware Group
To rename a firmware group:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the firmware group to rename.

4. Move the cursor over the group and click the Edit Group Name pencil icon.

5. In the Rename Group window, enter the new name and then click OK.

Note: As shown above, when you enter an invalid character entry (such as, @, #, !, or +) within a field, IoT FND displays a red alert 
icon, highlights the field in red, and disables the OK button.

Deleting Firmware Groups
Note: Before deleting a firmware group, you must move all devices in the group to another group. You cannot delete non-empty groups.

To delete a firmware group:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the firmware group to delete.

4. Move the cursor over the group and click Delete Group ( ).
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5. To confirm deletion, click Yes.

6. Click OK.

Working with FAR Firmware Images
This section describes how to add FAR firmware images to IoT FND and how to upload and install the images on FARs, and includes the 
following topics:

 Viewing Firmware Image Files in IoT FND

 Adding a Firmware Image to IoT FND

 Uploading a Firmware Image to a FAR Group

 Canceling FAR Firmware Image Upload

 Pausing and Resuming FAR Firmware Image Uploads

 Installing a Firmware Image

 Stopping Firmware Image Installation

 Pausing and Resuming FAR Firmware Image Installation

 Excluding Subnets from Firmware Image Installation and Other Actions

Viewing Firmware Image Files in IoT FND
You can display firmware image information from the Images pane in the Config > Firmware Update page. Select ROUTER or 
ENDPOINT to display all firmware images for those devices in the IoT FND database. Select the firmware image type to refine the display. 
For example, Figure 2 shows that selecting ENDPOINT > BBU displays the available BBU firmware image file name and version, and 
supported Hardware ID.
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Figure 2 Config > Firmware Update Images Pane

For every image in the list, IoT FND provides this information:

Adding a Firmware Image to IoT FND
Before you can upload and install a firmware image on a device, add the image file (as a zip archive) to IoT FND. IoT FND stores the image 
in its database. 

Note: Do not unzip the image file. IoT FND unzips the file.

To add a firmware image to IoT FND:

1. Choose Config > Firmware Update.

2. Click the Images tab (Figure 2).

3. In the Firmware Images pane, select ROUTER or ENDPOINT, and the type of device group.

4. Click Add Image ( ).

5. Click Browse to locate the firmware image. Select the image, then click Choose.

6. Click Upload.

The image appears in the Firmware Images pane.

Field Description

Name The filename of the firmware image bundle.

Version The version of the firmware bundle.

Hardware ID The hardware family to which you can download this image.

Size The size of the firmware bundle.

Active Download The active firmware using the firmware image.
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Uploading a Firmware Image to a FAR Group
When you upload a firmware image to FAR firmware group members, IoT FND pushes the image to the group members in the background 
and tracks the upload progress to ensure that the devices receive the image.

On FARs, firmware image upload and installation requires 200 MB of free disk space. IoT FND stores image files in the .../managed/images 
directory on the FAR. 

Note: If there is not enough disk space on the FAR for the firmware image, the IoT FND initiates disk cleanup process on the FAR and 
removes the following files, sequentially, until there is enough disk space to upload the new image:

 Unused files in the .../managed/images directory that are not currently running or referenced in the before-tunnel-config, 
before-registration-config, express-setup-config, and factory-config files for IOS CGRs; golden-config, ps-start-config, 
express-setup-config, or factory-config for CG-OS CGRs

 Unused .gbin and .bin files from the bootflash directory in CG-OS CGRs

If there is still not enough space, you must manually delete unused files on the FAR.

To upload a firmware image to FAR group members:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the firmware group to update.

Note: CGR groups can include devices running Cisco IOS and CG-OS. Therefore, Cisco IOS software images only upload to devices 
running Cisco IOS (IR800s, ISR800s, CGRs); only CGRs accept CG-OS images.

IoT FND displays the firmware image type applicable to the router:

 To delete an image, click its Delete link. Click Yes to confirm.

Firmware images with a download in progress (with Yes in the Active Download? column) cannot be deleted.

 To upload the firmware image to devices in a group, select the group and then click Upload Image. See Uploading a Firmware 
Image to a FAR Group.

Image Type Applicable Device

CDMA all Cisco IOS CGRs, IR800s, and ISR800s

CGOS cgr1000 Cisco IOS CGRs running Guest OS

GSM all Cisco IOS CGRs, IR800s, and ISR800s

IOS-CGR cgr1000 Cisco IOS CGRs (CGR 1240 and CGR 1120)
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4. Click Upload Image to open the entry panel.

5. From the Select Type: drop-down menu, choose the firmware type for your device.

6. From the Select an Image: drop-down menu, choose the firmware bundle to upload.

For some IOS-CGR software bundles, you might have the option to select one of the following options: 

— Install Guest OS from this bundle

— Install WPAN firmware from this bundle

7. Click Upload Image.

8. Click OK.

IoT FND starts the upload process. After the image uploads, install the image as described in Installing a Firmware Image.

Canceling FAR Firmware Image Upload
You can stop the image upload process to firmware router groups at any time. Stopping the upload can take a few minutes. When you cancel 
the image upload, the image upload process immediately stops currently running tasks, and blocks all queued tasks.

Note: Running tasks do not complete, leaving partial files on the disk and sets the firmware group status to CANCELING until you complete 
the upload operation. 

To stop firmware image uploading to a group:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the firmware group.

4. Click Cancel.

5. Click Yes.

Pausing and Resuming FAR Firmware Image Uploads
You can pause the image upload process to FAR firmware groups at any time, and resume it later. 

Note: The image upload process does not immediately pause; all queued (but not running) operations pause, but currently running tasks 
complete. The status changes to PAUSING until the active operations complete.

To pause firmware image upload:

1. Choose Config > Firmware Update.

IOS-C800 c800 Cisco 800 Series ISR connected devices.

IOS-AP800 ap800 Cisco 800 Series Access Points.

IOS-IR800 ir800 Cisco 800 Series ISRs.

IOS-WPAN-RF cgr1000 Cisco IOS-CGR

IOS-WPAN-PLC cgr1000 Cisco IOS-CGR

LORAWAN lorawan Cisco IR829-GW

Image Type Applicable Device
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2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the firmware group.

4. Click Pause.

The Status column displays PAUSING until the active upload operations complete. No new upload operations start until you click the 
Resume button. 

5. Click Yes.

To resume the upload process, click Resume.

Note: If a IoT FND server goes down while the firmware image is being uploaded to devices, the server resumes the upload process for the 
scheduled devices after the server comes up. For IoT FND server clusters, if one server goes down during the upload process, another server 
in the cluster resumes the process.

Installing a Firmware Image 
To install an image on devices in a router firmware group:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the firmware group.

Note: IoT FND recognizes devices as firmware-specific, and uploads the proper image to selected devices. 

4. In the FIRMWARE IMAGES pane, select a device subgroup (such as IOS-CGR, IOS-WPAN-RF, CDMA) to refine the display to those 
device types.

This step above is necessary because IoT FND recognizes devices as firmware-specific and ensures the system uploads the proper 
image to selected devices.

5. At the Config > Firmware Update page, click the Groups tab; and, then Install Image on the Firmware Upgrade tab.

IoT FND sends commands to install the uploaded image and make it operational.

6. Click Yes.

IoT FND starts the installation or reloading process.

Note: If you restart IoT FND during the image installation process, IoT FND restarts the firmware installation operations that were running 
prior to IoT FND going offline.

You can pause or stop the installation operation as described in:

 Stopping Firmware Image Installation 

 Pausing and Resuming FAR Firmware Image Installation

 Excluding Subnets from Firmware Image Installation and Other Actions

Note: The firmware installation operation can time out on some routers. If routers are not heard from for more than an hour, IoT FND logs 
error messages.

Stopping Firmware Image Installation
You can stop firmware image installation at any time. When you stop image installation, the running version of the firmware remains in 
place.
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Note: Stopping the installation cancels all queued tasks. Currently running tasks complete.

To stop firmware image installation to devices in a firmware group:

1. Choose Config > Firmware Update.

2. Click Groups.

3. In the FIRMWARE GROUPS pane, select the firmware group.

4. Click Cancel.

5. Click Yes.

Pausing and Resuming FAR Firmware Image Installation
You can pause the firmware image installation process at any time.

Note: Pausing the installation pauses all queued tasks. Currently running tasks complete.

To pause firmware image installation to devices in a firmware group:

1. Choose Config > Firmware Update.

2. In the FIRMWARE GROUPS pane, select the firmware group.

3. Click Pause.

4. Click Yes.

You can resume the installation process by clicking Resume.

Excluding Subnets from Firmware Image Installation and Other Actions
At the Config > Firmware Update page (bottom of page), you can sort entries (ascending/descending).

You can define filters for the Pan Id and Subnet Prefix by hovering over the column name to expose an arrow, which allows you define the 
action; and, view details of a subnet such as Pan Id, Subnet Prefix, Nodes in group, Total in subnet, Upload Status and Last Message sent.

You can exclude a subnet from a firmware upgrade installation or other action by selecting the Pan Id for that subnet.

When you select a check box for a Pan Id, that subnet will be excluded from the firmware action.
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Performing OS Migrations
You can upgrade CGRs from CG-OS to IOS in bulk or by device. The migration package is in the IoT Field Network Director installation 
package, and is available in the Select IOS Image menu. 

Note: The Migration to IOS button is disabled if all CGRs in the group are IOS. 

BEFORE YOU BEGIN

For CG-OS CGRs that you are migrating, modify the device configuration properties CSV or XML file to include the following IOS 
properties (see Changing Device Configuration Properties, page 203):

EXAMPLE BOOTSTRAP PROPERTIES 

This example preserves tunnels during migration:

enable
!
configure terminal
!
!
!
interface GigabitEthernet2/2

no switchport
ip address 66.66.0.75 255.255.0.0
duplex auto
speed auto
no shut

!
crypto key generate rsa label LDevID modulus 2048
!
hostname IOS-IOT1
!
enable password cisco
!
aaa new-model
!
!
aaa authentication login default local
aaa authorization exec default local 
!
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!
aaa session-id common
clock timezone PDT -8 0
!
!
no ip domain lookup
ip domain name ios.com
ip host nms.sgbu.cisco.com 55.55.0.5
ip host ps.sgbu.cisco.com 55.55.0.8
ip cef
ipv6 unicast-routing
ipv6 cef
!
!
!
crypto pki profile enrollment NMS
enrollment url  http://55.55.0.17/certsrv/mscep/mscep.dll
!
crypto pki trustpoint LDevID

enrollment mode ra
enrollment profile NMS
serial-number none
ip-address none
password
fingerprint 1D33B1A88574F11E50F5B758EF217D1D51A7C83F
subject-name CN=mig.ios.com/serialNumber=PID:CGR1240/K9 SN:JAF1712BCAP
revocation-check none
rsakeypair LDevID 2048

!
!
!
license accept end user agreement
license boot module cgr1000 technology-package securityk9
license boot module cgr1000 technology-package datak9
!
!
!
username admin password 0 cisco
username cg-nms-administrator privilege 15 secret Sgbu123!
!
!
do mkdir flash:archive
#await Create directory filename
#send_CR
!
!
archive

path flash:archive/
maximum 8

!
!
!
no ip http server
ip http authentication local
ip http secure-server
ip http secure-ciphersuite aes-128-cbc-sha aes-256-cbc-sha dhe-aes-128-cbc-sha dhe-aes-256-cbc-sha
ip http secure-client-auth
ip http secure-port 8443
ip http secure-trustpoint LDevID
ip http max-connections 2
ip http timeout-policy idle 600 life 86400 requests 3
ip http client connection timeout 5
ip http client connection retry 5
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ip http client source-interface GigabitEthernet2/2
ip http client secure-ciphersuite aes-128-cbc-sha aes-256-cbc-sha dhe-aes-128-cbc-sha 
dhe-aes-256-cbc-sha
!
ip route 0.0.0.0 0.0.0.0 66.66.0.8
!
!
privilege exec level 2 dir /recursive
privilege exec level 2 dir
privilege exec level 2 show memory statistics
privilege exec level 2 show memory
privilege exec level 2 show inventory
privilege exec level 2 show platform hypervisor
privilege exec level 2 show platform led summary
privilege exec level 2 show platform led
privilege exec level 2 show processes cpu
privilege exec level 2 show processes
privilege exec level 2 show environment temperature
privilege exec level 2 show environment
privilege exec level 2 show module
privilege exec level 2 show version
privilege exec level 2 show logging
privilege exec level 2 show platform
privilege exec level 2 show
!
!
wsma agent exec

profile exec
!
wsma agent config

profile config
!
!
wsma profile listener exec

transport https path /wsma/exec
!
wsma profile listener config

transport https path /wsma/config
!
cgna profile cg-nms-tunnel

add-command show hosts | format flash:/managed/odm/cg-nms.odm
add-command show interfaces | format flash:/managed/odm/cg-nms.odm
add-command show ipv6 dhcp | format flash:/managed/odm/cg-nms.odm
add-command show ipv6 interface | format flash:/managed/odm/cg-nms.odm
add-command show version | format flash:/managed/odm/cg-nms.odm
interval 10
url https://ps.sgbu.cisco.com:9120/cgna/ios/tunnel
active

!
!
cgna exec-profile CGNA-default-exec-profile

add-command event manager run no_config_replace.tcl flash:/before-tunnel-config cg-nms-tunnel 1 0
interval 1
exec-count 1

!
event manager environment ZTD_SCEP_CGNA_Profile cg-nms-tunnel
event manager environment ZTD_SCEP_LDevID_trustpoint_name LDevID
event manager directory user policy "flash:/managed/scripts"
event manager policy tm_ztd_scep.tcl type system authorization bypass
event manager policy no_config_replace.tcl type system authorization bypass
event manager environment ZTD_SCEP_Enabled TRUE
!
!
do write memory
!
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do reload in 005
#await Proceed with reload?
#send_CR
!
crypto pki authenticate LDevID
!
end

Note: You can only migrate from CG4(3) to the minimum IOS image for that device. Refer to Table 1 on page 22 for minimum IOS image 
requirements. 

To add CGR IOS images to IoT Field Network Director and upload and install the migration image on CGRs:

1. Select Config > Firmware Update, and click the Migration to IOS tab.

2. In the ROUTERS pane, select a CGR group.

3. Select the check box at the top of the devices list for group migration or individual CGRs, and click Upload Image.

4. From the Select IOS Image drop-down menu, choose the desired image, and click Upload Image.

5. Click OK to begin the upload.
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Upload progress appears in the device list. 

6. Upload the following properties files (see Installing Cisco IoT FND, page 21):

7. Click the Migrate To IOS button.

8. Click Yes to confirm and begin the migration process.

You can follow the update progress in the devices list. Error messages also appear in the devices list. You can cancel, pause, and resume 
the migration process.

Tip: If any routers fail to upgrade, restart migration on the group. IoT Field Network Director skips upgraded routers.

Interface Names After Migration
IoT Field Network Director preserves metrics for the various interfaces and associated properties during migration. Table 1 maps CG-OS 
interfaces to the corresponding IOS interfaces to preserve metrics.

 config  tunnel provisioning

 bootstrap  runtime configuration

Table 1 CG-OS-to-IOS Interface Migration Map

CG-OS Interface Corresponding IOS Interface

Wifi2/1 Dot11Radio2/1

Ethernet2/1 GigabitEthernet2/1

Ethernet2/2 GigabitEthernet2/2

Ethernet2/3 FastEthernet2/3

Ethernet2/4 FastEthernet2/4

Ethernet2/5 FastEthernet2/5
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Working with Mesh Endpoint Firmware Images
This section describes how to add ME firmware images to IoT FND, and how to upload and install the images on FARs, and includes the 
following topics:

 Uploading a Firmware Image to a Mesh Endpoint Group

 Viewing Mesh Device Firmware Image Upload Logs

 Viewing Mesh Endpoint Firmware Update Information

 Excluding Subnets from Firmware Image Installation and Other Actions

Note: IR500s and other mesh endpoint devices can coexist on a network; however, for firmware management they cannot belong to the 
same group.

Note: ENDPOINT devices can report BL/Boot Loader image types to IoT FND, but IoT FND cannot upload boot loader images to devices.

Uploading a Firmware Image to a Mesh Endpoint Group
To upload a firmware image to ME group members:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the firmware group to update.

4. Click Firmware Management.

5. Click Upload Image.

6. From the Select Type: drop-down menu, choose the firmware type for your device.

IoT FND can upload these image types to ENDPOINT devices.

Ethernet2/6 FastEthernet2/6

Wpan4/1 Wpan4/1

Serial1/1 Async1/1

Serial1/2 Async1/2

Cellular3/1 Cellular3/1

N/A GigabitEthernet0/1

Table 1 CG-OS-to-IOS Interface Migration Map

CG-OS Interface Corresponding IOS Interface

Image Type Description

RF RFLAN connected devices.

PLC Power line communication devices.

BBU Devices with battery back up. 

LMAC Local MAC connected devices.

PLC-RF PLC-Radio Frequency devices.
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7. From the Select an Image: drop-down menu, choose the firmware bundle to upload.

8. Click Upload Image.

9. Click OK.

IoT FND adds the image to the list of images in the Firmware Management pane and starts the upload process in the background.

For every image in the list, IoT FND displays the following information:

1 2 3

3
4

7
1

3
8

1 Sync membership button

2 Schedule Install and Reload button

3 Set as Backup button

Column Description

Image Image name.

Uploaded Specifies the number of devices that uploaded the image. Click the number to display a list of these devices.

Running Specifies the number of devices running this image. Click the number to display a list of these devices.

Backup Specifies the number of devices using this image as a backup. Click the number to display a list of these 
devices.

Boot Loader Specifies the boot loader image version.

LMAC Specifies the LMAC image version.

BBU Specifies the BBU image version.

Status Specifies the status of the upload process.
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Setting the Installation Schedule

To set the installation schedule:

1. Click the Schedule Install and Reload button (2).

2. Specify the date and time for the installation of the image and the rebooting of the device.

3. Click Set Reboot Time.

4. Click Yes.

Viewing Mesh Device Firmware Image Upload Logs
To view the firmware image upload logs for mesh devices:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select the mesh device firmware group.

4. Click the Logs tab.

Scheduled Reload Specifies the scheduled reload time.

Actions Provides two actions:

 Schedule Install and Reload—Schedule the installation of the loaded image and the rebooting of the ME.

 Set as Backup—Set the image as the backup image.

Column Description

 To set the selected image as the firmware image backup, click the Set as Backup button (3).

 To sync the group members in the same firmware group, click Sync Membership (1). 

 To view member devices, click the Devices tab.

 To view log files for the group, click the Logs tab.
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Viewing Mesh Endpoint Firmware Update Information

You can view the endpoint firmware update process down to the subnet level for greater visibility. To view details of firmware updates for 
mesh endpoint devices (by subnet, Pan Id or Group) in a table or histogram, during the upgrade process or after the firmware upgrade 
completes, follow these steps:

Note: For Subnet and Pan Ids, you must enter the value in the text box provided:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

3. In the FIRMWARE GROUPS pane, select a MESH DEVICES group.

4. Click the Firmware Management tab.
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Field Description

(Top, Left Panel)

Upload Image radio button Click radio button to begin the firmware upload.
Note: By default, all subnets listed at the bottom of the screen will receive the image upload.

To exclude a subnet from the firmware upload, check the box (such as 1 or 2) next to that 
subnet. For more details, see PAN ID definition below.

Current Status Status of the firmware upload (for example, Image Loading or Upload Finished).

 Image Loading, Upload Paused, Upload Stopped, Upload Finished, Upload Stopping, 
Upload Pausing

 Scheduling Reload, Reload Paused, Reload Stopped, Reload Scheduling Finished, Reload 
Stopping, Reload Pausing

 Setting Backup, Backup Paused, Backup Stopped, Backup Finished, Backup Stopping, 
Backup Pausing

Image Firmware image name.

Uploaded/Devices Number of completed, successful firmware updates against the total devices that will receive the 
updates.

Error/Devices Number of devices the operation failed (error) against the total devices in the group.
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Viewing Mesh Device Firmware Information
To view the firmware information for mesh devices:

1. Choose Config > Firmware Update.

2. Click the Groups tab.

Not Synced/Devices Number of firmware group membership non-synchronized devices against the total number of 
devices in the group.

(Right Panel) Histogram

% Completed Visual status of upload percentage completed.

Filter by Filter and display results by: Subnet, Pan ID, Group

(Bottom Panel)

All or RF All displays information about all images in the Running, uploaded and backup slot as well as 
the BBU and PLC information for all device images (RF mesh, IR500 WPAN Range Extender 
and WPAN Range Extender with BBU and PLC) in the group; and the schedule reload and status 
information.

RF displays information regarding RF mesh images in the Running, uploaded and backup slots 
as well as the schedule reload and status information.

Image Displays image file name and provides the completion percentage of the firmware upload (0 to 
100) with respect to the following states:

 Uploaded, Running, Backup, Bootloader, LMAC, BBU, Status, Sched Reload

Clear filter Click radio button to clear selected firmware image update results.

PAN ID Identifies the Personal Area Network Identifier for a group of endpoints (nodes).

To exclude a group of nodes from a new firmware upload, you must select the Pan ID check box 
next to that group of nodes before selecting the Upload Image radio button in the Firmware 
Management pane.

Note: The check boxes next to the PAN IDs are not visible during a firmware upload.

Note: You can sort PAN IDs in an ascending or descending manner or filter by PAN ID to define 
which PAN ID displays in the window by selecting the downward arrow to the right of the 
column. Select Clear Filter to leave that view.

Note: To see a listing of all nodes within a subnet, select the Device tab.

Subnet Prefix Identifies the IPv6 subnet prefix for the endpoint. To view all of the nodes within a given subnet, 
select the Devices tab.

Note: You can filter by Subnet by entering a portion of the subnet (for example, 200b:0:0) by 
selecting the downward arrow to the right of the column. Select Clear Filter to leave that view.

Nodes in Group Number of nodes within the group. In the screen shot above, there are a total of 25 nodes within 
the group, which are split across two different subnets (8 nodes in 200b:0:0:0:0:0:0:0 and 17 
nodes in 200c:0:0:0:0:0:0:0). 

Total in Subnet Number of nodes with the subnet. In the screen shot above, there are 19 nodes in the subnet.

Upload status Number of nodes out of the total nodes that have been successfully upgraded with the new 
firmware.

Last message sent Display of latest message relevant to the current firmware update process within the given PAN.

Field Description
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3. In the FIRMWARE GROUPS pane, select a MESH DEVICES group.

4. Click the Devices tab.

For every device in the group, IoT FND displays this information:

Field Description

Status Status of the device (for example, Up, Down, or Unheard).

Name EID of the device. 

IP Address IP address of the device.

Firmware Version Version of the firmware image running on the device.

Backup Version Version of the firmware image used as a backup.

Uploaded Version Version of the firmware image loaded on the device.

Member Synced? Whether the device is in sync with the rest of the group.

Activity Firmware image upload activity.

Update Progress Firmware image upload progress. An update progress of 100% indicates that the upload is 
complete.

Last Firmware Status Heard Last time the firmware status was heard.

Scheduled Reload Time The time set for upload image reloads.

Error Message Error message if image upload failed.
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Managing Tunnel Provisioning
This section describes how to configure IoT FND for tunnel provisioning, and how to manage and monitor tunnels connecting FARs (CGRs 
and C800s) and HERs, and includes the following topics.

 Overview

 Configuring Tunnel Provisioning

 Monitoring Tunnel Status

 Reprovisioning CGRs

Overview
IoT FND sends the commands generated from processing the tunnel provisioning templates to FARs and HERs to provision secure tunnels 
between them. The default IoT FND templates contain CLI commands to set up and configure GRE and IPsec tunnels. One HER can serve 
up to 500 FARs, which may include multiple tunnels with the same HER EID and name.

Note: Beginning with IoT FND Release 3.1.x, you no longer need to configure IPSec Tunnel Provisioning between FARs and HERs (as 
shown in Figure 1) prior to deployment of the FAR in your network.

Instead you can initiate ZTD with no IPSec configured by ensuring that the Tunnel Provisioning Template is empty of any CLI. This initial 
approach of bringing up your network without a factory configuration, does not preclude subsequent use of IPSec in your network.

Figure 1 Tunnels Connect FARs and their Corresponding HERs

To provision tunnels between HERs and FARs, IoT FND executes CLI tunnel configuration commands on these devices. By default, 
IoT FND provides basic tunnel configuration templates containing the CLI tunnel configuration commands. You can also use your own 
templates. Although the tunnel provisioning process is automatic, you must first complete the configuration steps outlined in Tunnel 
Provisioning Configuration Process. After that, whenever a FAR comes online, IoT FND automatically provisions it with a tunnel. Before 
you configure IoT FND for tunnel provisioning, ensure that the IoT FND TPS Proxy is installed and running.

30
23

13

IoT FND

HER

FAR FAR FAR FAR

HER
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Tunnel Provisioning Configuration Process
You must generate the keystore files on the IoT FND and TPS Proxy before configuring tunnel provisioning. Then, you configure IoT FND 
and the TPS Proxy to talk to one another (Setting Up the TPS Proxy and Configuring IoT FND to Use the TPS Proxy). 

To configure IoT FND for tunnel provisioning:

After completing the previous steps, deploy the FARs and power them on. Tunnel provisioning happens automatically.

This is the sequence of events after a FAR is turned on:

1. Upon joining the uplink network after being turned on, the FAR sends a request for certificate enrollment.

2. The FAR then requests tunnel provisioning to IoT FND through the IoT FND TPS Proxy.

3. IoT FND looks up the FAR record in the IoT FND database and determines which tunnel provisioning templates to use. IoT FND also 
looks up which HERs to which to establish a tunnel.

Notes

1. (CG-OS CGRs) Configure the DHCP servers.

Configure DHCP servers to provide unique IP addresses to IoT FND. 
The default IoT FND tunnel provisioning templates configure a 
loopback interface and the IP addresses required to create the tunnels. 

Configuring the DHCP Server for Tunnel Provisioning.

Cisco IOS CGRs use FlexVPN. Ensure that the template only 
contains addresses for the loopback interface.

2. Configure the tunnel settings.

Configure the NMS URL and the DHCP proxy client settings on the 
Provisioning Settings page in IoT FND (Admin > System 
Management > Provisioning Settings). 

Configuring Provisioning Settings.

3. (CG-OS CGRs) Configure IoT FND to accept FAR registration 
requests on first contact (call home) to request tunnel provisioning.

Cisco IOS CGRs use the CGNA service.

4. Configure HER management.

Configure HERs to allow management by IoT FND using NETCONF 
over SSH.

Configuring HERs Before Adding them to IoT FND.

5. Add HERs to IoT FND. Adding HERs to IoT FND.

6. Review the IoT FND tunnel provisioning templates to ensure that 
they create the correct type of tunnel.

7. (Optional) If you plan to use your own templates for tunnel 
provisioning, create one or more tunnel provisioning groups and 
modify the default tunnel provisioning templates.

Configuring Tunnel Provisioning Templates.

8. (CG-OS CGRs) Configure FARs to call home.

Configure FARs to contact IoT FND over HTTPS through the 
IoT FND TPS proxy.

This step is typically performed at the factory where the 
FARs are configured to contact the TPS Proxy.

9. Add FARs to IoT FND.

Import the FARs in to IoT FND using the Notice-of-Shipment XML 
file.

Adding FARs to IoT FND.

10. Map FARs to their corresponding HER. Mapping FARs to HERs.
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4. For Cisco IOS CGRs, the default templates configure the CGR to use FlexVPN. The FlexVPN client is configured on the CGR that 
will contact the HER and ask for a FlexVPN tunnel to be dynamically constructed. This is how the HER dynamically adds a new tunnel 
endpoint interface for the CGR. 

5. Before processing FAR templates, IoT FND processes the HER Tunnel Deletion template and sends the resulting commands to the 
HERs. This is done for each HER to remove existing tunnel configuration that may be associated with the FAR.

6. IoT FND uses the FreeMarker template engine to process the FAR Tunnel Addition template. The engine converts the templates to 
text, which IoT FND assumes to be CLI configuration commands (CG-OS or Cisco IOS, per the CGR). IoT FND uses these commands 
to configure and bring up one end of the tunnel on the FAR.

7. IoT FND uses the FreeMarker template engine to process the HER Tunnel Addition template. The engine converts the templates to 
text, which IoT FND assumes to be commands for configuring the tunnel on the HERs. 

8. This step is OS-specific:

The specified URL uses the IoT FND registration port (default 9121) instead of the tunnel provisioning port. The Fully Qualified Domain 
Name (FQDN) in that URL is different and resolves to an IP address that is only reachable through the tunnels.

 For Cisco IOS CGRs, if no errors occurred applying the commands generated by the templates to the FAR and HERs, IoT FND 
configures a new active CGNA profile “cg-nms-register,” and deactivates the cg-nms-tunnel profile. That cg-nms-register 
profile uses the IoT FND URL.

 For CG-OS CGRs, IoT FND re-configures the call home URL to the IoT FND URL specified in the Provisioning Settings page 
(Admin > System Management > Provisioning Settings).
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Configuring Tunnel Provisioning
This section describes how to configure IoT FND for tunnel provisioning.

 Configuring the DHCP Server for Tunnel Provisioning

 Configuring DHCP for Tunnel Provisioning Using CNR

Configuring the DHCP Server for Tunnel Provisioning 
For tunnel provisioning to succeed, configure the DHCP server used by IoT FND to supply addresses to create tunnels between the FARs 
and HERs. For example, configure the DHCP server to provide IP addresses for tunnel provisioning on a permanent-lease basis.

IoT FND makes the DHCP requests based on the settings defined in the tunnel provisioning templates. During tunnel provisioning, the 
IoT FND templates can make two kinds of DHCP requests:

 Request an IP address, and then make it available to the template.

 Request a subnet with two IP addresses, and then make both addresses available to the template.

IoT FND can make these requests for IPv4 addresses and IPv6 addresses. 

The ability to request DHCP addresses from the template gives you maximum flexibility when defining tunnel configurations because you 
allocate the exact address needed for each FAR and corresponding interface on the HER. The default tunnel provisioning templates provided 
address the most common use case: one IPsec tunnel between the FAR and its corresponding HER. Each end of this IPsec tunnel gets a 
dynamically allocated IPv4 address:

 If your DHCP server supports subnet allocation, use it to obtain two addresses that belong to the same subnet.

 If your DHCP server only supports address allocation, configure it so that the two DHCP address requests return addresses that can be 
used as ends of an IPsec tunnel.

 If your routing plan calls for allocating unique IPv4 addresses for each FAR and assigning it to a loopback interface above the IPsec 
tunnel, allocate this address using the IoT FND template.

If you choose to build IPv6 GRE tunnels, allocate the IPv6 addresses for each end of the tunnel using DHCP prefix delegation or individual 
address requests.

This section describes example DHCP settings for tunnel provisioning. How you configure these settings depends on your installation. This 
section provides general guidelines for configuring the DHCP server for tunnel provisioning using the Cisco Network Registrar (CNR). 

Configuring DHCP for Tunnel Provisioning Using CNR
The CNR CLI script in the following example configures the CNR DHCP server to service requests made by the default tunnel provisioning 
templates in IoT FND. When using this script, ensure that the subnets are appropriate for your DHCP server environment.

Example CNR DHCP Server Tunnel Provisioning Script

# These commented out commands support re-applying the configuration by first 
# removing any previously applied configuration, in reverse order. This should
# not be done in a production environment, but may be useful when initially
# developing and testing a configuration. 

# scope v4address-perm delete
# dhcp-address-block v4subnet-perm delete
# prefix v6subnet-perm delete
# prefix v6address-perm delete
# policy permanent delete

# Configure the server to automatically map any IPv4 or IPv6 user class
# option values to selection tags. By default CG-NMS includes a value of
# "CG-NMS" for the user class in its requests. The tag is used to insure
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# prefixes and scopes configured to satisfy requests from CG-NMS are only
# used for that purpose.

dhcp set map-user-class-id=append-to-tags

# Since CG-NMS uses the leased addresses and subnets in router 
# configuration the addresses and subnets must be permanently allocated
# for that purpose. Create a policy that instructs the DHCP server to
# offer a permanent lease.

policy permanent create
policy permanent set permanent-leases=enabled

# Configure DHCPv6. 

# The default CG-NMS tunnel template will request IPv6 addresses for
# use with CGR loopback interfaces.

prefix v6address-perm create 2001:DB8:0:0:1::/80 dhcp-type=dhcp
prefix v6address-perm set description="Pool for leasing addresses for loopback interfaces."
prefix v6address-perm set policy=permanent
prefix v6address-perm set selection-tags=CG-NMS

# The default CG-NMS tunnel template will request IPv6 prefixes for
# use with GRE tunnels. Force use of a /127 prefix. 

prefix v6subnet-perm create 2001:DB8:0:0:2::/80 dhcp-type=prefix-delegation
prefix v6subnet-perm set description="Pool for leasing prefixes for GRE tunnels."
prefix v6subnet-perm set policy=permanent
prefix v6subnet-perm set selection-tags=CG-NMS
prefix-policy v6subnet-perm set default-prefix-length=127
prefix-policy v6subnet-perm set shortest-prefix-length=127

# Configure DHCPv4.

# The default CG-NMS tunnel template will request IPv4 subnets for
# use with IPsec tunnels. Note that currently address pools for 
# IPv4 subnet allocation can only be configured using the CLI as the
# CNR Web UI does not currently support them.

# If CNR allowed you to set a description on DHCP address blocks it would be:
# "Pool for leasing subnets for IPsec tunnels."

dhcp-address-block v4subnet-perm create 192.0.2.0/24
dhcp-address-block v4subnet-perm set default-subnet-size=31
dhcp-address-block v4subnet-perm set policy=permanent
dhcp-address-block v4subnet-perm set selection-tags=CG-NMS

# The default CG-NMS tunnel template will request IPv4 addresses for
# use with loopback interfaces.

scope v4address-perm create 198.51.100.0 255.255.255.0
scope v4address-perm set description="Pool for leasing addresses for loopback interfaces."
scope v4address-perm set policy=permanent
scope v4address-perm addRange 198.51.100.2 198.51.100.254
scope v4address-perm set selection-tag-list=CG-NMS

# Configure detailed logging of incoming and outgoing packets. This is useful when 
# debugging issues involving DHCP, however this level of logging will lower the 
# performance of the DHCP server. If this is a production server under heavy load
# it may be necessary to forgo detailed packet logging.
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dhcp set 
log-settings=missing-options,incoming-packet-detail,outgoing-packet-detail,unknown-criteria,client-deta
il,client-criteria-processing,dropped-waiting-packets,v6-lease-detail

# Save the changes and reload the server to have them take effect.
save
dhcp reload

# List the current configuration.

policy list
prefix list
dhcp-address-block list
scope list
dhcp show

Configuring Tunnel Group Settings
You use groups in IoT FND to bulk configure tunnel provisioning for FARs. By default, all FARs added to IoT FND (see Adding Devices 
in Bulk) the appropriate default group: default-cgr1000 or default-c800. Default groups contain the three templates IoT FND uses for 
tunnel provisioning. 

Topics in this section include the following:

 Creating Tunnel Groups

 Deleting Tunnel Groups

 Viewing Tunnel Groups

 Moving FARs to Another Group

 Renaming a Tunnel Group

Creating Tunnel Groups

If you plan to use one set of templates for all FARs, whether using the default templates, modified default templates or custom templates, 
do not create additional groups. To define multiple sets of templates, create groups and customize the templates for these groups.

Note: CGRs and C800s can be in the same tunnel provisioning group if your custom templates are applicable to both router types.

To create a tunnel group:

1. Choose Config > Tunnel Provisioning.

2. Click Add Group ( ).

3. Enter a name of the new group, and then click OK.

The group appears in the TUNNEL GROUPS pane.

After creating a tunnel group, the next step is to move FARs from other groups to it, as described in Moving FARs to Another Group.
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Deleting Tunnel Groups

Only empty groups can be deleted. Before you can delete a tunnel group, you must move the devices it contains to another group. 

To delete an empty tunnel group:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, select the tunnel group to delete.

3. Click Delete Group ( ).

4. Click Yes.

Viewing Tunnel Groups

The Tunnel Provisioning page lists information about existing tunnel groups.

Follow these steps to view the tunnel groups defined in IoT FND:

1. Choose Config > Tunnel Provisioning.

2. Click Group Members.

3. In the TUNNEL GROUPS pane, select a group.
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IoT FND displays a list of all FARs in the group. Use the list navigation buttons to scroll through the list. Table 1 describes the list fields.

Renaming a Tunnel Group

You can rename a tunnel group at any time. Cisco recommends using short, meaningful names. Names cannot be more than 250 characters 
long.

To rename a tunnel group:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, roll over the tunnel group to rename and click the Edit pencil icon ( ).

Table 1 Tunnel Group Fields

Field Description

Name FAR EID (device identifier).

Status Status of the FAR:

 Unheard—The FAR has not contacted IoT FND yet.

 Unsupported—The FAR is not supported by IoT FND. 

Note: Only CGR 1000 Series routers are supported.

 Up—The FAR is in operation.

 Down—The FAR is turned off.

Last Heard Last time the router contacted or sent metrics to IoT FND. If the router never contacted IoT FND, never 
appears in this field. Otherwise, IoT FND displays the date and time of the last contact, for example, 
4/10 19:06.

Tunnel Source Interface 1
Tunnel Source Interface 2

FAR interface used by the tunnel.

OSPF Area 1
OSPF Area 2

Open shortest path first (OSPF) areas 1 and 2.

OSPFv3 Area 1 OSPFv3 area 1.

IPsec Dest Addr 1
IPsec Dest Addr 2

IPv4 destination address of the tunnel.

GRE Tunnel Dest Addr 1
GRE Tunnel Dest Addr 2

IPv6 destination address of the tunnel.

Certificate Issuer Common 
Name

Name of the CA that issued the certificate.
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3. Enter the new name, and then click OK.

Note: As shown above, when you enter an invalid character entry (such as, @, #, !, or +) within a field, highlights the field in red, and 
disables the OK button.

Moving FARs to Another Group

You can move FARs to another group in two ways:

 Moving FARs to Another Group Manually

 Moving FARs to Another Group in Bulk

Moving FARs to Another Group Manually

To move FARs to another group manually:

1. Choose Config > Tunnel Provisioning.

2. Click the Group Members tab.

3. In the TUNNEL GROUPS pane, select the tunnel group with the routers to move.

4. Choose the device type from the Select a device type drop-down menu.

5. Check the check boxes of the FARs to move. 

To select all FARs in a group, click the check box at the top of the column. When you select devices, a yellow bar displays that 
maintains a count of selected devices and has the Clear Selection and Select All commands. The maximum number of devices you can 
select is 1000.

6. Click the Change Tunnel Group button.
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7. From the drop-down menu, choose the tunnel group to which you want to move the FARs.

8. Click Change Tunnel Group.

9. Click OK to close the dialog box.

Moving FARs to Another Group in Bulk

You can move FARs in bulk to another group by importing a CSV or XML file containing the names of the FARs to move. Ensure that the 
file contains entries in the format shown the following example:

eid
CGR1120/k9+JSM1
CGR1120/k9+JSM2
CGR1120/k9+JSM3
CGR1120/k9+JSM4
C819HGW-S-A-K9+FTX174685V0

The first line is the header, which tells IoT FND to expect FAR EIDs in the remaining lines (one FAR EID per line).

To move FARs to another group in bulk:

1. Create a CSV or XML file with the EIDs of the devices to move to a different group.

2. Choose Config > Tunnel Provisioning.

3. Click Assign Devices to Group.
296



 

Managing Tunnel Provisioning

  
4. Click Browse and locate the file that contains the FARs that you want to move.

5. From the Group drop-down menu, choose the destination tunnel group.

6. Click Change Group.

7. Click Close.

Configuring Tunnel Provisioning Templates
IoT FND has three default tunnel provisioning templates:

 Field Area Router Tunnel Addition—IoT FND uses this template to generate the CLI configuration commands for creating one end of 
an IPsec tunnel on the FAR.

 Head-End Router Tunnel Addition—IoT FND uses this template to generate the CLI configuration commands for creating the other 
end of the IPsec tunnel on the HER.

 Head-End Router Tunnel Deletion—IoT FND uses this template to generate the CLI configuration commands for deleting any existing 
tunnel to the FAR at the other end of the tunnel.

Tunnel Provisioning Template Syntax

The IoT FND tunnel provisioning templates are expressed with the FreeMarker syntax. FreeMarker is an open-source Java-based engine 
for processing templates and is built into IoT FND. As shown in Figure 2, FreeMarker takes as input the tunnel provisioning template and 
data supplied by IoT FND, and generates CLI commands that IoT FND runs on the FARs and HERs in the “configure terminal” context. 
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Figure 2 CLI Command Generation from Templates in IoT FND

In IoT FND, the tunnel provisioning templates consist of router CLI commands and FreeMarker variables and directives. The use of 
FreeMarker syntax allows IoT FND to define one template to provision multiple routers. 

This section describes the basic FreeMarker syntax in the tunnel provisioning templates. For information about FreeMarker visit 
http://freemarker.sourceforge.net/.

 Template Syntax

 Data Model

Template Syntax

Table 2 describes the syntax in the default tunnel provisioning templates.

IoT FND
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FreeMarker
Engine

Tunnel
Provisioning

Template

NMS
Database

CLI
Commands FAR/ASR

Table 2 Tunnel Provisioning Template Syntax

Component Description

Text Unmarked text is carried through as CG-OS CLI configuration commands for FARs and Cisco IOS CLI 
commands for HERs.

Interpolations ${variable} 

FreeMarker replaces this construct with the value of a string variable that IoT FND supplies. In this example, 
IoT FND provides the EID of the FAR:

description IPsec tunnel to ${far.eid}

Default Values ${variable!"Default"} 

FreeMarker replaces this construct with the value of a string variable. If the variable is not set, FreeMarker 
replaces this construct with Default.

Conditionals <#if condition> output1 <#else> output2 </#if>

FreeMarker uses this construct to determine the text to use in the output. For example:

<#if far.ipsecTunnelDestAddr1??>
      <#assign destinationAddress=far.ipsecTunnelDestAddr1>
    <#else>
      <#assign destinationAddress=

her.interfaces("GigabitEthernet0/0/0")[0].v4.addresses[0].address>
</#if>

Iteration over lists <#list list as variable> ${variable} </#list>

FreeMarker uses this construct to iterate over a list.

Comments <#-- this is a comment -->

FreeMarker allows comments, but does not retain them in the output.
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Data Model

This section describes the data model in the tunnel provisioning templates. The far and her prefixes provide access to the properties of the 
FARs and HERs, respectively. These properties are stored in the IoT FND database. Table 3 describes referencing the information provided 
by the data model in tunnel provisioning templates.

Assign statements <#assign name=value>

This construct declares a local variable within the template and assigns a value to it. After that, use this construct 
to reference the variable:

${name}

For example:

<#assign interfaceNumber=0>
...
interface Tunnel${interfaceNumber}

Macros These constructs are similar to function calls. 

<#macro name(param1,param2, … ,paramN)>

… ${param1} …

</#macro>

Here is an example of a macro definition:

<#macro configureTunnel(interfaceNamePrefix,ospfCost)>
  <#assign wanInterface=far.interfaces(interfaceNamePrefix)>
  <#if (wanInterface[0].v4.addresses[0].address)??>

<#assign interfaceName=wanInterface[0].name>
    interface Tunnel${her.unusedInterfaceNumber()}
      description IPsec tunnel to ${far.eid}

...
ip ospf cost ${ospfCost}
...

</#macro>

Macro calls To call macros in a tunnel provisioning template:

<@name param1, param2 … paramN>

FreeMarker replaces the macro call with the output of the macro after resolving all variables. 

For example:

<@configureTunnel far.tunnelSrcInterface1!"Wimax", 100/>

Table 2 Tunnel Provisioning Template Syntax (continued)

Component Description

Table 3 Data Model

Property Description

far.eid Returns the EID of the FAR. For example:

${far.eid}

far.hostname Returns the hostname of the FAR.

far.tunnelSrcInterface1 Returns the name of the FAR interface on which to establish the tunnel.
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far.ipsecTunnelDestAddr1 Returns the name of the tunnel destination IP address on the HER.

far.ipv4Address(clientId, linkAddress, userClass) Returns an IPv4 address. The IPv4 address method takes these parameters as input:

 clientId — DCHP Client Identifier for the DHCP request

 linkAddress — Link address for the DHCP request

 userClass — Value for the DHCP User Class option (defaults to “CG-NMS”)

To establish a loopback interface and assign it an address:

interface Loopback0
ip address ${far.ipv4Address(dhcpClientId(far.enDuid, 0), 
far.dhcpV4LoopbackLink).address}/32  
ipv6 address ${far.ipv6Address(far.enDuid, 0, 
far.dhcpV6LoopbackLink).address}/128
exit

far.ipv4Subnet() Returns a DHCP IPv4 subnet lease. This call takes a clientId and linkAddress as 
arguments. 

Construct the clientId from the FAR EID and interface ID number using the 
dhcpClientId() method provided in the template API. This method takes as input a 
DHCPv6 Identity Association Identifier (IAID) and a DHCP Unique Identifier 
(DUID) and generates the DHCPv4 client identifier, as specified in RFC 4361. This 
method provides consistency for how network elements are identified by the DHCP 
server.

For example:

<#assign lease=far.ipv4Subnet(dhcpClientId(far.enDuid,iaId),
far.dhcpV4TunnelLink)>

far.[any device property] Returns the value of the specified property. 

For example, far.tunnelSrcInterface1 returns the value of the FAR 
tunnelSrcInterface1 property.

far.interfaces(interfaceNamePrefix) Returns a list of interfaces discovered from the device that with that prefix (not case 
sensitive).

Use square brackets to index list members for example, [0], [1], [2], and so on. Use 
the <#list> construct to iterate list members.

For example:

<#assign wanInterface = far.interfaces(interfaceNamePrefix)>
  <#if (wanInterface[0].v4.addresses[0].address)??>
...

Table 3 Data Model (continued)

Property Description
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Addresses

Table 4 describes referencing addresses in the tunnel provisioning templates.  

Configuring the Field Area Router Tunnel Addition Template

To edit the FAR Tunnel Addition template to provide one end of an IPsec tunnel on FARs in the group:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, select the tunnel group with the template to edit.

3. Click the Field Area Router Tunnel Addition tab.

4. Modify the default template.

Tip: Use a text editor to modify templates and copy the text into the template field in IoT FND.

5. Click Save Changes.

Table 4 Address References

Property Description

address.address Returns the address of the interface.

address.prefixLength Returns the prefix length of the address.

address.prefix Returns the address prefix.

address.subnetMask Returns the subnet mask for the address.

address.wildcardMask Returns the wildcard mask for the subnet.
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6. Click OK to confirm the changes.

See also, Tunnel Provisioning Template Syntax.

Configuring the Head-End Router Tunnel Addition Template

Note: To ensure that both endpoints are in a matching subnet, this template must use the same IAID as the FAR template.

To edit the HER Tunnel Addition template to create the other end of the IPsec tunnel on HERs in the group:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, select a tunnel group.

3. Click the Head-End Router Tunnel Addition tab.

4. Modify the default HER addition template.

5. Click Save Changes.

6. Click OK to confirm the changes.

Configuring the HER Tunnel Deletion Template

To edit the HER tunnel deletion template to delete existing tunnels to FARs at the other end of the tunnel:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, select the tunnel group whose template to edit.
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3. Click the Head-End Router Tunnel Deletion tab.

4. Modify the default HER deletion template.

5. Click Save Changes.

6. Click OK to confirm the changes.

Monitoring Tunnel Status
To view tunnel status, choose Operations > Tunnel Status. The Tunnel Status page lists devices and their provisioned tunnels and displays 
relevant information about tunnels and their status. Tunnels are provisioned between HERs and FARs.

When you select Show Filter at the top of the page, a number of search fields appear. You can filter by all the Field Names listed in Table 5. 
The value entered in one search field, will determine the available selections in the other fields. Select Hide Filter to remove the search 
fields.
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Table 5 describes the tunnel status fields. To change the sort order of tunnels in the list by name, click the HER Name column heading. A 
small arrow next to the heading indicates the sort order.

Note: It takes time for the status of the newly created tunnel to be reflected in IoT FND

..

Reprovisioning CGRs
In IoT FND, CGR reprovisioning is a process for modifying the configuration files on CGRs.

Table 5 Tunnel Status Fields

Field Description

HER Name The EID of the HER at one end of the tunnel. To view the HER details, click its EID. 

Note: Because one HER can serve up to 500 FARs, there may be multiple tunnels in the list with the same 
HER EID. 

The Network Interfaces area of the Device Info page displays a list of tunnels configured on the HER. The 
Config Properties and Running Config tabs also contain information about tunnels configured on this HER.

HER Interface The name of the HER tunnel interface. These names are automatically generated when tunnels are created 
(Tunnel1, Tunnel2, Tunnel3, and so on).

Admin Status The administrative status of the tunnel (up or down). This indicates if the administrator enabled or disabled 
the tunnel.

Oper. Status The operational status of the tunnel (up or down). If the tunnel is down, traffic does not flow through the 
tunnel, which indicates a problem to troubleshoot. Ping the HER and FAR to determine if they are online, 
or log on to the routers over SSH to determine the cause of the problem. 

Protocol The protocol used by the tunnel (IPSEC, PIM, or GRE).

HER Tunnel IP Address The IP address of the tunnel at the HER side. Depending on the protocol used, the IP address appears in 
dotted decimal (IPv4) or hexadecimal (IPv6) slash notation.

HER IP Address The destination IP address of the tunnel on the HER side.

FAR IP Address The destination IP address of the tunnel on the FAR side.

FAR Interface The name of the interface on the FAR used by the tunnel. 

FAR Tunnel IP Address The IP address of the tunnel on the FAR side. 

Note: The IP addresses on both sides of the tunnel are on the same subnet.

FAR Name The EID of the FAR. To view the FAR details, click its EID. 

The Network Interfaces area of the Device Info page displays a list of tunnels configured on the FAR. The 
Config Properties and Running Config tabs also contain information about tunnels configured on this FAR.
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 CGR Reprovisioning Basics

 Tunnel Reprovisioning

 Factory Reprovisioning

Note: C800s do not support reprovisioning.

CGR Reprovisioning Basics
 CGR Reprovisioning Actions

 CGR Reprovisioning Sequence

CGR Reprovisioning Actions

In IoT FND, you can perform the following two CGR reprovisioning actions in the Reprovisioning Actions pane of the Tunnel Provisioning 
page (Config > Tunnel Provisioning). 

You can also activate the mesh firmware on this page.

Reprovisioning Actions Description

Factory Reprovisioning Change the express-setup-config file loaded on the CGR during factory configuration.

This file contains a minimal set of information and is loaded on the CGR at the factory. This file provides the 
CGR with information to contact IoT FND (call home) through the TPS Proxy after the CGR is deployed and 
powered on.

Tunnel Reprovisioning Change the golden-config file on a CGR. This file has the tunnel configuration defined on the CGR.
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Table 6 describes the fields on the Reprovisioning Actions pane.

CGR Reprovisioning Sequence

When you start tunnel or factory reprovisioning on a tunnel provisioning group, the reprovisioning algorithm sequentially goes through 12 
CGRs at a time and reprovisions them. 

After IoT FND reprovisions a router successfully or if an error is reported, IoT FND starts the reprovisioning process for the next router in 
the group. IoT FND repeats the process until all CGRs are reprovisioned.

There is a timeout of 4 hours when reprovisioning each CGR in the group. If the CGR does not report successful reprovisioning or an error 
within the timeout period, then IoT FND changes the Reprovisioning Status of the CGR to Error and displays a timeout error and any further 
information displays in the Error Details field.

Tunnel Reprovisioning
If you make changes to the Field Area Router Tunnel Addition template and want all CGRs already connected to IoT FND reprovisioned 
with new tunnels based on the modified template, use the tunnel reprovisioning feature of IoT FND. 

Tunnel reprovisioning places the CGR in a state where no tunnels are configured, and then initiates a new tunnel provisioning request. To 
reprovision tunnels, IoT FND sequentially goes through the FARs (12 at a time) in a tunnel provisioning group. For every CGR, IoT FND 
rolls back the configuration of the CGR to that defined in the ps-start-config template file.

After a rollback to ps-start-config, the CGR contacts IoT FND to request tunnel provisioning. IoT FND processes the Field Area Router 
Tunnel Addition template and sends the resultant configuration commands for creating new tunnels to the CGR. As shown in Figure 3, the 
tunnel provisioning process includes updating the golden-config file to include the new configuration information.

Table 6 Reprovisioning Actions Pane Fields

Field Description

Current Action The current reprovisioning action being performed.

Reprovisioning Status The status of the reprovisioning action.

Completed devices /All Scheduled Devices The number of CGRs that were processed relative to the number of all CGRs 
scheduled to be processed.

Error devices/ All Scheduled Devices The number of CGRs that reported an error relative to the number of all CGRs 
scheduled to be processed.

Name The EID of the CGR.

Reprovisioning Status The status of the reprovisioning action for this CGR.

Last Updated The last time the status of the reprovisioning action for this CGR was updated.

Template Version The version of the Field Area Router Factory Reprovision template being applied.

Error Message The error message reported by the CGR, if any.

Error Details The error details.
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Figure 3 Tunnel Reprovisioning Process

Note: For CG-OS CGRs, a rollback results in a reload of the CGR. Also, when IoT FND rolls back a CGR, IoT FND removes the 
corresponding tunnel information from the HERs to which the CGR was connected. 

You perform a configuration replace for Cisco IOS based CGRs.

Note: The Field Area Router Factory Reprovision template is not used when performing tunnel reprovisioning.

To configure and trigger tunnel reprovisioning:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, select the tunnel group whose template to provision.

3. Click the Reprovisioning Actions tab.
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4. From the Action drop-down menu, choose Tunnel Reprovisioning.

5. Click Start.

IoT FND changes the Reprovisioning Status field to Initialized, and then to Running.

Note: If you click Stop while tunnel reprovisioning is running, IoT FND stops the reprovisioning process only for the FARs in the 
queue that were not selected. However, for those CGRs in the queue that were selected for reprovisioning, the process completes 
(success or error) and cannot be stopped.

The reprovisioning process completes after IoT FND finishes attempting to reprovision each CGR in the tunnel provisioning group. If 
a CGR cannot be reprovisioned, IoT FND displays the error message reported by the CGR.
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Factory Reprovisioning
Use the Factory Reprovisioning feature in IoT FND to change the factory configuration of CGRs (express-setup-config).

Factory Reprovisioning involves these steps:

1. Sending the roll back command to the CGR.

2. Reloading the CGR. 

3. Processing the Field Area Router Factory Reprovision template, and pushing the resultant commands to the CGR.

4. Saving the configuration in the express-setup-config file.

After these steps complete successfully, IoT FND processes the Field Area Router Tunnel Addition, Head-End Router Tunnel Addition, and 
Head-End Router Tunnel Deletion templates and pushes the resultant commands to the CGR (see Tunnel Provisioning Configuration 
Process).

To configure and trigger factory reprovisioning:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, select the tunnel group whose template you want to edit.

3. Click the Field Area Router Factory Reprovision tab and enter the template that contains the configuration commands to apply.

Note: The Field Area Router Factory Reprovision template is processed twice during factory reprovisioning; once when pushing the 
configuration and again before saving the configuration in express-setup-config. Because of this, when making your own template, use 
the specific if/else condition model defined in the default template.
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4. Click Save Changes.

5. If needed, make the necessary modifications to the Field Area Router Tunnel Addition, Head-End Router Tunnel Addition, and 
Head-End Router Tunnel Deletion templates.

6. Click the Reprovisioning Actions tab.

7. From the Action drop-down menu, choose Factory Reprovisioning.

8. From the Interface drop-down menu, choose the CGR interface for IoT FND to use to contact the FARs for reprovisioning.
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9. From the Interface Type drop-down menu, choose IPv4 or IPv6.

10. Click the Start button.

IoT FND changes the Reprovisioning Status field to Initialized, and then to Running.

Note: If you click Stop while factory reprovisioning is running, IoT FND stops the reprovisioning process only for the FARs in the 
queue that were not selected. However, for those CGRs in the queue that were selected for reprovisioning, the process completes and 
cannot be stopped.

The reprovisioning process completes after IoT FND has finished attempting to reprovision each CGR in the tunnel provisioning group. If 
a CGR cannot be reprovisioned, IoT FND displays the error message reported by the CGR.
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Sample Field Area Router Factory Reprovision Template

This sample template changes the WiFi SSID and passphrase in the factory configuration.

<#--IMPORTANT: This template is processed twice during factory reprovisioning. The if/else condition 
described below is needed to determine which part of the template is applied.
In this example, if no schedule name wimaxMigrationRebootTimer is found in runningConfig, then the if 
part of the if/else section is applied. During the second pass, this template runs the commands in the 
else section and the no scheduler command is applied. If modifying this template, do not remove the 
if/else condition or else the template fails. -->

<#if !far.runningConfig.text?contains("scheduler schedule name wimaxMigrationRebootTimer")>

<#--Comment: This is a sample of generating wifi ssid and passphrase randomly-->

wifi ssid ${far.randomSSID("PREFIX_")}
authentication key-management wpa2
wpa2-psk ascii ${far.randomPassword(10)}
exit

feature scheduler
scheduler job name wimaxMigration
reload
exit

scheduler schedule name wimaxMigrationRebootTimer
time start +02:00
job name wimaxMigration
exit

<#else>

no scheduler job name wimaxMigration
no scheduler schedule name wimaxMigrationRebootTimer 

</#if>
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This section describes how to monitor IoT FND system activity, including the following topics:

 Using the Dashboard

 Monitoring Events

 Monitoring Issues

 Viewing Device Charts

Using the Dashboard
The IoT FND Dashboard (Figure 1) displays dashlets to provide a visual overview of important network metrics. 

Figure 1 IoT FND Dashboard

This section describes the following Dashboard features:

 Types of Dashlets

 Repositioning Dashlets

 Setting the Dashlet Refresh Interval
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 Adding Dashlets

 Removing Dashlets

 Exporting Dashlet Data

Types of Dashlets
The Dashboard displays two types of dashlets:

 Pie-chart dashlets display a ratio of device properties as a pie chart.

 Line-graph dashlets display graphs that show device counts over time.

Tip: Graphs set to intervals longer than one day may not display the data at the last datapoint exactly as shown in the matching field on the 
Device Info page. This is because data aggregation is occurring less frequently than polling to update the fields on the Device Info page. 
Set these graphs to the 6h or 1d intervals to update the data more frequently. Use intervals longer than one day to view data trends.
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Dashboard Dashlets
The IoT FND Dashboard dashlets are described below.

Dashlet Description

Router Inventory This FAR status counts pie chart displays the status distribution 
and absolute count of FARs.

Router States Over Time This line graph shows a count of the FARs and their states for the 
configured time interval.

Endpoint Inventory This endpoint status displays the proportion (and count) of 
endpoints. For example, the count of devices with an Unheard 
status relative to the other states: Up, Down, and Outage.

Endpoint States Over Time This line graph shows a count of endpoints and their states for the 
configured time interval.

Endpoint Config Group Template Mismatch Over Time This line graph shows the number of endpoints across all 
configuration groups and particular configuration groups that are 
out of sync for the configured time interval.

Endpoint Firmware Group Membership Mismatch Over Time This line graph shows the number of endpoints across all firmware 
groups and particular firmware groups that are out of sync for the 
configured time interval. 

Config Group Template Mismatch This pie chart shows the number of devices with matched and 
mismatched configuration group templates (applicable only to ME 
configuration groups).

Firmware Group Membership Mismatch This pie chart shows the number of devices with mismatched 
firmware groups (applicable only to endpoint firmware groups).

Hop Count Distribution This pie chart shows the hop count distribution for mesh devices.

Service Providers with Maximum Down Routers for Cellular 1 This dashlet displays the aggregated maximum Down Routers for 
device types CGR1000, C800 and IR800 for single modem 
routers.

Service Providers with Maximum Down Routers for Cellular 2 This dashlet will display the aggregated maximum Down Routers 
for device types CGR1000, C800 and IR800 for dual modem 
routers.

Service Providers with Maximum Routers This dashlet shows the service provider names, their associated 
cell IDs (if available), their associated total router count, and the 
count of down routers. This dashlet also displays the bandwidth 
usage and a sparkline showing the down routers over time.

Tip: Click the triangle in any column heading, select Columns in 
the context menu, and check the Down Routers Over Time 
check box to hide this column.
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Routers With Top Cellular Bandwidth Usage This bandwidth chart displays the top n routers using the 
maximum cellular bandwidth, where n is the number of top routers 
to display. It also identifies each cellular interface. Click the Filter 
button and select the number of routers to display from the Show 
drop-down list.

 Click the Last Billing Period button to display the bandwidth 
usage information for the top n routers that used the 
maximum bandwidth during last billing period.

 Click the Current Billing Period button to display the 
bandwidth usage information for the current billing period.

The start days are defined on the Billing Period Settings tab 
(Admin > System Management > Server Settings). 

Routers With Top Ethernet Bandwidth Usage This dashlet is similar to the Routers With Top Cellular Bandwidth 
Usage dashlet, except that it displays the top n routers with the 
maximum Ethernet bandwidth usage. 

Routers With Least Cellular RSSI This dashlet displays a chart of routers with the lowest RSSI values 
at the last poll, which indicates the quality of the signal strength 
and identifies each cellular interface. Use this chart to gauge the 
cellular channel conditions for FARs.

Dashlet Description
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Repositioning Dashlets
The Dashboard is configurable to display charts in your preferred arrangement. To configure the Dashboard:

 Click and drag the title bar of a chart to the desired position. 

 Click the close box to remove the chart from the page. 

 Click the interval button to do the following:

— Define an interval for line-graph chart displays. 

— Define a custom interval for line-graph chart displays.

— Select the number of devices to chart for line-graph chart displays.

— Select a series to refine data in line-graph chart displays.

— Filter line-graph chart displays by group.

 Click the Settings button in the title bar to set the refresh interval for all charts and add dashlets back to the Dashboard.

To better view dashlets in the bottom of the Dashboard, collapse a dashlet to just its title bar by clicking the dashlet show/hide button (  
). In Figure 2 the Config Group Template Mismatch dashlet is expanded in the Dashboard with several other dashlets collapsed above it. To 
refresh the Dashboard, click the Refresh button (  ). To refresh a dashlet, click its Refresh button.

Figure 2 Dashboard with Collapsed Dashlets
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Setting the Dashlet Refresh Interval
To set the refresh interval for dashlets:

1. Choose Devices > Dashboard.

2. Click the Settings button (  ).

3. Click Set Refresh Interval.

Note: On line-graph dashlets, open the filter bar and click an interval button to display metrics for that time period.

4. From the drop-down menu, choose a refresh interval.

5. Close the Dashboard Settings dialog box when finished.

Adding Dashlets
To add dashlets to the Dashboard:

1. Choose Devices > Dashboard.

2. Click the Settings button (  ).
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3. Click Add Dashlets.

Note: No dashlets display in this dialog box if all are displaying on the Dashboard.

4. Click the dashlet to add to the Dashboard.

5. Close the Dashboard Settings dialog box when finished.

Removing Dashlets
To delete dashlets from the Dashboard:

1. Choose Devices > Dashboard.

2. Click the dashlet Close button.

Using Pie Charts to Get More Information
Mouse over any segment of a pie chart to display a callout with information on that segment. Click any segment in the Router Inventory 
and Mesh Endpoint Inventory pie charts to display the devices in List View.

Setting Dashlet Time Properties
To specify the time interval for data collection for line-graph dashlets, click the interval icon (  ) in the title bar to display the 6h, 1d, 1w, 
4w, or Custom buttons. The 6h button sets the data-collection time interval to the last six hours. The 1d button sets the time interval to the 
last 24 hours.

To specify a custom time interval for a line-graph dashlet:

1. Click Custom.

2. In the From fields, specify the beginning date and time.
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3. In the To fields, specify the end date and time.

4. Click OK.

Collapsing Dashlets
Click the show/hide icon (  ) at the top-right of the dashlet to collapse it to its title bar.

Using the Series Selector
You use the Series Selector to refine line-graphs to display by device status. The device options are:

 Routers: Down, Outage, Unsupported, Unheard, and Up

 Mesh Endpoint Config Group: Config Out of Sync and Config In Sync

 Mesh Endpoint Firmware Group: Membership Out of Sync and Membership In Sync

 Mesh Endpoint States: Down, Outage, Unheard, and Up

To use the Series Selector:

1. Click Series Selector.

2. In the Series Selector dialog box, check the check boxes for the data series to show in the graph.
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3. Click Close.

Using Filters
You use filters to refine the displayed line-graph data by groups. Applied filters display after the dashlet title. 

To use the filters:

1. Click Add Filter in the line-graph dashlet pane.

2. From the first drop-down menu, choose a group type.

3. From the third drop-down menu, choose a group.

4. Click Apply.
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The pencil icon is green and the filter displays next to the dashlet name to indicate that a filter is applied.

Note: Click the Remove Filter button to remove the filter and close the filter options.

Exporting Dashlet Data
You can export dashlet data to a CSV file. 

To export dashlet data:

1. On the desired dashlet, click the export button ( ).

A browser download session begins. 

2. Navigate to your default download directory to view the export file.

The filename begins with the word “export-” and includes the dashlet name (for example, 
export-Node_State_Over_Time_chart-1392746225010.csv).

Monitoring Events
This section provides an overview of events and how to search and sort events, including the following topics:

 Viewing Events

 Filtering by Severity Level

 Advanced Event Search

 Sorting Events

 Searching By Event Name

 Searching by Labels

Viewing Events
As shown in Figure 3, the Events page (Operations > Events) lists all events for those devices that IoT FND tracks. All events are stored 
in the CG-NMS database server.
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Figure 3 Events Page

By default, the Events page displays the Events chart, which is a visual view of events in a time line. However, depending on the number 
of devices the CG-NMS server manages, this page can sometimes time out, especially when the system is fully loaded. In that case, open 
the Preferences window by choosing username > Preferences (top right), clearing the check boxes for showing chart and summary counts 
on the Events page, and clicking Apply.

To limit the amount of event data displayed on this page, use the Filter drop-down menu (at the top of the left pane). For example, you can 
show the events for the last 24 hours relative to the last 30 days, or events for a specific day within the last seven days.

To enable automatic refresh of event data to refresh every 14 seconds, check the check box next to the Refresh button. To immediately 
refresh event data click the Refresh button or the refresh icon.

Note: The amount of event data displayed on the Events page is limited by the data retention setting for events (Admin > System 
Management > Data Retention).
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All Events Pane Filters

Use the preset filters in the All Events pane to only view those event types. 

Device Events

In the left pane, IoT FND tracks events for the following devices:

 Routers

 Endpoints

 Head-end Devices

 CG Mesh Devices

 NMS Servers

 Database Servers

Event Severity Level

In the left pane, select an event severity level to filter the list view to devices with that severity level:

 Critical

 Major

 Minor

 Info

Each event type has a preset severity level. For example, a Router Down event is a Major severity level event.
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Preset Events By Device

IoT FND has a preset list of events it reports for each device it tracks. A list of those events is summarized under each device in the left pane 
on the Events page. For example, in the left pane click the show/hide icon (  ) next to Routers to expand the list of all events for routers. 

Filtering by Severity Level

To filter by severity level:

1. Choose Operations > Events.

2. Click the SEVERITY show/hide arrow.

Note: Only severity levels that have occurred display.

3. Click a severity level (CRITICAL, MAJOR, MINOR, OR INFO). 

All events of that severity level display in the Events pane.

Advanced Event Search
To use the filter to search for events:

1. Choose Operations > Events.

2. Under All Events (left pane), select an event category to narrow down your search.

3. Click the Show Filter link at the top of the main pane. 

4. Use the filter drop-down menus and fields to specify your search criteria.
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5. Click the plus button ( ) to add the search strings to the Search field.

Repeat the process of adding search strings to the Search field as needed.

6. Click Search Events or press Enter.

The search results display in the Events pane.

You can also add search strings manually, as shown in the following examples:

 To filter events by Name (EID), enter the following string in the Search Events field, as shown in Figure 3: 

name: router eid string.

Search Events by Name Filter 

Note: Note the use of the asterisk (*) wild card with this filter.

 To filter by event time period, enter the following string in the Search Events field, as shown in Figure 4:

eventTimeoperator“YYYY-MM-DD HH:MM:SS:SSS”
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Sorting Events
To sort events in ascending or descending order, mouse over any column and select the appropriate option from the heading drop-down 
menu. 

Searching By Event Name
To search by event name (for example, Battery Low):

1. Choose Operations > Events.

2. Click the device type to search for in the left pane.

3. Click the Show Filter link at the top of the right pane.

The filter fields display under the Search Events field.

4. Choose Event Name from the left drop-down menu.

Supported operators are: <, >, >=, <=, :

Note: Do not enter a space between eventTime and the operator.

Figure 4 Search Events by Time Filter Example
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5. Choose the event name from the options in the right drop-down menu.

6. Click the plus button ( ) at the right to add the filter to the Search Events field.

The filter syntax appears in the Search Events field.

7. Click the Search Events button.

The search results display in the Events pane.

Searching by Labels
Allows you to search and filter events based on Label names tagged to Field Devices.

1. Choose Operations > Events.

2. Click All Events in the left pane.

3. Click the Show Filter link at the top of the right pane.

4. Choose Label from the left drop-down menu.

5. Click the Show Filter link at the top of the right pane.
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6. Choose the event name from the options in the right drop-down menu or create your own.

7. Click the plus button ( ) at the right to add the filter to the Search Events field.

The filter syntax appears in the Search Events field.

8. Click the Search Events button.

The search results display in the Events pane.

Exporting Events 
You can export events to a CSV file to examine as a log of event severity, time, name and event description by device.

To export events:

1. Choose Operations > Events.

2. Click the desired severity level or device type in the left pane.

3. Click the Export button (  ).

A browser download session begins. 

4. Navigate to your default download directory to access the CSV file.

Events Reported
Table 1 lists the events reported by IoT FND 3.1.x (and later). Details include the event severity (Critical, Major, Minor, Information) and 
the devices that report those events.

Table 1 Events Reported

Event Devices Severity

CRITICAL EVENTS

Certificate Expired AP800, CGR1000, C800, FND, IR800 Critical

DB FRA Space Critically Low Database Critical

DB Table Space Critically Low Database Critical

Invalid CSMP Signature CGMESH, IR500 Critical

Outage Cellular, CGMESH, IR500 Critical

RPL Tree Size Critical CGR1000 Critical

SD Card Removal Alarm CGR1000 Critical

MAJOR EVENTS

AAA Failure C800, CGR1000, IR800 Major

ACT2L Failure C800, CGR1000, IR800 Major

Archive Log Mode Disabled Database Major

Battery Failure CGR1000 Major

Battery Low CGR1000, IR500 Major

BBU Configuration Failed IR500 Major

BBU Firmware Download Failed CGR1000 Major
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BBU Firmware Mismatch Found CGR1000 Major

BBU Firmware Upgrade Failed IR500 Major

BBU Lock Out IR500 Major

BBU Power Off IR500 Major

Block Mesh Device Operation Failed CGR1000 Major

Certificate Expiration AP800, C800, CGR1000, FND, IR800 Major

DB FRA Space Very Low Database Major

Default Route Lost CGMESH, IR500 Major

Device Unknown FND Major

Door Open C800, CGR1000, IR800, LORA Major

Dot1X Authentication Failure CGR1000 Major

Dot1X Authentication Flood C800, CGR1000, IR800 Major

Down AP800, ASR, C800, Cellular, CGMESH, CGR1000, 
Database, FND, IR500, IR800, ISR3900, LORA

Major

Element Configuration Failed C800, CGR1000, IR800 Major

High CPU Usage LORA Major

High Flash Usage LORA Major

High Temperature LORA Major

HSM Down FND Major

Interface Down ASR, ISR3900 Major

Linecard Failure C800, CGR1000, IR800 Major

Line Power Failure C800, CGR1000, IR800 Major

Link Down IR500 Major

Low Flash Space C800, CGR1000, IR800 Major

Low Memory/Memory Low C800, CGR1000, FND, IR800, 
LORA ( Memory Low)

Major

Low Temperature LORA Major

Mesh Connectivity Lost/ Node 
Connectivity Lost

CGMESH, IR500 Major

Mesh Link Key Timeout/ Node Link Key 
Timeout

CGMESH, IR500 Major

Metric Retrieval Failure ASR, C800, CGR1000, IR800, ISR3900 Major

Modem Temperature Cold Alarm C800, CGR1000, IR800 Major

Modem Temperature Warm Alarm C800, CGR1000, IR800 Major

Node Connectivity Lost CGMESH, IR500 Major

Node Link Key Timeout CGMESH, IR500 Major

Packet Forwarder Usage High LORA Major

Port Down AP800, C800, CGR1000, IR800 Major

Port Failure AP800, C800, CGR1000, IR800 Major

Refresh Router Mesh Key Failure CGR1000 Major

RPL Tree Size Warning CGR1000 Major

Table 1 Events Reported

Event Devices Severity
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Software Crash C800, CGR1000, IR800 Major

SSM Down FND Major

System Software Inconsistent C800, CGR1000, IR800 Major

Temperature Major Alarm C800, CGR1000, IR800 Major

Time Mismatch CGMESH, IR500 Major

Tunnel Down C800, CGR1000, IR800 Major

Tunnel Provisioning Failure C800, CGR1000, IR800 Major

Unknown WPAN Change CGMESH, IR500 Major

MINOR EVENTS

DB FRA Space Low Database Minor

Dot1X Re-authentication CGMESH, IR500 Minor

Temperature Minor Alarm C800, CGR1000, IR800 Minor

Temperature Low Minor Alarm C800, CGR1000, IR800 Minor

RPL Tree Reset CGR1000 Minor

INFORMATION EVENTS

Archive Log Mode Enabled Database Information

Battery Normal CGR1000 Information

Battery Power CGR1000 Information

BBU Firmware Download Passed CGR1000 Information

Certificate Expiration Recovery AP800, C800, CGR1000, FND, IR800 Information

Cold Boot AP800, C800, CGMESH, CGR1000, IR500, IR800 Information

Configuration is Pushed FND Information

Configuration Rollback AP800, C800, CGR1000, IR800 Information

DB FRA Space Normal Database Information

DB Table Space Normal Database Information

Device Added Cellular, C800, CGMESH, CGR1000, IR500, IR800 Information

Device Location Changed C800, CGR1000, IR800 Information

Device Removed Cellular, C800, CGMESH, CGR1000, IR500, IR800 Information

Door Close C800, CGR1000, IR800, LORA Information

Dot11 Deauthenticate Send C800, CGR1000, IR800 Information

Dot11 Disassociate Send C800, CGR1000, IR800 Information

Dot11 Authentication Failed C800, CGR1000, IR800 Information

Hardware Insertion C800, CGR1000, IR800 Information

Hardware Removal C800, CGR1000, IR800 Information

High CPU Usage Recovery LORA Information

High Flash Usage Recovery LORA Information

High Temperature Recovery LORA Information

HSM Up FND Information

Table 1 Events Reported

Event Devices Severity
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Interface Up ASR, ISR3900 Information

Line Power C800, CGR1000, IR800 Information

Line Power Restored C800, CGR1000, IR800 Information

Link Up IR500 Information

Low Flash Space OK C800, CGR1000, IR800 Information

Low Memory OK/Low Memory Recovery C800, CGR1000, IR800, LORA (Low Memory Recovery) Information

Manual Close ASR, Cellular, C800, CGMESH, CGR1000, IR500, IR800, 
ISR3900

Information

Major RPL Tree Size Warning OK CGR1000 Information

Manual NMS Address Change CGMESH, IR500 Information

Manual Re-Registration CGMESH, IR500 Information

Mesh Certificate Change/ Node 
Certificate Change

CGMESH, IR500 Information

Mesh Module Firmware Upgrade has been 
successful

CGR1000 Information

Migrated To Better PAN CGMESH, IR500 Information

Modem Status Changed LORA Information

Modem Temperature Cold Alarm 
Recovery

C800, CGR1000, IR800 Information

Modem Temperature Warm Alarm 
Recovery

C800, CGR1000, IR800 Information

NMS Address Change CGMESH, IR500 Information

NMS Returned Error CGMESH, IR500 Information

Node Certificate Change CGMESH, IR500 Information

Packet Forwarded High Usage Recovery LORA Information

Packet Forwarder Status LORA Information

Packet Forwarded High Usage Recovery LORA Information

Port Up AP800, C800, CGR1000, IR800 Information

Power Source OK C800, CGR1000, IR800 Information

Power Source Warning C800, CGR1000, IR800 Information

Registered ASR, ISR3900 Information

Registration Failure AP800, Cellular, C800, CGR1000, IR800, LORA Information

Registration Request AP800, C800, CGR1000, IR800, LORA Information

Registration Success AP800, Cellular, C800, CGR1000, IR800, LORA Information

Rejoined With New IP Address CGMESH, IR500 Information

Restoration Cellular, CGMESH, IR500 Information

Restoration Registration CGMESH, IR500 Information

RPL Tree Size Critical OK CGR1000 Information

Rule Event ASR, C800, CGMESH, CGR1000, Database, FND, IR500, 
IR800, ISR3900

Information

SSM Up FND Information

Table 1 Events Reported

Event Devices Severity
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Monitoring Issues
This section provides an overview of issues and how to search for and close issues in IoT FND, including the following topics:

 Viewing Issues

 Viewing Device Severity Status on the Issues Status Bar

 Adding Notes to Issues

 Searching Issues Using Predefined Filters

 Search Issues Using Custom Filters

 Closing an Issue

Viewing Issues
IoT FND offers different ways to monitor issues:

 The Operations > Issues page (Figure 5) provides a snapshot of the health of the network by highlighting only major and critical 
events that are active within the network. 

 The Issues Status bar (Figure 6) displays in the footer of the browser window and shows a count of all issues by severity for selected 
devices. 

Temperature Low Recovery LORA Information

Temperature Low Minor Alarm Recovery C800, CGR1000, IR800 Information

Temperature Major Recovery C800, CGR1000, IR800 Information

Temperature Low Major Alarm Recovery C800, CGR1000, IR800 Information

Temperature Minor Recovery C800, CGR1000, IR800 Information

Time Mismatch Resolved CGMESH, IR500 Information

Tunnel Provisioning Request C800, CGR1000, IR800 Information

Tunnel Provisioning Success C800, CGR1000, IR800 Information

Tunnel Up C800, CGR1000, IR800 Information

Unknown Event AP800, ASR, C800, Cellular, CGMESH, CGR1000, 
Database, FND, IR500, IR800, ISR3900, LORA

Information

Unknown Registration Reason CGMESH, IR500 Information

Unsupported AP800, C800, CGR1000, IR800, LORA Information

Up AP800, ASR, C800, Cellular, CGMESH, CGR1000, 
Database, FND, IR500, IR800, ISR3900, LORA,

Information

Warm Start IR500 Information

WPAN Watchdog Reload CGR1000 Information

Table 1 Events Reported

Event Devices Severity
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Figure 5 Issues Page

The Issues page provides an abbreviated subset of unresolved network events for quick review and resolution by the administrator. Issues 
remain open until either the associated event is resolved (and IoT FND generates a resolution event) or the administrator manually closes 
the event. 

Only one issue is recorded when multiple entries for the same event are reported. Each issue has a counter associated with it. As an 
associated event is closed, the counter decrements by one. Every open or closed issue has an associated event.

Note: The amount of closed issues data that displays on the Issues page is limited by the Keep Closed Issues for data retention setting 
(Admin > System Management > Data Retention), which is based on the time the issue was closed. When the issue was closed displays 
as the Last Update Time for the issue.

Viewing Device Severity Status on the Issues Status Bar
A tally of issues listed by severity for the selected devices displays in the Issues status bar in the bottom-right of the browser window frame 
(Figure 6). You can set the device types for issues that display in the Issues status bar in User Preferences (see Setting User Preferences). 

Figure 6 Issues Status Bar

Click the Issues status bar to view the Issues Summary pane (Figure 7), which displays issues listed by the selected device category. Click 
count links in the Issues Summary pane to view complete issue criteria filtered by severity on the Operations > Issues page.
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Figure 7 Issues Summary Pane

Adding Notes to Issues
On the Operations > Issues page, you can maintain notes on issues for the device. Click the Notes link inline with the issue to access any 
notes entered in the issue or add a note on the Notes for Issues Name page. You can and edit and delete notes from issues on this page. Issues 
can have multiple notes. The Notes for Issues Name page displays the time the note was created, the name of the user who wrote the note, 
and the text of the note. You can also add a note when closing a issue. Notes are purged from the database with the issue. 

To add a note to an issue:

1. Click the Notes link inline with the desired issue or check the check box of the device and click Add Note. 

The Notes for Issues Name pane displays. The issue in the following example has existing notes.
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2. Click Add Note.

The Add Note dialog displays.

3. Insert your cursor in the Note field and type your note. 

4. Click Add when finished.

The note text displays on the Notes for Issues Name pane in the Note column.

To add notes to issues with existing notes:

1. Click the Notes link inline with the issue or check the check box of the device and click Add Note.

The Notes for Issues Name pane displays.

2. To add a new note to the issue, click Add Note.

The Add Note dialog displays.

3. Insert your cursor in the Note field and type your note.

4. Click Add when finished.

To edit an existing note in an issue: 

1. Click the Notes link inline with the issue.

The Notes for Issues Name pane displays.

2. To edit an existing note, click the pencil icon ( ) at the right of the note that you want to edit.
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3. Edit the note, and click Done when finished.

To delete a note from an issue:

1. Click the Notes link inline with the issue.

The Notes for Issues Name pane displays.

2. To delete a note, click the red X icon ( ) at the right of the note.

3. Click Yes to confirm the deletion.

To add a note when closing an issue:

1. Check the check box of the issue to close.

2. Click Close Issue.

3. In the Confirm dialog box, insert your cursor in the Note field and type the note text.

4. To confirm that you want to close the issue and save the note, click Yes.
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Searching Issues Using Predefined Filters
To search for open issues for a specific system or severity level:

1. Choose Operations > Issues.

To list only open issues, click All Open Issues (left pane). 

Note: By default, IoT FND displays all issues that occurred within the specified data retention period (see Configuring Data 
Retention). To see Closed Issues associated with an event type or severity level, change issueStatus:OPEN to issueStatus:CLOSED 
in the Search Issues field, and then click Search Issues. To list all closed issues, in the left pane, click All Closed Issues.

2. Click a device category, event type, or severity level to filter the list.

The filter syntax appears in the Search Issues field, and the search results display in the main pane.

Search Issues Using Custom Filters
To search by creating custom filters:

1. Choose Operations > Issues.

2. Click Show Filter.

3. From the Filter drop-down menus, choose the appropriate options.

For example, to filter severity levels by EID:

You can also enter the search string in the Search Issues field. For example:

issueSeverity:CRITICAL issueStatus:OPEN eid:CG-NMS-DB+localhost

4. Click Search Issues.

The issues, if any, display in the Search Issues section (right pane). 

 In the left pane, select a severity level.

 From the first Filter drop-down menu, choose EID.

 In the third Filter field, enter the EID of the device to discover issues about.
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5. Click the Events link to display events associated with an issue.

The Events for Issue Name pane displays all events for that device. 

6. Click Search Issues or any link in the left pane to return to the Issues pane.

Closing an Issue
In most cases, when an event is resolved, the issue is closed automatically by the software. However, when the administrator has actively 
worked on resolving the issue, it might make sense to close the issue directly. When the issue is closed, IoT FND generates an event.

To close a resolved issue:

1. Choose Operations > Issues.

2. Locate the issue by following the steps in either the Searching Issues Using Predefined Filters or Search Issues Using Custom Filters 
section.

3. In the Search Issues section (right pane), check the check boxes of the issues to close.
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4. Click Close Issue.

Note: You can also add a note to the issue at this time.

5. Click Yes.

Viewing Device Charts
 Router Charts

 Mesh Endpoint Charts

Router Charts
IoT FND provides these charts in the Device Info pane on the Device Details page for any FAR:

Figure 8 shows the Mesh Link Traffic and Mesh Endpoint Count charts.

Table 2 Device Detail Charts

Chart Description

Mesh Link Traffic Shows the aggregated WPAN rate for a FAR over time.

Mesh Endpoint Count Shows the number of MEs over time.

Cellular Link Metrics Shows the metrics (transmit and receive speed), RSSI, Bandwidth Usage (current Billing 
Cycle) for all logical cellular GSM and CDMA interfaces. 

Cellular Link Settings Shows properties for cellular physical interfaces with dual and single modems.

Cellular Link Traffic Shows the aggregated WPAN rate per protocol over time.

Cellular RSSI Cellular RSSI.

WiMAX Link Traffic Shows the receiving and sending rates of the WiMAX link traffic for the FAR over time.

WiMAX RSSI Shows the receiving and sending rates of the WiMAX RSSI traffic for the FAR over time.

WPAN Traffic (Master only) Shows Dual PHY WPAN traffic trends.

Ethernet Link Traffic Shows the receiving and sending rates of the Ethernet traffic for the FAR over time.

Cellular Bandwidth Usage Over Time Shows the bandwidth usage over time for the cellular interface.

Ethernet Bandwidth Usage Over Time Shows the bandwidth usage over time for the Ethernet interface.
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Figure 8 FAR Device Charts

Mesh Endpoint Charts
IoT FND provides the charts listed in Table 3 in the Device Info pane on the Device Details page (Figure 9) for any ME.

Table 3 Device Detail Charts

Chart Description

Mesh Link Traffic Shows the aggregated WPAN rate for a FAR over time.

Mesh Path Cost and Hops Shows the RPL path cost value between the element and the root of the routing tree over time (see 
Configuring RPL Tree Polling).

Mesh Link Cost Shows the RPL cost value for the link between the element and its uplink neighbor over time.

Mesh RSSI Shows the measured RSSI value of the primary mesh RF uplink (dBm) over time.
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Figure 9 Mesh Endpoint Device Charts
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This section describes how to set up IoT FND for high availability, and includes the following sections:

 Overview of IoT FND High Availability

 HA Guidelines and Limitations

 Configuring IoT FND Installations for HA

Overview of IoT FND High Availability
This section provides an overview of IoT FND high availability installations, including the following sections:

 Load Balancer

 Server Heartbeats

 Database High Availability

 Tunnel Redundancy

IoT FND is a critical application for monitoring and managing a connected grid. IoT FND High Availability (IoT FND HA) solutions 
address the overall availability of IoT FND during software, network, or hardware failures.

IoT FND provides two main levels of HA, as shown in Figure 1:

 IoT FND Server HA—This is achieved by connecting multiple IoT FND servers to a Cisco ACE 4710 load balancer. Traffic 
originating at MEs, FARs, and ASRs goes to the load balancer, which uses a round-robin protocol to distribute the load among the 
IoT FND cluster servers.

 IoT FND Database HA—This is achieved by configuring two IoT FND Database servers: a primary server and a standby (or 
secondary) server. When the primary database receives new data it sends a copy to the standby database. A separate system runs the 
Observer (the Observer can also run on the standby server), which is a program that monitors the IoT FND Database servers. If the 
primary database fails, the Observer configures the standby server as the new primary database. IoT FND Database HA works in single 
and cluster IoT FND server deployments.
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Figure 1 IoT FND Server and Database HA

In addition to IoT FND Server and Database HA, IoT FND improves reliability by adding tunnel redundancy. This is achieved by defining 
multiple tunnels between one FAR and multiple ASRs. If one tunnel fails, the FAR routes traffic through another tunnel.

Figure 2 IoT FND Tunnel Redundancy

IoT FND HA addresses these failure scenarios:

Load Balancer
The Load Balancer (LB) plays a critical role in IoT FND HA, as it performs these tasks:

 Load balances traffic destined for IoT FND.

 Maintains heartbeats with servers in the cluster and detects any failure. If a IoT FND server fails, the LB directs traffic to other cluster 
members. 

Cisco recommends using the Cisco ACE 4710 (Cisco ACE) as the load balancer in this deployment. See 
http://www.cisco.com/en/US/partner/products/ps7027/tsd_products_support_series_home.html for information on the Cisco ACE 4710.

Failure Type Description

IoT FND server failure If a server within a IoT FND server cluster fails, the load balancer routes traffic to the other servers 
in the cluster.

IoT FND database failures If the primary database fails, the associated standby database becomes the primary database. This is 
transparent to the IoT FND servers. All IoT FND servers in the cluster connect to the new primary 
database.

Tunnel failure If a tunnel fails, traffic flows through another tunnel.
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Server Heartbeats
The LB maintains heartbeats with each IoT FND server in the cluster. In the health monitoring mechanism adopted by the IoT FND solution 
(there are alternate solutions), the heartbeats are regular GET messages to IoT FND on port 80. IoT FND expects an HTTP 200 OK response 
from an active IoT FND server. 

You can configure these heartbeat parameters on the LB:

 Periodicity of probes—This is the number of seconds between heartbeats. The default value on the Cisco ACE is 15 seconds

 Number of retries—This is the number of times the LB tries to send a heartbeat to a non-responding IoT FND server before declaring 
it down. The default number of retries is 3.

 Regular checks after failure detection—The LB checks whether the server is back online at this time interval. The default failure 
detection check value is 60 seconds.

Database High Availability
IoT FND Database HA works in IoT FND single-server and cluster deployments. IoT FND HA uses Oracle Active Dataguard to deploy 
Oracle HA. To configure HA for the IoT FND Database, use the Oracle Recovery Manager (RMAN) and Dataguard Management CLI 
(DGMGRL). 

The IoT FND Database HA configuration process involves:

 Configuring the primary and secondary databases the same on separate physical servers.

Note: The secondary database server is also referred to as the standby database.

Note: There is a possibility of losing some data during a database failover.

 Configuring data replication to be performed over SSL using an Oracle wallet. The wallet contains a self-signed certificate to facilitate 
quick deployment. 

Note: The Oracle wallet bundled with the IoT FND RPMs uses self-signed certificates. You can configure custom certificates and 
wallet to facilitate replication.

Note: There is no performance impact when performing data replication over SSL. 

 Using the sys user for replication and not cgms_dev.

 Configuring replication as asynchronous to prevent performance bottlenecks. 

By default, IoT FND connects to the database using TCP over port 1522. Replication uses TCPS (TCP over SSL) on port 1622. 

The scripts for configuring IoT FND Database HA are included in the IoT FND Oracle Database RPM package 
(cgms-oracle-version_number.x86_64.rpm). When you install the IoT FND Database, the HA scripts are located in 
$ORACLE_HOME/cgms/scripts/ha.

Tunnel Redundancy
To add another layer of redundancy to your IoT FND deployment, configure multiple tunnels to connect every FAR in a FAR tunnel 
provisioning group to multiple ASRs. For example, you could configure IoT FND to provision two tunnels for every FAR. One tunnel is 
active over the Cellular interface, while the redundant tunnel is configured to communicate with a second ASR over the WiMAX interfaces.

To configure tunnel redundancy, you need to:

1. Add ASRs to a tunnel provisioning group.

2. Modify the tunnel provisioning templates to include commands to create additional tunnels. 
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3. Define policies that determine the mapping between interfaces on the FAR and ASR interfaces:

HA Guidelines and Limitations
Note the following about IoT FND HA configurations:

 IoT FND HA does not include HA support for other network components like FARs, ASRs, and the load balancer.

 Zero service downtime is targeted by IoT FND HA, but it is not guaranteed. 

 All IoT FND nodes must on the same subnet.

 All IoT FND nodes must run on similar hardware.

 All IoT FND nodes must run the same software version.

 Run the IoT FND setup script (/opt/cgms/bin/setupCgms.sh) on all the nodes.

 Run the DB migration script (/opt/cgms/bin/db-migrate) on only one node.

 The /opt/cgms/bin/print_cluster_view.sh script displays information about IoT FND cluster members.

Configuring IoT FND Installations for HA
This section describes the various configuration settings for IoT FND HA installations, including the following sections:

 Setting Up IoT FND Database for HA

 Disabling IoT FND Database HA

 Load-Balancing Policies

 Running LB Configuration Example

 Configuring Tunnel Provisioning Policies

 Modifying the Tunnel Provisioning Templates for Tunnel Redundancy

Setting Up IoT FND Database for HA
To set up the IoT FND Database HA:

1. Set up the standby database (see Setting Up the Standby Database).

Note: Always configure the standby database first. 

 Configuring Tunnel Provisioning Policies

 Modifying the Tunnel Provisioning Templates for Tunnel Redundancy

 The default SID for the standby server is cgms_s and not cgms. 

 Before setting up the standby server for HA, ensure that the environment variable $ORACLE_SID on the standby server is set 
to cgms_s.

 The port is always 1522.
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2. Set up the primary database (see Setting Up the Primary Database).

3. Set up IoT FND for database HA (see Setting Up IoT FND for Database HA).

4. Set up the database Observer (see Setting Up the Observer).

Setting Up the Standby Database

To set up the standby database server for HA, run the setupStandbyDb.sh script. This script prompts for configuration information needed 
for the standby database, including the IP address of the primary database.

$ ./setupStandbyDb.sh
$ Are you sure you want to setup a standby database ? (y/n)? y

09-20-2012 13:59:18 PDT: INFO: User response: y
09-20-2012 13:59:18 PDT: INFO: CGMS_S database does not exist.
Enter the SYS DBA password. NOTE: This password should be same as the one set on the primary server: 
Re-enter password for SYS DBA:
09-20-2012 13:59:58 PDT: INFO: User entered SYS DBA password.

Enter new password for CG-NMS database: 
Re-enter new password CG-NMS database: 
09-20-2012 14:00:09 PDT: INFO: User entered CG-NMS DB password.
Enter primary database server IP address: 192.168.1.12
09-20-2012 14:00:27 PDT: INFO: Cleaning up instance - cgms_s
DGMGRL for Linux: Version 11.2.0.3.0 - 64bit Production
…
Total System Global Area 329895936 bytes
Fixed Size    2228024 bytes
Variable Size  255852744 bytes
Database Buffers   67108864 bytes
Redo Buffers    4706304 bytes
...
09-20-2012 14:00:29 PDT: INFO: ========== CGMS_S Database Setup Completed Successfully ==========

Setting Up the Primary Database

To set up the primary database server for HA, run the setupHaForPrimary.sh script. This script prompts for configuration information needed 
for the primary database, including the IP address of the standby database.

$ ./setupHaForPrimary.sh
[oracle@pdb ha]$ ./setupHaForPrimary.sh 
09-20-2012 13:58:39 PDT: INFO: ORACLE_BASE: /home/oracle/app/oracle
09-20-2012 13:58:39 PDT: INFO: ORACLE_HOME: /home/oracle/app/oracle/product/11.2.0/dbhome_1
09-20-2012 13:58:39 PDT: INFO: ORACLE_SID : cgms
09-20-2012 13:58:39 PDT: INFO: Make sure the above environment variables are what you expect

Are you sure you wish to configure high availability for this database server ? (y/n)? y

09-20-2012 13:58:45 PDT: INFO: User response: y
Enter standby database server IP address: 192.168.1.10
09-20-2012 13:58:56 PDT: INFO: Secondary listener reachable. Moving on with configuration
mkdir: cannot create directory `/home/oracle/app/oracle/oradata/cgms': File exists
09-20-2012 13:58:58 PDT: INFO: Reloading the listener to pick the new settings

 The default SID for the primary server is cgms. 

 Before setting up the primary server for HA, ensure that the environment variable $ORACLE_SID on the primary server is set 
to cgms.
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LSNRCTL for Linux: Version 11.2.0.3.0 - Production on 20-SEP-2012 13:58:58

…
DGMGRL> 09-20-2012 14:14:54 PDT: INFO: Please start the 'Observer' on appropriate server for ha 
monitoring
Total time taken to perform the operation: 975 seconds
09-20-2012 14:14:54 PDT: INFO: ==========  Completed Successfully ==========

Setting Up the Observer

The Observer should run on a separate server, but can be set up on the server hosting the standby database.

Note: The password required for running Observer is the same as the SYS DBA password. See Creating the IoT FND Oracle Database

To set up the Observer:

1. On a separate server, run the observer script.

$ ./manageObserver.sh start cgms_s password
$ DGMGRL for Linux: Version 11.2.0.3.0 - 64bit Production
...
Welcome to DGMGRL, type "help" for information.
DGMGRL> Connected.
DGMGRL> Observer started

2. Run the getHaStatus.sh script to verify that the database is set up for HA.

$ ./getHaStatus.sh
...
Configuration - cgms_dgconfig

Protection Mode: MaxPerformance
Databases:
cgms  - Primary database
cgms_s - (*) Physical standby database

Fast-Start Failover: ENABLED

Configuration Status:
SUCCESS

DGMGRL> 
Database - cgms

Role: PRIMARY
Intended State: TRANSPORT-ON
Instance(s):
cgms

Database Status:
SUCCESS

DGMGRL> 
Database - cgms_s

Role: PHYSICAL STANDBY
Intended State: APPLY-ON
Transport Lag:  0 seconds
Apply Lag:  0 seconds
Real Time Query: OFF
Instance(s):
cgms_s

Database Status:
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SUCCESS

Setting Up IoT FND for Database HA

To set up IoT FND for database HA:

1. Stop IoT FND.

2. Run the setupCgms.sh script.

The script prompts you to change the database settings. Enter y. Then, the script prompts you to enter the primary database server 
information (IP address, port, and database SID). After that, the script prompts you to add another database server. Enter y. Then, the 
script prompts you to enter the standby database server information (IP address, port, and database SID), as follows:

Note: IoT FND always uses port 1522 to communicate with the database. Port 1622 is only used by the database for replication.

# cd /opt/cgms/bin
# ./setupCgms.sh 
09-13-2012 17:10:00 PDT: INFO: ========== CG-NMS Setup Started - 2012-09-13-17-10-00 ==========
09-13-2012 17:10:00 PDT: INFO: Log file: /opt/cgms/bin/../server/cgms/log/cgms_setup.log

Are you sure you want to setup CG-NMS (y/n)? y

09-13-2012 17:10:02 PDT: INFO: User response: y

Do you want to change the database settings (y/n)? y

09-13-2012 17:10:05 PDT: INFO: User response: y

Enter database server IP address [128.107.154.246]: 128.107.154.246
09-13-2012 17:11:02 PDT: INFO: Database server IP: 128.107.154.246

Enter database server port [1522]: 
09-13-2012 17:11:07 PDT: INFO: Database server port: 1522

Enter database SID [cgms]: 
09-13-2012 17:11:12 PDT: INFO: Database SID: cgms

Do you wish to configure another database server for this CG-NMS ? (y/n)? y

09-13-2012 17:11:18 PDT: INFO: User response: y
Enter database server IP address []: 128.107.154.20
09-13-2012 17:11:02 PDT: INFO: Database server IP: 128.107.154.20
Enter database server port []: 1522
09-13-2012 17:11:07 PDT: INFO: Database server port: 1522
Enter database SID []: cgms_s
09-13-2012 17:11:12 PDT: INFO: Database SID: cgms_s
09-13-2012 17:11:18 PDT: INFO: Configuring database settings. This may take a while. Please wait 
...
09-13-2012 17:11:19 PDT: INFO: Database settings configured.

Do you want to change the database password (y/n)? y

09-13-2012 17:15:07 PDT: INFO: User response: y

Enter database password: 
Re-enter database password: 

09-13-2012 17:15:31 PDT: INFO: Configuring database password. This may take a while. Please wait 
...
09-13-2012 17:15:34 PDT: INFO: Database password configured.
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Do you want to change the keystore password (y/n)? n

09-13-2012 17:16:18 PDT: INFO: User response: n

Do you want to change the web application 'root' user password (y/n)? n

09-13-2012 17:16:34 PDT: INFO: User response: n

Do you want to change the FTP settings (y/n)? n

09-13-2012 17:16:45 PDT: INFO: User response: n
09-13-2012 17:16:45 PDT: INFO: ========== CG-NMS Setup Completed Successfully ==========

Disabling IoT FND Database HA
To disable IoT FND Database HA:

1. On the server running the Observer program, stop the Observer:

$ ./manageObserver.sh stop cgms_s password
DGMGRL for Linux: Version 11.2.0.3.0 - 64bit Production

Copyright (c) 2000, 2009, Oracle. All rights reserved.

Welcome to DGMGRL, type "help" for information.
DGMGRL> Connected.
DGMGRL> Done.
$ Observer stopped

2. On the standby IoT FND Database server, delete the standby database:

$ ./deleteStandbyDb.sh 

Are you sure you want to delete the standby database ? All replicated data will be lost (y/n)? y

09-20-2012 14:27:02 PDT: INFO: User response: y
09-20-2012 14:27:02 PDT: INFO: Cleaning up instance - cgms_s
DGMGRL for Linux: Version 11.2.0.3.0 - 64bit Production

Copyright (c) 2000, 2009, Oracle. All rights reserved.

Welcome to DGMGRL, type "help" for information.
DGMGRL> Connected.
DGMGRL> Done.
DGMGRL> DGMGRL for Linux: Version 11.2.0.3.0 - 64bit Production

Copyright (c) 2000, 2009, Oracle. All rights reserved.

Welcome to DGMGRL, type "help" for information.
DGMGRL> Connected.
DGMGRL> Disabled.
DGMGRL> 09-20-2012 14:27:06 PDT: INFO: Removing dataguard configuration
DGMGRL for Linux: Version 11.2.0.3.0 - 64bit Production

Copyright (c) 2000, 2009, Oracle. All rights reserved.

Welcome to DGMGRL, type "help" for information.
DGMGRL> Connected.
DGMGRL> Removed configuration
DGMGRL> 09-20-2012 14:27:07 PDT: INFO: Stopping the database

SQL*Plus: Release 11.2.0.3.0 Production on Thu Sep 20 14:27:07 2012
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Copyright (c) 1982, 2011, Oracle. All rights reserved.

Connected to:
Oracle Database 11g Enterprise Edition Release 11.2.0.3.0 - 64bit Production
With the Partitioning, OLAP, Data Mining and Real Application Testing options

SQL> ORA-01109: database not open

Database dismounted.
ORACLE instance shut down.
SQL> Disconnected from Oracle Database 11g Enterprise Edition Release 11.2.0.3.0 - 64bit Production
With the Partitioning, OLAP, Data Mining and Real Application Testing options

LSNRCTL for Linux: Version 11.2.0.3.0 - Production on 20-SEP-2012 14:27:19

Copyright (c) 1991, 2011, Oracle. All rights reserved.

Connecting to 
(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=test-scale-15krpm)(PORT=1522))(CONNECT_DATA=(SERVER=DEDIC
ATED)(SERVICE_NAME=cgms_s)))
The command completed successfully
Cleaning up instance - cgms_s
09-20-2012 14:27:29 PDT: INFO: ========== Completed Successfully ==========

3. On the primary IoT FND Database server, delete the HA configuration:

$ ./deletePrimaryDbHa.sh 
Are you sure you want to delete the high availability configuration ? All replicated data will be 
lost (y/n)? y

09-20-2012 14:25:25 PDT: INFO: User response: y
09-20-2012 14:25:25 PDT: INFO: Removing secondary configuration from primary

SQL*Plus: Release 11.2.0.3.0 Production on Thu Sep 20 14:25:25 2012

Copyright (c) 1982, 2011, Oracle. All rights reserved.

Connected to:
Oracle Database 11g Enterprise Edition Release 11.2.0.3.0 - 64bit Production
With the Partitioning, OLAP, Data Mining and Real Application Testing options

SQL> 
System altered.
...
SQL> Disconnected from Oracle Database 11g Enterprise Edition Release 11.2.0.3.0 - 64bit Production
With the Partitioning, OLAP, Data Mining and Real Application Testing options
09-20-2012 14:25:28 PDT: INFO: Removing data guard config files
09-20-2012 14:25:28 PDT: INFO: Removing standby redo logs
09-20-2012 14:25:29 PDT: INFO: Creating listener file
09-20-2012 14:25:29 PDT: INFO: Listener successfully configured.
09-20-2012 14:25:29 PDT: INFO: Recreating tnsnames ora file
09-20-2012 14:25:29 PDT: INFO: reloading the listener

LSNRCTL for Linux: Version 11.2.0.3.0 - Production on 20-SEP-2012 14:25:29

Copyright (c) 1991, 2011, Oracle. All rights reserved.

Connecting to (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=test-scale-15krpm-db2)(PORT=1522)))
The command completed successfully
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LSNRCTL for Linux: Version 11.2.0.3.0 - Production on 20-SEP-2012 14:25:30

Copyright (c) 1991, 2011, Oracle. All rights reserved.

Starting /home/oracle/app/oracle/product/11.2.0/dbhome_1/bin/tnslsnr: please wait...

TNSLSNR for Linux: Version 11.2.0.3.0 - Production
System parameter file is /home/oracle/app/oracle/product/11.2.0/dbhome_1/network/admin/listener.ora
Log messages written to 
/home/oracle/app/oracle/diag/tnslsnr/test-scale-15krpm-db2/cgmstns/alert/log.xml
Listening on: (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=test-scale-15krpm-db2)(PORT=1522)))

Connecting to (DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=test-scale-15krpm-db2)(PORT=1522)))
STATUS of the LISTENER
------------------------
Alias                     cgmstns
Version                   TNSLSNR for Linux: Version 11.2.0.3.0 - Production
Start Date                20-SEP-2012 14:25:30
Uptime                    0 days 0 hr. 0 min. 0 sec
Trace Level               off
Security                  ON: Local OS Authentication
SNMP                      OFF
Listener Parameter File   
/home/oracle/app/oracle/product/11.2.0/dbhome_1/network/admin/listener.ora
Listener Log File         
/home/oracle/app/oracle/diag/tnslsnr/test-scale-15krpm-db2/cgmstns/alert/log.xml
Listening Endpoints Summary...
  (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=test-scale-15krpm-db2)(PORT=1522)))
Services Summary...
Service "cgms" has 1 instance(s).
  Instance "cgms", status UNKNOWN, has 1 handler(s) for this service...
The command completed successfully
09-20-2012 14:25:30 PDT: INFO: ==========  Completed Successfully ==========

Load-Balancing Policies
The following table describes the load-balancing policy for each type of traffic the LB supports:

Traffic Load Balancing Policy

HTTPS traffic to and from browsers and IoT FND API clients 
(IPv4; ports 80 and 443)

The LB uses Layer 7 load balancing for all traffic from Web 
browsers and IoT FND API clients. 

The LB uses stickiness for general HTTPS traffic.
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Running LB Configuration Example
The following is an example of the running configuration of a properly configured IoT FND LB:

# show running-config 
Generating configuration....

ssh maxsessions 10

boot system image:c4710ace-t1k9-mz.A5_1_1.bin

hostname cgnmslb2 
interface gigabitEthernet 1/1
switchport access vlan 10
no shutdown

interface gigabitEthernet 1/2
description server-side
switchport access vlan 11
no shutdown

interface gigabitEthernet 1/3
description client-side
switchport access vlan 8
no shutdown

interface gigabitEthernet 1/4
switchport access vlan 55
no shutdown

access-list ALL line 8 extended permit ip any any 
access-list everyone line 8 extended permit ip any any 
access-list everyone line 16 extended permit icmp any any 
access-list ipv6_acl line 8 extended permit ip anyv6 anyv6 
access-list ipv6_acl2 line 8 extended permit icmpv6 anyv6 anyv6 

ip domain-lookup

For FAR IPv4 traffic going to ports 9121 and 9120:

 Tunnel Provisioning on port 9120 over HTTPS

 Regular registration and periodic on 9121 over HTTPS

The LB uses Layer 3 load balancing for all FAR traffic. This is the 
traffic from the FAR to IoT FND.

For IPv6 CSMP traffic to and from mesh endpoints (MEs):

 UDP traffic over port 61624 

— Registration

— Periodic transmission of metrics

— Firmware push

— Configuration push

 UDP traffic over port 61625 

For outage notifications sent by MEs.

The LB uses Layer 3 load balancing for all ME traffic to port 61624, 
and outage messages to port 61625.

Traffic Load Balancing Policy
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ip domain-name cisco.com
ip name-server 171.68.226.120
ip name-server 171.70.168.183

probe http probe_cgnms-http
port 80
interval 15
passdetect interval 60
expect status 200 200
open 1

rserver host 12-12-1-31
ip address 12.12.1.31
conn-limit max 4000000 min 4000000
probe probe_cgnms-http
inservice

rserver host 12-12-1-32
ip address 12.12.1.32
conn-limit max 4000000 min 4000000
probe probe_cgnms-http
inservice

rserver host 2002-cafe-server-202
description realserver 2002:cafe:server::202
ip address 2002::202
conn-limit max 4000000 min 4000000
probe probe_cgnms-http
inservice

rserver host 2002-cafe-server-211
ip address 2002:cafe:server::211
conn-limit max 4000000 min 4000000
probe probe_cgnms-http
inservice

serverfarm host cgnms_2
description cgnms-serverfarm
probe probe_cgnms-http
rserver 2002-cafe-server-202 61624
conn-limit max 4000000 min 4000000
inservice

rserver 2002-cafe-server-211 61624
conn-limit max 4000000 min 4000000
inservice

serverfarm host cgnms_2_ipv4
probe probe_cgnms-http
rserver 12-12-1-31
conn-limit max 4000000 min 4000000
inservice

rserver 12-12-1-32
conn-limit max 4000000 min 4000000
inservice

sticky ip-netmask 255.255.255.255 address source CGNMS_SRC_STICKY
serverfarm cgnms_2_ipv4

class-map type management match-any remote_access
2 match protocol xml-https any
3 match protocol icmp any
4 match protocol telnet any
5 match protocol ssh any
6 match protocol http any
7 match protocol https any
8 match protocol snmp any

class-map type management match-all ssh_allow_access
2 match protocol ssh any
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class-map match-any virtual-server-cgnms
2 match virtual-address 2002:server:cafe::210 udp eq 61624

class-map match-any vs_cgnms_ipv4
3 match virtual-address 12.12.1.101 tcp eq https
4 match virtual-address 12.12.1.101 tcp eq 9120
5 match virtual-address 12.12.1.101 tcp eq 9121
6 match virtual-address 12.12.1.101 tcp eq 8443
7 match virtual-address 12.12.1.101 tcp any

policy-map type management first-match remote_mgmt_allow_policy
class remote_access
permit

policy-map type loadbalance first-match virtual_cgnms_l7
class class-default
serverfarm cgnms_2

policy-map type loadbalance first-match vs_cgnms_l7_v4
class class-default
sticky-serverfarm CGNMS_SRC_STICKY

policy-map multi-match cgnms_policy_ipv6
class virtual-server-cgnms
loadbalance vip inservice
loadbalance policy virtual_cgnms_l7
loadbalance vip icmp-reply active

policy-map multi-match int1000
class vs_cgnms_ipv4
loadbalance vip inservice
loadbalance policy vs_cgnms_l7_v4
loadbalance vip icmp-reply active

interface vlan 8
bridge-group 1
access-group input everyone
access-group input ipv6_acl
no shutdown

interface vlan 10
bridge-group 2
access-group input everyone
access-group input ipv6_acl
service-policy input int1000
no shutdown

interface vlan 11
bridge-group 2
access-group input everyone
access-group input ipv6_acl
no shutdown

interface vlan 55
bridge-group 1
access-group input everyone
access-group input ipv6_acl
service-policy input cgnms_policy_ipv6
no shutdown

interface bvi 1
ipv6 enable
ip address 2002:server:cafe::206/64
no shutdown

interface bvi 2
ip address 12.12.1.100 255.255.255.0
no shutdown

domain cisco.com
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ip route 2011::/16 2002:server:cafe::101
ip route 2001:server:cafe::/64 2002:cafe::101
ip route 11.1.0.0 255.255.0.0 12.12.1.33
ip route 15.1.0.0 255.255.0.0 12.12.1.33
ip route 13.211.0.0 255.255.0.0 12.12.1.33

context VC_Setup1
allocate-interface vlan 40
allocate-interface vlan 50
allocate-interface vlan 1000

username admin password 5 $1$CB34uAB9$BW8a3ijjxvBGttuGtTcST/ role Admin domain 
default-domain 
username www password 5 $1$q/YDKDp4$9PkZl1SBMQW7yZ7E.sOZA/ role Admin domain de
fault-domain 

ssh key rsa 1024 force

Configuring Tunnel Provisioning Policies
Use tunnel policies to configure multiple tunnels for a FAR. Each tunnel is associated with an interface on a FAR and an HER. If a tunnel 
provisioning group has one or more HERs, IoT FND displays a policy in the Tunnel Provisioning Policies tab (Config > Tunnel 
Provisioning). Use this policy to configure FAR-to-HER interface mapping. 

To map FAR-to-HER interfaces in IoT FND:

1. Choose Config > Tunnel Provisioning.

2. In the TUNNEL GROUPS pane, select a group to configure with tunnel redundancy.

3. Create a CSV or XML file that lists the HERs to add to the group in the format EID, device type, as follows:

eid,deviceType
asr-0, asr1000 
asr-1, asr1000 
asr-2, asr1000 

4. Click Assign Devices to Group to import the file and add HERs to the group.
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Note: An HER can a member of multiple tunnel provisioning groups.

5. With the tunnel provisioning group selected, click the Policies tab.

By default, IoT FND displays the InterfaceMapping policy. 

Note: InterfaceMapping is the only policy type currently supported in IoT FND.

IoT FND displays one interface mapping entry for every HER in the group. You can add or remove interface mapping entries as needed.

6. In the Policy Name field, enter the name of the policy.
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7. To add an interface-mapping entry to the policy, click Add More Interfaces.

To delete an entry, click Delete ( ) for that entry.

8. To configure an interface-mapping entry, click the Policy Name link, and complete the following as necessary:

a. To select a different HER, click the currently selected HER and choose a different one from the Select a HER drop-down menu.

b. To select the HER IP for the tunnel destination on the HER, click the selected interface and choose a different one from the Select 
HER IP drop-down menu.

c. To select the FAR interface that maps to the selected HER interface, choose an interface from the Select CGR Interface drop-down 
menu.

d. Click Update.

9. To enable the policy, check the Enabled check box.

10. Click Save.

Modifying the Tunnel Provisioning Templates for Tunnel Redundancy
After defining the tunnel provisioning policy for a tunnel provisioning group, modify the Field Area Router Tunnel Addition and the 
Head-End Router Tunnel Addition templates to include commands to establish the multiple tunnels defined in the policy.

Field Area Router Tunnel Addition Template Example

In this example, bold text indicates the changes made to the default Field Area Router Tunnel Addition template to create multiple tunnels:

<#-- 
  Configure a Loopback0 interface for the FAR. This is done first as features
  look for this interface and use it as a source.

  This is independent of policies
-->
interface Loopback0
  <#--
    Now obtain an IPv4 address that can be used to for this FAR's Loopback
    interface. The template API provides methods for requesting a lease from
    a DHCP server. The IPv4 address method requires a DHCP client ID and a link
    address to send in the DHCP request. The 3rd parameter is optional and
    defaults to "CG-NMS". This value is sent in the DHCP user class option. 
    The API also provides the method "dhcpClientId". This method takes a DHCPv6
358



 

Managing High Availability Installations

  
    Identity association identifier (IAID) and a DHCP Unique  IDentifier (DUID) 
    and generates a DHCPv4 client identifier as specified in RFC 4361. This
    provides some consistency in how network elements are identified by the 
    DHCP server.
  -->
  ip address ${far.ipv4Address(dhcpClientId(far.enDuid, 0), far.dhcpV4LoopbackLink).address}/32  
  <#--
    Now obtain an IPv6 address that can be used to for this FAR's loopback
    interface. The method is similar to the one used for IPv4, except clients
    in DHCPv6 are directly identified by their DUID and IAID. IAIDs used for
    IPv4 are separate from IAIDs used for IPv6, so we can use zero for both
    requests. 
  -->
  ipv6 address ${far.ipv6Address(far.enDuid, 0, far.dhcpV6LoopbackLink).address}/128
exit

<#-- Make certain the required features are enabled on the FAR. -->
feature crypto ike
feature ospf
feature ospfv3
feature tunnel
<#-- Features ike and tunnel must be enabled before ipsec. -->
feature crypto ipsec virtual-tunnel

<#--
  Toggle on/off the c1222r feature to be certain it uses the Loopback0 
  interface as its source IP.
-->
no feature c1222r
feature c1222r

<#-- Configure Open Shortest Path First routing processes for IPv4 and IPv6. -->
router ospf 1
exit
router ospfv3 2
exit

<#-- 
  Now that OSPF has been configured complete the configuration of Loopback0. 
-->
interface Loopback0
  ip router ospf 1 area ${far.ospfArea1!"1"}
  ipv6 router ospfv3 2 area ${far.ospfV3Area1!"0"}
exit

<#-- Configure Internet Key Exchange for use by the IPsec tunnel(s). -->
crypto ike domain ipsec
  identity hostname
  policy 1
    <#-- Use RSA signatures for the authentication method. -->
    authentication rsa-sig
    <#-- Use the 1536-bit modular exponential group. -->
    group 5
  exit
exit
crypto ipsec transform-set IPSecTransformSet esp-aes 128 esp-sha1-hmac
crypto ipsec profile IPSecProfile
  set transform-set IPSecTransformSet
exit

<#--
  Define template variables to keep track of the next available IAID (IPv4)
  and the next available tunnel interface number. We used zero when leasing
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  addresses for Loopback0, so start the IAID at one.
-->
<#assign iaId = 1>
<#assign interfaceNumber = 0>

<#-- 
  The same logic is needed for each of the IPsec tunnels, so a macro is used
  to avoid duplicating configuration. The first parameter is the prefix to
  use when looking for the WAN interface on the FAR to use for the source of
  the tunnel. The second parameter is the OSPF cost to assign to the tunnel.
-->
<#macro configureTunnel interfaceNamePrefix destinationInterface her tunnelIndex ospfCost>
  <#-- 
    If an interface exists on the FAR whose name starts with the given prefix 
    and an IPv4 address as been assigned to that interface then the IPsec 
    tunnel can be configured, otherwise no tunnel will be configured. The
    template API interfaces method will return all interfaces whose name
    starts with the given prefix.
  -->
  <#assign wanInterface = far.interfaces(interfaceNamePrefix)>
  <#-- Check if an interface was found and it has an IPv4 address. -->
  <#if (wanInterface[0].v4.addresses[0].address)??>
    <#-- 
      Determine the HER destination address to use when configuring the tunnel.
      If the optional property "ipsecTunnelDestAddr1" has been set on this FAR 
      then use the value of that property. Otherwise look for that same property
      on the HER. If the property is not set on the FAR or the HER, then fallback
      to using an address on the HER GigabitEthernet0/0/0 interface.
    -->
    <#assign destinationAddress = her.interfaces(destinationInterface)[0].v4.addresses[0].address>
    
    <#if !(destinationAddress??)>
      ${provisioningFailed("Unable to determine the destination address for IPsec tunnels")}
    </#if>
    interface Tunnel${interfaceNumber}
      <#assign interfaceNumber = interfaceNumber + 1>
      description IPsec tunnel to ${her.eid}
      <#--
        For a tunnel interface two addresses in their own tiny subnet are 
        needed. The template API provides an ipv4Subnet method for leasing an 
        IPv4 from a DHCP server. The parameters match those of ipv4Address,
        with a fourth optional parameter that can be used to specify the 
        prefix length of the subnet to request. If not specified the prefix
        length requested will default to 31, which provides the two addresses
        needed for a point to point link. 
        
        NOTE: If the DHCP server being used does not support leasing an IPv4 
        subnet, then this call will have to be changed to use the ipv4Address 
        method and the DHCP server will have to be configured to respond
        appropriately to the request made here and the second request that
        will have to be made when configuring the HER side of the tunnel.
        That may require configuring the DHCP server with reserved addresses
        for the client identifiers used in the calls.
      -->
      <#assign lease = far.ipv4Subnet(dhcpClientId(far.enDuid, tunnelIndex), far.dhcpV4TunnelLink)>
      <#assign iaId = iaId + 1>
      <#-- Use the second address in the subnet for this side of the tunnel. -->
      ip address ${lease.secondAddress}/${lease.prefixLength}
      ip ospf cost ${ospfCost}
      ip ospf mtu-ignore
      ip router ospf 1 area ${far.ospfArea1!"1"}
      tunnel destination ${destinationAddress}
      tunnel mode ipsec ipv4
      tunnel protection ipsec profile IPSecProfile
      tunnel source ${wanInterface[0].name}
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      no shutdown
    exit
  </#if>
</#macro>

<#-- 
  Since we are doing policies for each tunnel here, the list of policies passed to this template can be
  iterated over to get the tunnel configuration viz interface mapping

  tunnelObject.ipSecTunnelDestInterface is the "interface on CGR"
  tunnelObject.ipSecTunnelSrcInterface is the "interface on HER"
  tunnelObject.her is the HER of interest
 -->

<#list far.tunnels("ipSec") as tunnelObject>
<@configureTunnel tunnelObject.ipSecTunnelDestInterface tunnelObject.ipSecTunnelSrcInterface 

tunnelObject.her tunnelObject.tunnelIndex 100/>  <----- Loop through policies (aka Tunnels)
</#list>

<#-- 
  Make certain provisioning fails if we were unable to configure any IPsec 
  tunnels. For example this could happen if the interface properties are
  set incorrectly.
-->
<#if iaId = 1>
  ${provisioningFailed("Did not find any WAN interfaces to use as the source for IPsec tunnels")}
</#if>

<#-- 
  Configure an IPv6-in-IPv4 GRE tunnel to allow IPv6 traffic to reach the data 
  center.
-->
<#macro configureGreTunnel destinationInterface her tunnelIndex>

<#assign destinationAddress = her.interfaces(destinationInterface)[0].v4.addresses[0].address>

<#if !(destinationAddress??)>
     ${provisioningFailed("Unable to determine the destination address for GRE tunnels")}
</#if>

interface Tunnel${interfaceNumber}
  <#assign interfaceNumber = interfaceNumber + 1>
  description GRE IPv6 tunnel to ${her.eid}
  <#--
    The ipv6Subnet method is similar to the ipv4Subnet method except instead
    of obtaining an IPv4 subnet it uses DHCPv6 prefix delegation to obtain an
    IPv6 prefix. The prefix length will default to 127, providing the two 
    addresses needed for the point to point link. For the IAID, zero was used 
    when requesting an IPv6 address for loopback0, so use one in this request.
  -->
  <#assign lease = far.ipv6Subnet(far.enDuid, tunnelIndex, far.dhcpV6TunnelLink)>
  ipv6 address ${lease.secondAddress}/${lease.prefixLength}
  ipv6 router ospfv3 2 area ${far.ospfV3Area1!"0"}
  ospfv3 mtu-ignore
  tunnel destination ${destinationAddress}
  tunnel mode gre ip
  tunnel source Loopback0
  no shutdown
exit

</#macro>

<#-- Loop through the policies for GRE tunnels -->
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<#list far.tunnels("gre") as greTunnelObj>
<@configureGreTunnel greTunnelObj.greDestInterface greTunnelObj.her greTunnelObj.tunnelIndex/>

</#list>

Head-End Router Tunnel Addition Template

In this example, bold text indicates the changes made to the default Head-End Router Tunnel Addition template to create multiple tunnels:

<#--
  Define template variables to keep track of the IAID (IPv4) that was used by
  the FAR template when configuring the other end of the tunnel. This template
  must use the same IAID in order to locate the same subnet that was leased by
  the FAR template so both endpoints are in the matching subnet.
-->
<#assign iaId = 1>

<#-- 
  The same logic is needed for each of the IPsec tunnels, so a macro is used. 
-->
<#macro configureTunnel ipSecTunnelSrcInterface ipSecTunnelDestInterface her tunnelIndex ospfCost>
  <#--
    Only configure the HER tunnel end point if the FAR tunnel end point was
    configured. This must match the corresponding logic in the FAR tunnel
    template. The tunnel will not have been configured if the WAN interface 
    does not exist on the FAR or does not have an address assigned to it.
  -->
  <#assign wanInterface = far.interfaces(ipSecTunnelDestInterface)>
  <#if (wanInterface[0].v4.addresses[0].address)??>
    <#-- Obtain the full interface name based on the prefix. -->
    <#assign interfaceName = wanInterface[0].name>
    <#-- 
      Locate a tunnel interface on the HER that is not in use. The template
      API provides an unusedInterfaceNumber method for this purpose. All of
      the parameters are optional. The first parameter is a name prefix
      identifying the type of interfaces, it defaults to "tunnel". The second
      parameter is a lower bound on the range the unused interface number must
      be in, it defaults to zero. The third parameter is the upper bound on
      the range, it defaults to max integer (signed). The method remembers
      the unused interface numbers it has returned while the template is
      being processed and excludes previously returned numbers. If no unused
      interface number meets the constraints an exception will be thrown.
    -->
    interface Tunnel${her.unusedInterfaceNumber()}
      description IPsec tunnel to ${far.eid}
      <#assign lease = far.ipv4Subnet(dhcpClientId(far.enDuid, tunnelIndex), far.dhcpV4TunnelLink)>
      <#assign iaId = iaId + 1>
      ip address ${lease.firstAddress} ${lease.subnetMask}
      ip ospf cost ${ospfCost}
      ip ospf mtu-ignore
      tunnel destination ${wanInterface[0].v4.addresses[0].address}
      tunnel mode ipsec ipv4
      tunnel protection ipsec profile IPSecProfile
      tunnel source ${ipSecTunnelSrcInterface}
      no shutdown
    exit
    router ospf 1
      network ${lease.prefix} ${lease.wildcardMask} area ${far.ospfArea1!"1"}
    exit
  </#if>
</#macro>

<#list far.tunnels("ipSec") as tunnelObject>
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        <@configureTunnel tunnelObject.ipSecTunnelSrcInterface tunnelObject.ipSecTunnelDestInterface 
tunnelObject.her tunnelObject.tunnelIndex 100/>
</#list>

<#-- 
  Configure an IPv6-in-IPv4 GRE tunnel to allow IPv6 traffic to reach the data 
  center.
-->
<#macro configureGreTunnel greSrcInterface her tunnelIndex>
interface Tunnel${her.unusedInterfaceNumber()}
  description GRE IPv6 tunnel to ${far.eid}
  <#assign lease = far.ipv6Subnet(far.enDuid, tunnelIndex, far.dhcpV6TunnelLink)>
  ipv6 address ${lease.firstAddress}/${lease.prefixLength}
  ipv6 enable
  ipv6 ospf 2 area ${far.ospfV3Area1!"0"}
  ipv6 ospf mtu-ignore
  tunnel destination ${far.interfaces("Loopback0")[0].v4.addresses[0].address}
  tunnel mode gre ip
  tunnel source ${greSrcInterface}
exit
</#macro>

<#-- Loop through the policies for GRE tunnels -->
<#list far.tunnels("gre") as greTunnelObj>
        <@configureGreTunnel greTunnelObj.greSrcInterface greTunnelObj.her greTunnelObj.tunnelIndex/>
</#list>
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Troubleshooting IoT FND
This section describes how to troubleshoot common IoT FND issues.

 Tunnel Provisioning DHCP Configuration Issues

 Mesh Endpoint Registration Issues

 Recovering an Expired Database Password

 Unlocking the IoT FND Database Password

 IoT FND Service Will Not Start

 Exception in the server.log File on the IoT FND Server

 Resetting the root Password

 Second IoT FND Server Not Forming a Cluster

 IoT FND Service Restarts Automatically

 FAR Management Issues

 Mesh Endpoint Management Issues

Note: Always reference the release notes for your IoT FND version.

Tunnel Provisioning DHCP Configuration Issues
If there is a problem allocating an address, IoT FND logs a Tunnel Provisioning Failure event. The log entry includes details of the error.

To monitor the address allocation process:

 Check the IoT FND server.log file to determine if IoT FND is sending a DHCP request during tunnel provisioning.

 Check your DHCP server log file to determine if the DHCP request from IoT FND reached the DHCP server.

If requests are not reaching the server:

 Ensure that the DHCP server address is correct on the Provisioning Settings page in IoT FND (Admin > System Management > 
Provisioning Settings). 

 Check for network problems between IoT FND and the DHCP server.

If the DHCP server is receiving the request but not responding:

 View the DHCP server log file, and ensure that the DHCP server is configured to support requests from the link address included in 
the DHCP requests. The link address is defined in the tunnel provisioning template. 

 Ensure that the DHCP server has not exhausted its address pool.

If the DHCP server is responding, but IoT FND is not processing the response:
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 Ensure that the lease time is infinite. Otherwise, IoT FND will not process the response. 

 View the DHCP server logs and IoT FND server logs for other errors.

Mesh Endpoint Registration Issues
To determine why MEs register with IoT FND, IoT FND collects the registration reason code from the MEs and logs events and the code 
with other relevant information as printed key value pairs to help diagnose registration issues. 

Here is an example of a logged event:

?Event logged: Event(id=0, eventTime=1335304407477, eventSeverity=0, eventSource=cgmesh, 
eventMessage=Mesh node registered due to cold boot: [lastReg: 0, lastRegReason: 1], 
NetElement.id=10043, EventType.name=null, lat=1000.0, lng=1000.0, geoHash=null 

Table 1 lists reason codes for ME registration and corresponding event:

In addition to generating events when MEs register with IoT FND, IoT FND also generates events after receiving a WPAN change TLV 
WPANStatus.

Event logged: Event(id=0, eventTime=1335304407974, eventSeverity=0, eventSource=cgmesh, 
eventMessage=WPAN change due to migration to better PAN: [lastChanged: 0, astChangedReason: 4], 
NetElement.id=10044, EventType.name=null, lat=1000.0, lng=1000.0, geoHash=null)

Table 1 Mesh Endpoint Registration Reason Codes

Registration Reason Code Code Event Type Name Severity Message Description 

REASON_UNKNOWN 0 unknownRegReason INFO Mesh node registered for 
unknown reason.

REASON_COLDSTART 1 coldBoot INFO Mesh node registered 
due to cold boot.

The message includes 
the new IP address of 
the ME.

REASON_ADMIN 2 manualReRegistration INFO Mesh node registered 
due to manual 
registration.

The endpoint received 
an 
NMSRedirectRequest 
without a URL field.

REASON_IP_CHANGE 3 rejoinedWithNewIP INFO Mesh node registered 
with new IP address.

The message includes 
the new IP address of 
the ME.

REASON_NMS_CHANGE 4 nmsAddrChange INFO Mesh node registered 
due to NMS address 
change.

The IoT FND IP 
address changed 
OUTSIDE of an 
NMSRedirect (a new 
DHCPv6 option value 
was received).

REASON_NMS_REDIRECT 5 manualNMSAddrChange INFO Mesh node registered 
due to manual NMS 
address change.

Endpoint received an 
NMSRedirect request.

REASON_NMS_ERROR 6 nmsError INFO Mesh node registered 
due to NMS error.

Endpoint received an 
error from IoT FND.
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Table 2 lists reasons for ME WPAN changes and the corresponding event.

For these events, the message includes the time elapsed since the ME left the network to when it rejoined. IoT FND displays the amount of 
time the ME was offline since the event was logged (for example, 4 hours 23 minutes ago).

Recovering an Expired Database Password
To recover from an expired password, run these commands:

su - oracle

sqlplus sys/cgmsDbaAccount@cgms as sysdba
alter user cgms_dev identified by test;
alter user cgms_dev identified by password;
exit;

Unlocking the IoT FND Database Password
If you enter an incorrect IoT FND Database password multiple times, Oracle locks your user account. Unlock your password using the 
Oracle software, as shown in this example:

# su - oracle
# sqlplus sys/<database_password>@cgms as sysdba
alter user cgms_dev account unlock;
exit;

IoT FND Service Will Not Start
If the IoT FND service does not start:

1. Validate connectivity to the database:

a. Log in as root on the IoT FND server.

b. Enter the following at the command prompt:

service cgms status

Table 2 Reasons for Mesh Endpoint WPAN Changes

Registration Reason Code Code Event Name Severity
Type

Description

IEEE154_PAN_LEAVE_UNKNOWN -1 unknownWPANChange MAJOR WPAN change for unknown 
reason.

IEEE154_PAN_LEAVE_INIT 0 meshInit N/A No event is generated for this code.

IEEE154_PAN_LEAVE_SYNC_TIMEOUT 1 meshConnectivityLost MAJOR WPAN change due to mesh 
connectivity loss.

IEEE154_PAN_LEAVE_GTK_TIMEOUT 2 meshLinkKeyTimeout MAJOR WPAN change due to mesh link 
key timeout.

IEEE154_PAN_LEAVE_NO_DEF_ROUTE 3 defaultRouteLost MAJOR WPAN change for no default route.

IEEE154_PAN_LEAVE_OPTIMIZE 4 migratedToBetterPAN MAJOR WPAN change due to migration to 
better PAN.
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c. Verify the database server IP address and that IoT FND can connect to the database. 

d. Run the service cgms status command and verify connectivity. 

e. Start IoT FND.

2. Verify that the JRE version installed on the server is correct (see System Requirements).

3. Verify that database migration was performed successfully.

Exception in the server.log File on the IoT FND Server
If the there is an exception in the server.log file indicating that IoT FND could not open the cgms_keystore file, then the cgms_keystore 
password stored in the cgms.properties file on the IoT FND server is incorrect.

The password for the cgms_keystore file is encrypted and stored in the /opt/cgms/server/cgms/conf/cgms.properties file.

To encrypt or decrypt the password, use the /opt/cgms/bin/encryption_util.sh script.

Verify or update the password in the cgms.properties file, and if an update is required, restart IoT FND after modifying the password.

Resetting the root Password 
If you forget the password of the IoT FND root user account, reset the password by running the /opt/cgms/bin/password_admin.sh script.

Second IoT FND Server Not Forming a Cluster
Typically, discovery of nodes in a IoT FND cluster is automatic. As long as the IoT FND servers are on the same subnet, they form a cluster. 

If you install a IoT FND server and it does not join the cluster:

1. Verify that your servers are on the same subnet, can ping each other, and share the same cluster name.

2. Check the status of all members by running the /opt/cgms/bin/print_cluster_view.sh script. 

3. Modify the cluster name, as follows:

a. Change the value of the HA_PARTITION_NAME parameter on all IoT FND cluster nodes, and then restart them.

b. Change the value of the UDP_MULTICAST_ADDR parameter (unique multicast address) to match on all nodes in the cluster.

c. Change the value of the CLUSTER_BIND_ADDR parameter to the interface to which you want the NMS to bind.

4. Verify that all the cluster nodes are configured to use NTP (see Configuring NTP Service).

5. Check the /etc/hosts file and verify that the IP address is correctly mapped to the hostname of the local server.

IoT FND Service Restarts Automatically
When the IoT FND services are started, the watchdog script is invoked. The watchdog script checks the health of the IoT FND services. If 
the watchdog script detects an anomaly, it logs the conditions in the /opt/cgms/server/cgms/log/cgms_watchdog.log file

The watchdog script tries three times to determine if the anomaly condition improved. If not, it restarts the IoT FND services automatically, 
unless the database has become unreachable. If the database is not reachable, the watchdog stops the IoT FND services. Check the log files, 
including server.log, to determine what is causing the restarts.

 If the IP address is incorrect or if IoT FND cannot access the database, run setupCgms.sh and enter the correct values. 
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Manually disable the watchdog process by running the /opt/cgms/bin/deinstall_cgms_watchdog.sh script on the IoT FND server as root.

FAR Management Issues
This section presents common issues with FAR management and possible resolutions.

Certificate Exception
If this exception appears in the server.log file stored on the IoT FND server when a FAR attempts to register with IoT FND, the 
cgms_keystore file does not contain the CA server certificates or the CA certificates that were imported into the cgms_keystore file are 
incorrect:

SSLException: Received fatal alert: unknown_ca

For information about how to import certificates into the cgms_keystore file, see Generating and Installing Certificates.

FAR Keeps Reloading and Does Not Switch to the Up State
When a FAR is continuously reloading every time it contacts IoT FND, it could be because the configuration pushed to the FAR by IoT FND 
is not being applied successfully. 

Check the server.log file on the IoT FND server for clues on the cause of the configuration push failure. Sometimes, typos in the in the Field 
Area Router Tunnel Addition template cause this failure (IoT FND does not provide template validation).

Note: When a FAR registers with IoT FND, IoT FND queries the FAR with show commands. IoT FND then configures the FAR based on 
the configuration commands in the Field Area Router Tunnel Addition template.

Other reasons for continuous reloads may be:

 A bad WAN link that drops packets and does not allow the registration to complete. 

 Firewall issues. Ensure that the firewall allows traffic in both directions and that traffic to and from the correct ports is allowed to pass.

Incorrect FAR State in IoT FND
In IoT FND, a FAR might appear in a Down state even though you can ping and trace the route to it without a problem.

IoT FND manages the FAR via the IoT-DM service running on the FAR. So even though the FAR is pingable and reachable, it is important 
to verify that the jetty server and call home features are enabled on the FAR:

'show run callhome' should have 'enable' in the config and 'sh jvm status'

Mesh Endpoint Management Issues
This section presents common issues with ME management and possible resolutions.

Mesh Endpoints Not Registering with IoT FND 
Verify that the MEs have joined the FAR and are pingable from IoT FND over IPv6. If they are pingable, verify the following:

 The clock is in sync.

 The DHCP server used by the MEs is programmed with the correct IoT FND IP address.
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 The MEs are running an image compatible with the current version of IoT FND.

 If HSM is used, HSM must be online and responding correctly.

Licensing Issues
This section presents common issues with license management and possible resolutions.

Device Import Failure

The importing of devices into IoT FND is dependent on the number of allotted IoT FND server licenses. 

Verify that your IoT FND server has the adequate license count available for the number and type of devices being imported into the 
IoT FND database.

Only unique device EIDs are allowed in IoT FND. Check that no one else imported this device EID in to IoT FND or is currently trying to 
import the same device EID. Verify that no other user is simultaneously importing the same device into IoT FND.

License File Upload Failure

An expired license file will cause an error. Check the license file validity and expiration date.
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